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About  this  document  

Throughout this document, ″Storage Manager Version 10.10″ refers to all host 

software release levels: Storage Manager versions 9.10, 9.12, 9.14, 9.15, 9.16, 

9.19, 9.23, and 10.10. References to other Storage Manager versions refer 

exclusively to those releases. 

This document provides information about how to plan, install, configure, and work 

with IBM® System Storage® DS4000 Storage Manager Version 10.10 in each of the 

following Intel® processor-based operating systems: 

v   Windows® 2000 Server/Advanced Server with Service Pack 4 

v   Windows Server 2003 

v   Novell NetWare 6.5 

v   Red Hat Enterprise Linux® Advanced Server 4 (RHEL AS 4) 

v   SUSE Linux Enterprise Server 9 (SLES 9) 

v   SUSE Linux Enterprise Server 10 (SLES 10) 

v   VMware ESX Server 2.5

Important:  Check the Storage Manager readme files for any updates to the list of 

supported operating systems. 

See “Readme files and concepts” on page 1 to find out how to access 

the most recent Storage Manager readme files on the Web. 

Overview 

Use this document to perform the following tasks: 

v   Determine the hardware and software that you will require to install the storage 

management software. 

v   Integrate the necessary hardware components into your network. 

v   Install the DS4000 Storage Manager software. 

v   Upgrade controller firmware, if necessary. 

v   Identify storage management features that are unique to your installation.

Note:   You can use Storage Manager 10.10 to manage storage subsystems with 

controller firmware versions 06.23.xx.xx through 07.10.xx.xx. Refer to Table 2 

on page 2 to find out which controller firmware code thread is supported for 

a given DS4000™ subsystem. There is currently no controller firmware 

version 6.1x.xx.xx for the following DS4000 storage subsystems: 

v   DS4300 - Single controller model (Machine Type 1722 model number 

6LU/6LX) 

v   FAStT200 

v   FAStT500

Contact your IBM reseller or representative regarding any future availability 

of 6.1x.xx.xx controller firmware for these DS4000 storage subsystems.
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Who should read this document 

This document is intended for system and storage administrators who are 

responsible for installing storage administration software. Readers should have 

knowledge of Redundant Array of Independent Disks (RAID), Small Computer 

System Interface (SCSI), fibre channel, and SATA technology. They should also 

have working knowledge of the applicable operating systems that are used with the 

management software. 
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DS4000 Storage Subsystem installation tasks - General overview 

Table 1 provides a sequential list of many installation and configuration tasks that 

are common to most DS4000 configurations. When you install and configure your 

DS4000 storage subsystem, refer to this table to find the documentation that 

explains how to complete each task. 

 Table 1. Where to find DS4000 installation and configuration procedures 

Installation task Where to find information or procedures 

1 Plan the installation v   DS4000 Storage Manager Concepts Guide 

v   DS4000 Storage Manager Installation and Host Support 

Guide for AIX®, HP-UX, Solaris, and Linux on POWER™ 

v   DS4000 Storage Manager Installation and Host Support 

Guide for Windows 2000/Server 2003/2008, NetWare, 

VMWare ESX Server, and Linux 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage™ Subsystem Installation, User’s, 

and Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User's, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User's, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage™ Quick Start Guide, Quick reference for 

the DS4800 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

2 Mount the DS4000 

storage subsystem in 

the rack 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   DS4400 and DS4500 Rack Mounting Instructions 

v   DS4300 Rack Mounting Instructions 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4100 Storage Subsystem Installation, User’s and 

Maintenance Guide 
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

3 Mount the DS4000 

EXP storage 

expansion unit in the 

rack 

v   DS4000 EXP100 Storage Expansion Unit Installation, User’s 

and Maintenance Guide 

v   DS4000 EXP420 Storage Expansion Enclosures Installation, 

User’s, and Maintenance Guide 

v   DS4000 EXP700 and EXP710 Storage Expansion Enclosures 

Installation, User’s, and Maintenance Guide 

v   DS4000 EXP810 Storage Expansion Enclosures Installation, 

User’s, and Maintenance Guide 

v   FAStT EXP500 Installation and User’s Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

4 Route the storage 

expansion unit fibre 

channel cables 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Cabling Instructions 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

5 Route the host 

server fibre channel 

cables 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Cabling Instructions 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

6 Power up the 

subsystem 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

7 Configure DS4000 

network settings 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

8 Zone the fabric 

switch 

(SAN-attached only) 

v   DS4000 Storage Manager Installation and Host Support 

Guide for AIX, HP-UX, Solaris, and Linux on POWER  

v   DS4000 Storage Manager Installation and Host Guide for 

Windows 2000/Server 2003/2008, NetWare, VMWare ESX  

Server, and Linux 

v   DS4000 Storage Manager Copy Services Guide (describes 

switch zoning for the Remote Mirror Option) 

v   See also the documentation provided by the switch 

manufacturer. 
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

9 Install DS4000 

Storage Manager 

software on the 

management station 

v   DS4000 Storage Manager Installation and Host Support 

Guide for AIX, HP-UX, Solaris, and Linux on POWER  

v   DS4000 Storage Manager Installation and Host Support 

Guide for Windows 2000/Server 2003/2008, NetWare, 

VMWare ESX Server, and Linux 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

v   DS4000 Storage Manager online help (for post-installation 

tasks) 

10 Install host software 

(failover drivers) on 

host server 

11 Start DS4000 

Storage Manager 

12 Set the DS4000 

Storage Manager 

clock 

13 Set the DS4000 

Storage Manager 

host default type 

14 Verify DS4000 

subsystem health 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

15 Enable DS4000 

Storage Manager 

premium feature 

keys 

Copy Services premium features 

DS4000 Storage Manager Copy Services Guide 

FC/SATA Intermix premium feature 

DS4000 Fibre Channel and Serial ATA Intermix 

Premium Feature Installation Overview 

Storage Partitioning (and general premium features 

information) 

v   DS4000 Storage Manager Concepts Guide 

v   DS4000 Storage Manager Installation and Host 

Support Guide for AIX, HP-UX, Solaris, and Linux on 

POWER  

v   DS4000 Storage Manager Installation and Host 

Support Guide for Windows 2000/Server 2003/2008, 

NetWare, VMWare ESX Server, and Linux
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

16 Configure arrays and 

logical drives 

v   DS4000 Storage Manager Installation and Host Support 

Guide for AIX, HP-UX, Solaris, and Linux on POWER  

v   DS4000 Storage Manager Installation and Host Support 

Guide for Windows 2000/Server 2003/2008, NetWare, 

VMWare ESX Server, and Linux 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4700 and DS4200, Sections 2, 3, and 4 also for 

installing the EXP810 and EXP420 

v   IBM System Storage Quick Start Guide, Quick reference for 

the DS4800 

v   DS4000 Storage Manager online help 

17 Configure host 

partitions 

18 Verify host access to 

DS4000 storage

  

How this document is organized 

Chapter 1, “Introduction,” on page 1 provides an overview of IBM DS4000 Storage 

Manager and describes storage subsystem management methods, configuration 

types, types of installations, and installation requirements. 

Chapter 2, “Preparing for installation,” on page 37 discusses preparing for a network 

installation, including setting up a Dynamic Host Configuration Protocol/Boot 

Protocol (DHCP/BOOTP) server on Windows 2000, Windows Server 2003, Linux, 

and UNIX® platforms. It also describes other setup tasks. 

Chapter 3, “Installing Storage Manager software in a standard Windows 

configuration,” on page 57 provides installation instructions for Windows 2000, and 

Windows 2000 Server software components in a standard (noncluster) environment. 

Chapter 4, “Installing Storage Manager software in a Windows cluster server 

environment,” on page 67 provides installation instructions for Windows 2000, and 

Windows 2000 Server software in a cluster server environment. 

Chapter 5, “Installing Storage Manager software in a Linux configuration,” on page 

83 provides installation instructions for the storage management software in a Linux 

operating system environment. 

Chapter 6, “Using DS4000 storage subsystems with NetWare hosts,” on page 101 

describes how to install the fibre channel HBA device driver, the LSIMPE.cdm 

driver, and the NetWare native failover device driver. 

Chapter 7, “Using DS4000 with a VMware ESX Server configuration,” on page 105 

provides installation instructions for the storage management software in a VMware 

ESX Server operating system environment. 

Chapter 8, “Completing storage management installation and configuration,” on 

page 113 discusses completion of Storage Manager software on Windows 2000, 

Windows 2000 Server, and Linux platforms. It provides details on the following 

tasks: 

v   Starting the Enterprise Management window 

v   Performing an automatic discovery of storage subsystems 

v   Adding devices 

v   Setting up alert notifications 
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v   Downloading firmware and nonvolatile storage random access memory 

(NVSRAM) 

v   Creating arrays and logical drives 

v   Other storage subsystem management tasks

Chapter 9, “Completing storage management tasks for Windows hosts,” on page 

137 provides information about adding and deleting logical drives, using the 

hot_add and SMdevices utilities, starting and stopping the host-agent software, and 

uninstalling Storage Manager components in Windows 2000 and Windows 2000 

Server operating system environments. 

Chapter 10, “SAN boot with Windows Server 2003,” on page 145 details the 

procedure for installing SAN boot in a Windows Server 2003 (x86 Enterprise Edition 

with SP1) environment, using Storport miniport or SCSIport miniport drivers. 

Chapter 11, “SAN boot with Linux,” on page 153 details the procedure for installing 

SAN boot in a Linux environment with an System x™ host. 

Appendix A, “Using the IBM System Storage DS4000 Controller Firmware Upgrade 

Tool,” on page 159 explains how to use this tool to migrate Storage Manager 

firmware versions 6.xx to the current 07.10.xx.xx and provides the steps to a 

successful migration. 

Appendix B, “Installing previous Storage Manager versions in a NetWare 

configuration,” on page 165 provides installation instructions for the storage 

management software in standard (noncluster) and cluster server configurations in 

the NetWare operating system environment. 

Appendix C, “Installing Storage Manager 9.2x Client,” on page 185 provides 

installation instructions specifically for Storage Manager 9.2x for Windows 2000, 

and Windows 2000 Server software components. 

Appendix E, “Operating system limitations,” on page 195 describes Windows 

2000/Windows Server 2003, Linux, and VMware ESX Server operating system 

limitations and other operating system issues. 

Appendix F, “SAN boot on Windows limitations,” on page 209 describes any known 

limitations of SAN boot on Windows operating systems. 

Appendix G, “SAN boot on Linux limitations,” on page 211 describes any known 

limitations of SAN boot on Linux operating systems. 

Appendix H, “Storage subsystem and controller information record,” on page 213 

provides a data sheet template that you can use to create a controller information 

record. 

Appendix I, “Host bus adapter settings,” on page 215 provides information on host 

bus adapter settings for different operating systems. 

Appendix J, “DS4000 Diagnostic Data Capture (DDC),” on page 223 provides 

information about saving event data for a critical internal controller error. 

Appendix K, “Additional DS4000 documentation,” on page 227 provides an overview 

of the DS4000 storage subsystem product libraries, as well as other related 

documents. 
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Appendix L, “Accessibility,” on page 237 provides information about accessibility 

features, which help a user who has a physical disability (such as restricted mobility 

or limited vision) to use software products successfully 

Notices that this document uses 

This document contains the following notices, which are designed to highlight key 

information: 

v   Notes: These notices provide important tips, guidance, or advice. 

v   Important: These notices provide information that might help you avoid 

inconvenient or problem situations. 

v   Attention: These notices indicate possible damage to programs, devices, or 

data. An attention notice is placed just before the instruction or situation in which 

damage could occur.

Getting information, help, and service 

If you need help, service, or technical assistance or just want more information 

about IBM products, you will find a wide variety of sources available from IBM to 

assist you. This section contains information about where to go for additional 

information about IBM and IBM products, what to do if you experience a problem 

with your system, and whom to call for service, if it is necessary. 

Before you call 

Before you call, take these steps to try to solve the problem yourself: 

v   Check all cables to make sure that they are connected. 

v   Check the power switches to make sure that the system is turned on. 

v   Use the troubleshooting information in your system documentation, and use the 

diagnostic tools that come with your system. 

v   Check for technical information, hints, tips, and new device drivers at the IBM 

support Web site pages that are listed in this section. 

v   Use an IBM discussion forum on the IBM Web site to ask questions.

You can solve many problems without outside assistance by following the 

troubleshooting procedures that IBM provides in the DS4000 Storage Manager 

online help or in the documents that are provided with your system and software. 

The information that comes with your system also describes the diagnostic tests 

that you can perform. Most subsystems, operating systems, and programs come 

with information that contains troubleshooting procedures and explanations of error 

messages and error codes. If you suspect a software problem, see the information 

for the operating system or program. 

Using the documentation 

Information about your IBM system and preinstalled software, if any, is available in 

the documents that come with your system. This includes printed books, online 

documents, readme files, and help files. See the troubleshooting information in your 

system documentation for instructions for using the diagnostic programs. The 

troubleshooting information or the diagnostic programs might tell you that you need 

additional or updated device drivers or other software. 
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Finding DS4000 readme files 

1.   Go to the following Web site: 

www.ibm.com/systems/support/storage/disk 

2.   Click the link for your Storage Subsystem (for example, DS4800). 

3.   When the subsystem support page opens, click the Download tab. 

4.   Under the Download tab, click Storage Manager, firmware, HBA, tools, 

support & pubs (including readmes). 

5.   Now, click the appropriate tab for the type of readme file that you are looking 

for: 

v   Firmware 

v   Storage Mgr 

v   HBA 

v   Tools

A table displays as you click each tab. 

6.   In the table, click on the appropriate link in the Current version and readmes 

column. 

7.   Click the link for the readme file.

Web  sites 

The most up-to-date information about DS4000 storage subsystems and DS4000 

Storage Manager, including documentation and the most recent software, firmware, 

and NVSRAM downloads, can be found at the following Web sites. 

DS4000 Midrange Disk Systems 

Find the latest information about IBM System Storage disk storage systems, 

including all of the DS4000 storage subsystems: 

 www.ibm.com/servers/storage/disk/ds4000 

IBM System Storage products 

Find information about all IBM System Storage products: 

 www.storage.ibm.com 

Support for IBM System Storage disk storage systems 

Find links to support pages for all IBM System Storage disk storage 

systems, including DS4000 storage subsystems and expansion units: 

 www.ibm.com/systems/support/storage/disk 

System Storage DS4000 interoperability matrix 

Find the latest information about operating system and HBA support, 

clustering support, storage area network (SAN) fabric support, and DS4000 

Storage Manager feature support: 

 www.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

Storage Area Network (SAN) support 

Find information about using SAN switches, including links to user guides 

and other documents: 

 www.ibm.com/systems/support/storage/san 

DS4000 technical support 

 Find downloads, hints and tips, documentation, parts information, HBA and 

fibre channel support: 
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Select your Storage Subsystem (for example, DS4800). 

Premium feature activation 

Activate a DS4000 premium feature by using the online tool: 

 www-912.ibm.com/PremiumFeatures/jsp/keyInput.jsp 

IBM publications center 

Find IBM publications: 

 www.ibm.com/shop/publications/order/ 

Support for System p™ servers 

Find the latest information supporting System p AIX and Linux servers: 

 www.ibm.com/systems/support/supportsite.wss/
brandmain?brandind=5000025 

Support for System x servers 

Find the latest information supporting System x Intel- and AMD-based 

servers: 

 www.ibm.com/systems/support/supportsite.wss/
brandmain?brandind=5000008 

Fix delivery center for AIX and Linux on POWER 

Find the latest AIX and Linux on POWER information and downloads: 

 www-912.ibm.com/eserver/support/fixes/fcgui.jsp 

In the Product family drop-down menu, select UNIX servers. Then select 

your product and fix type from the subsequent drop-down menus. 

Eserver System p and AIX information center 

Find everything you need to know about using AIX with System p and 

POWER servers: 

 publib.boulder.ibm.com/infocenter/pseries/index.jsp?

Software service and support 

Through IBM Support Line, for a fee you can get telephone assistance with usage, 

configuration, and software problems. For information about which products are 

supported by Support Line in your country or region, go to the following Web site: 

www.ibm.com/services/sl/products 

For more information about the IBM Support Line and other IBM services, go to the 

following Web sites: 

v   www.ibm.com/services 

v   www.ibm.com/planetwide

Hardware service and support 

You can receive hardware service through IBM Integrated Technology Services or 

through your IBM reseller, if your reseller is authorized by IBM to provide warranty 

service. Go to the following Web site for support telephone numbers: 

www.ibm.com/planetwide 
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In the U.S. and Canada, hardware service and support is available 24 hours a day, 

7 days a week. In the U.K., these services are available Monday through Friday, 

from 9 a.m. to 6 p.m. 

Fire suppression systems 

A fire suppression system is the responsibility of the customer. The customer’s own 

insurance underwriter, local fire marshal, or a local building inspector, or both, 

should be consulted in selecting a fire suppression system that provides the correct 

level of coverage and protection. IBM designs and manufactures equipment to 

internal and external standards that require certain environments for reliable 

operation. Because IBM does not test any equipment for compatibility with fire 

suppression systems, IBM does not make compatibility claims of any kind nor does 

IBM provide recommendations on fire suppression systems. 

How to send your comments 

Your feedback is important to help us provide the highest quality information. If you 

have any comments about this document, you can submit them in one of the 

following ways: 

E-mail 

 Submit your comments by e-mail to: 

starpubs@us.ibm.com 

Be sure to include the name and order number of the document and, if 

applicable, the specific location of the text that you are commenting on, 

such as a page number or table number. 

Mail 

 Fill out the Readers’ Comments form (RCF) at the back of this document 

and return it by mail or give it to an IBM representative. 

If the RCF has been removed, send your comments to:

International Business Machines Corporation 

Information Development 

Department GZW 

9000 South Rita Road 

Tucson, Arizona 

USA 

85744-0001

 Be sure to include the name and order number of the document and, if 

applicable, the specific location of the text that you are commenting on, 

such as a page number or table number.
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Chapter  1.  Introduction  

IBM DS4000 Storage Manager version 10.10.xx.xx host software supports the new 

features that are incorporated into all releases of controller firmware version 

07.10.xx.xx, and manages DS4000 storage subsystems with all generally-released 

controller firmware versions (05.3x.xx.xx to 07.10.xx.xx). 

Note:  Controller firmware version 07.10.xx.xx is only supported on the DS4800, 

DS4700, and DS4200. 

This document provides information on how to prepare, install, configure, and start 

the IBM System Storage DS4000 Storage Manager host management software and 

firmware in the following operating system environments: 

v   Windows 2000 

v   Windows Server 2003 

v   Novell NetWare 6.0 and 6.5 

v   RHEL 4, RHEL 5, SLES 9, and SLES 10 

v   VMware ESX Server

Note:  For analogous information regarding other operating systems, see theIBM 

System Storage DS4000 Storage Manager Installation and Host Support 

Guide for AIX, HP-UX, Solaris and Linux on POWER 

Consult your IBM resellers or representatives for any future support of additional 

operating system environments. Also, check the Storage Manager 10.10 readme 

files for any updates to the list of supported operating systems. 

Readme files and concepts 

Before you install DS4000 Storage Manager software, consult the following 

documentation: 

Storage Manager readme files 

Read these first.

Important:  Updated readme files contain the latest device driver versions, 

firmware levels and other information that supersedes this 

document. 

To access the most recent DS4000 Storage Manager readme files, 

complete the following steps: 

1.   Go to the following Web site:
www-1.ibm.com/servers/storage/support/disk/ 

2.   Click the link for your storage subsystem. 

3.   When the subsystem page opens, click the Download tab. 

4.   When the download page opens, click the Storage Mgr tab then click 

on the appropriate link under the Current versions and readmes 

column.

IBM DS4000 Storage Manager Concepts Guide 

Use this reference document to become familiar with the terminology and 

the features of the DS4000 Storage Manager software. This document is 

available on the DS4000 Storage Manager installation CD and at the Web 

site listed above.
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Supported controller firmware 

All of the controller firmware versions that are listed in Table 2 are available 

free-of-charge. However, you must purchase a DS4100 single-controller (SCU) 

storage subsystem to obtain controller firmware 05.42.xx.xx. 

In the table, the latest client code software and controller firmware versions are 

indicated by the use of bold text. To ensure the highest level of compatibility and 

error-free operation, ensure that the controller firmware for your DS4000 Storage 

Subsystem is the latest firmware version for the storage subsystem model. 

See “New Storage Manager 10.10 features” on page 3 for new features that are 

associated with the 07.10.xx.xx controller firmware. 

 Table 2. Machine types and supported storage management software 

Storage subsystem model 

Machine type and 

model Current firmware version 

IBM System Storage DS4800 Storage 

Subsystem 

1815—82A/H
84A/H 

07.10.xx.xx 

IBM System Storage DS4100 Storage 

Subsystem (Base Model) 

1724—100 06.12.xx.xx 

IBM System Storage DS4100 Storage 

Subsystem (Single Controller Model) 

1724—1SC 

1S 

05.42.xx.xx 

IBM System Storage DS4500 Disk 

Storage Subsystem 

1742—90X 

90U 

05.30.xx.xx 05.40.xx.xx 

05.41.xx.xx (supports 

EXP100 only) 06.1x.xx.xx 

IBM System Storage DS4400 Disk 

Storage Subsystem 

1742—1RU 

1RX 

05.00.xx.xx 05.20.xx.xx 

05.21.xx.xx 05.30.xx.xx 

05.40.xx.xx 06.1x.xx.xx 

IBM System Storage DS4300 Disk 

Storage Subsystem (Single Controller) 

1722—6LU 

6LX 

05.34.xx.xx 

IBM System Storage DS4300 Disk 

Storage Subsystem (Base Model) 

1722—60U 

60X 

05.33.xx.xx 05.34.xx.xx 

05.40.xx.xx 06.1x.xx.xx 

IBM System Storage DS4300 Disk 

Storage Subsystem (Turbo Model) 

1722—60U 

60X 

05.41.xx.xx (supports 

EXP100 only) 

IBM Netfinity® FAStT500 RAID Controller 

Enclosure Unit (no longer available for 

purchase) 

3552—1RU 

1RX 

04.x, 05.00.xx.xx 

05.20.xx.xx 05.21.xx.xx 

05.30.xx.xx 

IBM FAStT200 High Availability (HA) 

Storage Subsystem (no longer available 

for purchase) 

3542—2RU 

2RX 

04.x, 05.20.xx.xx 

05.30.xx.xx 

IBM FAStT200 Storage Subsystem (no 

longer available for purchase) 

3542—1RU 

1RX 

04.x, 05.20.xx.xx 

05.30.xx.xx 

IBM Netfinity Fibre Channel RAID 

Controller Unit (no longer available for 

purchase) 

3526—1RU 

1RX 

04.x 
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Table 2. Machine types and supported storage management software (continued) 

Storage subsystem model 

Machine type and 

model Current firmware version 

Notes:  

1.   The DS4800 Model 80A/H does not support controller firmware versions 06.14.xx.xx or 

06.15.xx.xx; however, firmware versions 06.23.xx.xx through 07.10.xx.xx are fully 

supported. 

2.   With controller firmware 06.12.xx.xx and higher, Storage Manager 10.10 supports 

DS4100 standard (base) and single-controller (SCU) SATA storage subsystems, and 

EXP100 SATA storage expansion enclosures. 

3.   FAStT200 and FAStT500 storage subsystems are no longer available; therefore, the 

Storage Manager features that are specific to version 06.1x.xx.xx firmware and above, 

and corresponding NVSRAM, are unavailable for those FAStT subsystems. IBM 

recommends that you use Storage Manager 10.10 software to manage these FAStT 

subsystems, using controller firmware versions 05.30.xx.xx.
  

Storage Manager online help and diagnostics 

When you finish the installation process, refer to the following online help systems: 

v   Enterprise Management window help 

Use this online help system to learn more about working with the entire 

management domain. 

v   Subsystem Management window help 

Use this online help system to learn more about managing individual storage 

subsystems.

You can access these help systems from within the Storage Manager Client. From 

either an Enterprise Management or Subsystem Management window, click Help or 

press F1. 

After you install IBM DS4000 Storage Manager version 10.10, consider installing 

the DS4000 diagnostic program. You can use these programs to verify the status of 

the fibre channel connections before you use the storage subsystem. 

The IBM QLogic SANsurfer User’s Guide and the QLogic SANsurfer program are 

located on the IBM DS4000 Storage Manager Version 10.10 CD where associated 

with your particular operating system. 

Note:  If your DS4000 storage subsystem is connected to a fibre channel host bus 

adapter (HBA) in the host server in a SAN environment, consider purchase 

one of the following software applications helpful for SAN management and 

troubleshooting. 

v   IBM Tivoli® SAN Manager 

v   McData SANavigator

New Storage Manager 10.10 features 

This section describes new DS4000 Storage Manager features and new host 

operating system capabilities that are available with Storage Manager 10.10. 
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New features with firmware 07.10.xx.xx 

Controller firmware version 07.10.xx.xx supports the following storage subsystems: 

v   DS4800 Storage Subsystems models 

v   DS4700 Storage Subsystems models 

v   DS4200 Express Storage Subsystems 

v   RAID 6 on DS4700, DS4200 only 

–   RAID 6 using a p+q implementation

v    Support for greater than 2TB volumes 

v   Support for RAID 0 and 1 volume groups with more than 30 drives 

v   Increase maximum number of partitions 

–   128 for DS4200 and DS4700 

–   512 for DS4800

v   Increased queue depth 

–   Increases the controller queue depth to 4096 for the DS4800 controllers and 

to 2048 for DS4700 and DS4200 controllers

v    Increased number of Global Hot Spares 

–   Lifts any previous limits on the number of Global Hot Spares allowed per 

array

v   Drive Migration Warning 

–   When migrating configured volume groups to an existing array, there will be a 

warning given if the number of volumes being added will overrun the 

maximum number of volumes allowed on this particular array.

v    Configurable failed drive replacement 

–   You will be allowed to specify a hot spare to be a permanent member of a 

volume group, thus eliminating the copy back portion once the failed drive has 

been replaced. The replacement drive will be in an unassigned state.

v    RAID redundant data verification prior to read 

–   Enables verification of redundant RAID data consistency before returning the 

requested read data back to the host. This feature should be enabled on a 

volume basis. It will automatically be disabled when a volume is degraded. If 

a mismatch is detected, the controller will return a Media error—unrecoverable 

read error (03/11/00). The array will not attempt to correct or recalculate parity 

automatically. This will support all raid levels.

v    8K cache block size 

v   Increase to 16 snapshots per volume for DS4800 

v   Increase the number of snapshots on DS4700 

v   DS4700 Path Redundancy Improvement 

–   Board turn-on DS4700 to allow the alternate controller to access drive 

channels, when a controller is held in reset or is undergoing SOD processing

v    Increase number of mirrors supported 

–   Increase the number of mirrors supported on the DS4800 from 64 to 128 and 

on the DS4700 from 32 to 64

v   Create Unmanageable Icon 

–   Create a new icon in the Enterprise Management Window to differentiate 

between Unresponsive and Unmanageable. The Unmanageable would be any 

array for which there is no corresponding JAR file.

v    Portable Volume Groups, SAFE changes 
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–   New export and import behavior, which will also include SAFE import changes 

of premium features.

Premium features 

The following premium features can be enabled on all DS4000 subsystems by 

purchasing a premium feature key: 

v   FlashCopy 

v   Enhanced Remote Mirror Option 

v   VolumeCopy 

v   Storage Partitioning 

v   FC/SATA Intermix

The first four premium features are described in the following section; FC/SATA 

Intermix is described in “FC/SATA Intermix premium feature” on page 6. 

FlashCopy 

This feature supports the creation and management of FlashCopy logical 

drives. A FlashCopy logical drive is a logical point-in-time image of another 

logical drive, called a base logical drive, that is in the storage subsystem. A 

FlashCopy is the logical equivalent of a complete physical copy, but you 

create it much more quickly and it requires less disk space. Because a 

FlashCopy is a host addressable logical drive, you can perform backups 

using the FlashCopy while the base logical drive remains online and 

user-accessible. In addition, you can write to the FlashCopy logical drive to 

perform application testing or scenario development and analysis. The 

maximum number of FlashCopy logical drives allowed is one half of the 

total number of logical drives supported by your controller model. 

Enhanced Remote Mirror Option 

The Enhanced Remote Mirror Option provides online, real-time replication 

of data between storage subsystems over a remote distance. 

 In the event of a disaster or unrecoverable error at one storage subsystem, 

the Enhanced Remote Mirror Option enables you to promote a second 

storage subsystem to take over responsibility for normal I/O operations.

Notes:  

1.   With DS4000 controller firmware versions earlier than 6.1x.xx.xx, you 

cannot use the Enhanced Remote Mirror Option. However, you can use 

a previous version of the Remote Mirror Option. See IBM System 

Storage DS4000 Storage Manager Copy Services User’s Guide for 

more information about the different versions. 

2.   Exception: You cannot use the Remote Mirror Option or the Enhanced 

Remote Mirror Option with DS4000 controller firmware versions 

5.41.xx.xx or 5.42.xx.xx, or with the DS4100 storage subsystem.

VolumeCopy 

The VolumeCopy feature is a firmware-based mechanism for replicating 

logical drive data within a storage array. This feature is designed as a 

system management tool for tasks such as relocating data to other drives 

for hardware upgrades or performance management, data backup, or 

restoring FlashCopy logical drive data. Users submit VolumeCopy requests 

by specifying two compatible drives. One drive is designated as the Source 

and the other as the Target. The VolumeCopy request is persistent so that 

any relevant result of the copy process can be communicated to the user.
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Note:  The terms VolumeCopy and Logical Drive Copy are used 

interchangeably throughout this document, the DS4000 Storage 

Manager client program GUI, and online help.

Storage Partitioning 

 Storage Partitioning allows the user to present all of the logical drives that 

are defined in the DS4000 storage subsystem to a SAN, through several 

different partitions by mapping each logical drive to a LUN number (0 - 255) 

in each of the defined partitions. A given logical drive can be mapped to 

only one partition at a given time. The logical drives that are mapped in a 

given storage partition will be accessible only to the host server or servers 

whose fibre channel HBA host ports are defined in that storage partition. 

This feature allows the DS4000 storage subsystem to act as a multiple 

virtual storage subsystem to the host servers. 

This feature also allows multiple hosts that use different operating systems 

with their own unique disk storage subsystem settings to connect to the 

same DS4000 storage subsystem at the same time (heterogeneous host 

environment).

FC/SATA  Intermix premium feature 

For important information about using the Intermix premium feature, including 

configuration and setup requirements, see the IBM System Storage DS4000 Fibre 

Channel and Serial ATA Intermix Premium Feature Installation Overview. 

Enabling the DS4000 FC/SATA  Intermix premium feature 

Storage Manager 10.10 supports the DS4000 FC/SATA Intermix premium feature 

with all 06.1x.xx.xx and higher controller firmware versions. However, depending on 

which level of the controller firmware is installed on your storage subsystem, you 

need to follow different procedures to enable the premium feature. 

DS4000 controller firmware version 07.10.xx.xx 

On storage subsystems using DS4000 controller firmware versions 

07.10.xx.xx, the DS4000 FC/SATA Intermix premium feature is enabled 

using a premium feature key. 

 Install the DS4000 FC/SATA Intermix Premium Feature Key, as described in 

the IBM System Storage DS4000 Fibre Channel and Serial ATA Intermix 

Premium Feature Installation Overview, to enable the DS4000 FC/SATA 

Intermix premium feature. 

DS4000 controller firmware versions 6.12.xx.xx and later 

On storage subsystems using DS4000 controller firmware versions 

6.12.xx.xx and later, the DS4000 FC/SATA Intermix premium feature is 

enabled using a premium feature key. 

 Install the DS4000 FC/SATA Intermix Premium Feature Key, as described in 

the IBM System Storage DS4000 Fibre Channel and Serial ATA Intermix 

Premium Feature Installation Overview, to enable the DS4000 FC/SATA 

Intermix premium feature. 

DS4000 controller firmware version 6.10.xx.xx 

On storage subsystems using DS4000 controller firmware version 

6.10.xx.xx, the DS4000 FC/SATA Intermix premium feature is enabled using 

an NVSRAM file. 
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Download the appropriate NVSRAM version, as described in the IBM 

System Storage DS4000 Fibre Channel and Serial ATA Intermix Premium 

Feature Installation Overview, to enable the DS4000 FC/SATA Intermix 

premium feature.

Upgrading DS4000 controller firmware on systems with FC/SATA 

Intermix already enabled 

Complete the following steps if you are currently using DS4000 controller firmware 

06.10.xx.xx, want to upgrade to 06.12.xx.xx or 06.14.xx.xx, and you already have 

the FC/SATA Intermix premium feature enabled. 

Complete the following steps to upgrade the controller firmware to 06.12.xx.xx or 

later: 

1.   Use the instructions in the DS4000 FC/SATA Intermix premium feature activation 

card to generate the premium feature key file. 

2.   Upgrade the controller firmware and NVSRAM to 06.12.xx.xx or 06.14.xx.xx 

version. 

Note:  After the firmware is upgraded, the recovery guru will display the error 

“premium feature out-of-compliance.” The premium feature that is 

out-of-compliance is the DS4000 FC/SATA Intermix premium feature. You 

will not be able to create any arrays or logical drives or modify the LUNs 

until after you complete step 3. 

3.   Enable the DS4000 FC/SATA Intermix premium feature using the premium 

feature key file. This restores the DS4000 subsystem to full functionality.

Storage Manager 10.10 limitations 

For the latest information, you can also refer to the Limitations and Prerequisites 

section in the Storage Manager readme file for your operating system. 

To access the most recent DS4000 Storage Manager readme files, complete the 

following steps: 

1.   Go to the following Web site:
www-1.ibm.com/servers/storage/support/disk/ 

2.   Click the link for your storage subsystem. 

3.   When the subsystem page opens, click the Download tab. 

4.   When the download page opens, click the Storage Mgr tab then click on the 

appropriate link under the Current versions and readmes column.

Limitations:  

1.   Controller firmware version 07.10.xx.xx is not supported on the following storage 

subsystems. 

v   FAStT200 (3542, all models) 

v   FAStT500 (3552, all models) 

v   DS4100 (1724, all models) 

v   DS4200 (1722, all models) 

v   DS4400 (1742, all models) 

v   DS4500 (1742, all models) 

Therefore, the Storage Manager features that are specific to version 07.10.xx.xx 

firmware are unavailable for these DS4000 servers. For the DS4100 (single 

controller only), use Storage Manager 10.1x with controller firmware versions 
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05.3x.xx.xx and 05.42.xx.xx. For more information about which firmware to use 

with your configuration, see Table 2 on page 2. 

2.   DS4000 controller firmware version 07.10.xx.xx supports only DS4800, DS4700, 

and DS4200 storage subsystems.

Terms  to know 

For information on terminology, see the Help section of the Storage Manager 

Enterprise Management window, the Storage Subsystem Management window, or 

the glossary on page 243. 

It is important to understand the distinction between the following two terms when 

you read this document. 

Management station 

A management station is a system that is used to manage the storage 

subsystem. You can attach it to the storage subsystem in either of the 

following ways: 

v   Through a TCP/IP Ethernet connection to the controllers in the storage 

subsystem 

v   Through a TCP/IP connection to the host-agent software that is installed 

on a host computer, which in turn is directly attached to the storage 

subsystem through the fibre-channel I/O path

Host computer 

A host computer is a system that is directly attached to the storage 

subsystem through a fibre-channel I/O path. This system is used to perform 

the following tasks: 

v   Serve data (typically in the form of files) from the storage subsystem 

v   Function as a connection point to the storage subsystem for a 

remote-management station

Notes:  

1.   The terms host and host computer are used interchangeably throughout 

this document. 

2.   A host computer can also function as a management station.

IBM DS4000 Storage Manager Version 10.10 software for Windows 

The Storage Manager Version 10.10 software package contains the following 

software components for Windows 2000 and Windows Server 2003. 

v   The following component is installed on the host and on the management station. 

–   Storage Manager 10.10 Client (SMclient)

v    The following components are installed only on the host: 

–   Redundant Disk Array Controller (RDAC) 

–   Storage Manager 10.0x Agent (SMagent) 

–   Storage Manager 10.0x Utility (SMutil)

Storage Manager Client 

The Storage Manager Client (SMclient) component provides the graphical user 

interface (GUI) for managing storage subsystems. The SMclient contains two main 

components: 
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v   Enterprise Management. You can use the Enterprise Management component 

to add, remove, and monitor storage subsystems within the management 

domain. 

v   Subsystem Management. You can use the Subsystem Management component 

to manage the components of an individual storage subsystem. 

The Event Monitor is a separate program that is bundled with the SMclient. If 

installed, it monitors storage subsystems whenever the Enterprise Management 

window is closed. It runs continuously in the background and can send alert 

notifications in the event of a critical problem. 

Redundant disk array controller 

The redundant disk array controller (RDAC) contains the multi-path device driver 

that is necessary to provide controller failover support when a component on the 

fibre-channel I/O path fails. For RDAC in Storage Manager 9.1x and later, a 

maximum of four end-to-end fibre-channel paths from the host to the storage 

subsystems are supported. 

Storage Manager Agent 

The Storage Manager Agent (SMagent) provides a management conduit for the 

SMclient to configure and monitor the subsystem through the fibre-channel I/O path. 

The agent also provides local or remote access to the SMclient depending on 

whether the client is installed on the host or in a network management station over 

the TCP/IP network. 

Storage Manager Utility 

The Storage Manager Utility (SMutil) dynamically defines and maps new logical 

drives to the operating system. This software package contains the following 

components: 

v   hot_add utility. The hot_add utility enables you to register newly created logical 

drives with the operating system. For more information, see “Using the hot_add 

utility” on page 140. 

v   SMdevices utility. The SMdevices utility enables you to associate storage 

subsystem logical drives with operating-system device names. For more 

information, see “Using the SMdevices utility” on page 140. 

v   SMrepassist utility. The SMrepassist utility enables you to perform the following 

tasks: 

–   Flush cached data before creating a FlashCopy or VolumeCopy. 

–   This is a Windows-only utility. Unmount the file system when using other 

operating systems.

For more information, see “Using the SMrepassist utility” on page 141.

IBM DS4000 Storage Manager Version 10.10 software for NetWare 

Note:  SMclient for NetWare is not currently supported. To manage DS4000 storage 

subsystems that have NetWare hosts, you must use either a Windows or 

Linux workstation. 

The Storage Manager Version 10.10 software package contains the following 

software components for NetWare: 

v   The following components are installed only on the host. 
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–   LSIMPE.CDM 

Versions of this component appear on the latest IBM fibre channel HBA 

device driver for NetWare, on Novell NetWare Support Packs and on the 

Novell web site. Always select the latest version of this component for use. 

Download this software component from the following Web site: 

support.novell.com

Recommendation:  In a Novell NetWare environment, you should manage the 

DS4000 storage subsystem using the direct (out-of-band) 

method. 

IBM DS4000 Storage Manager Version 10.10 software for Linux 

DS4000 Storage Manager 10.10 packages are available for two Linux operating 

systems on the product CD and Internet site. These packages are for servers with 

Intel architecture 32-bit (IA-32) or 64-bit (IA-64) processors only. 

Note:  Storage Manager 10.10 host software does not support servers with AMD, 

AMD64 or Intel EM64T processor architecture when the operating systems 

are written in AMD64 or EM64T native code. If the IA-32 version of the 

operating system is installed and running in compatibility mode on the 

AMD64 or EM64T servers, you can use the appropriate IA-32 software 

package. Contact your IBM resellers or representatives for the latest 

information about Storage Manager 10.10 host software support for AMD64 

or EM64T. 

The Storage Manager Version 10.10 software package contains the following 

software components for Linux: 

Management station components 

Install the following components on both the host and management station. 

Storage Manager Runtime (SMruntime) 

This component contains the Java™ JRE for the other software packages. 

Storage Manager 10.10 Client (SMclient)  

This component is necessary if you intend to manage the storage 

subsystem from a host computer or a management station.

Host components 

Install the following components only on the host. 

Storage Manager Utility (SMutil) 

SMutil is packaged with the SMclient package and contains the hot_add 

and SMdevices utilities. 

Storage Manager RDAC (SMRDAC) 

SMRDAC provides multipath failover/failback capability. The RDAC 

component requires that you install the non-failover version of the fibre 

channel HBA device driver. Therefore, if you plan to use the fibre channel 

HBA failover driver as the multipath failover driver, do not install RDAC.

Restrictions:  If you have logical drives that are created on DS4000 

storage subsystems on which you have controller firmware 
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05.3x.xx.xx and earlier installed, you must use the fibre 

channel HBA failover device driver as the multipath driver 

instead of RDAC.

Storage Manager Agent (SMagent) 

SMagent is necessary if you intend to use the host-agent (in band) 

management method. You must install RDAC before installing SMagent. 

 Recommendation: In a Linux environment, you should manage DS4000 

storage subsystems using the direct (out-of-band) method. 

QLogic SANsurfer 

QLogic SANsurfer is required if you did not install RDAC and plan to use 

the fibre channel HBA failover device driver as the multipath driver, instead 

of RDAC. (It is optional if you installed RDAC.) 

 QLogic SANsurfer is used to configure failover information for the Linux 

fibre channel HBA failover device drivers.

Notes:  

1.   The IBM QLogic SANsurfer QLremote agent is automatically installed 

with the Storage Manager software. 

2.   In a Linux environment that uses the fibre channel HBA failover driver, 

you must manage the DS4000 storage subsystem using the direct 

(out-of-band) management method.

Storage subsystem management methods 

Storage Manager software provides the following two methods for managing 

storage subsystems: 

v   The host-agent (in-band) management method 

v   The direct (out-of-band or Ethernet) management method
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Note: 

v   You must make direct (out-of-band) management connection to the DS4000 

storage subsystem in order to obtain the correct host type. The correct host 

type will allow the DS4000 storage subsystem to configure itself properly for 

the operating system of the host server. After you do so, and depending on 

your particular site requirements, you can use either or both management 

methods. The management methods you select will determine where you 

will need to install the software components. 

v   To optimize DS4000 storage subsystem management availability and 

access, IBM recommends that you configure both host-agent (in-band) and 

direct (out-of-band) management connections. If you use both types of 

management connections and either connection fails, you can still manage 

your storage subsystem using the other connection. 

v   If you establish management connections from multiple management 

stations or hosts to the same DS4000 storage subsystems, it is best 

practice to have only one active management connection to the DS4000 

storage subsystem at a time, even though eight simultaneous active 

management sessions are supported in a given DS4000 storage 

subsystem. 

v   Storage Manager 10.10 supports only the direct (out-of-band) management 

method for use with the Linux operating system when you do not use Linux 

RDAC.

 Host-agent (in-band) management method 

When you use the host-agent (in-band) management method, you manage the 

storage subsystems through the fibre-channel I/O path to the host. The 

management information can either be processed in the host or passed to the 

management station through the network connection, as shown in Figure 1 on page 

13. 

Managing storage subsystems through the host-agent has the following 

advantages: 

v   You do not need to run Ethernet cables to the controllers. 

v   Yo do not need a Dynamic Host Configuration Protocol/Bootstrap Protocol 

(DHCP/BOOTP) server to connect the storage subsystems to the network. 

v   You do not need to perform the controller network configuration tasks that are 

described in Chapter 2, “Preparing for installation,” on page 37. 

v   You only need to specify a host name or IP address for the host instead of for 

the individual controllers in a storage subsystem. Storage subsystems that are 

attached to the host are automatically discovered.

Managing storage subsystems through the host-agent has the following 

disadvantages: 

v   The host-agent requires a special logical drive, called an access logical drive, to 

communicate with the controllers in the storage subsystem. Therefore, you are 

limited to configuring one less logical drive than the maximum number that is 

allowed by the operating system and the host adapter that you are using. 

v   If the connection through the fibre channel is lost between the host and the 

subsystem, you cannot manage or monitor the subsystem.
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Important:  If your host already has the maximum number of logical drives 

configured, either use the direct-management method or give up a 

logical drive for use as the access logical drive. For more information, 

see “Number of supported logical drives” on page 35. 

The access logical drive is also referred to as the Universal Xport 

Device. 

 

Required host-agent (in-band) management activities 

Perform the following activities to establish host-agent (in-band) management 

connections. 

1.   Make fibre channel connections between the DS4000 and host computer. 

2.   Install TCP/IP on the host computer and establish a host IP address. (See 

“Preparing a network installation” on page 40 for instructions for host-managed 

systems.) 

3.   Install the HBA device driver, SMruntime (if required), SMclient, RDAC, and 

SMagent on the host server. 

4.   Make sure that the Storage Manager Agent Service starts successfully. 

5.   Open the SMclient Enterprise window and add the IP address of the host server 

to the management domain. All DS4000 devices recognized by the host 

computer will be displayed in the management window.

Host computer

Controller

Controller

Controller

Controller

Fibre Channel
I/O path

Management station
(one or more)

Network

Storage subsystems

Running the
host-agent software

Note: The host can
act as a management
station also.

SJ000879

  

Figure 1. Host-agent (in-band) managed storage subsystems
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Key installation requirements: 

1.   Use a fibre channel HBA device driver 

2.   Install RDAC before you install SMagent (depending on your operating system). 

3.   Install SMagent and start the Storage Manager Agent Service successfully.

Direct-management (out-of-band) method 

When you use the direct-management (out-of-band) method, you manage storage 

subsystems directly over the network through a TCP/IP Ethernet connection to each 

controller. To manage the storage subsystem through the Ethernet connections, you 

must define the IP address and host name for each controller. Each of the storage 

subsystem controllers must be connected to an Ethernet network through a cable 

connected to the RJ-45 connector, as shown in Figure 2 on page 16. 

Managing storage subsystems using the direct-management (out-of-band) method 

has the following advantages: 

v   The Ethernet connections to the controllers enable you to manage storage 

subsystems that are connected to a host running any of the operating systems 

that Storage Manager supports through an SMclient management station. 

v   You do not need an access logical drive to communicate with the controllers. You 

can configure the maximum number of logical drives that are supported by the 

operating system and the host adapter that you are using. 

v   You can manage and troubleshoot the storage subsystem when there are 

problems with the fibre-channel links.

Managing storage subsystems using the direct-management (out-of-band) method 

has the following disadvantages: 

v   You need two Ethernet cables to connect the storage subsystem controllers to a 

network. 

v   When adding devices, you must specify an IP address or host name for each 

controller. 

v   Network preparation tasks are required and you might need a DHCP/BOOTP 

server. For a summary of the preparation tasks, see Chapter 2, “Preparing for 

installation,” on page 37. 

Important:  To avoid DHCP/BOOTP server and network tasks, assign static IP 

addresses to the controller or use the controller default TCP/IP 

addresses (see Table 3).

Defining controller TCP/IP addresses 

Table 3 shows the default settings storage subsystem controllers with firmware 

version 05.00.xx.xx or later: 

 Table 3. Default controller TCP/IP addresses 

Controller IP address Subnet mask 

All  DS4000 subsystems: 255.255.255.0 

A 192.168.128.101 

B 192.168.128.102 

DS4800, DS4700, and DS4200 only: (in addition to 

ports A and B) 

A2 (port 2) 192.168.129.101 

B2 (port 2) 192.168.129.102 
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Table 3. Default controller TCP/IP addresses (continued) 

Controller IP address Subnet mask 

Notes:  

1.   The DS4800 has four Ethernet ports: two on each controller blade (A, B, A2 and B2). 

2.   If both network ports on the same controller are used, each network port much use a 

different Subnet Mask or you will be able to use only the primary network port (port 1) on 

the controller. 

network port 1 IP address 192.168.128.101, with subnet mask of 255.255.255.0 

network port 2 IP address 192.168.129.101, with subnet mask of 255.255.0.0 

  

In order to change the DS4000 storage subsystem controller default TCP/IP 

address, you must first make a direct management connection to the storage 

subsystem using the default TCP/IP addresses. 

If the DS4000 storage subsystem controllers have firmware version 05.4x.xx.xx or 

later, you can use the DS4000 Storage Manager Client Program to change the 

controller default TCP/IP address. Complete the following steps in the Subsystem 

Management window of the DS4000 storage subsystem for which you want to 

define new controller TCP/IP addresses: 

1.   Right-click the controller icon and select Change → Network Configuration 

from the pull-down menu. 

2.   When the Change Network Configuration window opens, select the 

appropriate controller tab in the window and enter the appropriate TCP/IP 

address information for both controller A and B. 

3.   Click OK to apply the new TCP/IP address.

Important:  Make sure that the new TCP/IP address information is correct 

because you will not be able to make direct management 

connection to the storage subsystem again via the controller default 

TCP/IP addresses once they are changed to different values. 

4.   Close the Subsystem Management window. 

5.   In the Enterprise Management window, delete the storage subsystem entry 

with the default TCP/IP addresses. 

6.   Wait about five minutes, and then reestablish management connection to the 

storage subsystem using the new TCP/IP addresses. 

Note:  You might want to ping the new addresses first to make sure that there is 

a good network connection to the controllers before adding the storage 

subsystem into the Enterprise management window.

Important:  If you are not able to use the controller default TCP/IP address to 

assign the static TCP/IP address, see the IBM support Web site at:
www.ibm.com/pc/support/ 

At the Web site, see Retain Tip 

#H171389 Unable To Setup Networking 

Without DHCP/BOOTP. 

Example of direct-managed (out-of-band) storage subsystem 

Figure 2 on page 16 shows a system in which storage subsystems are managed by 

using the direct-management (out-of-band) method. 
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Ethernet

Host computer

Fibre Channel
I/O path

Management station
(one or more)

Controller

Controller

Controller

Controller

Storage subsystems

SJ000864

Required direct-management (out-of-band) management 

activities 

1.   Make Ethernet connections between the DS4000 and the Ethernet network. 

2.   Follow instructions located at “Preparing a network installation” on page 40 for 

directly managed systems. Assign IP addresses to the DS4000 controllers. 

3.   Install SMruntime (if required) and SMclient. 

4.   Open the GUI and add the IP addresses for the DS4000 controllers (A and B). If 

you have multiple DS4000 storage subsystems, add the IP address of each to 

the domain.

Reviewing a sample network 

Figure 3 on page 17 shows an example of a network that contains both a 

directly-managed storage subsystem (Network A) and a host-agent-managed 

storage subsystem (Network B). 

Directly-managed storage subsystem: Network A is a directly-managed storage 

subsystem. Network A contains the following components: 

v   A DHCP/BOOTP server 

v   A network management station (NMS) for Simple Network Management Protocol 

(SNMP) traps 

Figure 2. Direct-management (out-of-band) storage subsystems
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v   A host that is connected to a storage subsystem through a fibre-channel I/O path 

v   A management station that is connected by an Ethernet cable to the storage 

subsystem controllers

Note:  If the controllers static TCP/IP addresses or default TCP/IP addresses are 

used, you do not need to setup the DHCP/BOOTP server. 

Host-agent-managed storage subsystem: Network B is a host-agent-managed 

storage subsystem. Network B contains the following components: 

v   A host that is connected to a storage subsystem through a fibre-channel I/O path 

v   A management station that is connected by an Ethernet cable to the host 

computer

   

Installation process diagram 

Figure 4 on page 18 through Figure 9 on page 23 provide an overview of the 

installation process.
 

  

Figure 3. Sample network using directly-managed and host-agent managed storage 

subsystems
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Figure 4. Installation process (part 1 of 6)
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Where to install software components 

How you manage the storage subsystems determines where you must install the 

various software components. 

Management stations 

You must install the following software components on each management station: 

v   SMclient 

v   SMruntime (for Linux only)

Host computers 

Table 4 shows the software components that you are required to install on each 

host computer: 

 Table 4. Required host software components 

RDAC  SMutil LSIMPE.com 

QLogic 

SANsurfer 

QLRemote 

agent 

Linux U U U U 

Windows 2000 U U 

Windows Server 2003 U U 

NetWare U U 

VMware ESX Server 

Attention:  Linux RDAC is supported only when the DS4000 storage subsystems have 

controller firmware version 05.4x.xx.xx and later installed. See “Linux RDAC installation” on 

page 91 for detailed Linux RDAC installation instructions.
  

Depending on how you intend to manage the storage subsystems, you might also 

need to install the following additional host software components: 

v   SMruntime (for Linux only) 

v   SMclient 

v   SMagent (for Linux (with Linux RDAC only), Windows 2000, Windows Server 

2003, and NetWare)

Notes:  

1.    Install the SMagent on a host computer if you intend to manage the storage 

subsystems using the host-agent management method. 

2.   You must install the SMclient on a host computer if you intend the host 

computer to act as a management station. If the host computer is not connected 

to a network, you must install TCP/IP software and assign an IP address.

Creating the SAN-attached configuration 

This section contains the following topics: 

v   “Preparing for a SAN-attached configuration” 

v   “Steps for setting up a SAN-attached configuration” on page 25 

v   “Connecting HBAs in a FC switch environment” on page 25

Preparing for a SAN-attached configuration 

To create a SAN-attached configuration, you must ensure that: 
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v   Multiple fibre channel HBAs within the same server cannot “see” the same 

DS4000 controller port. 

v   The IBM fibre channel HBAs in a host system must be isolated from each other if 

they are connected to the same switch that is connected to the same DS4000 

controller port. 

v   A multipath configuration requires two HBAs per host system, each in a separate 

switch zone that is connected to one of the two controllers. 

v   Each fibre channel HBA on each host, and controller port on each DS4000 

subsystem, must be in its own fabric zone, if they are connecting through a 

single fibre channel switch. 

Note:  Single HBA configurations are allowed. If you have a single HBA in a 

SAN-attached configuration, the controller must be fibre channel 

connected to the HBA through a switch, and both controllers must be 

within the same SAN zone as the HBA. 

Attention: Having a single HBA configuration can lead to loss of access 

data in the event of a path failure. 

Steps for setting up a SAN-attached configuration 

Complete the following steps to set up a SAN-attached configuration: 

1.   Connect the HBAs to the switch or switches. 

2.   Connect the DS4000 storage subsystem controllers to the switch or switches. 

3.   Set the required zones on the fibre channel switch or switches, if applicable. 

4.   Configure, then verify the configuration by logging into the switch to view the 

system.

Connecting HBAs in a FC switch environment 

When connecting fibre channel host bus adapters in host servers to DS4000 

Storage Server host ports in a fibre channel switch environment, IBM recommends 

that you establish one-to-one zones between the HBA and DS4000 host ports. 

For instructions on how to set up a zone inside a fibre channel switch, see your 

fibre channel switch’s installation and user’s guide. 

Note:  You can find links to switch documentation at the following Web site:
www.ibm.com/servers/storage/support/san/index.html 

Figure 10 on page 26 illustrates a sample configuration consisting of two host 

servers, each with two fibre channel host bus adapters, each of which are 

connected to a DS4000 Storage Server host port through a fibre channel switch. 
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Legend: 

 Controller Zone Port Connection to 

and from 

Description 

A 1 �7�
�3� 

HA1
CA2 

This will zone the fibre channel HBA port 

HA1 in host server A to port 2 of the 

DS4000 Storage Server controller A. 
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�3� 

HB1
CA2 

This will zone the fibre channel HBA port 

HB1 in host server B to port 2 of the 

DS4000 Storage Server controller A. 

B 3 �6�
�4� 

HA2
CB2 

This will zone the fibre channel HBA port 

HA2 in host server A to port 2 of the 

DS4000 Storage Server controller B. 

4 �0�
�4� 

HB2
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This will zone the fibre channel HBA port 

HB2 in host server B to port 2 of the 

DS4000 Storage Server controller B.
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Figure 10. Fibre channel fabric switch environment connecting host servers to a DS4000 

Storage Server
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Configuration types 

You can install Storage Manager 10.10 in either of the two following configurations: 

v   Standard (noncluster) configuration 

v   Cluster server configuration 

–   Storage Manager 10.10, with controller firmware versions 07.10.xx.xx or later, 

supports SteelEye technology Linux cluster server configurations. You can 

contact your IBM resellers or representatives for updates regarding availability 

of support for other Linux cluster configurations in the future. 

–   The following illustrations of the cluster server configurations do not pertain to 

NetWare or Linux.

Standard (non-cluster) configuration 

Figure 11 shows a sample standard (non-cluster) configuration. 

Ethernet

SJ000869

Host computer

Controller

Controller

Controller

Controller

Fibre Channel
I/O path

Management station

RDAC, SMutil,
SMagent

The SMclient software
can also be installed

on the host computer.
Storage subsystems

SMclient

  

 

 

Figure 11. Sample standard (non-cluster) configuration
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Cluster server configuration for Windows 

Figure 12 shows a sample cluster server configuration. 

Ethernet

Fibre Channel
I/O path

Management station
(one or more)

Cluster server
node A

Cluster server
node B

RDAC, SMutil,
SMagent

Controller
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System requirements 

This section provides detailed information about the hardware, software, and 

operating system requirements for Storage Manager 10.10. 

Hardware requirements 

Table 5 on page 29 lists the hardware required for installing Storage Manager 

10.10. 

Figure 12. Sample cluster server configuration
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Table 5. Hardware requirements for Storage Manager 10.10 software 

Hardware component Requirements 

A DHCP/BOOTP server 

(only for directly managed 

storage subsystems) 

Note: If the controllers 

static IP addresses or 

default IP addresses are 

used, you do not need to 

set up the DHCP/BOOTP 

server. 

One of the following BOOTP or BOOTP-compatible servers: 

v   Microsoft® BOOTP-compatible DHCP server for Windows 

2000 

v   Microsoft BOOTP-compatible DHCP server for Windows 

Server 2003 

v   UNIX BOOTP server 

v   NetWare DHCP server 

Storage subsystems (one 

or more) 

Storage subsystems with controllers running controller firmware 

version levels 04.01.xx.xx through 06.xx.xx.xx 

Supported fibre channel 

host adapters 

v   IBM DS4000 host adapter (part number: 00N6881) 

v   An IBM DS4000 FC2 Host Bus Adapter (part number 

19K1246) or IBM DS4000 single port FC2-133 Host Bus 

Adapter (part number 24P0960)

For information about specific host adapter requirements: 

v   Refer to the readme file in the \Host_Adapter directory on the 

installation CD. 

v   Read the host adapter documentation. 

v   Go to the Web site at: 

www.ibm.com/pc/support/ 

Management station 

requirements (for client 

software) 

v   Intel Pentium®® or Pentium-equivalent microprocessor (450 

MHz or faster) 

v   CD-ROM drive 

v   Mouse or similar pointing device 

v   System memory: 

–   For Windows 2000: A minimum of 128 MB (256 MB 

recommended) 

–   For Windows Server 2003, NetWare, and Linux: A 

minimum of 256 MB (512 MB recommended)

v    Ethernet network interface adapter 

v   AGP or PCI video adapter (AGP preferred); ISA adapters are 

not supported 

v   Monitor setting of 1024 x 768 pixels with 64,000 colors. The 

minimum display setting that is allowed is 800 x 600 pixels 

with 256 colors. 

v   Hardware-based Windows acceleration. Desktop computers 

that use system memory for video memory are not preferred 

for use with the storage management software.

Important: Many PC-based servers are not designed to run 

graphic-intensive software. If your server has difficulty displaying 

the Storage Manager user interface, you might need to upgrade 

the server video adapter. 

 

Chapter 1. Introduction 29

http://www.ibm.com/pc/support/


Table 5. Hardware requirements for Storage Manager 10.10 software (continued) 

Hardware component Requirements 

Supported fibre channel 

fabric switches (if needed 

for the desired 

configuration) 

Switch product name Model number 

IBM System Storage SAN 

Switch 

2109 S08 

2109 S16 

2019 F16 

2109 F32 

3534 F08 

2005-H08 

2005-H16 

2005-B32 

CNT switch 2042-01 

2042-128 

McDATA 4500 switch 2031-216 

2031-224 

2032-232 

McDATA 6140 switch 2032-140 

CISCO MDS 9209 switch 2062-D07 

2062-T07 

CISCO MDS 9216 switch 2062-D01 

  

Notes:  

1.   For more information about host adapters, fabric switches, and managed hubs, 

see the following ServerProven®™ Web site:
www.ibm.com/pc/us/compat/ 

Also, see the DS4000 interoperability matrix at the following Web Site:
www.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

2.   For specific fibre-channel switch setup requirements, read the documentation 

provided by the switch manufacturer. You can also find more information about 

switches at the following Web site:
www.ibm.com/servers/storage/san

Determining firmware levels 

There are two different methods to determine DS4000 storage subsystem, 

expansion unit, drive, and ESM firmware versions. Each method uses the DS4000 

Storage Manager client that manages the DS4000 storage subsystem with the 

attached expansion unit. 

Method one: 

Go to the Subsystem Management window and select Storage Subsystem → View 

Profile (if the DS4000 storage subsystem has controller firmware 06.xx.xx.xx or 

later) or View → Storage Subsystem Profile (if the DS4000 storage subsystem has 

controller firmware 05.4x.xx.xx or earlier). When the Storage Subsystem Profile 

window opens, select the All tab and scroll through the Profile For Storage 

Subsystem to locate the following information.

Note:  The Profile For Storage Subsystem contains all the profile information for 

the entire subsystem. Therefore, it may be necessary to scroll through a 

large amount of information to locate the firmware version numbers.

DS4000 storage subsystem 
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v   NVSRAM version 

v   Appware version (Appware is a reference to controller firmware.) 

v   Bootware version (Bootware is a reference to controller firmware.)

See the following example of profile information. 

 Controller in Enclosure 0, Slot A 

Status: Online 

Current configuration 

Firmware version: 07.10.xx.xx 

Appware version: 07.10.xx.xx 

Bootware version: 07.10.xx.xx 

NVSRAM version: 1722F600R910V05 

  

Drives 

v   Firmware version

ESM 

v   ESM card firmware version

Method two: 

Select the appropriate procedure from the following options and complete it to 

obtain the specified firmware version. 

To obtain the controller firmware version: 

Right click the Controller icon in the Physical View pane of the Subsystem 

Management window and select Properties. The Controller Enclosure 

properties window opens and displays the properties for that controller. 

 You must perform this step for each individual controller. 

To obtain the drive firmware version: 

Right Click the Drive icon in the Physical View pane of the Subsystem 

Management window and select Properties. The Drive Properties window 

opens and displays the properties for that drive. 

 You must perform this step for each individual drive. 

To obtain the ESM firmware version: 

1.   In the Physical View pane of the Subsystem Management window, click 

the Drive Enclosure Component icon (which is the icon furthest to the 

right). The Drive Enclosure Component Information window opens. 

2.   Click the ESM icon in the left pane. The ESM information displays in the 

right pane of the Drive Enclosure Component Information window. 

3.   Locate the firmware version of each ESM in the drive enclosure.

Windows software requirements 

Table 6 on page 32 lists the disk space and administrator privileges that are 

required to install version 10.10 of the storage management software in a Windows 

environment.

Note:  The disk space listed in Table 6 on page 32 is for the packages after the 

installation. During the installation of each software package, you might need 

up to 150 MB of free disk space.
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Table 6. Installation requirements for Windows by software package 

Package 

Disk space requirement 

(Windows 2000/Server 2003) 

Administrator privilege 

(Windows 2000/Server 2003) 

SMclient 90 MB (125 MB for host server 

based on the Intel Architecture 

64 bit [Itanium 2] processor 

technology) 

Not required 

RDAC 2 MB Required 

SMagent 1 MB 

45 MB (75 MB for host server 

based on the Intel Architecture 

64 bit [Itanium 2] processor 

technology) if SMclient is not 

installed. 

Required 

SMutil 2 MB Required
  

Windows operating system requirements 

Each management station, host computer, or cluster node requires one of the 

following operating systems. 

Important:  Check the Storage Manager readme files for the latest supported 

operating system and host software versions. 

To access the most recent Storage Manager readme files, complete the 

following steps: 

1.   Go to the following Web site:
www-1.ibm.com/servers/storage/support/disk/ 

2.   Click the link for your storage subsystem. 

3.   When the subsystem page opens, click the Download tab. 

4.   When the download page opens, click the Storage Mgr tab then 

click on the appropriate link under the Current versions and 

readmes column.

Management stations 

v   Windows 2000 Server with Service Pack 4 

v   Windows 2000 Professional with Service Pack 4 

v   Windows 2000 Advanced Server with Service Pack 4 

v   Windows XP, Professional Edition 

v   Windows Server 2003, Web Edition with Service Pack 1 (SP1) 

v   Windows Server 2003, Standard Edition with SP1 

v   Windows Server 2003, Enterprise Edition with SP1

Host computers 

v   Windows 2000 Server with Service Pack 4 

v   Windows 2000 Professional with Service Pack 4 

v   Windows 2000 Advanced Server with Service Pack 4 

v   Windows Server 2003, Web Edition with SP1 

v   Windows Server 2003, Standard Edition with SP1 
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v   Windows Server 2003, Enterprise Edition with SP1

Cluster nodes 

v   Windows 2000 Advanced Server with Service Pack 4 

v   Windows 2000 Datacenter 

v   Windows Server 2003, Enterprise Edition with SP1

NetWare software requirements 

Table 7 lists the disk space that is required for installing the Storage Manager 

software in a NetWare environment. During the installation of each software 

package, you may need up to 130 MB of free disk space. 

 Table 7. Installation requirements for NetWare by software package 

Package Disk space requirement 

Storage Manager 10.10 Client (SMclient) 60 MB 

LSIMPE.CDM driver 2 MB 

IBM QLogic SANsurfer agent only; (see the Notes 

at the end of the table) 

2 MB 

IBM Host Adapter device driver 2 MB 

Note: Another 100 MB on a separate Microsoft Windows computer is required to install the 

actual QLogic SANsurfer program. This program will work with the installed agent in the 

NetWare server to allow for the IBM DS4000 and FC2, FC2-133 Fibre Channel Host Bus 

Adapter maintenance and troubleshooting.
  

NetWare operating system requirements 

Each management station, host computer, or cluster node requires one of the 

following operating systems. 

Important:  Check the Storage Manager readme files for the latest supported 

operating system and host software versions. To access the most 

recent Storage Manager readme files, complete the following steps: 

1.   Go to the following Web site:
www-1.ibm.com/servers/storage/support/disk/ 

2.   Click the link for your storage subsystem. 

3.   When the subsystem page opens, click the Download tab. 

4.   When the download page opens, click the Storage Mgr tab then 

click on the appropriate link under the Current versions and 

readmes column.

Management stations 

v   Windows 2000 Server with Service Pack 4 

v   Windows 2000 Professional with Service Pack 4 

v   Windows 2000 Advanced Server with Service Pack 4 

v   Windows XP 

v   Windows Server 2003 with SP1

Host computers 

v   Novell NetWare 6.0 with Service Pack 4 
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v   Novell NetWare 6.5 with Service Pack 2

Cluster nodes 

v   Novell NetWare 6.0 with Service Pack 4 and NCS 1.6 

v   Novell NetWare 6.5 with Service Pack 2 and NCS 1.7

Linux software requirements 

Table 8 lists the disk space that is required for installing Storage Manager 10.10 in 

a Linux environment. 

 Table 8. Installation requirements for Linux by software package 

Package Disk space requirement 

Storage Manager 10.10 Runtime (SMruntime) 70 MB on /opt, 1 MB on /var 

Storage Manager 10.10 Esm (SMesm) 40 MB on /var 

Storage Manager 10.10 Client (SMclient) 60 MB on /opt, 2 MB on /tmp 

Storage Manager 10.10 Agent (SMagent) 2 MB on /opt 

Storage Manager 10.10 Utility (SMutil) 7 MB on /opt 

IBM DS4000 QLogic SANsurfer 100 MB on /opt 

Storage Manager 10.10 RDAC 2 MB 

IBM Host Adapter device driver 1 MB
  

Linux operating system requirements 

Table 9 lists the minimum operating system and kernel levels required by each 

management station or host computer. 

Important:  Check the Storage Manager readme files for the latest supported Linux 

kernel versions. 

For the most recent Storage Manager readme files for your operating 

system, see the following Web site:
www-1.ibm.com/servers/storage/support/disk/ 

Click the link for your storage subsystem. 

When the subsystem page opens, click the Download tab. When the 

download page opens, click the Storage Mgr tab then click on the 

appropriate link under the Current versions and readmes column. 

 Table 9. Management station or host computer by minimum operating system and kernel 

levels 

Operating system Kernel 

Red Hat Enterprise Linux Advanced Server 4 For the appropriate kernel, see 

the readme file for your RHEL 

version. 

Red Hat Enterprise Linux Advanced Server 5 For the appropriate kernel, see 

the readme file for your RHEL 

version. 
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Table 9. Management station or host computer by minimum operating system and kernel 

levels (continued) 

Operating system Kernel 

SUSE Linux Enterprise Server Version 9 (SLES 9) For the appropriate kernel, see 

the readme file for your SLES 

version. 

SUSE Linux Enterprise Server Version 10 (SLES 10) For the appropriate kernel, see 

the readme file for your SLES 

version.
  

Notes:  

1.   Red Hat Enterprise Linux Advanced Server 2.1 is not supported with Storage 

Manager 09.12 or higher. 

2.   Red Hat Enterprise Linux Advanced Server 4 and 5 support 256 logical drives 

per partition. Older Red Hat Linux kernels support only 128 logical drives per 

storage partition. 

3.   SUSE Linux Enterprise Server 9, and SUSE Linux Enterprise Server 10 support 

a maximum of 256 logical drives per storage partition.

Number of supported logical drives 

With controller firmware versions 05.40.xx.xx and later, the supported logical drive 

limits for NetWare 6.0, Linux, Windows 2000, and Windows Server 2003 are as 

follows: 

v   NetWare 6.0 with SP3 or later and NetWare 6.5 with SP2 or later, support up to 

256 logical drives per storage subsystem (LUNs 0-255) when you use 

IBM-approved DS4000 adapters and their supported device drivers. 

v   Linux supports up to 256 logical drives per storage subsystem (LUNs 0 through 

255) when you use IBM-approved DS4000 adapters and their supported device 

drivers. 

Check your Linux kernel documentation for the maximum total number of logical 

drives supported in the host sever and the maximum number of logical drives 

that can be mapped from a storage subsystem. 

v   Windows 2000 supports up to 64 logical drives per storage subsystem (LUNs 0 

through 63) when you use IBM-approved DS4000 adapters and their supported 

device drivers. 

v   Windows Server 2003 supports a maximum of 255 LUNs (LUNs 0 through 254) 

when you use IBM-approved DS4000 adapters and their supported device 

drivers. 

v   The maximum number of logical drives that a DS4000 storage subsystem 

supports with firmware version 05.4x.xx.xx depends on the model of the DS4000 

storage subsystem. See Table 10.

 Table 10. Maximum number of logical drives per storage subsystem 

Product 

name 

Model 

Type 

Maximum logical 

drives 

Maximum logical 

drives per storage 

unit partition 

Maximum 

FlashCopy® logical 

drives 

DS4800 1815 2048 (See notes2 on 

page 36 and 3 on 

page 36) 

256 (See notes4 on 

page 36 and 5 on 

page 36) 

1024 (See note 1 on 

page 36) 

DS4700 1814 1024 256 512 
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Table 10. Maximum number of logical drives per storage subsystem (continued) 

Product 

name 

Model 

Type 

Maximum logical 

drives 

Maximum logical 

drives per storage 

unit partition 

Maximum 

FlashCopy® logical 

drives 

DS4500 2048 (See notes2 and 

3) 

256 (See notes4 and 

5) 

1024 (See note 1) 

DS4400 

DS4300 1722 1024 (See note 3) 256 (See notes4 and 

5) 

512 (See note 1) 

DS4200 1814 1024 256 512 

DS4100 1724 1024 (See note 3) 256 (See notes 4 and 

5) 

512 (See note 1)

  

The access logical drive is also referred to as the Universal Xport Device.

Notes:  

1.   The DS4300, DS4400, and DS4500 only support a maximum of 4 FlashCopy 

logical drives for each standard logical drive defined within these storage 

subsystems. 

2.   Using the Enhanced Remote Mirror premium feature, a maximum of 128 

Remote Mirror pairs with controller firmware version 07.10.xx.xx for the DS4800. 

For the DS4700, DS4500, DS4400, DS4300, and DS4200, a maximum of 64 

Remote Mirror pairs is supported. 

3.   If the Remote Mirror option is enabled, 2 logical drives are reserved for use by 

the system. 

4.   For firmware version level 05.4x.xx.xx and later, the default host type limit is the 

maximum LUN value allowed in the default partition. If the default host type has 

the restriction option enabled, the default partition allows only 32 LUNs; 

otherwise, it allows 256 LUNs. 

5.   The host-agent management method uses a special logical drive, called an 

access logical drive, to communicate with the controllers on the storage 

subsystem. The access logical drive uses one of the available LUNs. Therefore, 

managing storage subsystems with the host-agent software limits you to one 

fewer LUN than the maximum number supported by the operating system and 

the host adapter.

Important: 

v   The FlashCopy drive cannot be added or mapped to the same server that has 

the base logical drive of the FlashCopy logical drive in a Windows 2000, 

Windows Server 2003, or NetWare environment. You must map the FlashCopy 

logical drive to another server. 

v   For firmware versions 05.3x.xx.xx and earlier, the maximum number of logical 

drives that can be mapped to a host server from each storage subsystem is 32.
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Chapter  2.  Preparing  for  installation  

This chapter provides information to help you plan the installation of the storage 

management software. 

See the appropriate sections of this document to install Storage Manager client and 

host software for a particular operating system. When you have completed Storage 

Manager software component installation procedures, perform the procedures in 

Chapter 8, “Completing storage management installation and configuration,” on 

page 113 and Chapter 9, “Completing storage management tasks for Windows 

hosts,” on page 137. 

Planning and preparing for Windows installation 

Note:  DS4000 Storage Manager 10.10 supports Microsoft Windows Server 2003 

SP2 x64 editions for servers with AMD AMD64 and Intel EM64T processor 

technology for the DS4700 and DS4800 storage subsystems. This support 

requires certain versions of the following: 

v   Storage manager host software (including multipath driver) 

v   Controller firmware 

v   Fibre channel host bus adapter device driver

Review “IBM DS4000 Storage Manager Version 10.10 software for Windows” 

on page 8 and any up-to-date information in the readme file, which is 

included with the SM host software package for Microsoft Windows Server 

2003 SP1 - x64 edition. 

Table 11 contains information about where you need to install the Storage Manager 

software components. 

 Table 11. Software component installation in a Windows environment 

System type Software installation sequence 

Management station SMclient component of Storage Manager 10.10 host software 

package 

Host computer and 

cluster node 

1.   IBM FC host bus adapter driver 

2.   Storage Manager 10.10 host software package, which installs the 

following components: 

a.   SMclient (optional) 

SMclient is necessary if you intend to manage the storage 

subsystem from the host computer. 

b.   Multipath driver (required) 

c.   SMagent (optional) 

SMagent is installed when you select the Typical Installation 

option in the Storage Manager installation wizard. It is 

necessary if you intend to use the host-agent management 

method. 

d.   SMutil (required) 

SMutil contains the hot_add, SMdevices, and SMrepassist 

utilities.

3.   QLogic SANsurfer
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Planning and preparing for Linux installation 

Note:  Storage Manager 10.10 supports AMD64 and EM64T Linux RHEL 4 and 

SLES 10.1 servers running x86_64 Linux kernels (AMD64 or EM64T native 

code), in addition to the previously supported Intel Itanium® 64 bit processor 

architecture (IA64) Linux operating systems. See Chapter 5, “Installing 

Storage Manager software in a Linux configuration,” on page 83 for details. 

Table 12 shows the installation sequence for Storage Manager software 

components and provides information to help you plan for the installation of the 

storage management software for Linux. 

 Table 12. Software component installation sequence in a Linux environment 

System type Software installation sequence 

Management station 

(and any host server 

in use as a 

management station) 

1.   Storage Manager 10.10 Runtime (SMruntime) 

2.   Storage Manager 10.10 Esm (SMesm—required by SMclient) 

3.   Storage Manager 10.10 Client (SMclient) 

See “Installing the Storage Manager 10.10 Client (SMclient)” on 

page 88. 

4.   Storage Manager 10.10 Agent (SMagent) 

5.   Storage Manager 10.10 Utility (SMutil) 

6.   ESM firmware 

7.   Controller firmware and NVSRAM 

8.   Drive firmware 
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Table 12. Software component installation sequence in a Linux environment (continued) 

System type Software installation sequence 

Host computer and 

cluster node 

If you chose the Linux RDAC as the failover multipath, install the 

following components: 

Note: This is the recommended multipath driver for the DS4000 

storage subsystem with controller firmware 6.12.xx.xx or higher 

environments. 

1.   IBM Linux fibre channel host bus adapter non-failover device 

driver version of the fibre channel HBA (QLA2200.o and QLA2300.o). 

2.   Storage Manager 10.10 RDAC (required) 

This component provides failover/failback capability. See 

“Redundant disk array controller” on page 9. 

3.   Storage Manager 10.10 Agent (SMagent—optional) 

This component is necessary if you intend to use the host-agent 

(in band) management method. It requires that you first install 

RDAC (see step 2). IBM recommends direct (out-of-band) 

management method only in a Linux environment. 

See “Installing Storage Manager 10.10 Agent (SMagent)” on page 

90. 

4.   Storage Manager 10.10 Utility (SMutil) 

This required component packaged with the SMclient package 

contains the hot_add, SMdevices, and SMrepassist utilities. 

5.   QLogic SANsurfer and QLRemote Agent (optional, for diagnostics 

only) 

These components are optional. Completed this step to provide 

fibre channel host bus adapter diagnostic functions. 

See “Installing QLogic SANsurfer” on page 97.

Install the following packages if you chose the IBM Linux host bus 

adapter failover driver as the multipath (non-RDAC) failover driver: 

1.   IBM Linux Host Adapter failover device driver version of the FC 

HBA (QLA2200.o and QLA2300.o). 

These required components enable your computer to communicate 

with the host adapter and to provide logical drive failover/failback 

support. 

See “Installing the IBM fibre channel host bus adapter device 

driver” on page 98. 

2.   QLogic SANsurfer and QLRemote (required) 

This package is required if you did not install RDAC (step 5). It will 

configure the LUN failover/failback path information for the Linux 

FC host bus adapter failover device drivers and also provide 

diagnostic function. See the readme file that ships with the QLogic 

SANsurfer package and the Linux FC HBA failover device driver 

for information needed to set up the failover/failback path. 

See “Installing QLogic SANsurfer” on page 97. 
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Table 12. Software component installation sequence in a Linux environment (continued) 

System type Software installation sequence 

Notes:  

1.   There are three different packages for QLogic SANsurfer, one for each of the following 

systems: 

v   32 bit (IA32) Linux 

v   Intel Itanium 64-bit 

v   AMD64 and EM64T

Be sure to install the correct package for your system. 

2.   Linux RDAC is provided separately from the Storage Manager 10.10 host software 

package.
  

Planning and preparing for NetWare installation 

Storage Manager 10.10 software, which is required to manage DS4000 storage 

subsystem with controller firmware 6.16.xx.xx, 06.19.xx.xx, 06.23.xx.xx, or 

07.10.xx.xx is not available for the NetWare operating system environment. 

To manage a DS4000 storage subsystem with controller firmware 6.16.xx.xx, 

6.19.xx.xx, or 07.10.xx.xx that is connected to a NetWare host server, you must 

install the Windows version of the Storage Manager 10.10 SMclient program in a 

Microsoft Windows management station, and make an out-of-band management 

connection to the DS4000 storage subsystem. 

Table 13 shows the installation sequence for host software components. 

 Table 13. Software component installation sequence in a Novell NetWare 6.0 environment 

System type Software installation sequence 

Management station 

(Windows 

management station 

only) 

Storage Manager 10.10 client (SMclient) 

NetWare host 

computer and cluster 

node 

1.   Fibre channel host bus adapter device driver 

2.   LSIMPE.cdm driver and NetWare native failover device driver

  

To prepare the NetWare 6.0 or 6.5 operating system environments for host I/O 

attachment to the DS4000 storage subsystem, you must install the software on 

each host computer in the following order: 

1.   Fibre channel host bus adapter device driver 

2.   LSIMPE.cdm driver and NetWare native failover device driver 

3.   NetWare Agent component of QLogic SANsurfer

Preparing a network installation 

To begin installing the storage management software, ensure that the network 

components are set up and operating properly, and that you have all the host and 

controller information needed for the software to operate correctly. 
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Overview of network installation tasks 

The following procedures provide an overview of the tasks involved in setting up a 

network installation: 

v   “Direct-managed systems: Network installation overview” 

v   “Host-managed systems: Network installation overview”

Direct-managed systems: Network installation overview 

The following steps provide an overview of the tasks involved in setting up a 

network installation of a direct-managed system: 

1.   Install all hardware components (host computers, storage subsystems, and 

cables) that you want to connect to the network. You might need to refer to the 

installation guides for the specific hardware components. 

2.   Establish a naming convention for the storage subsystems that will be 

connected to the network. See “Step 1: Naming the storage subsystems” on 

page 42 for more information. 

3.   Record the storage subsystem names and management types in Appendix H, 

“Storage subsystem and controller information record,” on page 213. An 

example of a completed information record is shown in Table 14 on page 42. 

Note:  Throughout the remaining steps, you will need to return to Appendix H, 

“Storage subsystem and controller information record,” on page 213 to 

record information such as hardware Ethernet addresses and IP 

addresses. 

4.   Determine the hardware Ethernet address for each controller in storage 

subsystems connected to the network. See “Step 3: Identifying the hardware 

Ethernet MAC address for each controller” on page 43 for more information. 

5.   For a directly managed system only: If you are using a default controller IP 

address, go to step 7. Otherwise, obtain the TCP/IP address and host name for 

each of the controllers in the storage subsystems on the network from the 

network administrator. See “Step 4: Assigning IP addresses to hosts and 

controllers” on page 47. 

6.   Set up the DHCP/BOOTP server to provide network configuration information 

for a specific controller. If you are using a controller static IP addresses, skip 

this step. 

7.   Verify that the TCP/IP software is installed. For more information, see “Step 6 

(Windows): Verifying the TCP/IP protocol and setting up the host or DNS table” 

on page 52. 

8.   Set up the host or domain name server (DNS) table. For more information, see 

“Step 6 (Windows): Verifying the TCP/IP protocol and setting up the host or 

DNS table” on page 52. 

9.   Power on the devices that are connected to the network.

Host-managed systems: Network installation overview 

The following steps provide an overview of the tasks involved in setting up a 

network installation of a host-managed system: 

1.   Install all hardware components (host computers, storage subsystems, and 

cables) that you want to connect to the network. You might need to refer to the 

installation guides for the specific hardware components. 

2.   Establish a naming convention for the storage subsystems that will be 

connected to the network. See “Step 1: Naming the storage subsystems” on 

page 42 for more information. 
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3.   Record the storage subsystem names and management types in Appendix H, 

“Storage subsystem and controller information record,” on page 213. An 

example of a completed information record is shown in Table 14. 

Note:  Throughout the remaining steps, you will need to return to Appendix H, 

“Storage subsystem and controller information record,” on page 213 to 

record information such as hardware Ethernet addresses and IP 

addresses. 

4.   Obtain the IP address and host name of the host computer on which the 

host-agent software will run from the network administrator. See “Step 4: 

Assigning IP addresses to hosts and controllers” on page 47. 

5.   Verify that the TCP/IP software is installed. For more information, see “Step 6 

(Windows): Verifying the TCP/IP protocol and setting up the host or DNS table” 

on page 52. 

6.   Power on the devices that are connected to the network.

Step 1: Naming the storage subsystems 

As you set up your network, decide on a naming convention for the storage 

subsystems. When you install the storage management software and start it for the 

first time, all storage subsystems in the management domain display as <unnamed>. 

Use the Subsystem Management window to rename the individual storage 

subsystems. 

Consider the following factors when you name storage subsystems: 

v   There is a 30-character limit. All leading and trailing spaces are deleted from the 

name. 

v   Use a unique, meaningful naming scheme that is easy to understand and 

remember. 

v   Avoid arbitrary names or names that might quickly lose their meaning. 

v   The software adds the prefix Storage Subsystem when displaying storage 

subsystem names. For example, if you name a storage subsystem Engineering, 

it is displayed as: 

Storage Subsystem Engineering

Step 2: Recording the subsystem names 

After you decide on a naming scheme, record the storage subsystem names in the 

blank information record form provided in Appendix H, “Storage subsystem and 

controller information record,” on page 213). 

Table 14 shows a sample information record for the network shown in Figure 3 on 

page 17. This network contains storage subsystems that are managed by using 

both the direct-management and host-agent-management method. 

 Table 14. Sample information record 

Storage 

subsystem name 

Management 

method 

Controllers-Ethernet and IP 

addresses, and host name 

Host-IP address 

and host name 

Controller A Controller B 
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Table 14. Sample information record (continued) 

Finance Direct Hardware 

Ethernet address 

= 00a0b8020420 

Hardware 

Ethernet address 

= 00a0b80000d8 

IP address = 

192.168.128.101 

IP address = 

192.168.128.102 

Host = Denver_a Host = Denver_b 

Engineering Host-agent IP address = 

192.168.2.22 

Host = Atlanta
  

Direct-management method:  If you plan to manage your storage subsystem using 

the direct-management method, go to “Step 3: 

Identifying the hardware Ethernet MAC address for 

each controller.”

Host-Management method:  If you plan to manage your storage subsystem using 

the host-agent management method, go to “Step 4: 

Assigning IP addresses to hosts and controllers” on 

page 47. 

Step 3: Identifying the hardware Ethernet MAC address for each 

controller 

To manage your storage subsystem using the direct-management method, you 

need to identify the hardware Ethernet medium access control (MAC) address for 

each controller. 

Identifying the Ethernet MAC addresses on a DS4700 Storage 

Subsystem 

The MAC addresses on a DS4700 storage subsystem are located near the Ethernet 

ports on each RAID controller. 

Note:  You can access the controllers from the back of the DS4700 chassis as 

shown in Figure 13. 

   

sm
00

00
1

MAC address label (Controller B)

MAC address label (Controller A)
  

Figure 13. Location of MAC address on DS4700 RAID controllers
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Identifying the Ethernet MAC addresses on a DS4800 Storage 

Subsystem 

The machine type, model number, and serial number are located on top of each 

RAID controller unit. The MAC addresses are located near the Ethernet ports on 

each RAID controller, as shown in Figure 14.

Note:  You can access the controllers from the back of the DS4800 chassis. 

   

Identifying the Ethernet MAC addresses on FAStT500, DS4100, 

DS4400, and DS4500 Storage Subsystems 

To identify the hardware Ethernet MAC address for FAStT500, DS4100, DS4400 

and DS4500 storage subsystems, perform the following steps: 

1.   Remove the front bezel from the storage subsystem, as shown in Figure 15 on 

page 45. Carefully pull the bottom of the bezel out �1�to release the pins. Then 

slide the bezel down �2�. 
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Figure 14. Location of MAC address on DS4800 RAID controllers
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2.   On the front of each controller, look for a label with the hardware Ethernet MAC 

address. The number will be in the form xx.xx.xx.xx.xx.xx (for example, 

00.a0.b8.20.00.d8). 

3.   Record each Ethernet address in the information record (Appendix H, “Storage 

subsystem and controller information record,” on page 213). 

4.   To replace the bezel, slide the top edge under the lip on the chassis �1�. Then 

push the bezel bottom until the pins snap into the mounting holes �2�, as shown 

in Figure 16 on page 46. 
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Figure 15. Removing the controller-unit bezel (machine types 3552 [FAStT500] and 1742 

[DS4400 and DS4500])
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5.   Continue with “Step 4: Assigning IP addresses to hosts and controllers” on page 

47.

Identifying the Ethernet MAC addresses on FAStT200 and DS4300 

To identify the hardware Ethernet MAC address for machine types 3542 (FAStT200) 

and 1722 (DS4300), perform the following steps: 

1.   Locate the Ethernet MAC address at the back of the unit, under the controller 

fibre channel host ports, as shown in Figure 17 on page 47. The number will be 

in the form xx.xx.xx.xx.xx.xx (for example, 00.a0.b8.20.00.d8). 

2.   Record each Ethernet address in the information record (Appendix H, “Storage 

subsystem and controller information record,” on page 213).
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Figure 16. Replacing the controller-unit bezel (machine types 3552 [FAStT500] and 1742 

[DS4400 and DS4500])
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Step 4: Assigning IP addresses to hosts and controllers 

If you plan to manage your storage subsystem using the out-of-band management 

(direct-management) method, assign a unique IP address for every controller in all 

storage subsystems on the network. Record the IP address for each controller in 

the information record (Appendix H, “Storage subsystem and controller information 

record,” on page 213). Then, go to “Step 5: Setting up the DHCP or 

BOOTP-compatible server” on page 48. 

Note:  If you are not able to use the controller default TCP/IP address to assign the 

static TCP/IP address, refer to the information in “Direct-management 

(out-of-band) method” on page 14 and Retain Tip #H171389 Unable to setup 

networking without DHCP/BOOTP, which is located at the following IBM 

support Web site: 

www.ibm.com/support 

Then go to “Step 6 (Windows): Verifying the TCP/IP protocol and setting up the host 

or DNS table” on page 52. 

For DS4000 storage controllers with firmware versions 07.10.xx.xx, you can 

establish the out-of-band management connection to the DS4000 storage 

subsystem by using the default IP addresses of 192.168.128.101 and 

192.168.128.102 for controllers A and B, respectively. You can change the IP 

addresses by using the Controller → Change → Network Configuration menu 

option in the Storage Manager Client Subsystem Management window. 

If you plan to manage your storage subsystem using the host-agent management 

method, assign an IP address for each host on which you will install the host-agent 

software. Record the IP address for each host in the information record 

(Appendix H, “Storage subsystem and controller information record,” on page 213). 

Then, go to “Step 6 (Windows): Verifying the TCP/IP protocol and setting up the 

host or DNS table” on page 52. 

Hardware Ethernet
address label SJ000866

  

Figure 17. Locating the Ethernet MAC  address (machine types 3542 [FAStT200], 1724 

[DS4100], and 1722 [DS4300])
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Step 5: Setting up the DHCP or BOOTP-compatible server 

To directly manage storage subsystems through the Ethernet connection to each 

controller, you will need to set up a DHCP or BOOTP-compatible server and 

configure the following options: 

v   Router/Gateway 

v   DNS Server 

v   Hostname 

v   DNS

This section provides instructions to set up a DHCP server on Windows 2000 or 

Windows Server 2003, as well as instructions to set up a UNIX BOOT server. 

Note:  The remote management station (RMS) and network management station 

(NMS) entries used in previous versions of the storage management 

software are not required for Storage Manager 10.10. 

Setting up a Windows 2000 DHCP server 

You must use a version of DHCP that supports BOOTP static addressing. To use a 

DHCP server, you must have a DHCP Manager installed. If a DHCP Manager is 

installed on the system, go to “Creating a scope and setting up a DHCP server” on 

page 49. 

Installing the DHCP Manager 

To install the DHCP Manager, perform the following steps: 

 1.   Click Start → Administrative Tools → Configure Your Server. The Configure 

Your Server window opens. 

 2.   In the left pane, double-click Networking. Click DHCP. 

 3.   In the right pane, click Start. The Windows Components Wizard starts. 

 4.   In the Components field, select Networking Services. Then click Details. 

The Networking Services window opens. 

Note:  Do not select the check box; you do not want to install all of the 

Networking Services subcomponents. 

 5.   In the Subcomponents of Networking Services field, select Dynamic Host 

Configuration Protocol (DHCP). 

 6.   Click OK. The Windows Components Wizard window opens. 

 7.   Click Next to start the installation process. 

 8.   If prompted, type the full path to the Windows 2000 distribution files and click 

Continue. 

 9.   When the installation has successfully completed, the Windows Components 

Wizard window closes and the Configure Your Server Window opens. 

10.   Click Next. 

11.   Click Open the DHCP Manager. The DHCP window opens. 

12.   Continue with step 2 on page 49 of “Creating a scope and setting up a DHCP 

server” on page 49.

Note:  After you install the DHCP Manager, you can refer to the DHCP Manager 

online help for additional information.
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Creating a scope and setting up a DHCP server 

Use the following procedure to create a scope and to set up a DHCP server. A 

scope defines a group of controllers by their IP addresses. You must create and 

configure a scope so that dynamic IP addresses can be assigned to controllers on 

your network. Refer to the information record (Appendix H, “Storage subsystem and 

controller information record,” on page 213). Before you begin, read through the 

instructions to determine what information is required. Then request the information 

from your network administrator. 

 1.   Click Start → Programs → Administrative Tools → DHCP. The DHCP window 

opens. 

 2.   In the Console tree, right-click the server you want to configure; click New 

Scope. The New Scope Wizard starts, as shown in Figure 18.
 

 3.   Follow the on-screen instructions to define the scope of IP addresses for 

TCP/IP clients. You will define the following fields: 

a.   Scope name and description 

b.   IP address range for the subnet mask, and the controllers you are 

configuring 

c.   IP addresses that you want to exclude from the IP address range 

d.   IP address lease duration 

e.   Common DHCP options: 

v   IP address for a router 

v   Domain name and DNS servers

 4.   When you have defined the scope, click Yes, I want to activate this scope 

now. The wizard ends, and the DHCP window opens. 

 5.   In the Console tree, open the scope folder. 

SJ000868

  

Figure 18. New  Scope Wizard: IP Address Range window
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6.   Right-click Reservations. Then select New Reservations. The New 

Reservations window opens. 

 7.   To define the IP address reservation, type the following information: 

a.   Reservation name 

b.   IP address 

c.   Ethernet hardware MAC address 

d.   Description

 8.   In the Supported Type field, select Both (DHCP and BOOTP). 

 9.   Click Add. 

10.   Repeat steps 5 on page 49 through 9 for each controller in the network. 

11.   Restart the DHCP server and then restart the storage subsystem so that all 

modifications are applied. 

12.   Proceed to “Step 6 (Windows): Verifying the TCP/IP protocol and setting up the 

host or DNS table” on page 52.

Setting up a Windows Server 2003 DHCP server 

You must use a version of DHCP that supports BOOTP static addressing. To use a 

DHCP server, you must have a DHCP Manager installed. If a DHCP Manager is 

already installed on the system, see “Creating a scope and setting up a DHCP 

server.” 

Installing the DHCP Manager 

To install the DHCP Manager, perform the following steps: 

1.   Click Start → Control Panel → Add or Remove Programs. The Add or Remove 

Programs window opens. 

2.   In the left pane, click Add/Remove Windows Components. The Windows 

Components Wizard window opens. 

3.   In the Components field, select Networking Services. Then click Details. The 

Networking Services window opens.

Note:  Do not select the check box; you do not want to install all of the 

Networking Services subcomponents. 

4.   In the Subcomponents of Networking Services field, select Dynamic Host 

Configuration Protocol (DHCP). Click OK. The Networking Services window 

closes. 

5.   In the Windows Components Wizard window, click Next to start the installation 

process. 

6.   If prompted, type the full path to the Windows Server 2003 distribution files and 

click Continue. 

7.   When the installation has successfully completed, the Windows Components 

Wizard window opens. Click Finish to close the Windows Components Wizard 

window. 

8.   Close the Add or Remove Programs window. You are now ready to perform the 

tasks in “Creating a scope and setting up a DHCP server.”

After you install the DHCP Manager, you can refer to the DHCP Manager online 

help for additional information. 

Creating a scope and setting up a DHCP server 

Perform the following steps to create a scope and to set up a DHCP server. A 

scope defines a group of controllers by their IP addresses. You must create and 

configure a scope so that dynamic IP addresses can be assigned to controllers on 
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your network. See Appendix H, “Storage subsystem and controller information 

record,” on page 213. Before you begin, read through the instructions to determine 

what information is required. Then request the information from your network 

administrator. 

 1.   Click Start → Administrative Tools → DHCP. The DHCP window opens. 

 2.   In the Console tree, right-click the server you want to configure, then click New 

Scope. The New Scope Wizard starts. 

 3.   Follow the on-screen instructions to define the scope of IP addresses for 

TCP/IP clients. You will define the following fields: 

v   Scope name and description 

v   IP address range for the subnet mask, and the controllers that you are 

configuring 

v   IP addresses that you want to exclude from the IP address range 

v   IP address lease duration 

v   Common DHCP options: 

–   IP address for a router 

–   Domain name and DNS servers or Windows Internet Naming Service 

(WINS) servers

 4.   When you have defined the scope, click Yes, I want to activate this scope 

now. The New Scope Wizard window opens. 

 5.   Click Finish. The New Scope Wizard window closes and the DHCP window 

opens. 

 6.   In the Console tree, expand the Scope folder. 

 7.   Right-click Reservations. Then select New Reservations. The New 

Reservations window opens. 

 8.   To define the IP address reservation, type the following information: 

v   Reservation name 

v   IP address 

v   Ethernet hardware MAC address 

v   Description

 9.   In the Supported Type field, select Both (DHCP and BOOTP). 

10.   Click Add. 

11.   Repeat steps 7 through 10 for each controller in the network. 

12.   Restart the DHCP server and then restart the storage subsystem so that all 

the modifications are applied. 

13.   Proceed to “Step 6 (Windows): Verifying the TCP/IP protocol and setting up the 

host or DNS table” on page 52.

Setting up a UNIX BOOTP server 

To use a UNIX BOOTP server, you must set up a BOOTP table. Table 15 and the 

information record (Appendix H, “Storage subsystem and controller information 

record,” on page 213) provide the necessary information. 

 Table 15. Required entries for setting up the UNIX  BOOTP  server 

Entry Description 

Sample format in 

BOOTP server 

Subnet mask Mask that is used to route packets to defined 

subnets 

dot notation 

(sm=255.255.0.0) 
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Table 15. Required entries for setting up the UNIX  BOOTP  server (continued) 

Entry Description 

Sample format in 

BOOTP  server 

Router IP address of the host computer that routes 

packets to networks 

dot notation 

(gw=192.168.128.1) 

Host name for the 

controller 

Host name that is associated with the controller 

(see Table 28 on page 213) 

host name (Denver_a) 

IP address IP address of the controller (see Table 28 on 

page 213) 

dot notation 

(ip=192.168.128.101) 

Ethernet address The Ethernet address of the controller 

hardware (see Table 28 on page 213) 

hexadecimal notation 

(ha=00a0b8020420)
  

Perform the following steps to set up a UNIX BOOTP server: 

1.   Use a text editor to edit the bootptab file in the /etc directory. 

Use the following example of the BOOTP table to configure the Network A 

server shown in Figure 3 on page 17 where the s4.default:\ entry denotes 

settings that are common to all controllers, and the tc=s4.default:\ entry 

associates this common setting group to a specific controller. 

 s4.default:\ (common settings) 

ht=ether:\ 

sm=255.255.255.0:\ 

gw=192.168.128.1:\ 

hn: 

denver_a:\ 

tc=s4.default:\ (common settings) 

ip=192.168.128.101:\ 

ha=00a0b8020420: 

denver_b:\ 

tc=s4.default:\ 

ip=192.168.128.102:\ 

ha=00a0b80000d8: 

  

2.   If the storage subsystem is running, shut down and then restart the subsystem. 

This ensures that the parameters in the BOOTP table take effect. 

3.   Continue with “Step 6 (Windows): Verifying the TCP/IP protocol and setting up 

the host or DNS table.”

Step 6 (Windows): Verifying the TCP/IP protocol and setting up the 

host or DNS table 

Install the TCP/IP networking stack to enable SMclient functions. Perform the 

following two tasks by using the procedure that follows them: 

v   Verify that the TCP/IP protocol software is installed on the management station or 

the host server on which you will install and from which will run SMclient. 

v   Set up the host or DNS table.

Note:  Make sure that the host names for the controllers match the IP addresses for 

the controllers. 

Windows 2000 

Perform the following steps for Windows 2000: 
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Important:  To manage storage subsystems through a firewall, configure the firewall 

to open port 2463 to TCP data after you complete these steps. 

1.   Right-click My Network Places. 

2.   Select Properties. The Network and Dial-up Connections window opens. 

3.   Right-click a defined network connection. 

4.   Select Properties. Make sure that the Internet Protocol TCP/IP box under the 

Components checked that are used by this connection is marked. If not, mark it, 

click Install, and follow the instructions that display. 

5.   Update the DNS table to specify a host name to associate with an IP address. 

If you do not have a DNS server, use a text editor to update the hosts file to link 

the IP address and controller name entries. The following example shows the 

host tables for the controllers that are connected to Network A as shown in 

Figure 3 on page 17: 
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# Copyright (c) 1993-1999 Microsoft Corp. 

  

# This is a sample HOSTS file used by Microsoft TCP/IP for Windows. 

  

# This file contains the mappings of IP addresses to host names. Each 

# entry should be kept on an individual line. The IP address should be placed 

# in the first column followed by the corresponding host name. The IP address 

# and the host name should be separated by at least one space. 

  

# Additionally, comments (such as these) might be inserted on individual 

  

# lines or following the machine name denoted by a’#’ symbol. 

  

# For example: 

  

# 102.54.94.97   rhino.acme.com   # source server 

  

# 38.25.63.10   x.acme.com     # x client host 

  

127.0.0.1     local host 

  

192.168.128.101   denver_a 

  

192.168.128.102   denver_b 

  

Windows Server 2003 

Perform the following steps for Windows Server 2003: 

Important:  To manage storage subsystems through a firewall, configure the firewall 

to open port 2463 to TCP data after you complete these steps. 

1.   Open the Windows Explorer window. 

2.   Right-click the My Network Places folder and select Properties from the 

pull-down menu. The Network Connections window opens. 

3.   Right-click a defined network connection and select Properties from the 

pull-down menu. 

4.   A network_name Properties window opens. Make sure that the Internet 

Protocol TCP/IP box under The Connection Uses The Following Items window 

pane is selected. If not, select it and click OK to close the network_name 

Properties window. 

5.   Update the DNS table to specify a host name to associate with an IP address. If 

you do not have a DNS server, use a text editor to update the hosts file to link 

the IP address and controller name entries. The following example shows the 

host tables for the controllers that are connected to Network A, as shown in 

Figure 3 on page 17. 
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# Copyright (c) 1993-1999 Microsoft Corp. 

  

# This is a sample HOSTS file used by Microsoft TCP/IP for Windows. 

  

# This file contains the mappings of IP addresses to host names. Each 

# entry should be kept on an individual line. The IP address should 

# be placed in the first column followed by the corresponding host name. 

# The IP address and the host name should be separated by at least one 

# space. 

  

# Additionally, comments (such as these) may be inserted on individual 

  

# lines or following the machine name denoted by a ’#’ symbol. 

  

# For example: 

  

#      102.54.94.97     rhino.acme.com          # source server 

  

#       38.25.63.10     x.acme.com              # x client host 

  

127.0.0.1       localhost 

  

192.168.128.101 denver_a 

  

192.168.128.102 denver_b 

  

Step 6 (Linux): Verifying the TCP/IP protocol and setting up the host or 

DNS table 

The normal default installation process will install the TCP/IP software package. 

Perform the following step to set up the host or DNS table. Make sure that the host 

names for the controller match the IP addresses for the controllers. 

Important:  To manage storage subsystems through a firewall, configure the firewall 

to open port 2463 to TCP data after you complete this step. 

Update either the host table or the DNS table to specify a host name to 

associate with an IP address. If you do not have a DNS table, edit the 

host table that is found in the /etc/hosts directory. Your directory might 

be different if the operating system is not installed on the root. 

The following sample shows a Linux host file. Do not remove the following line, or 

various programs that require network functionality will fail. 

 127.0.0.1 rh71_8500 localhost.localdomain 

localhost 102.54.94.97 rhino.acme.com x.acme.com 
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Chapter  3.  Installing  Storage  Manager  software  in a standard  

Windows  configuration  

This chapter describes how to install the storage management software for 

Windows 2000, and Windows Server 2003 in a standard (noncluster) configuration. 

Before you install the software, make sure that you have read the following 

information: 

v   If you intend to configure your system for clustering, see Chapter 4, “Installing 

Storage Manager software in a Windows cluster server environment,” on page 

67. 

v   To ensure proper installation, make sure that you have completed all preparation 

tasks described in Chapter 2, “Preparing for installation,” on page 37.

Important: 

1.   Always check for a readme file on any installation media. The readme file 

contains important information that was not available when the guide was 

prepared. 

See “Readme files and concepts” on page 1 to find out how to access the most 

recent Storage Manager readme files on the Web. 

2.   This version of the storage management software does not support 64-bit 

versions of Windows XP. All administrator functions using the storage 

management software must be performed from a 32-bit storage management 

station. 

3.   Configure the Event Monitor on only one storage management station to 

prevent receipt of duplicate event messages. Note that duplicate alerts are also 

sent if the Enterprise Management window and the SMmonitor are running 

simultaneously. 

4.   Do not reboot during the installation process. You will reboot after installing all 

storage management software components.

Process for a new installation 

You can install the Storage Manager 10.10 software components on host computers 

(only) or on both host computers and management stations. 

Important: 

1.   If you are upgrading from version 9.10 or earlier of DS4000 Storage Manager 

software, you must remove the current software before installing the DS4000 

Storage Manager Version 10.10 software. 

2.   The DS4000 Storage Manager 9.16 Release 2 and later supports Microsoft 

Windows Server 2003 x64 editions for servers with AMD, AMD64 and Intel 

EM64T processor technology for the DS4700 and DS4800 storage subsystems. 

This support requires certain versions of the following: 

v   Storage manager host software (including RDAC) 

v   Controller firmware 

v   Fibre channel host bus adapter device driver 

See “IBM DS4000 Storage Manager Version 10.10 software for Windows” on 

page 8 for more information. 

3.   The maximum number of LUNs in a given DS4000 subsystem that can be 

mapped to a Windows Server 2003 host is 256 when using the fibre channel 

host bus adapter device driver based on the Microsoft SCSIport miniport device 
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driver model that supports buschange=0 parameter (for example, IBM FC2-133 

HBA device driver version 9.0.2.60 or earlier). The maximum number of LUNs 

per Windows Server 2003 host is reduced to 128 LUNs when using the 

supported device driver based on the Microsoft Storport miniport device driver 

model or based on the Microsoft SCSIport miniport device driver model that 

does not support buschange=0 parameter (for example, IBM FC2-133 or FC 

4Gbps HBA device driver version 9.1.2.11 or later).

Management station: A management station is a system that you use to manage 

the storage subsystem. You can attach it to the storage subsystem in the following 

ways: 

v   Through a TCP/IP Ethernet connection to the controllers in the storage 

subsystem 

v   Through a TCP/IP network connection to a host computer with host-agent 

software installed on it, which in turn is directly attached to the storage 

subsystem through the fibre channel input/output (I/O)

Host computer: A host computer (or host) is a system that is directly attached to 

the storage subsystem through a fibre channel I/O path. 

Important: Be sure you install the host-bus adapter and driver before you install the 

storage management software. 

You must install storage management software on each host computer in the 

following order: 

1.   SMclient (SMclient is needed only if you want to manage the DS4000 storage 

subsystem through this host server.) 

2.   Multipath driver 

3.   SMagent 

4.   SMutil

For Storage Manager release version 10.10, all of the individual software packages 

are included in a single host software installer. The Installer wizard automatically 

installed software components in the correct order. 

To begin the installation on your management station, see the “Process for a new 

installation” on page 57. 

To begin installation on a host, see “Installing the IBM fibre channel host bus 

adapter device driver.” 

Installing the IBM fibre channel host bus adapter device driver 

An IBM fibre channel host bus adapter (HBA) provides the interface between a host 

server and an DS4000 storage subsystem. IBM DS4000 fibre channel HBAs are 

high-performance, direct memory access, bus-master, host adapters that are 

designed for high-end systems. These HBAs support all fibre channel peripheral 

devices that support private-loop direct-attach and fabric-loop attachment. The IBM 

Host Adapter device driver enables your operating system to communicate with the 

fibre channel HBA. 
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New Storport miniport HBA device driver 

Storage Manager 10.10 provides the support of a fibre channel host bus adapter 

(HBA) device driver that is based on the Microsoft Storport Miniport device driver 

model. 

The Storport miniport device driver model was introduced in the Microsoft Windows 

Server 2003 release as a replacement for the SCSIport miniport device driver 

model. It is the only supported device driver model for Windows Server 2003 x64 

editions, supporting the AMD64 and EM64T servers. It does not support the 

buschange=0 parameter to bypass the Microsoft Windows operating system Plug 

and Play driver; but rather works with the Plug and Play driver to detect the removal 

and insertion of devices at the fibre channel host bus adapter port. 

Currently, only the DS4100, DS4200, DS4300 standard/base or turbo models, 

DS4400, DS4500, DS4700 and DS4800 storage subsystems support this 

Storport-based device driver. The DS4100, DS4300 standard/base or turbo models, 

DS4400 and DS4500 subsystem models must have controller firmware version 

6.12.27.xx or higher installed. The Storport miniport device driver will not be 

supported with the following: 

v   The older DS4000 subsystems such as the FAStT500 and FAStT200 

v   The DS4000 single controller subsystem modes such as the DS4300 SCU and 

the DS4100 SCU 

v   The DS4100, DS4300 standard/base or turbo models, DS4400 and DS4500 

subsystem models with controller firmware version 6.12.26.xx or earlier installed

In addition to the controller firmware requirement, to support Storport Miniport 

device drivers, the Windows Server 2003 operating system must have Service Pack 

1, the latest Storport Miniport hotfix installed (Microsoft Windows Server 2003 

Storport hotfix KB916048—an updated Storport storage driver (version 

5.2.3790.2723)). 

See the Storage Manager readme file for Microsoft Windows operating systems for 

any other additional requirements, such as controller firmware versions or other 

Microsoft updates, in addition to information about the most up-to-date versions of 

the hotfix. 

Currently, in a Microsoft Windows Server 2003 operating system environment, IBM 

DS4000 subsystems also support fibre channel host bus adapter (FC HBA) device 

drivers based on the Microsoft SCSIport miniport device driver. However, IBM 

recommends the adoption of the newer Storport miniport fibre channel HBA device 

driver immediately because the support of device drivers based on the SCSIport 

miniport model might not be available in the future releases of Microsoft operating 

systems. 

SCSIport miniport HBA device driver 

For the Windows 2000 operating system environment, only the device drivers based 

on the SCSIport miniport device driver (not the Storport model) are currently 

supported. However, DS4000 Storage Manager 10.10 provides the following 

important change to the SCSIport device driver: 

In previous SCSIport device driver releases, the buschange=0 parameter allows 

the RDAC multipath driver to control and monitor device insertion and removal from 

the HBA port by preventing the Microsoft Plug and Play device drive from managing 
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the HBA port. This new SCSIport device driver version that is released with the 

DS4000 Storage Manager 10.10 does not support the buschange=0 parameter. 

 Attention:  Not all DS4000 controller firmware versions support this functionality. 

Only DS4000 controller firmware versions 06.16.27.xx (and later) for DS4200, 

DS4300 standard/base or turbo models, and DS4500 subsystems or versions 

6.16.8x.xx (and later) for DS4200, DS4700 and DS4800 subsystems support this 

new SCSIport miniport device driver. Check with your IBM reseller, IBM 

representative, or the DS4000 interoperative matrix for information on future 

DS4000 support of this device driver. 

Before installing the device driver, check the readme file that is included in the 

device driver package file and the DS4000 Storage Manager host software for 

Windows operating systems to see which device driver version is supported for 

which DS4000 storage subsystems in conjunction with which controller firmware 

version. 

 See the readme file included in the driver package for installation instructions 

associated with your operating system. See “Readme files and concepts” on page 1 

to find out how to access the most recent Storage Manager readme files on the 

Web. Additional information is also available in Appendix I, “Host bus adapter 

settings,” on page 215 for the FC HBA based on QLogic FC interface chipsets. 

Note:  Read the device driver readme for any required modifications to the default 

HBA BIOS and host operating system registry settings to ensure optimal 

performance. If you make any changes to the HBA BIOS settings, the 

machine must be rebooted for the changes to be enabled. 

For more information, see the Installation and User’s Guide for your particular fibre 

channel HBA model. 

Installing Storage Manager 10.10 Client 

This section describes how to install different components of Storage Manager host 

software on management stations and host computers that run Windows operating 

systems. The installation is applicable for Storage Manager 10.10 host software 

only. If you are installing Storage Manager 9.23, refer to Appendix C, “Installing 

Storage Manager 9.2x Client,” on page 185. 

Before you install the software, make sure that the management station or host 

computer has at least 300 MB (370 MB for Windows Server 2003 IA-64 [Itanium 2] 

environment) of available disk space for the installation software package, the 

temporary files during installation, and the final files after the installation. The final 

installation directory size will be 170 MB, if you install all software packages in 

Windows 2000 or Windows Server 2003 32-bit environment. In a Windows Server 

2003 IA-64 (Itanium 2) environment, the final installation directory size will be 200 

MB. 

Important:  When you install SMclient on a stand-alone host and manage storage 

subsystems through the fibre channel I/O path rather than through the 

network, you must install the TCP/IP software on the host and assign 

an IP address to the host. 

Starting with the DS4000 Storage Manager host software version 9.12, all four 

components of the host software—SMclient, multipath driver, SMagent, and 
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SMutil—are packaged in a single host software package installer. Depending on a 

user’s needs, up to four packages can be installed using this host software package 

installation program. 

Notes:  

1.   If the operating system of the computer that you want to install this software is 

of management support list only (like Windows XP and Windows 2000 

Professional), the only host software component that is available for installation 

is the SMclient program. 

2.   Windows 2000 Professional and Windows XP support the DS4000 Storage 

Manager Client package only. Do not install any other storage management 

software packages on Windows 2000 Professional or XP. The multipath driver is 

not supported on these Windows operating systems. 

Perform the following steps to install the DS4000 Storage Manager host software 

packages in either a server or management station. 

Important: These installation instructions are not for servers with SAN-boot or 

Remote-boot disk. 

 1.   Before installing this software, close all other programs. 

 2.   Insert the IBM DS4000 Storage Manager Version 10.10 support for Microsoft 

Windows operating system's CD into the CD-ROM drive.

Note:  If you downloaded the Storage Manager version 10.10 host software 

package for Windows from the DS4000 support Web site, you must 

unzip the downloaded .zip file to unpack the content of the Storage 

Manager host software Web package for Windows into your specified 

directory. Go to this directory and select the Windows directory to get 

access to the Windows host software package install program. Go to 

step 6. 

 3.   From the Windows desktop, double-click the My Computer icon. The My 

Computer window is displayed. 

 4.   Double-click the CD-ROM drive that has your DS4000 Storage Manager 

Version 10.10 CD. The CD window is displayed. 

 5.   Select the appropriate directory in the CD for your operating system 

architecture (IA-32-bit or IA-64-bit). 

 Directory Operating System 

Win32 Windows 2000 Server, Advanced Server 

and DataCenter 

WS03_x86 Windows Server 2003 x86 32bit edition 

(IA32) Server, Enterprise Edition and 

DataCenter 

WS03_IA64 Windows Server 2003 IA-64 64-bit edition 

(Itanium Architecture 64 only) Server, 

Enterprise Edition and DataCenter 

WS03_x64 Windows Server 2003 X64 64bit edition 

(AMD64 and EM64T) Server, Enterprise 

Edition and DataCenter
  

 6.   To launch the host software package installer, double-click the .exe file, such 

as SMIA-WS....exe. 

 7.   For Storage Manager 9.19 and later only, the installer displays an IBM System 

Storage DS4000 Storage Manager splash screen with a drop-down menu. 
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From this drop-down menu, you can select a language option. (Language 

selection is optional if you are performing an English language installation.) 

The language option you select will determine the language version of the 

License Agreement that is displayed. Once you have selected a language, 

click the OK button. 

 8.   The Introduction window is displayed. Click Next to continue. 

 9.   The License Agreement window will be displayed. Read the License 

Agreement and select either I accept the terms of the License Agreement or 

I do not accept the terms of the License Agreement radio button and click 

Next to continue with the installation. If you choose not to accept the terms of 

the License Agreement, the Installer wizard will terminate. (Otherwise, proceed 

to next step.) 

10.   The Copyright Statement window is displayed. Click Next. 

11.   The Choose Install Folder window is displayed, identifying the default install 

directory. The default directory is Windows_boot_drive_letter:\Program 

Files\IBM_DS4000. You could change this value to another directory; but it is 

recommended to keep the specified default installation directory. 

12.   Click Next. 

The Select Installation Type window is displayed. 

13.   Based on the type of installation you are performing, select one of the 

following actions. Note that the following steps are written for a typical (full 

installation). 

v   Typical (Full Installation)—This selection, which is the default, installs all of 

the packages on the system. This is a safe choice if you do not know which 

installation type to select. This option will install all four host software 

components - SMclient, mulitpath driver, SMagent and SMutil.

Notes:  

a.   You must select the Custom installation option if you do not use the 

DS4000 RDAC or a DS4000 MPIO/DSM driver as multipath/failover 

driver such as Symantec Dynamic Multipathing for Windows (DMP). 

b.   For a Microsoft Windows XP operating system environment, the only 

package that will be installed in a typical installation is the client 

package.

v   Management Station—This selection installs the software needed to 

configure, manage, and monitor a storage array. This option is for your 

workstation or management PC. This option will install SMclient program 

only. 

v   Host—This selection installs the storage array server software. Use this 

type of installation for the host (server) connected to the storage array 

(Windows 2000 and Windows Server 2003/2008 only). This option will install 

all host software components with the exception of SMclient program. 

v   Custom—This selection enables you to customize the features to be 

installed.

The selected installation type is highlighted in blue text. 

14.   Click Next. 

If there are previously installed Storage Manager software packages, the 

Overwrite Warning dialog is displayed. 

15.   If the Overwrite Warning dialog is displayed, click OK. 
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The Automatically Start Monitor? window is displayed. This refers to the Event 

Monitor service, which monitors the specified DS4000 storage subsystems and 

forward any critical alerts from those subsystems when the SMclient program 

is not running. 

16.   In the Automatically Start Monitor? window, select the appropriate option for 

your system.

Notes:  

a.   To enable automatic ESM firmware synchronization, you must enable the 

Event Monitor. Select Automatically Start Monitor. (See “Automatic ESM 

firmware synchronization” on page 124 for more information.) 

b.   If you start the Event Monitor service on multiple machines, you might 

receive duplicate error messages from the same storage array. To avoid 

receiving duplicate error messages, start the monitor on only one machine. 

It is recommended that you run the monitor on one machine that will run 

continually.

17.   If an RDAC/failover driver package was selected to be installed, a Select 

Multipath drive window driver will be displayed. Select either RDAC or MPIO 

as the choice for the multipath driver that will be installed. Click Next to 

continue. 

Refer to “Redundant disk array controller” on page 9 for more info about 

RDAC and MPIO multipath driver and the requirements to support either type 

of multipath driver. 

18.   Click Next. 

The Pre-Installation Summary window is displayed. 

19.   Click Install. 

The Installing window is displayed while the software is loading. The 

Installation/Remove status window is also displayed throughout the installation 

process. 

The Security Alert dialog might be displayed multiple times. 

20.   Did the Security Alert dialog display? 

v   Yes—Click Yes. 

v   No—Go to step 21 on page 64. When the software is loaded, the Install 

Complete window is displayed. 

Important: 

a.   With Storage Manager 10.10, RDAC is only offered if it is required for 

multipathing. In future releases of Microsoft Windows, RDAC will not be 

supported, and MPIO/DSM will become the main Multipath Support driver. 

b.   If RDAC is not installed in the computer, the Install Complete window might 

display an error message stating that the installation is finished and that 

there are some warnings. The message suggests looking at the installation 

log for details. The installation log contains a warning that a Win32 

exception can be found. This is normal and expected behavior. The 

installation was successful 

c.   If you cancel an installation before the installation completes its run (while 

the progress bar is still visible), the installation might not clean up the 

aborted installation properly, and the host-software installation wizard 

creates an install log. In addition, the Add/Remove Program window might 

show that the program is already installed. However, when you try to 

uninstall it, you will get an uninstallation error and whether you want to 

remove the entry from the Add/Remove program list. Click Yes to remove 

the entry. Then, you must delete the .xml file in the 
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Windows_boot_drive_letter:\Program Files\Zero G Registry directory. If 

you did not delete the .xml file, when you try to run the DS4000 Storage 

Manager Installation wizard again, it will state that an existing version of 

the program is already installed and whether you want to update it. 

However, when you click OK and proceed through the installation process, 

the files will be installed in the following directory: 

Documents and Settings\user_login_ID\LocalSettings\ 

Temp\UniqueDirectoryName\Windows\NULL 

This directory does not exist. In the above directory name, the 

user_login_ID and UniqueDirectoryName fields will be different for 

different installations. The Windows_boot_drive_letter:\Program 

Files\Zero G Registry directory might be hidden from the normal 

Windows Explorer view. If this is the case, change the settings of the 

Windows Explorer to Show hidden files and folders.

If you cancel the installation before the progress bar is visible, the installation 

wizard will clean up the abort process properly. You do not need to do anything 

before starting the wizard again. 

21.   Verify that the Yes, restart my system option is selected. 

22.   Click Done. 

Several files and program packages are installed to the directory that you 

specified in step 11 on page 62. The default directory is 

Windows_boot_drive_letter:\Program Files\IBM_DS4000. 

The installation is completed, and Windows is restarted. 

Important: If you repeatedly cancel an installation or uninstallation before the 

process completes its run and try to install again, the installation process might 

not work, and the software might not be installed after the installation process 

is completed. The installation complete panel tells you where the software is 

installed, but it is not there. If this problem occurs, delete the .xml file from the 

Windows_boot_drive_letter:\Program Files\Zero G directory. 

23.   To verify that the software packages were installed, go to Appendix D, 

“Verifying the installation,” on page 189.

Configuring storage management 

After you install Storage Manager, complete the tasks that are described in 

Chapter 8, “Completing storage management installation and configuration,” on 

page 113. These tasks include the following: 

v   Performing an initial automatic discovery of storage subsystems 

v   Adding devices 

v   Naming storage subsystems 

v   Creating arrays and logical drives 

v   Downloading controller firmware and NVSRAM 

v   Verifying and defining the default host type 

v   Setting up alert notifications

Additional information 

For additional information about installing and using Storage Manager 10.10 for 

Windows 2000 and Windows Server 2003 in a standard (noncluster) configuration, 

see “Windows operating system limitations” on page 195. 
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For additional information about uninstalling Storage Manager components in 

Windows, see “Uninstalling storage management software components” on page 

142. 
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Chapter  4.  Installing  Storage  Manager  software  in a Windows  

cluster  server  environment  

This chapter describes how to install the storage management software in a 

Windows cluster server environment. Before you install the software, make sure 

that you have read the following information: 

v   If you are upgrading from a previous version of Storage Manager on an existing 

cluster, go to “Upgrading from a previous version of the storage management 

software” on page 74. 

v   To ensure proper installation, complete all preparation tasks described in 

Chapter 2, “Preparing for installation,” on page 37. 

v   Review Table 23 on page 196 for related information.

Important:  Always check the Storage Manager readme file for your operating 

system before installing the software. A readme file contains important 

information that was not available when this guide was prepared. See 

“Readme files and concepts” on page 1 to find out how to access the 

most recent Storage Manager readme files on the Web. 

Preinstallation considerations 

The hardware installation involves installing host adapters and storage subsystems. 

Before you begin the installation of the DS4000 Storage Manager software, make 

sure that all hardware components are installed correctly for the cluster server 

configuration. 

Configuration options 

You can connect the storage subsystem to the cluster nodes either directly or 

through fibre channel switches. Figure 19 on page 68 shows typical direct-attached 

or fibre channel switch connection configurations. Both configurations offer full 

redundancy.
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Host adapters 

Refer to the appropriate host-adapter documentation for specific installation 

requirements and procedures. The following considerations apply: 

v   To use the dual-path configuration, perform the following tasks: 

–   Install two host adapters in each node. 

–   Run two fibre channel cables from each node to the storage subsystem.

Node A

Host adapters

Node A

Host adapters

Node B

Host adapters

Node B

Host adapters

Switch Switch

Storage
subsystem
controllers

Storage
subsystem
controllers

Storage subsystem

Storage subsystem

Interlink

Interlink

Fibre Channel
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Fibre Channel
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Mini hub
1

Mini hub
1

Mini hub
2

Mini hub
2

SJ000871

  

Figure 19. Installing the storage subsystem on a fibre channel network
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v   If you connect the storage subsystem through a Fibre Channel Arbitrated Loop 

(FC-AL), ensure that every adapter on the loop is assigned a unique hard ID. For 

instructions about changing hard IDs, see the documentation provided with your 

host adapters. 

v   The correct device driver is installed for the host adapter. See the readme file in 

the \Host_Adapter directory on the IBM DS4000 Storage Manager CD for 

information about supported host adapters and device drivers.

Storage subsystems 

Refer to the appropriate hardware documentation for specific installation 

requirements and procedures. If you are managing storage subsystems directly, you 

must connect Ethernet cables to both controllers in each storage subsystem. 

Installing the storage management software in a cluster environment 

The following procedures describe how to install the storage management software 

in a cluster environment. 

Windows 2000 

Perform the following steps to install the storage management and cluster service 

software on Windows 2000: 

 1.   Be sure that the HBA and device driver are installed in each cluster node. For 

information about HBA and device driver installation, see “Installing the IBM 

fibre channel host bus adapter device driver” on page 72. 

 2.   Power down node B. Start node A. 

 3.   Install the storage management software on node A. See “Installing the 

storage management software” on page 72 for instructions. 

 4.   Complete the procedures in Chapter 8, “Completing storage management 

installation and configuration,” on page 113. 

 5.   Run the hot_add utility on node A. See “Using the hot_add utility” on page 140 

for instructions. 

Note:  You might have to restart node A in order to see the newly added 

logical drives. 

 6.   Format all shared logical drives as NT File System (NTFS), assign volume 

labels, and specify a drive letter for each. 

Important: You must assign a permanent (sticky) drive letter to the shared 

logical drive on both cluster nodes. The two nodes must have the same drive 

letters on each shared drive. If you do not assign permanent drive letters, 

Windows might assign different drive letters on each node. Assigning a 

permanent drive letter ensures that Windows assigns the same drive letter to 

the partition on both cluster nodes. 

 7.   Shut down node A. Start node B. 

 8.   Install the storage management software on node B. See “Installing the 

storage management software” on page 72 for instructions. 

 9.   To verify the drive letters for the cluster configuration, perform one of the 

following procedures: 

v   For Windows 2000, perform the following steps: 

a.   Click Start → Programs → Administrative Tools → Computer 

Management. The Computer Management window opens. 

b.   Click Storage → Disk Management.
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10.   Verify that the following conditions are met: 

v   The same logical drives display on each cluster node. 

v   Each cluster node has the same number of partitions defined on the logical 

drives. 

v   Drive letters are assigned to the configured logical drives. 

v   The drive letters on the partitions are the same on both cluster nodes.

11.   Shut down node B. 

12.   Install the cluster server software. See “Installing the cluster server software” 

on page 73 for instructions. 

13.   Disable the RDAC or MPIO automatic failback feature by changing the 

DisableLunRebalance registry setting of the [HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\rdacdisk\Parameters] if you installed RDAC as 

the multipath driver or the [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\
Services\ds4dsm\Parameters] registry key if you installed MPIO or MPIO/DSM 

as the multipath driver from 0 to 3 in each cluster node. Reboot each node for 

the changes to take effect. 

If this RDAC or MPIO feature is not disabled, and if a host in a cluster server 

configuration loses a physical path to a DS4000 storage subsystem controller, 

the logical drives that are mapped to the cluster group will periodically failover 

and then failback between cluster nodes until the failed path is restored. This 

behavior is the result of the automatic logical drive failback feature of the 

RDAC or MPIO multipath driver. The cluster node with a failed path to a 

DS4000 controller will issue a failover command of all logical drives that were 

mapped to the cluster group to the controller that it can access. After a 

programmed interval, the nodes that did not have a failed path will issue a 

failback command for the logical drives because they can access both logical 

drives' controllers, resulting in the cluster node with the failed path to not be 

able to access certain logical drives. This cluster node will then issue a failover 

command for all logical drives, repeating the logical drives failover-failback 

cycle.

 Attention:  If you use Registry Editor incorrectly, you can cause serious 

problems that may require you to reinstall your operating system. IBM cannot 

guarantee that you can solve problems that result from using Registry Editor 

incorrectly. Use Registry Editor at your own risk. 

14.   Go to Chapter 8, “Completing storage management installation and 

configuration,” on page 113.

Windows Server 2003 

Perform the following steps to install the storage management and cluster service 

software on Windows Server 2003: 

 1.   Make sure that the HBA and device driver are installed in each cluster node. 

For information about HBA and device driver installation, see “Installing the 

IBM fibre channel host bus adapter device driver” on page 72. 

 2.   Install the storage management software on the host server that will be the 

first node of the cluster. See “Installing the storage management software” on 

page 72 for instructions. 

 3.   Complete the procedures in Chapter 8, “Completing storage management 

installation and configuration,” on page 113, specifically to create LUNs that 

will be used as cluster disks and to make sure that the host type of the host 

group or host ports that these LUNs are mapped to were set to “Windows 

2000/Server 2003...clustered” or “Windows 2000 clustered”. 
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4.   Run the hot_add utility on the first node of the cluster. See “Using the hot_add 

utility” on page 140 for instructions.

Note:  You might have to restart the first node of the cluster in order to see the 

newly added logical drives (LUNs). 

 5.   Format all shared logical drives as NT File System (NTFS), assign volume 

labels, and specify a drive letter for each. 

Important: You must make sure that the permanent (sticky) drive letters that 

are assigned to LUNs in the first cluster node are available (not used) in the 

rest of the cluster nodes. In another words, all of the nodes in the cluster must 

have the same drive letters on each shared drive. If you do not assign 

permanent drive letters, Windows might assign different drive letters on each 

node, which will prevent the cluster disks from operating correctly. Assigning a 

permanent drive letter ensures that Windows assigns the same drive letter to 

the partition on all cluster nodes. 

 6.   Install the storage management software on the second node of the cluster. 

Note:  You must install the RDAC and SMutil software packages. You do not 

have to install all of the storage management software packages unless 

you want to manage the storage subsystem from this cluster node. 

 7.   Run the hot_add utility on the second node of the cluster. 

 8.   Repeat step 6 and step 7 for each additional node of the cluster. 

 9.   Install the cluster server software. See “Installing the cluster server software” 

on page 73 for instructions. 

10.   Manually move the cluster disk groups from the first cluster node to each of 

the nodes in the cluster, making sure that they can be brought online. If they 

can be brought online with no problems, you are ready to continue with your 

application software installation. If you experience any problems, call IBM 

support for assistance. 

11.   Disable RDAC or MPIO automatic failback feature by changing the 

DisableLunRebalance registry setting of the [HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\rdacdisk\Parameters] if you installed RDAC as 

the multipath driver or the [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\
Services\ds4dsm\Parameters] registry key if you installed MPIO or MPIO/DSM 

as multipath driver from 0 to 3 in each cluster node. Each node needs to be 

rebooted for the changes to take effect. 

If this RDAC or MPIO feature is not disabled, and if a host in a cluster server 

configuration loses a physical path to a DS4000 storage subsystem controller, 

the logical drives that are mapped to the cluster group will periodically failover 

and then failback between cluster nodes until the failed path is restored. This 

behavior is the result of the automatic logical drive failback feature of the 

RDAC or MPIO multipath driver. The cluster node with a failed path to a 

DS4000 controller will issue a failover command of all logical drives that were 

mapped to the cluster group to the controller that it can access. After a 

programmed interval, the nodes that did not have a failed path will issue a 

failback command for the logical drives because they can access both logical 

drives' controllers, resulting in the cluster node with the failed path to not be 

able to access certain logical drives. This cluster node will then issue a failover 

command for all logical drives, repeating the logical drives failover-failback 

cycle.
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Attention:  If you use Registry Editor incorrectly, you can cause serious 

problems that may require you to reinstall your operating system. IBM cannot 

guarantee that you can solve problems that result from using Registry Editor 

incorrectly. Use Registry Editor at your own risk.

Installing the IBM fibre channel host bus adapter device driver 

An IBM fibre channel host bus adapter (HBA) provides the interface between a host 

server and a DS4000 storage subsystem. IBM DS4000 fibre channel HBAs are 

high-performance, direct memory access, bus-master, host adapters that are 

designed for high-end systems. These HBAs support all fibre channel peripheral 

devices that support private-loop direct-attach and fabric-loop attachment. The IBM 

Host Adapter device driver enables your operating system to communicate with the 

fibre channel HBA. 

New Storport miniport HBA device driver 

For information regarding the new Storport miniport HBA device driver, such as 

controller firmware support restrictions and operating system requirements, refer to 

“New Storport miniport HBA device driver” on page 59. 

SCSIport miniport HBA device driver 

For information regarding the SCSIport miniport HBA device driver, such as 

controller firmware support restrictions and operating system requirements, refer to 

“SCSIport miniport HBA device driver” on page 59. 

Before installing the device driver, check the readme file that is included in the 

device driver package file and the DS4000 Storage Manager host software for 

Windows operating systems to see which device driver version is supported for 

which DS4000 storage subsystems in conjunction with which controller firmware 

version. 

See the readme file included in the driver package for installation instructions 

associated with your operating system. Additional information can also be found in 

Appendix I, “Host bus adapter settings,” on page 215. 

Note:  Read the device driver readme for any required modifications to the default 

HBA BIOS and host operating system registry settings to ensure optimal 

performance. If you make any changes to the HBA BIOS settings, the 

machine will reboot automatically. 

For more information, see the Installation and User’s Guide for your particular fibre 

channel HBA model. The current readme file and latest multipath I/O device driver 

are available at the following Web site: 

www.ibm.com/servers/storage/support/disk/ 

See “Readme files and concepts” on page 1 to find out how to access the most 

recent Storage Manager readme files on the Web. 

Installing the storage management software 

This section describes how to install the storage management software on Windows 

operating systems. Before you install Storage Manager on an existing storage 

subsystem, see your hardware’s documentation for any specific configuration 

instructions. A specific configuration might be required for your hardware to support 
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the storage management software in a cluster configuration. If you are installing 

Storage Manager 10.10, refer to the “Process for a new installation” on page 57. 

If you are installing Storage Manager 10.10, refer to “Installing the Storage Manager 

10.10 software” on page 85. 

Installing the cluster server software 

The following sections describe how to install the cluster server software on 

Windows operating systems. 

Windows 2000 

Important: Do not perform this procedure unless you installed the necessary 

storage management software components on both cluster nodes. 

To install the cluster server software on node A and node B, perform the following 

steps: 

1.   Install the cluster server software on node A, as follows: 

a.   Refer to the appropriate Microsoft Cluster Server (MSCS) documentation for 

the correct procedure to install the cluster server software. 

Note:  During installation, specify that you want to form a new cluster. 

b.   After the system restarts, leave node A running.

2.   Install the cluster server software on node B, as follows: 

a.   Refer to the appropriate MSCS documentation for the correct procedure to 

install the Cluster Server software. 

Note:  During installation, specify that you want to join the existing cluster. 

b.   After the system restarts, leave node B running.

3.   After you install MSCS, perform one of the following tasks: 

v   For systems running Windows 2000, reinstall Service Pack 4.

Note:   Refer to Microsoft Knowledge Base article Q174799 for more information 

regarding service pack installation in a cluster environment. 

4.   Verify the software installation as follows: 

a.   On either node A or node B, click Start → Programs → Administrative Tools 

→ Cluster Administration. 

b.   In the Cluster or Server Name field, type either the name of the cluster or 

the name or IP address of one of the nodes. 

If the installation is successful, the computer names of both nodes appear 

on the left side of the Cluster Administrator window. 

c.   Make sure that the cluster disk groups can be moved between cluster 

nodes.

5.   If both node names do not display on the left side of the Cluster Administrator 

window, reinstall the cluster server software. If the problem persists, contact 

your IBM technical support representative.

Windows Server 2003 

Important: Do not perform this procedure unless the necessary storage 

management software components are installed on all cluster nodes. 
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Perform the following steps to install the cluster server software on cluster nodes: 

1.   Install the cluster server software on the first node of the cluster. Refer to the 

appropriate Microsoft Cluster Server (MSCS) documentation for the correct 

procedure to install the cluster server software.

Note:  During installation, specify that you want to form a new cluster. 

2.   In the Cluster Administrator window, make sure that all of the cluster disk 

groups can be varied online and offline with no problems. 

3.   Install the cluster server software on the second node of the cluster. Refer to 

the appropriate MSCS documentation for the correct procedure to install 

additional nodes in the cluster server. (For systems running Windows Server 

2003, reinstall Service Pack 1.)

Note:  During installation, specify that you want to join the existing cluster. You 

can add one cluster node at a time or all of the remaining cluster nodes 

at the same time. You should add cluster nodes one at a time. 

4.   If all node names do not display on the left side of the Cluster Administrator 

window, reinstall the cluster server software. If the problem persists, contact 

your IBM technical support representative.

Upgrading from a previous version of the storage management 

software 

Be sure that you are familiar with the steps required in a new installation before you 

continue with the following upgrade procedure. 

Choose one of the following two procedures: 

v   Performing a scheduled upgrade: A scheduled upgrade requires scheduling 

downtime on your cluster server to upgrade the controller firmware and storage 

management software. The services and resources offered by the cluster are not 

available during the upgrade. If you choose this upgrade method, it is important 

that you perform the upgrade during off-peak workload time.

Note:  The scheduled upgrade is the preferred procedure for upgrading a cluster 

server configuration. 

v   Performing a rolling upgrade: A rolling upgrade requires upgrading the storage 

management software first in one of the cluster nodes and then in each of the 

remaining cluster nodes, one cluster node a time, so that the services and 

resources offered by the cluster are always available.

Important: Do not upgrade your storage subsystem firmware until you have 

upgraded the storage management software on all cluster nodes and management 

stations. If you upgrade your storage subsystem controller firmware level to version 

07.10.xx.xx, you will not be able to communicate with the controller until you have 

upgraded to Storage Manager 10.10 software on your management station and 

cluster nodes. Previously installed versions of Storage Manager will not recognize 

controllers running version 07.10.xx.xx firmware. 

Performing a scheduled upgrade 

The following sections describe how to perform a scheduled upgrade on Windows 

operating systems. 
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Windows 2000 

To perform a scheduled upgrade from Storage Manager version 07.xx through 

version 09.23 to Storage Manager 10.10 (or from Storage Manager 09.23 to a 

newer version of Storage Manager) on machines that are running Windows 2000, 

perform the following procedure: 

 1.   In all cluster nodes, click Start → Programs → Administrative Tools → 

Services. The Services window opens. 

From the list of displayed services, right-click the cluster server and click 

Manual. Then stop the cluster server on all of the nodes in the cluster 

configuration. 

 2.   Shut down node B. 

 3.   From node A, uninstall the components from the previous version of the 

storage management software. To uninstall the previous version of Storage 

Manager, see “Uninstalling storage management software components” on 

page 142. 

Note:  Uninstall the storage management components in the following order: 

a.   SMagent 

b.   SMutil 

c.   RDAC 

d.   SMclient 

Starting with DS4000 Storage Manager 9.12 and later, the DS4000 host 

software uninstallation wizard will automatically uninstall the host software in 

the correct order. You can not uninstall SMclient, SMagent or SMutil packages 

individually. In addition, do not uninstall the multipath driver (RDAC or MPIO) 

by right-clicking on the appropriate entry in the SCSI and RAID Controllers tree 

node in the Device Manager folder of the Microsoft Windows Computer 

Management window and select the Uninstall option. Always use the DS4000 

host software uninstallation wizard to remove any of the installed host software 

packages. 

 4.   Verify that the IBM host adapter device driver versions are current. If they are 

not current, refer to the readme file located in the \Host_Adapter directory on 

the installation CD and upgrade the device drivers. 

 5.   Perform a full install of the storage management software on node A. See the 

“Installing Storage Manager 10.10 Client” on page 60 for instructions. 

 6.   Shut down node A. 

 7.   Restart node B. 

 8.   From node B, uninstall the components from the previous version of the 

storage management software. To uninstall the previous version of Storage 

Manager, see “Uninstalling storage management software components” on 

page 142. 

 9.   Verify that the IBM host adapter device driver versions are current. If they are 

not current, refer to the readme file located in the \Host_Adapter directory on 

the installation CD and upgrade the device driver versions before you continue. 

10.   Perform a full install of the storage management software on node B. See 

“Installing Storage Manager 10.10 Client” on page 60 for instructions. 

11.   Shut down node B. 

12.   Start up one node at a time and complete the following procedure: 

a.   Click Start → Programs → Administrative Tools → Services. The Services 

window opens. 
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b.   From the list of displayed services, right-click the cluster server. Click 

Automatic to change the cluster server startup option. 

c.   Start the cluster server service on each cluster node.

13.   Go to Chapter 8, “Completing storage management installation and 

configuration,” on page 113.

Windows Server 2003 

To perform a scheduled upgrade from Storage Manager version 07.xx through 

version 09.19 to Storage Manager 10.10 (or from Storage Manager 09.23 to 

Storage Manager 10.10) on machines that are running Windows Server 2003, 

perform the following procedure: 

1.   Before you install the storage management software, perform the following 

steps in each of the cluster nodes in the cluster: 

a.   Click Start → Administrative Tools → Services. The Services window 

opens. 

b.   From the list of displayed services, right-click the cluster server. Then click 

Manual. 

c.   Stop the cluster server on all nodes in the cluster configuration.

2.   From each cluster node, uninstall the components from the previous version of 

the storage management software. See “Uninstalling storage management 

software components” on page 142 for instructions. 

Note:  Uninstall the storage management components in the following order: 

a.   SMagent 

b.   SMutil 

c.   RDAC 

d.   SMclient

Starting with DS4000 Storage Manager 9.12 and later, the DS4000 host 

software uninstallation wizard will automatically uninstall the host 

software in the correct order. You can not uninstall SMclient, SMagent or 

SMutil packages individually. In addition, do not uninstall the multipath 

driver (RDAC or MPIO) by right-clicking on the appropriate entry in the 

SCSI and RAID Controllers tree node in the Device Manager folder of 

the Microsoft Windows Computer Management window and select the 

Uninstall option. Always use the DS4000 host software uninstallation 

wizard to remove any of the installed host software packages. 

3.   Verify that the IBM host adapter device driver version in each cluster node is 

current. If they are not current, refer to the readme file located in the 

\Host_Adapter directory on the installation CD and upgrade the device drivers. 

4.   Install the new version of the Storage Manager software in each cluster node. 

See “Installing Storage Manager 10.10 Client” on page 60 for instructions. 

5.   Start up one node at a time and complete the following steps for each node: 

a.   Click Start → Administrative Tools → Services. The Services window 

opens. 

b.   From the list of displayed services, right-click the cluster server. Click 

Automatic to change the cluster server startup option. 

c.   Manually start the cluster server service.

6.   Open Cluster Administrator windows and verify that the cluster groups can be 

brought online. If not, contact your IBM service representative for support.
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Performing a rolling upgrade 

This section describes how to perform a rolling upgrade on Windows operating 

systems. 

Important: If you have applications installed in the cluster server environment that 

do not support a rolling upgrade, perform one of the following tasks: 

v   Put those resources offline before the upgrade; then, put them back online after 

the upgrade. 

v   Perform a scheduled upgrade. A scheduled upgrade requires scheduling 

downtime on your cluster server to upgrade the controller firmware and storage 

management software.

Windows 2000 

To perform a rolling upgrade from Storage Manager version 07.xx through version 

09.19 to Storage Manager 10.10 (or from Storage Manager 09.23 to Storage 

Manager 10.10) on machines that are running Windows 2000, perform the following 

steps: 

 1.   From node A, open Cluster Administrator. 

 2.   Double-click the Active Groups folder in the right pane of the Cluster 

Administrator window. 

 3.   Select each group listed and move them to node B. 

 4.   Select node A. Then click File → Pause Node to pause cluster service in node 

A. 

 5.   From node A, uninstall the components from the previous version of the 

software. To uninstall previous versions of Storage Manager, see “Uninstalling 

storage management software components” on page 142. 

Note:  Uninstall the components in the following order: 

a.   SMagent 

b.   SMutil 

c.   RDAC 

d.   SMclient 

Starting with DS4000 Storage Manager 9.12 or later, the DS4000 host 

software uninstallation wizard will automatically uninstall the host software in 

the correct order. You can not uninstall SMclient, SMagent or SMutil packages 

individually. In addition, do not uninstall the multipath driver (RDAC or MPIO) 

by right-clicking on the appropriate entry in the SCSI and RAID Controllers tree 

node in the Device Manager folder of the Microsoft Windows Computer 

Management window and select the Uninstall option. Always use the DS4000 

host software uninstallation wizard to remove any of the installed host software 

packages. 

 6.   Verify that the IBM host adapter device driver versions are current. If they are 

not current, refer to the readme file located in the \Host_Adapter directory on 

the installation CD and upgrade the device drivers. 

 7.   Perform a full install of the storage management software on node A. See 

“Installing Storage Manager 10.10 Client” on page 60 for instructions. 

 8.   Run Cluster Administrator. Then click File → Resume Node to resume cluster 

service in node A. 

 9.   From node B, open Cluster Administrator. 

10.   Double-click the Active Groups folder in the right pane of the Cluster 

Administrator window. 
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11.   Select each group listed and move them to node A. 

12.   Select node B. Then click File → Pause Node to pause cluster service in node 

B. 

13.   From node B, uninstall the components from the previous version of the 

software. To uninstall previous versions of Storage Manager, see “Uninstalling 

storage management software components” on page 142. 

14.   Verify that the IBM HBA device driver versions are current. If they are not 

current, see the readme file located in the \Host_Adapter directory on the 

installation CD and upgrade the device drivers. 

15.   Perform a full install of the storage management software on node B. See 

“Installing Storage Manager 10.10 Client” on page 60 for instructions. 

16.   Run Cluster Administrator. Then click File → Resume Node to resume cluster 

service in node B. 

17.   Go to Chapter 8, “Completing storage management installation and 

configuration,” on page 113.

Windows Server 2003 

To perform a rolling upgrade from Storage Manager version 07.xx through 09.19 to 

Storage Manager 10.10 (or from Storage Manager 09.23 to Storage Manager 

10.10) on machines that are running Windows Server 2003, perform the following 

steps: 

 1.   In the first node of the cluster, open the Cluster Administrator window. 

 2.   Double-click the Active Groups folder in the right pane of the Cluster 

Administrator window. 

 3.   Select each of the active groups listed in the first cluster node and move them 

to other nodes in the cluster configuration. Make sure that the cluster groups 

come online successfully. 

 4.   Select the first node of the cluster in the Cluster Node Tree view and click File 

→ Pause Node to pause cluster service in that node. 

 5.   From node A, uninstall the components from the previous version of the 

software. To uninstall the previous version of Storage Manager software, see 

“Uninstalling storage management software components” on page 142.

Note:  Uninstall the components in the following order: 

a.   SMagent 

b.   SMutil 

c.   RDAC 

d.   SMclient 

Starting with DS4000 Storage Manager 09.12 or later, the DS4000 host 

software uninstallation wizard will automatically uninstall the host software in 

the correct order. You can not uninstall SMclient, SMagent or SMutil packages 

individually. In addition, do not uninstall the multipath driver (RDAC or MPIO) 

by right-clicking on the appropriate entry in the SCSI and RAID Controllers tree 

node in the Device Manager folder of the Microsoft Windows Computer 

Management window and select the Uninstall option. Always use the DS4000 

host software uninstallation wizard to remove any of the installed host software 

packages. 

 6.   Verify that the IBM HBA device driver versions in the cluster node are current. 

If they are not current, refer to the readme file located in the \Host_Adapter 

directory on the installation CD and upgrade the device drivers. 
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7.   Install the new version of the Storage Manager software in the first cluster 

node. See “Installing Storage Manager 10.10 Client” on page 60 for 

instructions. 

 8.   In the Cluster Administrator window, select the first node of the cluster and 

click File → Resume Node to resume cluster service in first cluster node. 

 9.   Move all cluster groups that were active in the first cluster node back to it. 

Make sure that the cluster groups can be brought online in the first cluster 

node with no problems. 

10.   Repeat steps 1 on page 78 through 9 for each of the other nodes in the cluster 

configuration. Perform all steps for each cluster node, one cluster node at a 

time.

Upgrading Windows operating systems 

The following sections describe how to upgrade from one supported Windows 

operating system to another. 

Upgrading from Windows 2000 to Windows Server 2003 in a cluster 

configuration 

Note:  Always perform a full system backup before you perform any upgrade 

procedure. 

Important: If you have applications that are installed in the cluster server 

environment that do not support a rolling upgrade, perform one of the following 

tasks: 

v   Put those applications offline before the upgrade. Then put them back online 

after the upgrade. 

v   Perform a scheduled upgrade. A scheduled upgrade requires scheduling 

downtime on your cluster server to upgrade the controller firmware and storage 

management software.

To upgrade from Windows 2000 Advanced Server to Windows Server 2003 

Enterprise Edition, perform the following steps: 

 1.   On node A, open the Cluster Administrator window. 

 2.   Double-click the Active Groups folder in the right pane of Cluster 

Administrator. 

 3.   Move all active cluster groups in node A to node B. Make sure that the cluster 

groups come online successfully in node B. 

 4.   Select node A. Click File → Pause Node to pause cluster service in node A. 

 5.   From node A, uninstall all software components. To uninstall the software, see 

“Uninstalling storage management software components” on page 142. 

Uninstall the components in the following order: 

a.   SMagent 

b.   SMutil 

c.   RDAC 

d.   SMclient 

Starting with DS4000 storage manager 09.12 and later, the DS4000 host 

software uninstallation wizard will automatically uninstall the host software in 

the correct order. You can not uninstall SMclient, SMagent or SMutil packages 

individually. In addition, do not uninstall the multipath driver (RDAC or MPIO) 
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by right-clicking on the appropriate entry in the SCSI and RAID Controllers tree 

node in the Device Manager folder of the Microsoft Windows Computer 

Management window and select the Uninstall option. Always use the DS4000 

host software uninstallation wizard to remove any of the installed host software 

packages. 

 6.   Follow the instructions from Microsoft to upgrade node A from Windows 2000 

Advanced Server to Windows Server 2003 Enterprise Edition.

Note:  During the upgrade, the existing cluster server installation is detected 

and clustering for Windows 2000 Advanced Server is installed. When 

the upgrade is complete, node A rejoins the cluster and remain paused. 

 7.   Verify that the HBA device driver versions are correct. If they are not the 

certified versions, refer to the readme file in the \Host_Adapter directory on the 

installation CD and upgrade the device driver versions before you continue. 

 8.   Verify that node A was successfully upgraded to Windows Server 2003 

Enterprise Edition. 

 9.   Install the Storage Management software in node A. See “Installing Storage 

Manager 10.10 Client” on page 60 for instructions. 

10.   In the Cluster Administrator window, select node A and click File → Resume 

Node to resume cluster service in node A. 

11.   Move the cluster groups that were active in node A back to node A. 

12.   On node B, open the Cluster Administrator window. 

13.   Double-click the Active Groups folder in the right pane of Cluster 

Administrator. 

14.   Make sure that all cluster groups failover to node A successfully. 

15.   Select node B. Click File → Pause Node to pause cluster service in node B. 

16.   From node B, uninstall all software components. To uninstall the software, see 

“Uninstalling storage management software components” on page 142. 

Uninstall the components in the following order: 

a.   SMagent 

b.   SMutil 

c.   RDAC 

d.   SMclient 

Starting with DS4000 storage manager 9.12 and later, the DS4000 host 

software uninstallation wizard will automatically uninstall the host software in 

the correct order. You can not uninstall SMclient, SMagent or SMutil packages 

individually. In addition, do not uninstall the multipath driver (RDAC or MPIO) 

by right-clicking on the appropriate entry in the SCSI and RAID Controllers tree 

node in the Device Manager folder of the Microsoft Windows Computer 

Management window and select the Uninstall option. Always use the DS4000 

host software uninstallation wizard to remove any of the installed host software 

packages. 

17.   Follow the instructions from Microsoft to upgrade node B from Windows 2000 

Advanced Server to Windows Server 2003 Enterprise Edition.

Note:  During the upgrade, the existing cluster server installation is detected 

and clustering for Windows 2000 Advanced Server is installed. When 

the upgrade is complete, node B rejoins the cluster and remain paused. 

18.   Verify that the HBA device driver versions are correct. If they are not the 

certified versions, refer to the readme file in the \Host_Adapter directory on the 

installation CD and upgrade the device driver versions before you continue. 
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19.   Verify that node B was successfully upgraded to Windows Server 2003 

Enterprise Edition. 

20.   Install the Storage Management software in node B. See “Installing Storage 

Manager 10.10 Client” on page 60 for instructions. 

21.   In the Cluster Administrator window, select node B and click File → Resume 

Node to resume cluster service in node B. 

22.   In the Cluster Administrator window, move the cluster groups that were active 

in node B back to node B. Make sure that they come online with no problems. 

23.   If there are more than two nodes in a cluster, repeat steps 12 on page 80 

through 22 for each of the remaining nodes in a cluster, one cluster node at a 

time.

Configuring storage management 

After you install Storage Manager, complete the tasks that are described in 

Chapter 8, “Completing storage management installation and configuration,” on 

page 113. These tasks include the following: 

v   Performing an initial automatic discovery of storage subsystems 

v   Adding devices 

v   Naming storage subsystems 

v   Creating arrays and logical drives 

v   Downloading controller firmware and NVSRAM 

v   Verifying and defining the default host type 

v   Setting up alert notifications

Additional information 

For additional information about installing and using Storage Manager in a Windows 

cluster server configuration, see “Windows operating system limitations” on page 

195. 
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Chapter  5.  Installing  Storage  Manager  software  in a Linux  

configuration  

This chapter describes how to install the storage management software in a Linux 

operating system environment.

Note:  This document does not provide any information about using Linux on 

POWER-based hosts. For information about using Linux on POWER-based 

hosts in a DS4000 subsystem, see IBM System Storage DS4000 Storage 

Manager Installation and Host Support Guide for AIX, HP-UX, Solaris, and 

Linux on POWER. 

To ensure proper installation, make sure you have completed all preparation tasks 

described in Chapter 2, “Preparing for installation,” on page 37. 

Important:  Always check the Storage Manager readme file for your operating 

system before installing the software. A readme file contains important 

information that was not available when this guide was prepared. 

See “Readme files and concepts” on page 1 to find out how to access 

the most recent Storage Manager readme files on the Web. 

Installation overview 

Important: Be sure that you install the HBA and device driver before you install the 

storage management software. 

Linux software requirements 

Table 16 lists the disk space that is required for installing Storage Manager 10.10 in 

a Linux environment. 

 Table 16. Installation requirements for Linux by software package 

Package Disk space requirement 

Storage Manager 10.10 Runtime (SMruntime) 70 MB on /opt, 1 MB on /var 

Storage Manager 10.10 Esm (SMesm) 40 MB on /var 

Storage Manager 10.10 Client (SMclient) 140 MB on /opt, 2 MB on /tmp 

Storage Manager 10.10 Agent (SMagent) 2 MB on /opt 

Storage Manager 10.10 Utility (SMutil) 7 MB on /opt 

IBM DS4000 QLogic SANsurfer 100 MB on /opt 

Storage Manager 10.10 RDAC 2 MB 

IBM Host Adapter device driver 1 MB
  

Linux operating system requirements 

Table 17 on page 84 describes the minimum operating system and kernel level 

requirements for each management station or host computer. Check the Storage 

Manager readme file for the latest information regarding supported kernel versions. 

See “Readme files and concepts” on page 1 to find out how to access the most 

recent Storage Manager readme files on the Web. 
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Table 17. Management station or host computer by minimum operating system and kernel 

levels 

Operating system Kernel 

Red Hat Enterprise Linux Advanced Server 4 IA-32 Update 5 For the appropriate 

kernel, see the readme 

file for your RHEL 

version. 

Red Hat Enterprise Linux Advanced Server 4 IA-64 Update 5 For the appropriate 

kernel, see the readme 

file for your RHEL 

version. 

Red Hat Enterprise Linux Advanced Server 4 AMD-64/EM64T 

Update 4 (x86 and x86_64 versions) 

For the appropriate 

kernel, see the readme 

file for your RHEL 

version. 

Red Hat Enterprise Linux Advanced Server 5 For the appropriate 

kernel, see the readme 

file for your RHEL 

version. 

SUSE SLES 9 SP3 32-bit For the appropriate 

kernel, see the readme 

file for your SLES 

version. 

SUSE SLES 9 SP3 IA-64 For the appropriate 

kernel, see the readme 

file for your SLES 

version. 

SUSE SLES 9 AMD-64/EM64T SP3 (x86 and x86_64 versions) For the appropriate 

kernel, see the readme 

file for your SLES 

version. 

SUSE SLES 10 For the appropriate 

kernel, see the readme 

file for your SLES 

version.
  

 To begin installing the storage management software, ensure that the network 

components are set up and operating properly, and that you have all the host and 

controller information that you need for the software to operate. 

 Attention:  Linux RDAC is supported only when the DS4000 storage subsystems 

have controller firmware version 05.4x.xx.xx and later installed. 

When using Linux RDAC as the multipath failover/failback device driver, it is 

recommended that you install the software on each host computer in the following 

order: 

1.   Uninstall the earlier version Storage Manager. See “Uninstalling Storage 

Manager” on page 98. 

2.   Install Storage Manager 10.10. 

3.   Disable and enable the Event Monitor. 

4.   Install the IBM fibre channel HBA non-failover version device driver (for Linux 

operating systems). 

5.   Install Linux RDAC. 
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6.   Specify the correct host type. See “Verifying and defining the default host type” 

on page 131.

When not using RDAC as the multipath failover/failback device driver, and using the 

IBM DS4000 fibre channel HBA failover version of the device driver as the multipath 

driver, you must install the software on each host computer in the following order: 

1.   Uninstall the earlier version Storage Manager. See “Uninstalling Storage 

Manager” on page 98. 

2.   Uninstall existing IBM DS4000 QLogic SANsurfer (use this procedure when 

installing Storage Manager 10.10 on an existing storage subsystem). 

3.   Install Storage Manager 10.10. 

4.   Disable and enable the Event Monitor. 

5.   Install Storage Manager 10.10 Utility. 

6.   Install the IBM fibre channel host bus adapter (HBA) failover version device 

driver for Linux operating systems. 

7.   Install IBM DS4000 QLogic SANsurfer and QLRemote Agent. 

8.   Configure path failover/failback. See the device driver readme file for 

information.

Note:  For Storage Manager version 9.14 and later, the default installed directory for 

the host software packages is /opt/IBM_DS4000. 

Installing the Storage Manager 10.10 software 

The DS4000 Storage Manager 10.10 software for Linux operating systems is 

available as a single package that you can install using the installation wizard, or as 

individual packages that you can install manually. 

Notes:  

1.   This document does not provide information about using Storage Manager with 

Linux on POWER host servers. For information about using Storage Manager 

with Linux on POWER servers, see IBM System Storage DS4000 Storage 

Manager Installation and Host Support Guide for AIX, HP-UX, Solaris, and Linux 

on POWER. 

2.   Storage Manager 10.10 supports AMD64 and EM64T Linux RHEL 4, RHEL 5, 

SLES 9, and SLES 10 servers running x86_64 Linux kernels (AMD64 or EM64T 

native code), in addition to the previously supported Intel Itanium 64 bit 

processor architecture (IA64) Linux operating systems. IBM supplies two 

different Storage Manager host software packages for Linux: 

v   Storage Manager 10.10 host software package for the 32-bit x86 (32-bit) and 

x86_64 (AMD64 and EM64T) processor architecture Linux operating systems 

v   Storage Manager 10.10 host software package for Intel Itanium 64 bit 

processor architecture (IA64) Linux operating systems only

Check the Storage Manager readme file for Linux operating systems to ensure 

that you have the correct software to use in your Linux operating system 

environment. See “Readme files and concepts” on page 1 to find out how to 

access the most recent Storage Manager readme files on the Web. 

The installation wizard package file names have the SMIA prefix. Each individual 

package file name have one of the following prefixes: SMruntime, SMclient, SMesm, 

SMutil or SMagent. 

This section contains the following procedures: 
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v   “Installing the Storage Manager 10.10 software using the installation wizard” 

v   “Installing the Storage Manager 10.10 software manually” on page 87

Installing the Storage Manager 10.10 software using the installation 

wizard 

The DS4000 Storage Manager installation wizard is a Java-based interactive 

method of choosing which packages to automatically install on your host system. 

The installation wizard installs the following software packages on the Linux host: 

v   SMruntime 

v   SMesm 

v   SMclient 

v   SMagent 

v   SMutil

Requirements 

v   DS4000 Storage Manager 10.10 

v   Graphics adapter card installed on the Linux host

Steps for installing DS4000 Storage Manager software using the 

installation wizard 

Complete the following steps to install the DS4000 Storage Manager software using 

the installation wizard. Adjust the steps as necessary for your specific installation. 

1.   Ensure that you have root privileges, which are required to install the software. 

2.   Get the Storage Manager 10.10 SMIA host software installation package file 

from the DS4000 Storage Manager CD, or download it from the DS4000 

support Web site, to a directory on your system.

Note:  The latest version of the DS4000 Storage Manager host software 

packages are available for download at the DS4000 support Web site. 

3.   Change into the following directory and type the following command to start the 

Storage Manager installation wizard replacing the SMIA-LINUXxxx-
10.1x.A5.xx.bin file name with the file name of the package file that you obtain 

from 1: 

 ./SMIA-LINUXxxx-10.1x.A5.xx.bin 

  

Note:  Use the exact file name of the SMIA file. The name shown in the 

example is for illustrative purposes only. 

The Storage Manager Installation wizard’s Introduction window opens. 

When you install Storage Manager, the installer displays an IBM System 

Storage DS4000 Storage Manager splash screen with a drop-down menu. From 

this drop-down menu, you can select a language option. (Language selection is 

optional if you are performing an English language installation.) The language 

option you select will determine the language version of the License Agreement 

that is displayed. Once you have selected a language, click the OK button to 

start the installation. 

4.   Follow the instructions in each window of the wizard. When you select the 

installation type, you can choose one of the following options: 

v   Typical (Full) Installation—Installs all Storage Manager software packages 

v   Management Station—Installs SMruntime and SMclient 
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v   Host—Installs SMruntime, SMagent and SMutil 

v   Custom—Allows you to select which packages you want to install

Result: The DS4000 Storage Manager software packages are installed in the 

/opt/IBM_DS4000 directory. 

Installing the Storage Manager 10.10 software manually 

Use the procedures in this section to install the applicable Storage Manager 10.10 

software packages on a management station or host computer. These software 

installation procedures can also be performed using an rpm-compatible, GUI-based 

package manager. 

Important: Before installing the client software, install the runtime software. A 

system reboot is only required when installing the RDAC driver package. The Event 

Monitor software is installed automatically during the client software installation. 

1.   Ensure that you have root privileges, which are required to install the software. 

2.   Skip this step if you download the packages from the IBM DS4000 Support Web 

site. Insert the installation CD and, if necessary, mount the CD-ROM drive.

Note:   In the following procedure, the CD-ROM drive is mounted at: 

v   /mnt/cdrom for Red Hat or 

v   /media/cdrom for SUSE

You must uncompress the installation packages from the CD-ROM to an 

existing folder on your hard drive. In the following procedure, this 

temporary directory is designated as /tmp. You may choose to create a 

different destination directory name. 

Modify these instructions as required to meet your particular installation 

requirements. 

Installing Storage Manager 10.10 Runtime (SMruntime) 

Installation of the SMruntime package is necessary for both hosts and storage 

management stations. 

Note:  The following steps direct you to enter commands necessary to install the 

appropriate software packages. After you invoke each command, the 

software installation begins. When the installation completes, a message 

displays indicating that the installation was successful and returning the 

system command prompt. 

Perform the following steps to install SMruntime: 

1.   Type the following command at the command prompt and press Enter. 

rpm -ivh SMruntime-LINUX<version number>.rpm 

2.   To verify the installation of the SMruntime package, type the following command 

at the command prompt and press Enter. 

rpm -qa SMruntime 

3.   If the installation was successful, and no failure was reported, continue with 

“Installing the Storage Manager 10.10 Esm (SMesm)” on page 88. If the 

installation was unsuccessful, repeat steps 1 and 2. If the failure persists, see 

the Storage Manager 10.10 Release Notes, or contact your IBM technical 

support representative.
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Installing the Storage Manager 10.10 Esm (SMesm) 

Installation of the SMesm package is necessary only if you are installing the 

SMclient. If you are not installing SMclient, proceed to “Installing the RDAC 

package” on page 90.

Note:  SMesm is necessary for automatic ESM firmware synchronization. 

Perform the following steps to install the SMesm: 

1.   Type the following command at the command prompt and press Enter. 

rpm -ivh SMesm-LINUX<version number>.rpm 

2.   To verify the installation of the SMesm package, type the following command at 

the command prompt and press Enter. 

rpm -qa SMesm 

3.   If the installation was successful, and no failure was reported, continue with 

“Installing the RDAC package” on page 90. If the installation was unsuccessful, 

repeat steps 1 and 2. If the failure persists, see the Storage Manager 10.10 

Release Notes, or contact your IBM technical support representative.

Installing the Storage Manager 10.10 Client (SMclient) 

Installation of the SMclient package is necessary only if the system is a storage 

management station or if the system is a host acting as a storage management 

station. If you are not installing SMclient, proceed to “Installing the RDAC package” 

on page 90. 

Perform the following steps to install the SMclient: 

1.   Type the following command at the command prompt and press Enter. 

rpm -ivh SMclient-LINUX<version number>.rpm 

2.   To verify the installation of the SMclient package, type the following command at 

the command prompt and press Enter. 

rpm -qa SMclient 

3.   If the installation was successful, and no failure was reported, continue with 

“Installing the RDAC package” on page 90. If the installation was unsuccessful, 

repeat steps 1 and 2. If the failure persists, see the Storage Manager 10.10 

Release Notes, or contact your IBM technical support representative.

Disabling and enabling the Event Monitor 

The Event Monitor, which comes with the client software, installs automatically 

during the client software installation. The Event Monitor handles storage 

subsystem error notification through e-mail or SNMP traps when the storage 

management software is not actively running on the management station or host 

computer. 

You can disable and enable the Event Monitor while the Event Monitor is running, 

or you can disable and enable the boot-time reloading of the Event Monitor. If you 

disable the Event Monitor while it is running, it will start automatically at the next 

reboot. 

Important:  

1.   The Event Monitor must remain enabled if you intend to use automatic ESM 

firmware synchronization. (See “Automatic ESM firmware synchronization” on 

page 124 for more information.) 

2.   If you installed the client software and configured alert notifications on multiple 

hosts, you might receive duplicate error messages from the same storage 
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subsystem. To avoid receiving duplicate error messages, disable the Event 

Monitor on all but one system. You must run the Event Monitor on one host that 

will run continually.

Disabling the Event Monitor while the software is running:   Important: If you 

disable the Event Monitor while it is running, it will start automatically at the next 

reboot. 

At the command prompt, type the following command and press Enter: 

SMmonitor stop 

When the program shutdown is complete, the system displays the following 

message: 

Stopping SMmonitor process <xxxx> 

where xxxx represents the process ID number. 

Enabling the Event Monitor while the software is running:   At the command 

prompt, type the following command and press Enter: 

SMmonitor start 

When the program startup begins, the system displays the following message. 

SMmonitor started. 

Disabling boot-time loading of the Event Monitor:   At the command prompt, 

type the following command and press Enter: 

mv /etc/rc2.d/S99SMmonitor /etc/rc2.d/disabledS99SMmonitor 

You are returned to the command prompt. 

Enabling boot-time loading of the Event Monitor:   At the command prompt, type 

the following command and press Enter: 

mv /etc/rc2.d/S99SMmonitor /etc/rc2.d/S99SMmonitor 

You are returned to the command prompt. 

Installing the Storage Manager 10.10 Utility (SMutil) 

Installing the SMutil package is necessary only if the system is a host. If you are 

not installing SMutil, proceed to “Installing Storage Manager 10.10 Agent 

(SMagent)” on page 90. 

Perform the following steps to install the SMutil: 

1.   Type the following command at the system prompt and press Enter. 

rpm -ivh SMutil-LINUX.rpm 

2.   To verify installation of the SMutil package, type the following command at the 

system prompt and press Enter. 

rpm -qa SMutil 

3.   If the installation was successful, and no failure was reported, continue with 

“Installing Storage Manager 10.10 Agent (SMagent)” on page 90. If the 
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installation was unsuccessful, repeat steps 1 on page 89 and 2 on page 89. If 

the failure persists, see the Storage Manager 9.19 Release Notes or contact 

your IBM technical support representative.

Installing Storage Manager 10.10 Agent (SMagent) 

Installation of the Storage Manager Agent software is necessary only if the system 

is a host and the storage array is to be managed using the in-band storage array 

management method. In addition, RDAC must be installed. If you are not installing 

SMagent, proceed to “Removing the temporary installation files” on page 97. To 

install the SMagent package complete the following steps: 

1.   Type the following command at the system prompt and press Enter. 

rpm -ivh SMagent-LINUX.rpm 

2.   To verify installation of the SMagent package, type the following command at 

the system prompt and press Enter. 

rpm -qa SMagent 

3.   If the installation was successful, and no failure was reported, continue with 

“Removing the temporary installation files” on page 97. If the installation was 

unsuccessful, repeat steps 1 and 2. If the failure persists, see the Storage 

Manager 9.1x Release Notes or contact your IBM technical support 

representative.

Installing the RDAC package 

This section describes how to install RDAC on the Linux operating system. 

Notes:  

1.   Linux RDAC is provided separately from the Storage Manager 10.10 host 

software package. The Linux RDAC package is the 2.6 kernel for RHEL 4, 

RHEL 5, SLES 9, and SLES 10. Be sure to install the correct Linux RDAC for 

your system. (Note that neither of these packages can be used for Linux on 

POWER-based servers. For information about installing RDAC for Linux on 

POWER systems, see IBM System Storage DS4000 Storage Manager 

Installation and Host Support Guide for AIX, HP-UX , Solaris, and Linux on 

POWER.) 

2.   Always see the readme file that is included with the Linux RDAC package for 

the latest instructions for installing Linux RDAC, including any dependencies or 

limitations.

Installation of the RDAC package is necessary only if the system is a host. You 

must install RDAC on each host computer. The RDAC package installs the 

multipath device driver that is necessary for controller failover support. A system 

reboot is required when installing the RDAC driver package. You must also need to 

install the non-failover version of the fibre channel HBA device driver before 

installing RDAC.

Note:  See the Storage Manager 10.10 Release Notes for information on supported 

levels of HBA drivers. 

1.    To unpack the Linux RDAC source files from the directory in which you placed 

the RDAC source .tgz file, type the following command at the command prompt, 

where <filename> is the name of the Linux RDAC source file, and press Enter. 

tar -zxvf <filename>.tar.gz 

The source files will uncompress into the <yourdirectory>/linuxrdac directory, 

or into <yourdirectory>/linuxrdac-<version> (where <version> is the RDAC 

number; for example, linuxrdac-09.01.B5.02). 

 

90 DS4000 Installation and Host Support Guide for Windows 2000/Server 2003, NetWare, ESX Server, and Linux



2.   For detailed procedures on compiling and installing the driver modules, see 

“Linux RDAC installation.”

Note:  If the RDAC driver is already installed, you will need to unload the 

mppVhba and mppUpper modules before proceeding with the upgrade. See 

the readme file in the appropriate linuxrdac directory for more 

information. For example: 

rmmod mppVhba 

rmmod <HBA device Driver Modules for example qla2300> 

rmmod mppUpper 

3.   Execute mppUpdate to create a new mpp initrd image. 

4.   If the installation was successful, and no failure was reported, continue with 

“Installing the Storage Manager 10.10 Utility (SMutil)” on page 89. If the 

installation was unsuccessful, repeat steps 1 on page 90 and 2. If the failure 

persists, see the Storage Manager 10.10 Release Notes or contact your IBM 

technical support representative.

Linux RDAC installation 

The Linux RDAC provides multipath failover/failback support for the logical drives in 

the DS4000 storage server that are mapped to the Linux host server. The Linux 

host server must have fibre channel connections to the host ports of both 

controllers A and B of the DS4000 Storage Server. It is provided as an IBM 

recommended multipath driver alternative to the Linux fibre channel host bus 

adapter failover device driver. 

See “Dependencies” on page 93 for the required code levels and Linux kernel 

versions. In addition, see the IBM System Storage Disk Storage Systems Technical 

Support Web site for the latest supported DS4000 Storage Server models, host 

adapters, device drivers, Linux kernel versions and updated readme. 

www.ibm.com/servers/storage/support/disk/ 

Note:  Deviations from the listed code levels are not supported. Contact IBM 

Support for assistance if required. 

Limitations 

 1.   The Linux RDAC driver cannot coexist with HBA-level multipath 

failover/failback drivers such as the 6.06.63-fo driver. You may have to modify 

the driver make file to enable it to be compiled in the non-failover mode. In 

addition, see the Linux RDAC readme file for the minimum fibre channel HBA 

device driver version that is required for a particular version of Linux RDAC. 

 2.   SteelEye LifeKeeper Clustering is currently supported with only eight LUNs. 

Use the following instructions to set up the LifeKeeper cluster. 

a.   Recompile the fibre channel host bus adapter driver using the following 

setting. 

Change the QLA2X_PERFORMANCE setting to 0 in the qla_settings.h file. 

b.   Change the following settings in the /etc/default/LifeKeeper file. 

v   LCMHBEATTIME=5 

v   LCMNUMHBEATS=16

c.   Reboot the Linux host after completing step 2a and 2b.
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3.   All limitations that apply to the current DS4000 Storage Server when 

configured with Linux servers also apply to this Linux RDAC release. 

 4.   This Linux RDAC release does not support auto-volume transfer/auto-disk 

transfer (AVT/ADT) mode. AVT/ADT is automatically enabled in the Linux 

storage partitioning host type. Disable it by using the script that is bundled in 

the IBM Linux RDAC Web package or in the \Scripts directory of the DS4000 

Storage Manager Version 10.10 Linux CD. The name of the script file is 

DisableAVT_Linux.scr. Use the following steps to disable the AVT/ADT mode 

in your Linux host type partition. 

v   Open the DS4000 Storage Manager Enterprise Management window. 

v   Highlight the subsystem. 

v   Select Tools. 

v   Select Execute Script. A script editing window opens. 

v   In this window, select File. 

v   Select Load Script. 

v   Give the full path name for the script file (for example, <CDROM>/scripts/
DisableAVT_Linux.scr) and click OK. 

v   Select Tools. 

v   Select Verify and Execute. 

Note:  It is assumed that the Linux host type is selected for the Storage 

Partition in which the Linux host server HBA port is defined. This Linux 

host type has AVT/ADT enabled as the default. See online Help for the 

script editor in the Enterprise Management window for information on 

how to execute a script. 

 5.   The Linux SCSI layer does not support skipped (sparse) LUNs. If the mapped 

LUNs are not contiguous, the Linux kernel will not scan the remaining LUNs. 

Therefore, LUNs following the skipped LUN will not be available to the host 

server. Always map LUNs using consecutive LUN numbers, and use the 

Storage Manager hot_add utility program. 

 6.   If a host server has multiple HBA ports and each HBA port sees both 

controllers (over an unzoned switch), the Linux RDAC driver may return I/O 

errors during controller failover. In this case, use multiple unconnected fibre 

channel switches to zone the fibre channel switch into multiple zones so that 

each HBA port sees only one controller in a DS4000 Storage Server. 

 7.   When the RDAC driver detects that all paths to a DS4000 Storage Server are 

failed, it will immediately report I/O failure. This behavior differs from that of the 

IBM fibre channel HBA failover driver, which will wait for a certain time period 

before reporting an I/O failure to the host application. There is no workaround 

for this behavioral difference. 

 8.   It is not possible to load the virtual HBA driver if there is no storage array 

attached. The workaround for this inability is to connect the host server to the 

DS4000 storage server and run the hot_add utility. 

Note:  If no LUN is mapped to the host server partition on the DS4000 Storage 

Server, the hot_add utility will not bring up the mpp_Vhba module. 

 9.   The cluster support feature in the Linux RDAC driver is only available for 

5.4x.xx.xx or later firmware. If a SCSI-2 reserve/release command is 

addressed to a LUN on an array running a firmware version lower than 05.40, 

a check-condition 05-02-00 (key-asc-ascq) (illegal request, invalid command 

operation code) will be returned. 
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10.   The Linux RDAC driver does not support LUN deletion. It is necessary to 

reboot the server after deleting mapped logical drives. 

11.   The RDAC driver stack, which includes the mpp_Upper and mpp_Vhba tools, 

and the low level HBA driver, should not be loaded or unloaded using the 

modprobe kernel module utility. Any use of modprobe on the RDAC driver 

stack is entirely the responsibility of the user. IBM does not support the use of 

modprobe with the RDAC driver stack. Use of rmmod to remove all the 

drivers in the RDAC driver stack, in order, is also not supported.

Recommendation:  Reboot the system whenever you need to unload the 

driver stack.

Dependencies 

See the Linux RDAC readme file for the latest related dependencies. See “Readme 

files and concepts” on page 1 to find out how to access the most recent Storage 

Manager readme files on the Web. 

Installation and setup instructions 

Prerequisites:  

1.   The Linux RDAC driver is released as a source-code package in the format of a 

gunzip compressed tar file. To unpack the driver source package, type the 

following command in the Linux console window: tar -zxvf 

rdac-LINUX-xx.xx.xx.xx-source.tar.gz where xx.xx.xx.xx is the release 

version of the RDAC driver. The source files will uncompress to the linuxrdac 

or linuxrdac-<version> directory (where <version> is the RDAC version; for 

example, linuxrdac-09.01.B5.01. 

2.   Properly build and install the non-failover fibre channel HBA device driver on the 

host server prior to Linux RDAC driver installation. See the fibre channel HBA 

device driver readme file or the fibre channel HBA User Guide for instructions 

on installing the non-failover version of the device driver. If you need to build the 

non-failover fibre channel HBA device driver from the source tree, the driver 

source tree is included in the source-code package. This driver must be loaded 

before the RDAC installation. 

3.   Although the host server can have different fibre channel HBAs from multiple 

vendors or different fibre channel HBA models from the same vendors, only one 

model of fibre channel HBAs can be connected to the IBM DS4000 Storage 

Servers. 

4.   Assure that the kernel source tree against which to build the Linux kernel 

version is installed prior to RDAC driver package installation.

Build and installation:   Complete the procedures in this section. 

For SUSE distribution only:   This first procedure is for the SUSE distribution only. 

For the Red Hat distribution, proceed to “RDAC driver building for SUSE and Red 

Hat” on page 94. 

1.   Install the kernel-source from the SUSE distribution. 

2.   Create a soft link to the kernel source. ln -sf /usr/src/<linux-version> 

/usr/src/linux. 

3.   To ensure kernel version synchronization between the driver and running kernel, 

type the following commands in the Linux console window. Press Enter after 

typing each command. 

v   cd /usr/src/linux 

v   make mrproper (completely clean the kernel tree) 
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v   - cp /boot/config-`uname -r  ̀ .config (copy the new config) 

v   make oldconfig (update configuration using .config) 

v   make dep (rebuild the dependencies) 

v   make modules (build the modules-not require on newer kernel version)

RDAC driver building for SUSE and Red Hat:  

1.   Change to the linuxrdac directory. 

2.   To remove the old driver modules in that directory, type the following command: 

make clean 

3.   Press Enter. 

4.   To compile all driver modules and utilities in a server with multiple CPUs (SMP 

kernel), type the following command: 

make 

5.   Press Enter.

RDAC driver installation:  

1.   To copy driver modules to the kernel module tree and build the new RAMdisk 

image (mpp.img) which includes RDAC driver modules and all driver modules 

that are needed during boot time, type make install and press Enter. 

2.   Follow the instructions that display at the end of the build process to add a new 

boot menu option which uses /boot/mpp-<kernel version>.img as the initial 

RAMdisk image. 

3.   Near the end of the Linux RDAC installation, if you see the error message All 

of your loopback devices are in use; and the RDAC RAMDISK does not get 

created; and the installation fails, type the following commands in the Linux 

console window: 

 insmod loop     <--this loads the loopback device driver onto the kernel--> 

  

  

make uninstall  <--this uninstalls the previous, unsuccessful RDAC driver--> 

  

  

make install    <--this installs the RDAC driver again--> 

  

The following instructions may work in certain Red Hat kernel versions. Add 

ramdisk_size=15000 as a kernel boot parameter in the new boot option, similar to 

the following grub.conf example.

Note:  The actual sample may vary in different system setup configurations.

 title Red Hat Linux Advanced Server-up (2.4.9-e.27smp) 

root (hd0,6) 

kernel /vmlinuz-2.4.9-e.27smp ro root=/dev/hda7 ramdisk_size=15000 

initrd /mpp-<kernel version>.img 

  

RDAC driver post-installation:  

1.   Reboot the system using the new boot menu option. 

2.   Type lsmod to verify that the driver stack is properly loaded.
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Note:  On Red Hat distributions, the following modules should be loaded: 

scsi_mod, sd_mod, sg, mpp_Upper, mpp_Vhba(*), and fibre channel HBA 

drivers (for example, qla2300). 

On SUSE distributions, the following modules should be loaded: sg, 

mpp_Upper, mpp_Vhba(*) fibre channel HBA drivers. 

3.   To verify that the RDAC driver discovered the available physical LUNs and 

created virtual LUNs for them, type ls -lR /proc/mpp and press Enter. 

4.   You can now issue I/Os to the LUNs. 

5.   If you make any changes to the MPP configuration file (/etc/mpp.conf) or the 

persistent binding file (/var/mpp/devicemapping), run mppUpdate to rebuild the 

RAMdisk image and to include the new file so that the new configuration file (or 

persistent binding file) can be used on any subsequent system reboot. 

6.   The file /etc/syslog.conf should have entries for kern.debug, kern.notice, 

kern.info and kern.warning in order to capture all debug and error messages 

for MPP driver. 

7.   If a host in a cluster server configuration loses a physical path to a DS4000 

storage subsystem controller, the logical drives that are mapped to the cluster 

group will periodically failover and then failback between cluster nodes until the 

failed path is restored. This behavior is the result of the automatic logical drive 

failback feature of the RDAC multipath driver. The cluster node with a failed 

path to a DS4000 controller will issue a failover command of all logical drives 

that were mapped to the cluster group to the controller that it can access. After 

a programmed interval, the nodes that did not have a failed path will issue the 

failback command for the logical drives because they can access the logical 

drives' controllers, resulting in the cluster node with the failed path not being 

able to access certain logical drives. This cluster node will then issue a failover 

command for all logical drives, repeating the logical drives failover-failback 

cycle. Therefore, if this Linux host is part of a Linux cluster (SteelEye) 

configuration, perform the following steps to disable this automatic failback 

feature: 

a.   Open the /etc/mpp.conf file, and change the DisableLunRebalance 

parameter to 3. Save the changes. 

b.   From a shell prompt, type the following command, and press Enter: 

mppUpdate 

c.   Reboot your computer for the changes to take effect. 

d.   Repeat this procedure on any system in the cluster configuration that has 

the Linux RDAC driver installed.

8.   If you use the Linux host type as the host type for your Linux host partition, you 

must disable AVT/ADT as indicated in “Limitations” on page 91. You do not need 

to do this if you choose LNXCLVMWARE (also known as LNXCL) as the host type. 

This host type will set AVT/ADT to disable and enable propagated reservation. 

PROC entries:   The Linux system provides a /proc file system that is a special 

memory-only, software-created file system that is used by the kernel to export driver 

information to the user space. 

The proc pseudo-filesystem is mounted to /proc. The Linux SCSI subsystem’s 

proc file system directory is /proc/scsi. By convention, each HBA driver creates a 

subdirectory under /proc/scsi. 

The Linux RDAC (MPP) driver proc entries are as follows: 

v   /proc/mpp 
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Entry for the MPP driver. 

v   /proc/scsi/mpp/<adapter_number> 

Entry for the MPP virtual host adapter. This can differ from system to system, 

and is assigned by the scsi middle-layer. 

v   /proc/mpp/<storage_sys_name> 

Entry for each subsystem that is visible to the host. 

v   /proc/mpp/<storage_sys_name>/controller<A/B> 

Entries for the two targets on each subsystem as seen by the host. Each storage 

subsystem has two controllers. 

v   /proc/mpp/<storage_sys_name>/controller<A/B>/<low_level_driver/HCT#> 

Here, the <low_level_driver> can be any one of QLogic, or Emulex HBAs. 

<HCT#> can be the <Host#> (host number of the low-level driver that is assigned 

by the scsi mid-layer), <Channel#> (depends on whether the HBA card is single- 

or dual-channeled), or <Target#> (target number that is assigned to that 

controller on that subsystem by the low-level HBA driver). 

v   /proc/mpp/<storage_sys_name>/controller<A/B>/<low_level_driver/HCT#/LUN#> 

These are the logical drives or LUN numbers of logical drives, as mapped on 

host partition on the storage subsystem and seen through that path, or initiator 

(host)-target combination.

Persistent naming:   Linux SCSI device names have the possibility of changing 

when the host system reboots. IBM recommends using a utility such as devlabel to 

create user-defined device names that will map devices based on a unique 

identifier, called a UUID. 

As of this writing, devlabel is available as part of the Red Hat Enterprise Linux 3 

distribution, or online at: 

linux.dell.com/devlabel/devlabel.html 

RDAC driver package uninstall and reinstall/update:   To uninstall the RDAC driver 

package, type make uninstall and press Enter.

Note:  To Reinstall/Update the RDAC driver package, issue the command ″make 

uninstall″ followed by the ″make install″ command under the /linuxrdac 

directory in the new RDAC driver source code bundle. 

Kernel update:   After applying the kernel update and booting into the new kernel, 

perform the following steps to build MPP Initrd image for the new kernel: 

1.   Change the directory to the Linuxrdac source code directory. 

2.   Issue the make uninstall command. 

3.   Follow the driver building and installation procedure described in “RDAC driver 

building for SUSE and Red Hat” on page 94 and “RDAC driver installation” on 

page 94.

Initial Ramdisk image (initrd):   The Initial RamDisk Image (initrd image) is 

automatically created when the driver is installed by issuing the make install 

command. The boot loader Configuration file needs to have an entry for this newly 

created image. 

The initrd image is located in the boot partition with file name, mpp-’uname 

-r’.img (for example, mpp-2.4.21-9.ELsmp.img). 
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For a driver update, if the system already has an entry for MPP, the system 

administrator need only modify the existing MPP entry accordingly in the boot 

loader configuration file. In most cases, no change is required if the kernel version 

is same. 

To create a new initrd image, run mppUpdate, which will overwrite the old image 

file with the new image file. 

If you need to add third-party drivers to the initrd image, edit the 

/etc/sysconfig/kernel (SUSE ) or /etc/modules.conf (Red Hat) with the 

third-party driver entries. Run mppUpdate to create a new ramdisk image. 

Adding and deleting mapped logical drives (LUNs):   Linux RDAC supports re-scan 

of newly mapped LUNs without rebooting the server. The utility program is 

packaged with the Linux RDAC driver. It can be invoked by issuing either the 

hot_add or mppBusRescan command. hot_add is a symbolic link to mppBusRescan. 

There are man pages for both commands. 

The Linux RDAC driver does not support LUN deletion. It is necessary to reboot the 

server after deleting mapped logical drives. 

Removing the temporary installation files 

This section describes how to remove the temporary installation files from the 

temporary directory. 

1.   At the prompt, type the following command, and press Enter. 

rm /install_dir/SM*-LINUX.rpm 

where /install_dir/ is the directory from which you will extract the installation 

files. 

2.   To confirm, type y and press Enter.

Uninstalling QLogic SANsurfer 

If you are installing Storage Manager 10.10 in an environment with existing storage 

subsystems, you need to uninstall older versions of QLogic SANsurfer and then 

install the version of QLogic SANsurfer that came on the IBM DS4000 Storage 

Manager Version 10.10 CD. 

Perform the following steps to uninstall QLogic SANsurfer from a Red Hat or SUSE 

Linux system: 

1.   Open a command shell. 

2.   Change to the directory where SANblade Manager is installed. For example, 

type the following and then press Enter: 

cd /opt/QLogic_Corporation/SANsurfer 

3.   Change to the UninstallData directory: 

cd /UninstallData 

4.   Type the following and then press Enter to run the InstallAnywhere uninstallation 

program: 

./SANsurferUninstaller

Installing QLogic SANsurfer 

The IBM QLogic SANsurfer software includes the DS4000 GUI device driver that is 

required for failover and diagnostic support. You can use the GUI to configure 

logical drives, storage, and failover. 
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Perform the following steps to install IBM QLogic SANsurfer onto a Red Hat or 

SUSE Linux system: 

1.   Open a command shell. 

2.   Change to the directory into which you downloaded the SANsurfer installer. 

3.   Type the following command and then press Enter: 

sh ./installer_file.bin where installer_file is the name of the SANsurfer 

installer file. 

4.   Restart your Linux server. 

5.   Continue with “Installing the IBM fibre channel host bus adapter device driver.”

For additional configuration information, see the QLogic SANsurfer online help. 

Installing the IBM fibre channel host bus adapter device driver 

An IBM fibre channel host bus adapter (HBA) provides the interface between a host 

server and a DS4000 storage subsystem. IBM DS4000 fibre channel HBAs are 

high-performance, direct memory access, bus-master, host adapters designed for 

high-end systems. These HBAs support all fibre channel peripheral devices that 

support private-loop direct-attach and fabric-loop attachment. The IBM host adapter 

device driver enables your operating system to communicate with the fibre channel 

HBA. 

See the readme file included in the driver package for installation instructions 

associated with your operating system. For more information, see the Installation 

and User’s Guide for your particular fibre channel HBA model. Additional information 

can also be found in Appendix I, “Host bus adapter settings,” on page 215. 

Note:  Depending on your controller’s firmware version, change the LUNs per target 

BIOS setting from the default value of 0 to 31 or 255 for an IBM DS4000 fibre 

channel HBA. 

The current readme file and latest multipath I/O device driver are available for 

download at the following Web site: 

www.ibm.com/servers/storage/support/disk/. 

See “Readme files and concepts” on page 1 to find out how to access the most 

recent Storage Manager readme files on the Web. 

Uninstalling Storage Manager 

This section contains procedures for uninstalling an earlier version of Storage 

Manager software from one or more Linux management stations or hosts. Use the 

following procedure to remove previous versions of the software before installing 

Storage Manager version 10.10. The software removal procedures can also be 

performed using an rpm-compatible, GUI-based package manager. 

If you installed the host software components individually, use the procedure in 

“Uninstalling manually-installed Storage Manager packages” on page 99 to uninstall 

an earlier version of Storage Manager. If you installed the host software using the 

DS4000 Storage Manager installation wizard, use the procedure in “Uninstalling 

wizard-installed Storage Manager packages” on page 99. 
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Note:  You do not need to restart your host computer after removing a software 

component. During the software removal process, the host keeps existing 

storage subsystem mappings and storage partition configurations, which the 

new client software will recognize. 

Uninstalling manually-installed Storage Manager packages 

Complete the following steps to uninstall an earlier version of Storage Manager if 

you installed the host software components individually. 

1.   Be sure that you have root privileges, which are required to uninstall Storage 

Manager. 

2.   To remove previously installed software packages, do the following: 

a.   Type the appropriate uninstallation command at the command prompt in the 

order listed in Table 18 and press Enter. 

 Table 18. Software removal commands 

Package Removal command 

SMutil rpm -e SMutil 

SMclient rpm -e SMclient 

SMesm rpm -e SMesm 

SMagent rpm -e SMagent 

SMruntime rpm -e SMruntime
  

When the software has been removed, the system will return to the 

command prompt. 

b.   At the command prompt, type the verification command for the selected 

software package, and press Enter. See Table 19. 

 Table 19. Software removal verification commands 

Package Removal command 

SMutil rpm -qi SMutil 

SMclient rpm -qi SMclient 

SMesm rpm -qi SMesm 

SMagent rpm -qi SMagent 

SMruntime rpm -qi SMruntime
  

The following message displays. 

Package <packagename> is not installed. 

c.   The Linux RDAC driver is not packaged as RPM package. See “Installation 

and setup instructions” on page 93 for that information. However, always 

check with the Linux RDAC readme file for the latest changes to the 

installation and uninstallation instructions. 

See “Readme files and concepts” on page 1 to find out how to access the 

most recent Storage Manager readme files on the Web.

3.   If you are installing a new version of the software, proceed to “Installing the 

Storage Manager 10.10 software” on page 85. If you are not installing a new 

version of the software, you have successfully completed this procedure.

Uninstalling wizard-installed Storage Manager packages 

The DS4000 Storage Manager installation wizard will create an Uninstall directory 

in the directory that you specified to install the Storage Manager host software. The 
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default name for this directory is /opt/IBM_DS4000. Inside, there is a file named 

Uninstall_IBM_DS4000. To uninstall the host software, change to this directory and 

type the following command: 

 # sh ./Uninstall_IBM_DS4000 

  

When the wizard opens, follow the instructions. 

Configuring storage management 

After you install Storage Manager, complete the tasks that are described in 

Chapter 8, “Completing storage management installation and configuration,” on 

page 113. These tasks include the following: 

v   Performing an initial automatic discovery of storage subsystems 

v   Adding devices 

v   Naming storage subsystems 

v   Creating arrays and logical drives 

v   Downloading controller firmware and NVSRAM 

v   Verifying and defining the default host type 

v   Setting up alert notifications

Additional information 

For additional information about installing and using Storage Manager in a Linux 

configuration, see “Linux operating system limitations” on page 204. 
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Chapter  6.  Using  DS4000  storage  subsystems  with  NetWare  

hosts  

Storage Manager 10.10 software, which is required to manage DS4000 storage 

subsystem with controller firmware 07.10.xx.xx, is not available for the NetWare 

operating system environment. 

To manage a DS4000 storage subsystem with controller firmware 6.16.xx.xx and 

later that is connected to a NetWare host server, you must install the Windows 

version of the Storage Manager 10.10 SMclient program in a Microsoft Windows 

management station, and make an out-of-band management connection to the 

DS4000 storage subsystem. 

This section describes how to install the fibre channel HBA device driver, the 

LSIMPE.cdm driver, and the NetWare native failover device driver. To ensure proper 

installation, complete all preparation tasks described in this section. 

If you have existing storage systems, read “Storage subsystem management 

methods” on page 11. 

Important:  Always check the latest Storage Manager readme file for NetWare, 

which might contain important information that was not available when 

this guide was prepared. 

See “Readme files and concepts” on page 1 to find out how to access 

the most recent Storage Manager readme files on the Web. 

Installing the NetWare fibre channel HBA device driver 

An IBM fibre channel host bus adapter (HBA) provides the interface between a host 

server and a DS4000 storage subsystem. IBM DS4000 fibre channel HBAs are 

high-performance, direct memory access, bus-master, host adapters that are 

designed for high-end systems. These HBAs support all fibre channel peripheral 

devices that support private-loop direct-attach and fabric-loop attachment. The 

Novell NetWare native failover device driver enables your operating system to 

communicate with the fibre channel HBA. 

See the readme file included in the driver package for installation instructions 

associated with your operating system. For more information, see the Installation 

and User’s Guide for your particular fibre channel HBA model. Additional information 

can also be found in Appendix I, “Host bus adapter settings,” on page 215.

Note:  Depending on your controller’s firmware version, change the LUNs per target 

BIOS setting from the default value of 0 to 31 or 255 for IBM DS4000 fibre 

channel HBA. In addition, review the device driver readme for any other 

required modifications to the default HBA BIOS and host operating system 

registry settings to ensure optimal performance. If you make any changes to 

the HBA BIOS settings, the machine will reboot automatically. 

The latest multipath I/O device driver is available at the following Web site: 

www.ibm.com/servers/storage/support/disk/ 

 

© Copyright IBM Corp. 2006, 2007 101

http://www.ibm.com/servers/storage/support/disk/


See “Readme files and concepts” on page 1 to find out how to access the most 

recent Storage Manager readme files on the Web. 

Installing the LSIMPE driver and NetWare native failover device driver 

The NetWare native failover device driver is the only recommended failover device 

driver for the NetWare operating system environment. The device driver is available 

in NW5.1 SP7 or later, NW6.0 SP3 or later, and in NW6.5 SP1a or later. 

Note:  Always use the Novell NetWare native failover device in the latest SP™ for a 

particular NetWare operating system version. In addition, use the later 

version of the LSIMPE.CDM file from either the latest Novell Support Pack or 

the version that is included with the IBM fibre channel HBA device driver for 

NetWare which is available at the IBM DS4000 support Web site. 

The LSIMPE.CDM driver is used in a Novell NetWare environment to enable the 

Novell native multipath driver to recognize the NetWare host-mapped logical drives 

on DS4000 storage subsystems. LSIMPE.CDM is a custom driver module that is 

packaged with the IBM DS4000 Host Adapter driver and the Novell operating 

system distribution CD. 

In previous DS4000 Storage Manager releases (before Release 2 of Storage 

Manager 9.16), the Novell native multipath driver sends I/O requests through the 

alternate path, and in case of a failure along the I/O path, Auto-Volume Transfer 

(AVT/ADT) fails over/fails back the LUNs within the DS4000 storage subsystem. 

However, beginning with Release 2 of Storage Manager 9.16, the Novell native 

multipath driver uses DS4000 RDAC to failover/failback the LUNs between the 

controllers, instead of AVT/ADT. 

The new Novell native multipath driver is recommended because it eliminates 

problems with LUNs moving between controllers unnecessarily, which can happen 

when different NetWare hosts have access to the same set of LUNs. This can be 

especially problematic in large Novell NetWare cluster environments. 

Currently, the new Novell native multipath driver is supported with Novell NetWare 

version 6.5 only. You must download the new Novell native multipath driver code 

from the Novell NetWare support Web site. 

The new Novell native multipath driver requires new versions of the following Novell 

NetWare 6.5 CDM and NLM modules: 

v   MM.NLM - NetWare 6.5 Media Manager Version 3.22 April 4, 2006 

v   NWPA.NLM - NetWare 6.5 NetWare Peripheral Architecture NLM Version 3.21 

March 27, 2006 

v   SCSIHD.CDM - Novell NetWare SCSI Fixed Disk Custom Device Module Version 

3.03.06 March 29, 2006 

v   LSIMPE.CDM - LSI Multipath Enhancer (also required to support the newly 

released DS4700/DS4800 storage subsystems) Version 1.02.01 March 13, 2006

These files can be downloaded from the Novell support Web site: 

http://support.novell.com/cgi-bin/search/searchtid.cgi?/2973674.htm 

Do not use any of the above modules whose release dates and versions are earlier 

than as stated above. 

 

102 DS4000 Installation and Host Support Guide for Windows 2000/Server 2003, NetWare, ESX Server, and Linux

http://support.novell.com/cgi-bin/search/searchtid.cgi?/2973674.htm


Note:  The above modules whose released dates and versions are earlier than as 

stated above support DS4000 AVT/ADT mode as a means to failover/fail 

back LUNs, whereas the newer modules support the DS4000 RDAC mode 

as a means to failover/fail back LUNs. 

 Attention:  To disable the AVT/ADT function so that the new Novell native 

multipath driver can be used, you must make changes to the NVSRAM ADT/AVT 

setting in the DS4000 controller. Use the DS4000 SMcli script file 

DisableAVT_Netware.script that is included in the scripts subdirectory of the 

DS4000 Storage Manager host software download package to disable AVT/ADT. 

Another file EnableAVT_Netware.script can be used to re-enable AVT/ADT if 

required. 

The DS4000 controller must be rebooted to activate the change in the NVSRAM 

settings. If you do not install NetWare 6.5, or if you use an older version of the 

Novell native multipath driver, do not make this NVSRAM change. NetWare hosts 

with the new Novell native multipath driver (NetWare 6.5) and the previous Novell 

native multipath driver (NetWare 6.0, or NetWare 6.5 without the new driver 

installed) cannot share the same DS4000 storage subsystem using the same 

NetWare failover host type. (This is because the different ADT/AVT enable/disable 

settings of the different driver versions conflict with each other.) 

Recommendation: If your system has NetWare version 6.0 (or earlier) installed, it 

is recommended that you switch to NetWare 6.5 to take advantage of this new 

multipath driver. 

See the current IBM fibre channel HBA device driver readme file for the current 

LSIMPE.CDM driver, and the pointer to the Novell native multipath driver installation 

instructions. You can find the readme at the following Web site: 

www.ibm.com/servers/storage/support/disk/ 

Installing QLogic SANsurfer 

The QLogic SANsurfer Storage Management Suite is a diagnostic application that 

you can use to verify the status of the fibre channel connections before you use the 

storage subsystem. 

For information about installing and using this software, see the IBM System 

Storage DS4000 Problem Determination Guide or see the Storage Manager online 

help. 

Additional information 

You cannot use a NetWare host operating system as a management station with 

Storage Manager 10.10. For information that describes how to use a NetWare host 

operating system as a management station with previous versions of Storage 

Manager, see Appendix B, “Installing previous Storage Manager versions in a 

NetWare configuration,” on page 165. 

For additional information about NetWare configurations, see “NetWare operating 

system limitations” on page 179. 
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Chapter  7.  Using  DS4000  with  a VMware  ESX  Server  

configuration  

DS4000 Storage Manager software is not currently available for VMware ESX 

Server operating systems. Therefore, to manage DS4000 storage subsystems with 

your VMware ESX Server host, you must install the Storage Manager client 

software (SMclient) on a Windows or Linux management workstation. (This can be 

the same workstation that you use for the browser-based VMware ESX Server 

Management Interface.) 

See Chapter 3, “Installing Storage Manager software in a standard Windows 

configuration,” on page 57 or Chapter 5, “Installing Storage Manager software in a 

Linux configuration,” on page 83 for instructions on how to install DS4000 Storage 

Manager 10.10 client software (SMclient) on a Windows or Linux management 

station. 

This chapter contains the following topics: 

v   “Finding DS4000 readme files online” 

v   “Sample configuration” on page 106 

v   “Software requirements” on page 106 

v   “Hardware requirements” on page 107 

v   “VMware ESX Server restrictions” on page 107 

v   “Other VMware ESX Server host information” on page 109 

v   “Configuring storage subsystems” on page 109

For additional information about using a DS4000 storage subsystem with a VMware 

ESX Server host, see “VMware ESX Server operating system limitations” on page 

207. 

Finding DS4000 readme files online 

Updated readme files contain important configuration information that supersedes 

the information in this document. To access the most recent DS4000 readme file for 

VMware ESX Server, complete the following steps. 

1.   Go to the following Web site:
www-1.ibm.com/servers/storage/support/disk/ 

2.   Click the link for your storage subsystem (for example, DS4800). 

3.   When the subsystem support page opens, click the Download tab, then click 

the Storage Manager, firmware, HBA and tools (including readmes) link. 

4.   When the download page opens, click the Storage Mgr tab. A table displays. 

5.   In the table, find the row that contains IBM DS4000 Storage Manager for 

VMware ESX Server, then click on the corresponding v10.10 link under the 

Current versions and readmes column.

For additional information, you can view the DS4000 interoperability matrix at the 

following Web site:
www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 
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Sample configuration 

Figure 20 shows a sample VMware ESX Server configuration. 
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Software requirements 

This section describes the software that is required to use a VMware ESX Server 

host operating system with a DS4000 storage subsystem.

Note:  See also “System requirements” on page 28 for general DS4000 

requirements. 

Management station 

The following software is required for the Windows or Linux management station: 

1.   SM Runtime (Linux only) 

2.   SMclient (Linux and Windows)

Host (VMware ESX Server) 

The following software is required for VMware ESX Server: 

v   VMware ESX Server (with DS4000 controller firmware version 07.10xx.xx) 

v   VMware ESX Server-supplied driver for the fibre channel HBAs 

v   VMware ESX Server-supplied QLogic driver failover setup 

v   VMware ESX Server Tools (installed on all virtual machines using DS4000 logical 

drives)

Figure 20. Sample VMware ESX Server configuration
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Earlier versions of VMware ESX Server:  

1.   VMware ESX Server 2.1 was supported with DS4000 controller firmware version 

06.12.xx.xx only. 

2.   VMware ESX Server 2.0 was supported with DS4000 controller firmware version 

05.xx.xx.xx only.

Clustering:  If you intend to create a cluster configuration, you must use Microsoft 

Cluster Services software, in addition to the host software 

requirements listed in this section. 

Note:  VMware ESX Server 2.5 and higher comes with a Distributed 

Resource Scheduler and high availability for clustering, which 

allows you to aggregate several hosts’ resources into one 

resource pool. (A DRS cluster is implicitly a resource pool.) 

For information about Windows clustering with VMware ESX Server, 

see the ESX Server 2.5 Installation Guide at the following Web site: 

www.vmware.com/support/pubs/ 

Hardware requirements 

You can use VMware ESX Server host servers with the following types of DS4000 

storage subsystems and expansion units. For additional information, you can view 

the DS4000 interoperability matrix at the following Web site: 

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html

Note:  See also “System requirements” on page 28 for general DS4000 

requirements.

DS4000 storage subsystems 

v   DS4800 

v   DS4700 

v   DS4500 

v   DS4400 

v   DS4300 (Dual-controller and Turbo units only) 

v   DS4200 

v   DS4100 (Dual-controller units only)

DS4000 storage expansion units 

v   EXP100 

v   EXP420 ( with DS4200 only) 

v   EXP500 

v   EXP700 

v   EXP710 

v   EXP810

VMware ESX Server restrictions 

SAN and connectivity restrictions 

v   VMware ESX Server hosts support host-agent (out-of-band) managed 

DS4000 configurations only. Direct-attach (in-band) managed 

configurations are not supported. 
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v   VMware ESX Server hosts can support multiple host bus adapters 

(HBAs) and DS4000 devices. However, there is a restriction on the 

number of HBAs that can be connected to a single DS4000 storage 

subsystem. You can configure up to two HBAs per partition and up to two 

partitions per DS4000 storage subsystem. Additional HBAs can be added 

for additional DS4000 storage subsystems and other SAN devices, up to 

the limits of your specific subsystem platform. 

v   When you are using two HBAs in one VMware ESX Server, LUN 

numbers must be the same for each HBA attached to DS4000 storage 

subsystem. 

v   Single HBA configurations are allowed, but each single HBA configuration 

requires that both controllers in the DS4000 be connected to the HBA 

through a switch. If they are connected through a switch, both controllers 

must be within the same SAN zone as the HBA.

Attention:  Having a single HBA configuration can lead to loss of access 

data in the event of a path failure. 

v   Single-switch configurations are allowed, but each HBA and DS4000 

controller combination must be in a separate SAN zone. 

v   Other storage devices, such as tape devices or other disk storage, must 

be connected through separate HBAs and SAN zones.

Partitioning restrictions 

v   The maximum number of partitions per VMware ESX Server host, per 

DS4000 storage subsystem, is two. 

v    All logical drives that are configured for VMware ESX Server must be 

mapped to an VMware ESX Server host group. 

Note:  Currently, a VMware ESX Server-specific host type is not available 

for DS4000 storage subsystems. If you are using the default host 

group, ensure that the default host type is LNXCL. 

v   In a DS4100 storage subsystem configuration, you must initially assign 

the LUNs to Controller A, on the lowest-numbered HBA. After the LUNs 

are formatted, you can change the path to Controller B. (This restriction 

will be corrected in a future release of ESX Server.) 

v   Assign LUNs to the ESX Server starting with LUN number 0. 

v   Do not map an access (UTM) LUN to any of the ESX Server hosts or 

host groups. Access (UTM) LUNs are used only with in-band managed 

DS4000 configurations, which VMware ESX Server does not support at 

this time.

Failover restrictions 

v   You must use the VMware ESX Server failover driver for multipath 

configurations. Other failover drivers (such as RDAC) are not supported 

in VMware ESX Server configurations. 

v   The default failover policy for all DS4000 storage subsystems is now 

MRU (most recently used). 

v   Use the LNXCL host type in VMware ESX Server configurations (2.0 and 

higher). The LNXCL host type automatically disables AVT/ADT.

Interoperability restrictions 

v   DS4100 and DS4300 single-controller storage subsystems are not 

supported with VMware ESX Server hosts. (DS4100 and DS4300 

dual-controller storage subsystems are supported.) 
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v   EXP700 storage expansion units are not supported with DS4800 storage 

subsystems. You must upgrade to EXP710 storage expansion units.

Other  restrictions 

v   Dynamic Volume Expansion is not supported for VMFS-formatted LUNs. 

v   For information about availability of DS4000 Copy Service features that 

are supported VMware ESX Server 2.5 Server and higher configurations, 

contact your IBM support representative. 

v   Recommendation: It is recommended that you do not boot your system 

from a SATA device.

Other VMware ESX Server host information 

For more information about setting up your VMware ESX Server host, see the 

documentation and readme files that are maintained at the VMware ESX Server 

support Web site:
www.vmware.com/support/pubs/ 

For information about installing a VMware ESX Server operating system on an IBM 

server, see the IBM support Web site at:
www.ibm.com/pc/us/compat/nos/matrix.shtml 

For information about configuring HBAs, see Appendix I, “Host bus adapter 

settings,” on page 215. 

Configuring storage subsystems 

Before you can configure storage subsystems, you must physically configure the 

host server, SAN fabric, and DS4000 controllers; assign initial IP addresses to the 

controllers; and install SMclient on the Windows or Linux management station. 

These procedures are described elsewhere in this document, as follows: 

Setting up your VMware ESX Server host 

For information about setting up your VMware ESX Server host, see “Other 

VMware ESX Server host information.” 

Setting up the SAN fabric 

For information about setting up the SAN fabric, including information about 

zoning, see “Creating the SAN-attached configuration” on page 24. 

Assigning initial IP addresses 

For information about assigning initial IP addresses to the DS4000 

controllers, see “Step 4: Assigning IP addresses to hosts and controllers” on 

page 47. 

Installing SMclient on a Windows or Linux management station 

For information about installing SMclient on a Windows management 

station, see Chapter 3, “Installing Storage Manager software in a standard 

Windows configuration,” on page 57. 

 For information about installing SMclient on a Linux management station, 

see Chapter 5, “Installing Storage Manager software in a Linux 

configuration,” on page 83. 

Completing storage management installation and configuration 

For information about completing storage management installation and 

configuration tasks, seeChapter 8, “Completing storage management 

installation and configuration,” on page 113. 
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These tasks include: 

v   Performing an initial automatic discovery of storage subsystems 

v   Adding devices, if necessary 

v   Setting up alert notifications, if you want 

v   Naming the storage subsystems 

v   Downloading controller firmware and NVSRAM 

v   Creating arrays and logical drives 

v   Verifying and define the default host type 

v   Configuring the heterogeneous hosts, including storage partitioning and 

defining host groups

Notes on mapping LUNs to a storage partition 

See “Mapping LUNs to a partition” on page 134 for procedures that describe how to 

map the LUNs to a partition. This section contains notes about LUN mapping that 

are specific to VMware ESX Servers. 

When you map you LUNs on VMware ESX Server, note the following: 

v    It is recommended that you always map the LUNs using consecutive numbers, 

starting with LUN 0. For example, map LUNs to numbers 0; 1; 2; 3; 4; 5; and so 

on, without skipping any numbers. 

v   On each partition, you must map a LUN 0. 

v   If your configuration does not require LUN sharing (single or multiple independent 

ESX Servers, local virtual cluster), each logical drive must be mapped either 

directly to a host, or to a host group with a single host as a member. 

v   LUN sharing across multiple ESX servers is only supported when you are 

configuring VMotion enabled hosts or Microsoft Cluster nodes. On LUNs that are 

mapped to multiple ESX Servers, you must change the access mode to Shared. 

You can map the LUNs to a host group for the ESX Servers, so they will be 

available to all members of the host group. For additional information on 

Windows Clustering with ESX Server, see the ESX Installation Guide at the 

following Web site: 

www.vmware.com/support/pubs/

Steps for verifying the storage configuration 

Complete the following steps to help you verify that your storage setup is 

fundamentally correct and that you can see the DS4000 storage. 

1.   Boot the server. 

2.   On initialization of the QLogic BIOS, press Ctrl+Q to enter the Fast!UTIL setup 

program. 

3.   Select the first host bus adapter that is displayed in the Fast!UTIL screen. 

4.   Select Host Adapter Settings and press Enter. 

5.   Select Scan Fibre Devices and press Enter. The resulting output is similar to 

the following: 
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Scan Fibre Channel Loop 

ID      Vendor        Product       Rev      Port Name         Port ID 

128     No device present      0520 

129     IBM     1742    0520  200400A0b00F0A16  610C00 

130  No device present 

131  No device present 

132  No device present 

133  No device present 

134  No device present 

135  No device present 

  

Note:  Depending on how the configuration is cabled, you might see multiple 

instances.

If you do not see a DS4000 controller, verify the cabling, switch zoning, and LUN 

mapping. 
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Chapter  8.  Completing  storage  management  installation  and  

configuration  

This chapter contains procedures on how to use the Enterprise Management and 

Subsystem Management features of DS4000 Storage Manager to complete storage 

management installation tasks for Windows, NetWare, Linux, and VMware ESX 

Server host operating system environments.

Notes:  

1.   DS4000 Storage Manager 9.16 and later software is not currently available for 

NetWare operating systems. To configure Storage Manager 9.16 and later 

storage management with your NetWare host, complete the tasks in this section 

using SMclient on a Windows or Linux management workstation or using 

Storage Manager 9.15. See Appendix B, “Installing previous Storage Manager 

versions in a NetWare configuration,” on page 165 for more information about 

using NetWare with Storage Manager 9.15. 

2.    DS4000 Storage Manager software is not currently available for VMware ESX 

Server operating systems. To configure DS4000 storage management with your 

VMware ESX Server host, complete the tasks in this section using SMclient on 

a Windows or Linux management workstation (this can be the same workstation 

that you use for the browser-based VMware ESX Server Management 

Interface). See Chapter 7, “Using DS4000 with a VMware ESX Server 

configuration,” on page 105 for more information.

Completing the installation 

To complete a Storage Manager installation, perform the following tasks: 

1.   Perform an initial automatic discovery of storage subsystems. 

2.   Add devices, if necessary. 

3.   Set up alert notifications, if you want. 

4.   Name the storage subsystems. 

5.   Download controller firmware and NVSRAM. 

6.   Create arrays and logical drives. 

7.   Verify and define the default host type. 

8.   Configure the heterogeneous hosts. 

9.   Perform other storage subsystem tasks.

Each of these steps is discussed in detail in the sections that follow. 

The Enterprise Management window opens when you start the DS4000 Storage 

Manager. Use the Enterprise Management window to do the following: 

v   Add and discover the storage subsystems. 

v   View all storage subsystems in your management domain. 

v   Perform batch storage subsystem management tasks using the Script Editor.

Using the Task  Assistant 

The Task Assistant provides a convenient, central location from which you can 

choose to perform the most common tasks in the Enterprise Management window 

and in the Subsystem Management window. 
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In the Enterprise Management window, the Task Assistant provides shortcuts to 

these tasks: 

v   Adding storage subsystems 

v   Naming or renaming storage subsystems 

v   Setting up alert destinations 

v   Managing storage subsystems

In the Subsystem Management window, the Task Assistant provides shortcuts to 

these tasks: 

v   Configuring storage subsystems 

v   Saving configurations 

v   Defining hosts 

v   Creating a new storage partition 

v   Mapping additional logical drives

If there is a problem with the storage subsystem, a shortcut to the Recovery Guru 

appears, where you can learn more about the problem and find solutions to correct 

the problem. 

To open the Task Assistant, choose View → Task Assistant from either the 

Enterprise Management window or the Subsystem Management window, or click 

the Task Assistant button in the toolbar:
  

 

The Task Assistant window opens. See Figure 21 on page 115 for the Enterprise 

Management window Task Assistant or Figure 22 on page 116 for the Subsystem 

Management window Task Assistant. 
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Figure 21. The task assistant in the Enterprise Management window
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Note:  The Task Assistant is automatically invoked every time you open the 

Subsystem Management window unless you check the Don’t show the task 

assistant at startup again check box at the bottom of the window.
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Figure 22. The task assistant in the Subsystem Management window
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Performing an initial automatic discovery of storage subsystems 

To perform an initial automatic discovery of storage subsystems, perform the 

following steps: 

1.   Click Start → Programs. 

2.   Click IBM DS4000 Storage Manager 10.10 Client. The client software starts 

and displays the Enterprise Management window and the Confirm Initial 

Automatic Discovery window as illustrated in Figure 23. 

 

Note:  The Enterprise Management window can take several minutes to open. 

No wait cursor (such as an hourglass) displays. Also, the Confirm Initial 

Automatic Discovery window might not be visible until you close the 

Enterprise Management window. 

3.   Click Yes to begin an initial automatic discovery of hosts and storage 

subsystems attached to the local subnetwork. 

After the initial automatic discovery is complete, the Enterprise Management 

window displays all hosts and storage subsystems attached to the local 

subnetwork. 

Note:  The Enterprise Management window can take up to a minute to refresh 

after an initial automatic discovery. 

 

d
s
s
0
0
0
3
3

  

Figure 23. Confirm Initial Automatic Discovery window
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4.   Verify that each host and storage subsystem displays in the Enterprise Manager 

window. 

If a host or storage subsystem is not displayed, perform the following tasks: 

v   Check the hardware and hardware connections for possible problems. (Refer 

to the hardware documentation for specific procedures). 

v   Refer to the Enterprise Management online help for additional information 

about discovering storage subsystems. 

v   If you are using the direct-management method, verify that all hosts and 

storage subsystems are connected to the same subnet network. If you are 

using the host-agent method, ensure that the fibre channel connection 

between the host and storage subsystems is made. 

v   Make sure that all of the preparation steps for setting up the storage 

subsystem for a directly managed system in Chapter 2, “Preparing for 

installation,” on page 37 are completed. If they are, use the Add Device 

option to add the IP addresses of the Storage subsystem. Add both IP 

addresses of the controller. Otherwise, you will get a ″partially-managed 

device″ error message when you try to manage the storage subsystem. 

v   If you are using the host-agent management method, perform the following 

steps: 

a.   Make sure that the SMagent is installed in the host. 

b.   Verify that you have a fibre channel connection from the storage 

subsystems to the host that has the SMagent installed. 

c.   Verify that all of the preparation steps outlined in Chapter 2, “Preparing for 

installation,” on page 37 are complete. If they are, perform the following 

steps: 

1)   Run the hot_add utility. 

2)   Restart the SMagent using the information in “Stopping and restarting 

the host-agent software” on page 141. 

3)   Right click on the host and click Tools → Rescan in the Enterprise 

management window.

Note:  In certain situations, a storage subsystem might be duplicated in the 

device tree after an automatic discovery. You can remove a duplicate 

storage management icon from the device tree by using the Remove 

Device option in the Enterprise Management window.
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Figure 24. Enterprise Management window
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5.   Verify that the status of each storage subsystem is Optimal. If a device shows a 

status of Unresponsive, right-click the device and select Remove Device to 

delete it from the management domain. Then use the Add Device option to add 

it to the management domain again. Refer to the Enterprise Management 

window online help for instructions on removing and adding devices. 

6.   Continue with “Adding devices.”

Adding devices 

You can manually add more hosts or storage subsystems. You can use this option 

to selectively manage a group of storage subsystems from an SMclient. You can 

also use this option to add additional devices to be managed that were not 

discovered during the SMclient initial discovery. For more information about this 

option, see the Enterprise Management window online help. 

Important: 

v   When you add new storage subsystems to the existing storage subsystems in a 

SAN that are managed through the host-agent software, you must stop and 

restart the host-agent service. When the host-agent service restarts, the new 

storage subsystem is detected. For more information, see “Stopping and 

restarting the host-agent software” on page 141. Then, go to the Enterprise 

Management window and click Tools → Rescan to add the new storage 

subsystems to the management domain. 

v   When you add new storage subsystems to existing storage subsystems that are 

managed using the direct-management method, be sure to specify the IP 

addresses for both controllers.

Continue with “Setting up alert notifications.” 

Setting up alert notifications 

After you add devices to the management domain, you can set up alert notifications 

to report critical events on the storage subsystems. The following alert-notification 

options are available: 

v   Notification to a designated network management station (NMS) using Simple 

Network Management Protocol (SNMP) traps 

v   Notification to designated e-mail addresses 

v   Notification to designated alphanumeric pagers (requires separately supplied 

software to convert e-mail messages)

Note:  You can only monitor storage subsystems within the management domain. If 

you do not install the Event Monitor service, the Enterprise Management 

window must remain open. If you close the window, you will not receive any 

alert notifications from the managed storage subsystems. Refer to the 

Enterprise Management window online help for additional information. 

Alert notification with SNMP traps 

 To set up alert notification to an NMS using SNMP traps, perform the 

following steps: 

1.   Insert the IBM DS4000 Storage Manager Version 10.10 CD into the 

CD-ROM drive on an NMS. You need to set up the designated 

management station only once. 

2.   Copy the SM10.1.MIB file from the SM10MIB directory to the NMS. 

 

Chapter 8. Completing storage management installation and configuration 119



3.   Follow the steps required by your NMS to compile the management 

information base (MIB) file. (For details, contact your network 

administrator or see the documentation specific to your particular 

storage management product.) 

4.   Continue with “Naming storage subsystems.”

Alert notification without SNMP traps 

 To set up alert notification without using SNMP traps, select Storage 

subsystem → Edit → Configure alerts from the Enterprise Management 

window.

Naming storage subsystems 

To name your storage subsystem, perform the following steps: 

1.   In the Enterprise Management window, Right-click the storage subsystem and 

select Rename. The Rename Storage Subsystem window opens as shown in 

Figure 25.
 

2.   Type the name of the storage subsystem (see Table 28 on page 213). Then 

click OK. Click Yes on the warning screen to continue. 

3.   Repeat this procedure for each unnamed storage subsystem. For more 

information, see the topic on renaming storage subsystems in the Subsystem 

Management window online help. 

4.   Proceed to “Downloading NVSRAM, controller firmware, ESM firmware” on page 

121.
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Figure 25. Rename Storage Subsystem window
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Downloading NVSRAM, controller firmware, ESM firmware 

 

Important 

To determine the correct order to upgrade these components, check the 

readmes for NVSRAM, controller firmware, and ESM firmware. 

The following procedures assume you using controller firmware at version 

6.10.xx.xx or later. If you are using an earlier version, refer to the following 

IBM web site for the appropriate firmware version documentation: 

For the most recent Storage Manager readme files for your operating system, 

see the following Web site: 

www-1.ibm.com/servers/storage/support/disk/ 

Click the link for your storage server. When the page opens, click the 

Download tab, then click the Storage Manager tab. Follow the links to the 

readmes. 

Note:  Access the latest versions of DS4000 storage subsystem NVSRAM, 

controller firmware, and DS4000 Storage Expansion Enclosure ESM 

firmware at the IBM Web site: 

www.ibm.com/servers/storage/support/disk/ 

Important: 

1.   IBM supports firmware download with I/O, sometimes referred to as ″concurrent 

firmware download," with some DS4000 storage subsystems. Before proceeding 

with concurrent firmware download, check the readme file packaged with the 

firmware code or your particular operating system’s DS4000 Storage Manager 

host software for any restrictions to this support. 

2.   Suspend all I/O activity while downloading firmware and NVSRAM to a DS4000 

storage subsystem with a single controller or you will not have redundant 

controller connections between the host server and the DS4000 Storage Server.

This section provides instructions for downloading DS4000 storage server controller 

firmware and NVSRAM, DS4000 Storage Expansion Enclosure ESM firmware, and 

drive firmware. Normally, the DS4000 storage subsystem firmware download 

sequence starts with controller firmware, followed by the NVSRAM and then the 

ESM firmware, and concludes with the drive firmware. 

Important:  Always check the DS4000 storage subsystem controller firmware 

readme file, as well as the ESM/HDD Update Package readme file, for 

any controller firmware Dependencies and Prerequisites before 

applying the firmware updates to the DS4000 storage subsystem. 

Updating any components of the DS4000 storage subsystem firmware 

without complying with the Dependencies and Prerequisites may cause 

down time (to fix the problems or recover). Contact IBM support if you 

have any questions regarding the appropriate download sequence for a 

particular version of firmware. 

If your controller’s existing firmware is 06.1x.xx.xx or later, you will have the option 

to select the NVSRAM for download at the same time that you upgrade/download 

the new controller firmware. Additionally, you will have the option to download the 

 

Chapter 8. Completing storage management installation and configuration 121

http://www.ibm.com/servers/storage/support/disk/
http://www.ibm.com/servers/storage/support/disk/


firmware and NVSRAM immediately, but activate it later, when it may be more 

appropriate. See the online help for more information. 

Note:  The option to activate firmware at a later time is not supported on the 

DS4400. 

Downloading controller or NVSRAM firmware 

This section provides instructions for downloading DS4000 storage server controller 

firmware and NVSRAM. Normally, the DS4000 storage subsystem firmware 

download sequence starts with controller firmware, followed by the NVSRAM and 

then the ESM firmware, and concludes with the drive firmware. 

To download firmware version 06.1x.xx.xx or later, and NVSRAM, perform the 

following steps: 

1.   From the Enterprise Management window, select a storage subsystem. 

2.   Click Tools → Manage Device. The Subsystem Management window opens. 

3.   Click Advanced → Maintenance → Download → Controller firmware.... The 

download firmware window opens as illustrated in Figure 26 on page 123.

Note:  DS4000 Storage Server with controller firmware version 06.1x.xx.xx and 

higher supports the downloading of the NVSRAM file together with the 

firmware file. Therefore, the following window will display only if your 

exiting controller firmware is of version 06.1x.xx.xx or higher. This 

download feature is not supported in DS4000 storage servers with 

controller firmware 05.4x.xx.xx and earlier. If your existing controller 

firmware is version 05.4x.xx.xx or lower, only a window for downloading 

firmware will display.
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4.   Click Browse next to the Selected firmware file: field to identify and select 

the file with the new firmware. 

5.   Optionally: 

v   Select the Download NVSRAM file with firmware option and click Browse 

next to the Selected NVSRAM file: field to identify and select the file and 

identify and select the correct NVSRAM filename. 

v   If you choose to transfer and activate immediately, do not select Transfer 

files but don’t activate them (activate later). Otherwise, click the box to 

select Transfer files but don’t activate them (activate later). To activate 

the firmware at a later time, in the Subsystem Management window, click 

Advanced → Maintenance → Activate Controller Firmware.

Downloading ESM firmware 

This section provides instructions for downloading DS4000 Storage Expansion 

Enclosure ESM firmware. Normally, the DS4000 storage subsystem firmware 

download sequence starts with controller firmware, followed by the NVSRAM and 

then the ESM firmware, and concludes with the drive firmware. 

Steps for downloading the ESM firmware:   Perform the following steps to 

download the ESM firmware: 

1.   In the DS4000 storage subsystem Subsystem Management window, select 

Advanced → Maintenance → Download → ESM firmware.... A Download 

Environmental Card Firmware window opens. 
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Figure 26. Download Firmware window

 

Chapter 8. Completing storage management installation and configuration 123



2.   Click Select All to direct the download to all enclosures. You can also select 

one enclosure or combinations of enclosures by pressing the cntl key while 

selecting the individual enclosures. 

3.   Click Browse to identify and select the filename of the ESM firmware file and 

click Start to begin the ESM firmware download. 

4.   A Confirm Download window opens. Type Yes and click OK to start the 

download process. 

5.   Click Cancel to close the window when the ESM firmware download to all 

selected enclosures is complete.

Note:  Suspend all I/O activity while ESM firmware downloads if you select 

multiple enclosures for downloading ESM firmware. If you select only one 

enclosure for download at a time, you can download ESM firmware while 

the server conducts I/O activity. However, IBM recommends that you 

suspend all I/O activity to perform firmware upgrades.

Automatic ESM firmware synchronization:   When you install a new ESM into an 

existing storage expansion enclosure in a DS4000 storage subsystem that supports 

automatic ESM firmware synchronization, the firmware in the new ESM is 

automatically synchronized with the firmware in the existing ESM. This resolves any 

ESM firmware mismatch conditions automatically. 

To enable automatic ESM firmware synchronization, ensure that your system meets 

the following requirements: 

v   The Storage Manager Event Monitor must be installed and running 

v   The DS4000 storage subsystem must be defined in the Enterprise Management 

window of the Storage Manager client (SMclient)

Note:  Storage Manager 10.10 currently supports automatic ESM firmware 

synchronization with EXP810 storage expansion enclosures only. Contact 

IBM for information about support for other types of storage expansion 

enclosures in the future. To correct ESM firmware mismatch conditions in 

storage expansion enclosures without automatic ESM firmware 

synchronization support, you must download the correct ESM firmware file 

by using the ESM firmware download menu function in the SMclient 

Subsystem Management window. 

Downloading drive firmware 

 

Important: 

The following procedures assume you are using controller firmware at version 

07.10.xx.xx. If you are using an earlier version refer to the following IBM Web 

site for the appropriate firmware version documentation: 

www.ibm.com/servers/storage/support/disk/ 

 This section provides instructions for downloading DS4000 drive firmware. See the 

online help for additional information. 

Important: 

1.   IBM supports firmware download with I/O, sometimes referred to as concurrent 

firmware download. This feature is not supported for drive firmware. 

2.   Before starting the drive firmware download process: 
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v   Stop all I/O activity before downloading drive firmware to a DS4000 Storage 

Server. 

v   Unmount the file systems on all logical drives accessing the drives that you 

select for firmware upgrade. 

v   Complete a full backup of all data residing on the drives that you select for 

firmware upgrade.

Downloading drive firmware with Storage Manager version 10.10 

To download drive firmware for DS4000 Storage Manager version 10.10, perform 

the following steps: 

 1.   From the Enterprise Management window, select a storage subsystem. 

 2.   On the Enterprise Management window’s menu bar, click Tools → Manage 

Device. The Subsystem Management window opens. 

 3.   On the Subsystem Management window’s menu bar, click Advanced → 

Maintenance → Download → Drive Firmware/Mode pages .... The Download 

Drive Firmware wizard window opens to the Introduction page. Read the 

instructions displayed and click Next.

Note:  Storage Manager version 10.10 offers you the option to download and 

update up to four different firmware file types simultaneously. 

 4.   Click Browse to locate the server directory that contains the firmware that you 

plan to download. 

 5.   Select the firmware file that you plan to download and click OK. The file 

appears listed in the ″Selected Packages″ window pane. 

 6.   Select the firmware file for any additional drive types that you intend to 

download and click OK. Additional files appear listed in the ″Selected 

Packages″ window pane. A maximum total of four drive types are possible. 

 7.   Click Browse to repeat step 6 until you have selected each firmware file that 

you plan to download. 

 8.   When you have finished specifying the firmware packages for download, select 

Next. 

 9.   The Select Drive window opens, containing two tabs, a Compatible Drives tab 

and an Incompatible Drives tab. The Compatible Drives tab contains a list 

of the drives compatible to the firmware package types that you selected. From 

that list, select the drives to which you plan to download the drive firmware that 

you selected in steps 6 and 7. 

Note:  The firmware that you propose to download should be listed on the 

Compatible Drives tab. If your particular drives’ product ID matches 

the firmware type, however, and it is not listed as compatible on the tab, 

contact your IBM technical support representative for additional 

instructions. 

10.   Select the Compatible Drives tab. 

Press and hold the Ctrl key while using your mouse to select multiple drives 

individually, or press and hold the shift key while using your mouse to select 

multiple drives listed in series. The compatible firmware that you selected in 

steps 5 and 6 will download to the drives that you select. 

11.   Click Finish to initiate download of the drive firmware to each compatible drive 

that you selected in step 9. 

12.   The Download Drive Firmware warning opens and prompts: ″Do you want to 

continue?″ Type yes and click OK to start the drive firmware download. 
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13.   The Download Progress window opens. Do not intervene until the download 

process completes. 

14.   Every drive scheduled for firmware download will be designated as in 

progress until successful or failed.

Note:  Complete the following two steps if you receive a failure. 

a.   Click the Save as button to save the error log. 

b.   On the Subsystem Management window’s menu bar, click 

Advanced →Trouble Shooting → Open Event Log and complete 

the following tasks necessary to save the storage subsystem event 

log before contacting your IBM Service Representative and 

proceeding to step 16. 

1)   Click the Select all button. 

2)   Click Save the Storage Subsystem Event Log.

15.   When the Close button appears active, the drive firmware download process is 

complete. 

16.   Click Close to exit the Download Progress window. 

17.   Use either of the following procedures to determine or verify what level of drive 

firmware resides on a particular drive: 

v   Right-click on that drive in the Logical/Physical View in the Subsystem 

Management window and click Properties. The associated drive firmware 

version will be listed in the drive properties table. 

v   Right-click on Storage Subsystem → View Profile in the Logical/Physical 

View of the Subsystem Management window.

Downloading drive firmware with Storage Manager version 9.1x 

and higher 

To download drive firmware for DS4000 Storage Manager version 9.1x, perform the 

following steps: 

 1.   From the Enterprise Management window, select a storage subsystem. 

 2.   On the Enterprise Management window’s menu bar, click Tools → Manage 

Device. The Subsystem Management window opens. 

 3.   On the Subsystem Management window’s menu bar, click Advanced → 

Maintenance → Download → Drive Firmware/Mode pages .... The Download 

Drive Firmware wizard window opens to the Introduction page. Read the 

instructions displayed and click Next.

Note:  Storage Manager versions 9.1x and higher offer you the option to 

download and update up to four different firmware file types 

simultaneously. Previous Storage Manager versions did not offer this 

capability. 

 4.   Click Browse to locate the server directory that contains the firmware that you 

plan to download. 

 5.   Select the firmware file that you plan to download and click OK. The file 

appears listed in the ″Selected Packages″ window pane. 

 6.   Select the firmware file for any additional drive types that you intend to 

download and click OK. Additional files appear listed in the ″Selected 

Packages″ window pane. A maximum total of four drive types are possible. 

 7.   Click Browse to repeat step 6 until you have selected each firmware file that 

you plan to download. 

 8.   When you have finished specifying the firmware packages for download, select 

Next. 
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9.   The Select Drive window opens, containing two tabs, a Compatible Drives tab 

and an Incompatible Drives tab. The Compatible Drives tab contains a list 

of the drives compatible to the firmware package types that you selected. From 

that list, select the drives to which you plan to download the drive firmware that 

you selected in steps 6 on page 126 and 7 on page 126. 

Note:  The firmware that you propose to download should be listed on the 

Compatible Drives tab. If your particular drives’ product ID matches 

the firmware type, however, and it is not listed as compatible on the tab, 

contact your IBM technical support representative for additional 

instructions. 

10.   Select the Compatible Drives tab. 

Press and hold the Ctrl key while using your mouse to select multiple drives 

individually, or press and hold the shift key while using your mouse to select 

multiple drives listed in series. The compatible firmware that you selected in 

steps 5 on page 126 and 6 on page 126 will download to the drives that you 

select. 

11.   Click Finish to initiate download of the drive firmware to each compatible drive 

that you selected in step 9. 

12.   The Download Drive Firmware warning opens and prompts: ″Do you want to 

continue?″ Type yes and click OK to start the drive firmware download. 

13.   The Download Progress window opens. Do not intervene until the download 

process completes. 

14.   Every drive scheduled for firmware download will be designated as in 

progress until successful or failed.

Note:  Complete the following two steps if you receive a failure. 

a.   Click the Save as button to save the error log. 

b.   On the Subsystem Management window’s menu bar, click 

Advanced →Trouble Shooting → Open Event Log and complete 

the following tasks necessary to save the storage subsystem event 

log before contacting your IBM Service Representative and 

proceeding to step 16. 

1)   Click the Select all button. 

2)   Click Save the Storage Subsystem Event Log.

15.   When the Close button appears active, the drive firmware download process is 

complete. 

16.   Click Close to exit the Download Progress window. 

17.   Use either of the following procedures to determine or verify what level of drive 

firmware resides on a particular drive: 

v   Right-click on that drive in the Logical/Physical View in the Subsystem 

Management window and click Properties. The associated drive firmware 

version will be listed in the drive properties table. 

v   Right-click on Storage Subsystem → View Profile in the Logical/Physical 

View of the Subsystem Management window.

Downloading drive firmware with Storage Manager version 8.x 

To download drive firmware for DS4000 Storage Manager version 8.x, perform the 

following steps: 

 1.   From the Enterprise Management window, select a storage subsystem. 

 2.   Click Tools → Manage Device. The Subsystem Management window opens. 
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3.   Click Advanced → Download → Drive Firmware. The Download Drive 

Firmware window opens. It presents a list of all installed drives. 

 4.   From the list of all installed drives, select the drive to which you plan to 

download drive firmware. 

Press and hold the Ctrl key while using your mouse to select multiple drives 

singly, or press and hold the shift key while selecting multiple drives in series 

by using your mouse pointer. 

 5.   Click Browse to identify the directory that contains the drive firmware that you 

intend to download. 

 6.   Select the file containing the drive firmware that you intend to download. 

 7.   Select Start. The Confirm Download window appears. 

 8.   Type yes when the Confirm Download window prompts: Are you sure you 

want to continue? 

 9.   The download begins and the Status window indicates progress. Do not 

intervene until the download process completes. 

10.   When the Cancel button appears active, the download process is complete. 

Click Cancel to close the Status window. 

11.   To determine or verify the level of drive firmware residing on a particular drive, 

click View → Subsystem Profile in the Logical/Physical View of the Subsystem 

Management window.

Creating arrays and logical drives 

Important: You should create a storage subsystem profile and save it in a safe 

place whenever you modify the arrays and logical drives in your storage subsystem. 

This saved profile contains detailed controller information, including logical and 

physical disk configuration information that can help you recover the configuration in 

the event of a catastrophic failure. Do not save the profile in the logical drives for 

which you create this configuration information backup. 

To create a storage subsystem profile, select Storage Subsystem → View Profile 

in the Storage Subsystem Management window and click the Save As button when 

the Storage Subsystem Profile window opens. In addition, using firmware version 

06.1x.xx.xx, you can also select Advanced → Troubleshooting → Collect All 

Support Data as shown in Figure 27 on page 129 to collect all the various types of 

inventory, status, diagnostic and performance data from this storage subsystem and 

save them to a single compressed file.
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An array is a set of fibre channel or SATA hard drives that are logically grouped 

together to form a Redundant Array of Independent Disks (RAID). 

A logical drive is a logical structure, which is the basic structure that you create to 

store data on the storage subsystem. The operating system recognizes a logical 

drive as a single drive. Choose a RAID level to meet application needs for data 

availability and maximize fibre channel I/O performance. 

Maximum number of drives:  

1.   For firmware level 07.10.xx.xx, the maximum number of drives supported in an 

array is 30, regardless of the hard drive capacity. Each array can be divided into 

from 1 to 256 logical drives. 

2.   For firmware levels 05.4x.xx.xx and later, the maximum number of drives 

supported in an array is 30, regardless of the hard drive capacity. Each array 

can be divided into from 1 to 256 logical drives. 

3.   For firmware levels 05.3x.xx.xx and lower, the maximum number of hard drives 

supported for each array is 30 if the hard drive capacities are 73.4GB or less 

and 14 if the hard drive capacities are 146GB.

Note:  For cluster configurations, if you add or delete logical drives, you must make 

them known to both nodes A and B. 

Creating an array 

In the DS4000 Storage Manager Subsystem Management window, perform the 

following steps to create an array from unconfigured capacity nodes. 
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Figure 27. Collect All Support Data window
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1.   Use either of the following two methods to create a new array: 

v   Select Total Unconfigured Capacity node, and click Array → Create, or; 

v   Select and right-click Total Unconfigured Capacity node, and click Create 

Array.

The Introduction (Create Array) window opens. 

2.   Click Next to continue. 

3.   The Array Name & Drive Selection (Create Array) window opens. 

v   Array name—Enter a name for the new array. This name can be a maximum 

of 30 characters. 

v   Drive selection choices—Select one of the two options. 

–   Automatic (Recommended)—Choose from a list of automatically 

generated drive and capacity options. (This option is preselected by 

default.) 

–   Manual (Advanced)—Choose specific drives to obtain capacity for the new 

array.

v   Click Next to continue.

4.   The RAID Level and Capacity (Create Array) window opens. Specify the RAID 

level (redundancy protection). 

5.   Select the number of drives (overall capacity) for the new array. 

6.   Click Finish. 

7.   The Array Created window opens. If, at this point, you want continue the 

process to create a logical drive, click Yes; if you want to wait to create a logical 

drive at another time, click No.

Creating a logical drive 

In the DS4000 Storage Manager Subsystem Management window, perform the 

following steps to create a logical drive. 

 1.   In the Logical/Physical View tab of the Introduction (Create Logical Drive) 

window, you will see how much Free Capacity is available for all existing 

arrays. Select the Free Capacity of an array for which you want to create a 

new logical drive; then, right-click and select Create Logical Drive. 

 2.   Click Next. 

 3.   In the Specify Capacity/Name (Create Logical Drive) window, specify the 

following parameters for the logical drive you are creating. 

New logical drive capacity 

The capacity can either be the entire unconfigured capacity in an array 

or a portion of the array's capacity. 

Units Choose GB, MB, or TB, depending upon the capacity available. 

Name Choose a name that is unique in the storage subsystem, up to a 

maximum of 30 characters.

 4.   Under Advanced logical drive parameters, select from one of the options. 

v   Use recommended settings 

v   Customize settings (I/O characteristics and controller ownership) 

You can create the logical drive using the DS4000 storage subsystem 

recommended settings, or you can customize your I/O characteristics, 

controller ownership, and logical-drive-to-LUN mapping settings. To use the 

recommended (default) settings, select Use recommended settings, and click 

 

130 DS4000 Installation and Host Support Guide for Windows 2000/Server 2003, NetWare, ESX Server, and Linux



Next, then proceed to step 6. If you want to customize your settings, select 

Customize settings, and click Next, then proceed to step 5. 

 5.   In the Advanced logical drive parameters window, specify the appropriate I/O 

characteristics (characteristics type, segment size, and cache readahead 

multiplier). 

The I/O characteristics settings can be set automatically or they can be 

manually specified, based on one of the following logical drive usages—file 

system, database, or multimedia. Click Next. The Specify Logical Drive-to-LUN 

Mapping (Create Logical Drive) window opens. 

 6.   In the Specify Logical Drive-to-LUN Mapping (Create Logical Drive) window, 

specify the logical drive-to-LUN mapping. 

The logical drive-to-LUN mapping preference can be one of the following two 

settings: 

Default mapping 

The Automatic setting specifies that a LUN is automatically assigned to 

the logical drive using the next available LUN within the default host 

group. This setting grants logical drive access to host groups or host 

computers that have no specific logical drive-to-LUN mappings (those 

that were designated by the default host group node in the Topology 

view). If the Storage Partition feature is not enabled, you must specify 

the Automatic setting. In addition, you can also change the host type to 

match the host operating system. 

Map later using the Mappings View 

This setting specifies that you are not going to assign a LUN to the 

logical drive during creation. This setting enables you to define a 

specific logical drive-to-LUN mapping and create storage partitions 

using the Mappings Defined option. When you enable storage 

partitioning, specify this setting.

 7.   Click Finish to create the logical drive. The Creation Successful (Create 

Logical Drive) window opens and states that the logical drive was successfully 

created. 

 8.   In the Creation Successful (Create Logical Drive) window, click Yes and 

proceed to step 9, if you want to create another logical drive; otherwise, click 

No. When the Completed (Create Logical Drive) window opens, click OK, and 

continue with step 10. 

 9.   In the Allocate Capacity (Create Logical Drive) window, choose to create the 

new logical drive from free capacity on the same array, free capacity on a 

different array, or from unconfigured capacity (create a new array). Then 

continue with step 1 on page 130. 

10.   The Completed (Create Logical Drive) window opens. Click OK. 

11.   Register the logical drive with the operating system. 

After you create logical drives with automatic logical drive-to-LUN mappings, 

follow the appropriate instructions in the Installation and Support Guide for your 

operating system to allow it to discover the new logical drive.

Verifying and defining the default host type 

Before you use the logical drives in a host computer, you must specify the correct 

host type. For information on available host types, see “Host type options” on page 

133. The host type determines how the storage subsystem controllers will work with 

each particular operating system on the hosts to which it is connected. If all of the 

host 
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computers connected to the same storage subsystem are running the same 

operating system, and you do not want to define partitioning, you can define a 

default host type. 

To verify the current default host type, perform the following steps: 

1.   In the Subsystem Management window, click Storage subsystem → View 

profile. A Storage Subsystem Profile window opens. 

2.   Click the Mappings folder tab and scroll down to NVSRAM Host Type Index 

Definitions. The host type name of the index that has the word DEFAULT next 

to it is the default host type. 

3.   Click Close.

To define a default host type, perform the following steps: 

1.   Click Storage subsystem → Change → Default host-type. The Default 

Host-type window opens. 

2.   From the pull-down list, select the host type. 

3.   Click OK.

If you have hosts with different operating systems or if you want to define partitions 

for the hosts, continue with “Configuring heterogeneous hosts.” 

Configuring heterogeneous hosts 

The heterogeneous hosts feature enables hosts running different operating systems 

to access a single storage subsystem. Previous releases of DS4000 Storage 

Manager (versions 7.02 or earlier) required that hosts run the same operating 

system in order to access a single storage subsystem. 

Overview of heterogeneous hosts 

Host computers can run completely different operating systems (for example, 

Solaris) or variants of the same operating system. When a host type is specified in 

the Define New Host Port window, the heterogeneous hosts feature enables the 

controllers in the storage subsystem to tailor their behavior (such as LUN reporting) 

to the needs of the host. 

Important: To use the heterogeneous host feature, you must meet the following 

conditions: 

v   You must enable storage partitioning. 

v   During host-port definition, you must set each host type to the appropriate 

operating system so that the firmware on each controller can respond correctly to 

the host.

Note:  Partitioning is a premium feature. If you disable partitioning, you must 

contact your IBM technical support representative to obtain a key to enable 

partitioning again. This is not a standard feature with the DS4300. 

Storage Partitioning: Defining a host group 

A host group is an entity in the Storage Partitioning topology that defines a logical 

collection of host computers that require shared access to one or more logical 

drives. You can grant individual hosts in a defined host group access to storage 

partitions, independently of the host group. You can make logical drive-to-LUN 

mappings to the host group or to an individual host in a host group. 
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Notes:  

1.   On the DS4800 storage subsystem, DS4000 Storage Manager version 10.10 

increases the maximum number of storage partitions from 64 to 512. 

2.   On the DS4700 and DS4200 storage subsystem, DS4000 Storage Manager 

version 10.10 increases the maximum number of storage partitions from 64 to 

128.

If you have purchased a Storage Partitioning premium feature, ensure that the 

premium feature is enabled. 

Steps for defining a host group:   Complete the following steps to define a host 

group. 

Before you begin: Note the following information. 

v    Create the host group at the storage subsystem level. Do not create host groups 

at the default group level. 

Exception: If you are running a DS4000 configuration without partitioning 

enabled, you can use the default host group.

1.   Click the Mappings View tab on the Subsystem Management window. 

2.   In the Topology section of the Mappings window, highlight the name of the 

storage subsystem, and click Mappings → Define → Host Group.

Note:  Make sure that the storage subsystem is highlighted in the left panel of 

the Subsystem Management window. Do not highlight Undefined 

Mappings. 

3.   Type a name for the new host group. Click Add, and then click Close. 

4.   Highlight the new host group and click Mappings → Define → Host. 

5.   Type the name of the host to which the storage subsystem is attached. Click 

Add, and then click Close. 

6.   Highlight the host that you just added, then right-click and select Define Host 

Port. 

7.   Select the host port identifier (WWPN) for the first HBA (for example, 

10:00:00:00:c9:24:0c:3f). If you do not see the identifier that you are looking for, 

see the note at the end of this procedure. 

8.   Change the host type and click Add.

Important:  Failure to change the host type from the default might cause 

undesired results. See “Host type options” for a list of host types 

you can use for each host operating system. 

9.   If you are configuring an additional HBA to this partition, choose the host port 

for the next HBA and click Add, and then click Close.

Important:  If you do not see the host port identifier that you want in the host port 

identifier drop-down menu, you can enter it manually. Otherwise, verify 

that the switch is properly zoned and cabled.

Host type options:   The following host type options are available for specification. 

1.   Windows 

v   Windows NT® Non-clustered (SP5 or later. Supports RDAC only multipath 

driver.) 

This host type is not available for DS4000 storage subsystems with controller 

firmware (and associated NVSRAM file) version 6.14.xx.xx to version 6.23. 
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v   Windows NT Clustered (SP5 or later. Supports RDAC only multipath driver.) 

This host type is not available for DS4000 storage subsystems with controller 

firmware (and associated NVSRAM file) version 6.14.xx.xx to version 6.23. 

v   Windows 2000/Server 2003 Non-clustered (supports RDAC or MPIO) 

v   Windows 2000/Server 2003 Clustered (supports RDAC or MPIO) 

v   Windows 2000/Server 2003 Non-clustered (Supports Symantec/VERITAS 

Dynamic Multipathing [DMP]) 

v   Windows 2000/Server 2003 Clustered (Supports Symantec/VERITAS 

Dynamic Multipathing [DMP])

2.   Linux 

v   Linux 

This host type is intended for use with fibre channel HBA multipath 

failover/failback device driver (non-RDAC). 

v   LNXCLVMWARE 

This host type is also referred to as LNXCL in the DS4000 storage 

subsystems with NVSRAM files loaded from before DS4000 Storage 

Manager 10.10. 

v   LNXCL 

This host type is intended for use with RDAC as the multipath 

failover/failback device driver.

3.   NetWare 

v   NetWare-IBMSAN 

This host type is intended for use with IBMSAN as multipath failover/failback 

device driver. It is not available for DS4000 storage subsystems with 

controller firmware (and associated NVSRAM file) version 07.10. 

v   NetWare Failover 

This host type is intended for use with Novell native multipath failover/failback 

device driver.

4.   VMware ESX Server 

Currently, a VMware ESX Server-specific host type is not available for DS4000 

storage subsystems. Use one of the following Linux host types for your VMware 

ESX Server host: 

v   Linux 

Use this host type for VMware ESX Server. 

v   LNXCLVMWARE 

This host type is also referred to as LNXCL in the DS4000 storage 

subsystems with NVSRAM files loaded from before DS4000 Storage 

Manager 07.10.

Mapping LUNs to a partition 

This section includes the following topics: 

v   “Mapping LUNs to a new partition” 

v   “Adding LUNs to an existing partition” on page 135

Mapping LUNs to a new partition 

When mapping LUNs for the first time to a newly created partition, complete the 

following steps to map LUNs to the partition: 

1.   Select the Mappings view of the Subsystem Management window. 
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2.   In the Topology section, right-click the host on which you want to map LUNs, 

and select Define Storage Partitioning. The Define Storage Partitioning 

window opens. 

3.   In the Define Storage Partitioning window, select Host, then click Next. 

4.   Select the logical drive by name, on the right side of the window. 

5.   Accept the default LUN ID, or change it, then click Add. 

6.   Repeat step 5 for each LUN that you want to map to the partition.

Adding LUNs to an existing partition 

When adding LUNs to an existing partition, complete the following steps to map the 

new LUNs to the partition: 

1.   Select the Mappings view of the Subsystem Management window. 

2.   In the Topology section, right-click the host on which you want to map LUNs, 

and select Define Additional Mappings. The Define Additional Mapping 

window opens. 

3.   In the Define Additional Mapping window, select the following options, and then 

click Add: 

v   Host group or host 

v   Logical unit number (LUN)(0-255) 

v   Logical drive

Repeat these steps for each LUN that you want to add to the partition. 

Creating a FlashCopy logical drive 

A FlashCopy logical drive is a logical point-in-time image of a logical drive, called a 

base logical drive. A FlashCopy logical drive has the following features: 

v   It is created quickly and requires less disk space than an actual logical drive. 

v   It can be assigned a host address, so that you can perform backups by using the 

FlashCopy logical drive while the base logical drive is online and accessible. 

v   You can use the FlashCopy logical drive to perform application testing or both 

scenario development and analysis. This does not effect the actual production 

environment. 

v   The maximum number of FlashCopy logical drives allowed is one half of the total 

logical drives supported by your controller model.

For additional information about the FlashCopy feature and how to manage Flash 

Copy logical drives, refer to the Storage Manager Subsystem Management online 

help. 

Note:  FlashCopy is a premium feature. Contact your IBM reseller or IBM marketing 

representative for more information. 

Important: The FlashCopy drive cannot be added or mapped to the same server 

that has the base logical drive of the FlashCopy logical drive in a Windows 2000, 

Windows Server 2003, or NetWare environment. You must map the FlashCopy 

logical drive to another server. 

Perform the following steps to create a FlashCopy logical drive: 

1.   To ensure that you have the accurate point-in-time image of the base logical 

drive, stop applications and flush cache I/O to the base logical drive. 

2.   Open the Subsystem Management window. From the Logical View, right-click 

the base logical drive. 
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3.   Select Create FlashCopy Logical Drive. The Create FlashCopy Logical Drive 

Wizard starts. 

4.   Follow the on-screen instructions. 

5.   Refer to the Subsystem Management online help for instructions on how to add 

the FlashCopy logical drive to the host.

Using VolumeCopy  

The VolumeCopy feature is a firmware-based mechanism for replicating logical 

drive data within a storage array. This feature is designed as a system management 

tool for tasks such as relocating data to other drives for hardware upgrades or 

performance management, data backup, or restoring snapshot volume data. Users 

submit VolumeCopy requests by specifying two compatible drives. One drive is 

designated as the Source and the other as the Target. The VolumeCopy request is 

persistent so that any relevant result of the copy process can be communicated to 

the user. For more information about this feature, see the IBM System Storage 

DS4000 Storage Manager 10 Copy Services User’s Guide, or contact your IBM 

reseller or marketing representative. 

Using the Remote Mirror option 

The Remote Mirror option is a premium feature. It is used for online, real-time 

replication of data between storage subsystems over a remote distance. In the 

event of a disaster or unrecoverable error at one storage subsystem, the Remote 

Mirror option enables you to promote a second storage subsystem to take over 

responsibility for normal input/output (I/O) operations. For more information about 

this feature, see the IBM DS4000 Remote Mirror Option Installation and User’s 

Guide, or contact your IBM reseller or marketing representative. 

Performing other storage subsystem management tasks 

The following list includes other storage subsystem management tasks that you can 

perform: 

v   Locating a storage subsystem 

v   Viewing a storage subsystem profile or event log 

v   Entering or changing a storage subsystem password 

v   Creating and managing logical drives and arrays 

v   Using the Performance Monitor 

v   Creating storage partitions (if applicable) and heterogeneous hosts 

v   Viewing or changing media scan settings 

v   Increasing capacity of an array or logical drive 

v   Changing RAID level for an array 

v   Monitoring read-link-status error counts

Note:  To create storage partitions, you must obtain the worldwide name or port of 

each host adapter in every host connected to the storage subsystem. 

For more information about these and other storage subsystem management tasks, 

refer to the appropriate topics in the Subsystem Management online help. 
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Chapter  9.  Completing  storage  management  tasks  for  

Windows  hosts  

This chapter provides information about how to add or delete logical drives, create 

FlashCopy logical drives, use the hot_add and SMdevices utilities, start and stop 

the host-agent software, and uninstall Storage Manager components in Windows 

host operating system environments. 

Using the storage management software for Windows 

This section provides information about how to add or delete logical drives, create 

FlashCopy logical drives, use the hot_add and SMdevices utilities, start and stop 

the host-agent software, and uninstall Storage Manager components in a Windows 

operating system environment. 

Adding or deleting logical drives 

Use the following procedures to add or delete logical drives in a standard 

(noncluster) and a cluster configuration. 

Standard (noncluster) configuration for Windows 2000 

Use the following procedures to create or delete logical drives in a standard server 

environment for Windows 2000. 

Creating logical drives:   When you create logical drives with the storage 

management software, you must add the new logical drives to Windows 2000. Each 

logical drive (not array) is recognized by Windows 2000 as a single drive. 

After creating logical drives, run the hot_add and SMdevices utilities that are 

provided with the storage management software. The hot_add utility adds newly 

created logical drives to the operating system without requiring a system restart. 

The SMdevices utility identifies the logical drives by their associated operating 

system device names. For more information, see “Using the hot_add utility” on page 

140 or “Using the SMdevices utility” on page 140. 

Deleting logical drives:  

Attention: Do not click Configuration → Reset if you have data or logical drives 

that you want to keep. This action resets the controller unit and deletes all 

previously configured logical drives. 

Before you delete logical drives with the storage management software or use 

Configuration → Reset, perform the following steps: 

1.   Use the Disk Administrator to delete any partitions and to unassign drive letters 

that are associated with the logical drives. 

2.   Restart the system to remove the configuration information.

Attention:  You must use the Disk Administrator to delete OS partitions and 

unassigned drive letters before you delete logical drives or reset the configuration in 

Storage Manager. Take this action to avoid damage to your registry information. 

Cluster server configuration for Windows 2000 

Use the following procedures to create or delete logical drives in a cluster server 

environment for Windows 2000. 
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Creating logical drives:   To add logical drives in a Windows 2000 cluster server 

environment, perform the following steps: 

1.   Using the IBM DS4000 Storage Manager Client, create arrays and assign them 

to the appropriate host group by using storage partitioning. 

2.   Use the hot_add utility to add the new logical drives to node A. 

3.   Using the Disk Administrator, create, format, and assign drive letters to the disk 

partitions on the new logical drives. 

4.   Use the hot_add utility to add the new logical drives to node B. 

5.   Using the Disk Administrator, ensure that the drive letters assigned to the disk 

partitions on the logical drives are the same on both node A and node B. 

6.   Restart node A. Then use the Cluster Administrator to create cluster physical 

disk resources using the new disk partitions on the new logical drives. 

7.   Bring the cluster resources online in node A. 

8.   Use cluster administrator to move the cluster physical disk resources to node B. 

9.   Verify that the resources come online in node B.

Deleting logical drives:  

Attention: Do not click Configuration → Reset in the Storage Manager Client 

Storage Subsystem management window if you have data or logical drives that you 

want to keep. This action resets the controller unit and deletes all previously 

configured logical drives. 

Before you delete logical drives with the storage management software or use 

Configuration → Reset in the Storage Manager Client Storage Subsystem 

management window, perform the following steps: 

1.   Use the Cluster Administrator to delete the cluster physical disk resources that 

own the logical drives that will be deleted. 

2.   Use the Disk Administrator to delete any partitions and to unassign drive letters 

that are associated with the logical drives. 

3.   Restart the system to remove the configuration information.

Attention:  You must use the Cluster Administrator and Disk Administrator to 

delete the cluster physical disk resources, delete OS partitions, and unassigned 

drive letters before deleting logical drives or resetting the configuration in Storage 

Manager. This avoids damage to your registry information. 

Standard (non-clustered) configuration for Windows Server 2003 

Use the following procedures to create or delete logical drives in a standard 

environment. 

Creating logical drives:   When you create logical drives with the storage 

management software, you must add the new logical drives to the Windows Server 

2003 operating system. Each logical drive (not array) is recognized by Windows 

Server 2003 as a single disk drive. 

After creating logical drives, run the hot_add and SMdevices utilities that are 

provided with the storage management software. The hot_add utility adds newly 

created logical drives to the operating system without requiring a system restart. 

The SMdevices utility identifies logical drives by their associated operating system 

device names. For more information, see “Using the hot_add utility” on page 140 or 

“Using the SMdevices utility” on page 140. 
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Deleting logical drives:  

Attention: Do not click Configuration → Reset in the Storage Manager Client 

Storage Subsystem management window if you have data or logical drives that you 

want to keep. This action resets the controller unit and deletes all previously 

configured logical drives. 

Before you delete logical drives with the storage management software or use 

Configuration → Reset in the Storage Manager Client Storage Subsystem 

management window, perform the following steps: 

1.   Use the Disk Administrator to delete any partitions and to unassign drive letters 

that are associated with the logical drives. 

2.   If possible, restart the system to remove the configuration information.

Attention:  You must use the Disk Administrator to delete the cluster physical disk 

resources, delete OS partitions, and unassigned drive letters before you delete 

logical drives or reset the configuration in Storage Manager. This action avoids 

damage to your registry information. 

Cluster server configuration for Windows Server 2003 

Use the following procedures to create or delete logical drives in a cluster server 

environment. 

Creating logical drives:   To add logical drives in a Windows Server 2003 cluster 

server environment, perform the following steps: 

1.   Use the IBM DS4000 Storage Manager Client program to create arrays and 

logical drives and use storage partitioning to assign them to the appropriate 

cluster host group. 

2.   Use the hot_add utility to add the new logical drives to the cluster node that is 

currently owned by the cluster quorum resource. 

3.   Use the Disk Administrator program to create, format, and assign drive letters to 

the disk partitions on the new logical drives. 

4.   In each of the rest of the cluster nodes in the cluster configuration, use the 

hot_add utility to add the new logical drives to the cluster node. 

5.   In the first cluster node, use the Cluster Administrator program to create cluster 

physical disk resources using the new disk partitions on the new logical drives.

Note:  If the new disk does not show up in the available disk pull-down list when 

you go through the Cluster Administrator program, you might have to 

reboot the server. 

6.   Bring the cluster resources online in the first cluster node. 

7.   Use the Cluster Administrator to move the newly-created cluster physical disk 

resources to other nodes in the cluster configuration. 

8.   Verify that the resources come online in other nodes in the cluster configuration.

Deleting logical drives:  

Attention: Do not click Configuration → Reset in the Storage Manager Client 

Storage Subsystem management window if you have data or logical drives that you 

want to keep. This action resets the controller unit and deletes all previously 

configured logical drives. 
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Before you delete logical drives with the storage management software or use 

Configuration → Reset in the Storage Manager Client Storage Subsystem 

management window, perform the following steps: 

1.   Use the Cluster Administrator to delete the cluster physical disk resources that 

own the logical drives that will be deleted. 

2.   Use the Disk Administrator to delete any partitions and to unassign drive letters 

that are associated with the logical drives. 

3.   If possible, restart the cluster nodes to remove the configuration information.

Attention:  You must use the Cluster Administrator and Disk Administrator to 

delete the cluster physical disk resources, delete OS partitions, and unassigned 

drive letters before you delete logical drives or reset the configuration in Storage 

Manager. This action avoids damage to your registry information. 

Using the hot_add utility 

The hot_add utility enables you to add new logical drives without restarting the 

system. The utility registers the new logical drives with the operating system so that 

you can use Disk Administrator to create partitions, add device names, and so on. 

The hot_add utility is part of the SMutil software package. If you run the program 

twice and the new logical drives are not displayed in the Disk Administrator window, 

you must either run fibre channel diagnostics or restart (reboot) the host. 

When you finish creating logical drives on a particular storage subsystem, go to the 

host that is attached to that storage subsystem and perform the following steps to 

use the hot_add utility: 

1.   From a DOS or command prompt, change to the directory 

<installation_directory>\Util 

...where installation_directory is the directory in which you installed the 

SMutil. 

The default directory is c:\Program Files\IBM_DS4000\Util. 

2.   From a DOS or command prompt, type the following command: 

hot_add 

3.   Press Enter. The new logical drives are available through the Disk Administrator.

Using the SMdevices utility 

The SMutil software includes a utility called SMdevices that you can use to view the 

storage subsystem logical drive that is associated with a particular operating system 

device name. This utility is helpful when you want to create drive letters or partitions 

by using Disk Administrator. 

When you finish creating the logical drives on a particular storage subsystem, go to 

the host that is attached to that storage subsystem, and perform the following steps 

to use SMdevices: 

1.   From a DOS or command prompt, change to the directory 

<installation_directory>\Util 

...where installation_directory is the directory in which you installed the 

SMutil. 

The default directory is c:\Program Files\IBM_DS4000\Util. 

2.   Type: 

SMdevices 
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3.   Press Enter. The software displays device identification information. For 

example, you might see the following information. 

 \\.\PHYSICALDRIVEx [Storage Subsystem Finance, Logical Drive DEBIT, LUN xx, 

WWN <worldwide_name>]
  

where: 

v   x is the Disk number that displays in Disk Administrator 

v   Finance is the name of the storage subsystem 

v   DEBIT is the name of the logical drive 

v   xx is the LUN associated with the logical drive 

v   worldwide_name is the worldwide name for the logical drive

Using the SMrepassist utility 

You can use the SMrepassist utility to perform the following tasks: 

v   Flush cached data for a logical drive.

Important: The FlashCopy drive can not be added or mapped to the same server 

that has the base logical drive of the FlashCopy logical drive in a Windows 2000, 

Windows Server 2003, or NetWare environment. You must map the FlashCopy 

logical drive to another server. 

To flush cached data in a logical drive, perform the following steps: 

1.   From a DOS or command prompt, change to the directory 

<installation_directory>\Util 

...where installation_directory is the directory in which you installed the 

SMutil. 

The default directory is c:\Program Files\IBM_DS4000\Util. 

2.   Type the following command: 

smrepassist -f logical_drive_letter: 

where logical_drive_letter is the operating system drive letter that was assigned 

to the disk partition created on the logical drive. 

3.   Press Enter.

Stopping and restarting the host-agent software 

You must stop and restart the host-agent software if you add additional storage 

subsystems to the management domain of the host-agent software. When you 

restart the service, the host-agent software discovers the new storage subsystems 

and adds them to the management domain. 

Note:  If none of the access logical drives are detected after a restart, the 

host-agent software automatically stops running. Make sure that there is a 

good fibre channel connection from the host to the SAN to which the storage 

subsystem is connected. Then restart the host or cluster node so that new 

host-agent-managed storage subsystems can be discovered. 

Windows 2000 

To stop and restart the host-agent software, perform the following steps: 

1.   Click Start → Programs → Administrative Tools → Services. The Services 

window opens. 

2.   Right-click IBM DS4000 Storage Manager Agent. 
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3.   Click Restart. The IBM DS4000 Storage Manager Agent stops and then starts 

again. 

4.   Close the Services window.

Windows Server 2003 

To stop and restart the host-agent software, perform the following steps: 

1.   Click Start → Administrative Tools → Services. The Services window opens. 

2.   Right-click IBM DS4000 Storage Manager Agent. 

3.   Click Restart. The IBM DS4000 Storage Manager Agent stops and then starts 

again. 

4.   Close the Services window.

Uninstalling storage management software components 

If you are upgrading from any Storage Manager version 08.x, 09.10, or 09.23, it will 

be necessary for you to remove all of the currently installed software before 

installing Storage Manager 10.10. No reboot is required after removing a Storage 

Manager software package version 08.3x or earlier. Existing storage array 

mappings and storage partition configurations are retained during software removal 

and will be recognized by the new client software. 

Use the following procedure to uninstall one or more of the components of Storage 

Manager 08.x or 09.1x. If you are uninstalling components released with an earlier 

version of the storage management software, use the uninstall procedure that came 

with the version of the storage management software that you are currently running. 

Note:  Starting with DS4000 Storage Manager 09.12, it is possible to update the 

installed host-software with the newer versions without uninstalling the 

existing installed version first. (The DS4000 Storage Manager host-software 

packages must be a later version than the installed Storage Manager version 

09.12 host-software packages.) Just click OK when you are prompted that 

existing versions of the host-software were already installed in the host 

server and whether you want to update them or not. Use the uninstallation 

instructions only when, for some reason, you are not able to update the 

existing installed host-software or you do not want the DS4000 Storage 

Manager host-software packages installed on the server. 

Important: 

v   Do not uninstall the RDAC or MPIO driver unless instructed by an IBM technical 

support representative. The host-agent package requires RDAC to function 

properly. If you uninstall RDAC in a coexistence environment, you will lose fibre 

channel I/O path failover support for both the version 08.xx and version 09.xx of 

Storage Manager. 

v   Do not uninstall the multipath driver (RDAC or MPIO) by right-clicking on the 

appropriate entry in the SCSI and RAID Controllers tree node in the Device 

Manager folder of the Microsoft Windows Computer Management window and 

select Uninstall option. Always use the DS4000 host software uninstallation 

wizard to remove any of the installed host software packages. 

v   If you have RDAC installed, you cannot update the RDAC with the MPIO 

multipath driver version without uninstalling the existing installed RDAC version 

first and reboot the host server. Similarly, if you have MPIO installed, you must 

uninstall the existing installed MPIO version first and reboot the host server 

before you can install the RDAC driver. 
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v   When rebooting the server after uninstalling the multipath (RDAC or MPIO) 

driver, the server might take a long time to shut down and to go through the 

Microsoft Windows boot screen. If possible, stop the applications that rely on the 

DS4000 logical drives and then disconnect/disable the fibre channel connections 

to the server to improve boot time.

Uninstalling Storage Manager version 9.12 or later 

1.   Click Start → Settings → Control Panel. The Control Panel window opens. 

Select Add/Remove programs. The Add/Remove Programs Properties window 

opens. 

2.   Look for the entry IBM DS4000 Storage Manager Host Software v09.xx.x5.yy 

where xx or yy will be the main release (i.e., 12) and the version (i.e,. 08) 

values, respectively. 

3.   Select the above entry and click Change/Remove button. The Uninstall 

Program opens. 

4.   Click Next. The Uninstall options window opens. 

5.   Select either to uninstall all installed DS4000 host-software packages or 

uninstall certain specific packages only and click Next. 

6.   If you choose to uninstall a certain host-software package, a Choose Product 

Features window will be opened to allow you selecting the host-software 

package(s) that you want to uninstall. Click Uninstall to start the uninstallation 

process. Otherwise, the program will begin the uninstallation of all of the 

installed host-software packages. 

7.   Click Done when the window open to complete the DS4000 host-software 

uninstallation process. If you are uninstalling RDAC, you will need to reboot the 

host server.

Uninstalling Storage Manager version 8.x or 9.10 

1.   Click Start → Settings → Control Panel. The Control Panel window opens. 

Select Add/Remove programs. The Add/Remove Programs Properties window 

opens. 

Note:  Uninstall the Storage Manager components in the following order: 

a.   SMagent 

b.   SMutil 

c.   RDAC 

d.   SMclient

2.   Select the component you want to uninstall from the list of programs (for 

example, IBM DS4000 Storage Manager Client). 

3.   Click Add/Remove. The Confirm File Deletion window opens. 

4.   Click Yes to start the uninstallation process. 

5.   When the uninstallation is complete, click OK. If you are uninstalling RDAC 

version 08.4x.xx.xx or newer, you will need to reboot the host server
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Chapter  10.  SAN  boot  with  Windows  Server  2003  

This chapter details the procedure for installing Windows Server 2003 (i386 (32bit) 

and x86_64 (32/64bit) Enterprise Edition with SP1) environment, using Storport 

miniport or SCSIport miniport drivers onto a System x host. It is assumed that no 

installation is present to work from, and when completed, the boot and swap will be 

running on RDAC virtual disk devices. 

Note:  Refer to the readme supplied with the host system software RDAC driver, for 

latest updates or limitations for SAN Boot. 

System configuration requirements 

Prior to beginning this SAN boot installation procedure, you must have knowledge 

of the following: 

v   Microsoft Windows installation: 

–   Network configuration 

–   Computer Management 

–   Microsoft Update 

http://www.microsoft.com/windowsserver2003/default.mspx

v   SAN Infrastructure/Switches/Zoning (This is required if the system is not directly 

connected to the storage array.) 

v   IBM System Storage Manager DS4000 Software: 

–   Storage Manager 

–   RDAC driver

Note:  The RDAC driver is bundled and installed with the IBM System Storage 

Manager (Storage Manager) software, which is available for download 

at: 

http://www-03.ibm.com/servers/storage/support/allproducts/
downloading.html. 

–   SMclient 

–   SMagent

Note:  Other Storage Manager (SM) tools are also available. For more 

information, see: 

http://www-03.ibm.com/servers/storage/support/allproducts/
downloading.html. 

v   Fibre channel host bus adapters (HBAs) and utilities (both vendor-specific): 

–   QLogic 

–   Emulex

Note:  QLogic and Emulex host bus adapters are specifically indicated for this 

installation procedure. Other HBAs may be supported but are not 

referred to here.

In addition to possessing knowledge of Windows, SAN, Storage Manager, and fibre 

channel host bus adapters, you must also have the following hardware and 
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software available (for DS4000 Storage Manager installation and configuration, see 

Chapter 3, “Installing Storage Manager software in a standard Windows 

configuration,” on page 57): 

v   Server Hardware: 

–   CDROM 

–   1.44 FDD 

–   Network connection 

–   Fibre HBA

v    DS4000: 

–   Current controller firmware / NVSRAM / ESM firmware / disk firmware 

–   Storage Manager V09.12.G5.20 or greater (includes RDAC driver) 

–   The SAN boot LUN must be set to LUN 0

v    HBA driver: 

–   Storport miniport driver on FDD (vendor-specific HBA), or 

–   SCSIport miniport driver on FDD (vendor-specific HBA) 

Attention:  Installation of Storage Manager on a separate computer is required to 

facilitate configuration of the DS4000, before beginning the installation of the SAN 

boot server. 

Installation prerequisites 

Prerequisites to the Windows SAN installation process include all of the following: 

v   The installation target must be single-pathed before beginning the installation. 

During any SAN boot procedure, there should only be a single logical path to the 

LUN where the boot volume will reside. 

v   A copy of Windows, accessible either from a network location, via RIS, or 

available on CD. 

v   Be familiar with the Windows installation, which includes understanding what 

packages will be installed or are required for the initial installation. 

v   Be familiar with how to setup a SAN network or direct attached SAN storage 

devices so that the host system can access LUNs from those storage systems. 

Refer to the Storage Manager Guide for setup and installation of the storage 

array. Because this is a SAN boot installation (see the “Installation procedure” on 

page 148), a secondary host is required for all initial installations, as well as for 

setup of the storage array. After installation, the storage array may then be 

managed from the SAN booted system.

 Attention:  Before continuing with this Windows SAN boot installation 

procedure, see the “Process for a new installation” on page 57, for instructions 

about installing Storage Manager on a separate host. 

v   Be familiar with creating LUNs on a DS4000 storage subsystem and with 

mapping them to a host. Although RDAC will perform correctly in single path 

environments, it is recommended that there be redundant physical paths to the 

devices from the host after installation. 

v   It is recommended that the internal disk drive controllers for the server be 

disabled in the server BIOS. 

v   Optional: Ensure there will be network access to the system.

Configuration of Windows installation volume 

Configuring the Windows installation volume is a prerequisite of the SAN 

installation. The configuration steps are provided here. 
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v   The boot device that will be used for installation and booting should be at least 

4GB in size. This is the minimum size for installing a base windows server 

system. Depending on the server configuration, the windows installation volume 

may need to be considerably larger. 

v   It is recommended that the Windows installation volume be mapped to the host 

as LUN 0 on the storage array. Ensure that the LUN’s preferred path on the 

DS4000 is set to the DS4000 controller that is connected and configured to the 

server's fibre channel host bus adapter (HBA).

Server BIOS configuration 

Although it is not required, IBM recommends that any internal SCSI or IDE disk 

controllers be disabled in the server BIOS prior to the SAN installation procedure. 

Configuring Emulex fibre channel HBAs 

Configuring an Emulex fibre channel HBA device is a prerequisite of the SAN 

installation. The configuration steps are provided here.

Note:  It is assumed that the boot BIOS has been installed on the Emulex card. 

This is usually done as part of the firmware installation with an Emulex utility 

like HBAnywhere or LP6DUTIL. Before continuing, verify that the boot BIOS 

is installed. 

__ Step 1.   During power-on of the host, select ALT-E to enter the Emulex boot 

BIOS. 

__ Step 2.   Select the HBA to be used for booting. This would be the HBA directly 

connected to, or zoned to, the LUNs preferred controller. 

__ Step 3.   Configure the adapter parameters, so the boot BIOS is enabled. 

__ Step 4.   Configure the BIOS, so the boot LUN (defined as part of the DS4000 

setup) is available and selected as the preferred boot device. For more 

information, refer to the Emulex BIOS setup documentation. 

Before proceeding with the final steps for configuring the Emulex fibre 

channel HBA, you must perform setup of the HBA on the storage array. 

Follow the steps here exactly as they are presented. 

__ Step a.   The HBA must be logged into the storage subsystem; and, 

even though no LUN will be available yet, you can use the 

BIOS to discover the storage subsystem. 

__ Step b.   Once the storage subsystem has discovered the HBA 

WWPNs, you must configure them as the HBAs to the boot 

LUN, using the host mapping procedures. 

__ Step c.   Now, the BIOS can be used to discover the newly 

configured LUN.

__ Step 5.   Use x to save. 

__ Step 6.   Reboot the server.

Configuring QLogic fibre channel HBA devices 

Configuring a QLogic fibre channel HBA device is a prerequisite of the SAN 

installation. The configuration steps are provided here. 

__ Step 1.   Verify that the QLogic fibre channel HBA devices configured for the host 

have been set up to have their boot BIOS enabled. This will allow for 

booting the installation LUN after the initial installation. 

__ Step 2.   During power-on of the host, select CNTL-Q to enter the QLogic boot 

BIOS. 

__ Step 3.   Select the HBA to be used for booting. This would be the HBA directly 

connected to, or zoned to, the LUNs preferred controller. 
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__ Step 4.   Configure the DS4000 device from which the system will be booted. If 

the utility cannot see the correct device or LUNs, check the SAN and 

DS4000 configurations before continuing. For more information, refer to 

the QLogic BIOS setup documentation. 

Before proceeding with the final steps for configuring the QLogic fibre 

channel HBAs, you must perform setup of the HBAs on the storage 

array. Follow the steps here exactly as they are presented. 

__ Step a.   The HBA must be logged into the storage subsystem; and, 

even though no LUN will be available yet, you can use the 

BIOS to discover the storage subsystem. 

__ Step b.   Once the storage subsystem has discovered the HBA 

WWPNs, you must configure them as the HBAs to the boot 

LUN, using the host mapping procedures. 

__ Step c.   Now, the BIOS can be used to discover the newly 

configured LUN.

__ Step 5.   Save and exit. 

__ Step 6.   Reboot the server.

Installation procedure 

The following procedure will step you through the complete SAN installation 

process. 

__ Step  1.   Boot the system from the Microsoft Windows Server 2003 CD or 

network RIS server. If using an RIS server, before proceeding refer to 

the RIS documentation about adding additional drivers. 

http://technet2.microsoft.com/WindowsServer/en/library/a6e23f3c-c982-
49b4-940d-bd0fd54cd4201033.mspx?mfr=true 

__ Step  2.   Press F6, when the following message appears at the bottom of the 

screen: 

Press F6 if you need to install a third party SCSI or RAID Driver 

QLogic 24xx 4GB HBA drivers must be available on floppy diskette for 

the Windows installation. (QLogic 23xx series SCSIport miniport 

drivers are supplied on the Windows Server 2003 CD and can be 

used during this installation. The driver can be updated later.) If 

Storport miniport drivers are to be used, they also may be installed 

during this procedure. 

Emulex HBA SCSIport or Storport drivers should be downloaded from 

the IBM Web site and made available on floppy disk for the 

installation. 

http://www-304.ibm.com/jct01004c/systems/support/supportsite.wss/
storageselectproduct?brandind=5000028&familyind=0&oldfamily=0

Note:  For x86_64 systems, the 64-bit driver must be used. If the 

32-bit driver is used, the Windows installation will throw an error 

stating that the 32-bit driver cannot be used. If this occurs, 

verify that the correct driver, including the architecture time, was 

copied to the floppy disk. 

__ Step  3.   Continue with the installation. 

__ Step  4.   For Windows Server 2003 the following message will appear: 

S = Specify additional Device 
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__ Step  5.   When prompted for third party software, insert the manufacturer's 

diskette and press ENTER. If the diskette is already in the floppy drive 

there will be no insert diskette prompt. 

__ Step  6.   When the appropriate adapter appears, select it and press ENTER. 

__ Step  7.   This message may appear: 

 The driver you provided seems to be newer 

than the Windows default driver. 

__ Step  8.   Press S, when 

S = Use the driver on floppy 

__ Step  9.   Continue with the standard installation. 

__ Step 10.   Windows setup will ask you to 

Specify Additional Devices. 

If there are no additional devices, press ENTER to continue. 

__ Step 11.   Before the system reboots you may be prompted to remove the floppy 

diskette and/or the Windows CD. (After the installation is complete, 

you may need the Windows CD to complete the configuration.) 

__ Step 12.   Once installation is complete, reboot and logon as Administrator. 

If the base installation did not include Windows Server 2003, install it 

now. Continue with the next step in this procedure. 

__ Step 13.   A Windows Server 2003 Hotfix must be applied to the system before 

Storage Manager is installed. Install the Hotfix and restart Windows. 

Notes:  

a.   The Microsoft Hotfix can be found at: 

www.microsoft.com/downloads. 

b.   An update for Windows Server 2003 x86 Edition (KB916048) is 

available at: 

http://www.microsoft.com/downloads/
details.aspx?familyid=027E693A-2221-4136-95BF-
7D676C8C3989=en. 

c.   An update for Windows Server 2003 x64 Edition (KB916048) is 

available at: 

http://www.microsoft.com/downloads/
details.aspx?familyid=027e693a-2221-4136-95bf-
7d676c8c3989=en. 

d.   An update for Windows Server 2003 for Itanium-Based Systems 

(KB903081) is available at 

http://www.microsoft.com/downloads/
details.aspx?familyid=CF96F748-EDC6-45A2-8375-
4C1F9EF35FAE=en.

__ Step 14.   Perform any updates to the fibre channel HBA drivers, if this was not 

done during the initial installation. This step should be performed 

before continuing with the installation of the Storage Manager and 

RDAC driver. Refer to the Storage Manager readme for the latest 

supported driver levels. 

__ Step 15.   To install Storage Manager (and RDAC Multi-Path Driver or MPIO 

Device Specific Modules), follow the instructions found in Chapter 3, 

“Installing Storage Manager software in a standard Windows 

configuration,” on page 57.
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Completing the SAN boot configuration 

The following procedure will guide you in the finalization of the SAN boot 

configuration process. 

__ Step 1.   Add the other path(s) to the boot LUN via SAN management and/or 

DS4000 Storage Partitioning, including any physical configuration 

changes. 

__ Step 2.   Use disk management via Administrative Tools → Computer 

Management from the Start menu to view and initialize additional disks. 

If the RDAC drive is working properly only 1 disk per LUN should 

appear. If the RDAC driver is not working correctly, or is not installed, 

there will be a disk for each path to the LUN (disk coalescence will not 

have occurred). 

An additional method to verify multiple paths to LUNs is via Device 

Manager. From Start → Administrator → Computer Management under 

System Tools select Device Manager. Check for RDAC Virtual devices 

in disk drives. There should be an RDAC Virtual Disk for each LUN and 

a SCSI disk for each LUN per path. Also, check for RDAC Multi-Path 

Pseudo-Bus in SCSI RAID controllers. 

In Figure 28, there are two LUNs configured on the DS4000 Storage 

System. The Windows Server has two paths to each LUN. 2 LUNs + 2 

Paths = 4 SCSI disks. The RDAC Virtual Disk represents the coalesced 

LUNs. 

 

Notes:  

a.   Additional registry information can be found in the Windows registry 

at:HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Services/
rdacdisk 

S
j0

0
1
2
0
0

  

Figure 28. Windows Device Manager window
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See the readme.txt for the HBA miniport drive for additional 

Windows registry modifications, if needed. 

b.   DS4000 Feature Key generation → ssgtech1.sanjose.ibm/
Raleigh/FastT PE Support.nsf/Home?OpenPage 

c.   On some System x systems a power cycle may be required for the 

fibre HBA to recognize the storage unit’s LUNs.

Modifying the installation 

If you will not be using Storage Manager on the SAN boot system, and you did a 

full install as instructed in Chapter 3, “Installing Storage Manager software in a 

standard Windows configuration,” on page 57, perform the following steps. 

__ Step 1.   From the Control Panel → Add or Remove Programs, select IBM 

DS4000 Storage Manager Host Software and click on the 

Change/Remove button. 

__ Step 2.   Click Next. 

__ Step 3.   Select Uninstall Specific Features. 

__ Step 4.   Click Next. 

__ Step 5.   Check all the features, except Storage Manager 9 failover driver, to 

uninstall. 

__ Step 6.   Click Uninstall. 

The Storage Manager will continue to reside in the Currently Installed 

programs section because the failover driver is still installed. 

Attention:  If a system failure occurs and there is no access to the boot volume, it 

will be necessary to verify the configuration, cabling, and setup of the host and 

storage before you reboot the system. Using the HBA BIOS utility, verify that the 

boot LUN is on the preferred controller and that the host HBA connected to the 

controller can see the boot LUN. 

Removing RDAC from a SAN booted system 

Removing RDAC from a SAN booted system should only be done after removing all 

secondary paths to the storage array leaving only a single available path to the 

array. 

__ Step 1.   Remove components: 

__ Step a.   Use the Start → Control Panel → Add or Remove 

Programs. 

__ Step 1)   Uninstall Storage Manager. 

__ Step 2)   Uninstall Storage Manager and RDAC/MPIO 

components.

__ Step b.   Uninstall Storport Hotfix KB91648 (x86 and x64). 

__ Step c.   Uninstall Storport Hotfix KB903081 (Itanium). 

__ Step 1)   Use the Start → Control Panel → Add or 

Remove Programs. 

__ Step a)   Check the Show updates box. 

__ Step b)   Uninstall the Hotfix.

__ Step d.   Reboot the host computer. 

__ Step e.   Remove the RDAC Multi-Path Pseudo-Bus. 

__ Step 1)   Use the Start → Administrative Tools → 

Computer Management. 

__ Step a)   Device Manager 
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__ Step b)   SCSI RAID Controllers 

__ Step c)   Right-click on RDAC Multi-Path 

Pseudo-Bus. 

__ Step d)   Select Uninstall.
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Chapter  11.  SAN  boot  with  Linux  

The following procedures are used to install Linux SLES 9 or RHEL 4 onto an 

System x host with fibre channel connections using DS4000 storage as the 

boot/root/swap volume. It is assumed that no installation is present to work from, 

and when these procedures are completed the boot and swap devices will be 

running on RDAC virtual disk devices. 

Note:  Refer to the readme supplied with the host system software RDAC driver, for 

latest updates or limitations for SAN Boot. 

System configuration requirements 

The following are system configuration requirements for installing SAN boot in a 

Linux environment: 

v   DS4800 Storage (may work with other DS4000 systems) 

v   System x i386/x86_64 architectures 

v   SAN boot (remote boot) 

v   SLES 9, RHEL 4, or later Linux distributions 

v   RDAC driver version 09.01.B5.35 or later 

v   QLogic fibre channel HBA or Emulex fibre channel HBA

Installation prerequisites 

Prerequisites to the Linux SAN installation process include all of the following: 

v   The installation target must be single-pathed before beginning the installation. 

During any SAN boot procedure, there should only be a single logical path to the 

LUN where the root volume will reside. For this installation procedure, it is 

assumed that the root volume and swap partition are located on the same LUN. 

v   A copy of the Linux distribution must be accessible either from a network location 

or must be available on CD. 

v   Be familiar with the Linux distribution installation, which includes understanding 

what packages will be installed or are required for the initial installation. 

v   Be familiar with how to setup a SAN network or direct attached SAN storage 

devices so that the host system can access LUNs from those storage systems. 

Refer to the Storage Manager Guide for setup and installation of the storage 

array. Because this is a SAN boot installation, a secondary host is required for all 

initial installations as well as setup of the storage array. After installation, the 

storage array may then be managed from the SAN booted system. 

v   Be familiar with creating LUNs on a DS4000 storage subsystem. Although RDAC 

will perform correctly in single path environments, it is recommended that there 

be redundant physical paths to the devices from the host after installation. 

v   It is recommended that the boot/root volume be mapped to the host as LUN 0 on 

the storage array. 

v   Optional: Know how the Linux kernel boot process functions and what processes 

and procedures are used to boot a Linux distribution for a local storage device. 

This will help if troubleshooting is required. 

v   Optional: Insure there will be network access to the system.

Note:  Installation of Storage Manager on a separate computer is required to 

facilitate configuration of the DS4000, before beginning the installation of the 

SAN boot server.
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Recommendations for boot/root/swap device 

The boot device to be used for installation and booting should be at least 4GB in 

size, which is the minimum size for installing a base package set from the 

installation media to the boot devices. Depending on the number of packages and 

the system configuration, the root volume may need to be considerably larger. 

It is recommended that the swap device be at least the size of physical memory 

that is configured in the host. This enables the swap device to be used for 

crashdumps, if desired. These instructions assume that the boot, root, and swap 

devices are all located on the same device; however, this is not a requirement for 

the installation. 

Configuring Emulex fibre channel HBAs 

Configuring an Emulex fibre channel HBA device is a prerequisite of the SAN 

installation. The configuration steps are provided here.

Note:  It is assumed that the boot BIOS has been installed on the Emulex card. 

This is usually done as part of the firmware installation with an Emulex utility 

like HBAnywhere or LP6DUTIL. Before continuing, verify that the boot BIOS 

is installed. 

__ Step 1.   During power-on of the host, select ALT-E to enter the Emulex boot 

BIOS. 

__ Step 2.   Select the HBA to be used for booting. This would be the HBA directly 

connected to, or zoned to, the LUNs preferred controller. 

__ Step 3.   Configure the adapter parameters, so the boot BIOS is enabled. 

__ Step 4.   Configure the BIOS, so the boot LUN (defined as part of the DS4000 

setup) is available and selected as the preferred boot device. For more 

information, refer to the Emulex BIOS setup documentation. 

Before proceeding with the final steps for configuring the Emulex fibre 

channel HBA, you must perform setup of the HBA on the storage array. 

Follow the steps here exactly as they are presented. 

__ Step a.   The HBA must be logged into the storage subsystem; and, 

even though no LUN will be available yet, you can use the 

BIOS to discover the storage subsystem. 

__ Step b.   Once the storage subsystem has discovered the HBA 

WWPNs, you must configure them as the HBAs to the boot 

LUN, using the host mapping procedures. 

__ Step c.   Now, the BIOS can be used to discover the newly 

configured LUN.

__ Step 5.   Use x to save. 

__ Step 6.   Reboot the server.

Configuring QLogic fibre channel HBA devices 

Configuring a QLogic fibre channel HBA device is a prerequisite of the SAN 

installation. The configuration steps are provided here. 

__ Step 1.   Verify that the QLogic fibre channel HBA devices configured for the host 

have been set up to have their boot BIOS enabled. This will allow for 

booting the installation LUN after the initial installation. 

__ Step 2.   During power-on of the host, select CNTL-Q to enter the QLogic boot 

BIOS. 

__ Step 3.   Select the HBA to be used for booting. This would be the HBA directly 

connected to, or zoned to, the LUNs preferred controller. 
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__ Step 4.   Configure the DS4000 device from which the system will be booted. If 

the utility cannot see the correct device or LUNs, check the SAN and 

DS4000 configurations before continuing. For more information, refer to 

the QLogic BIOS setup documentation. 

Before proceeding with the final steps for configuring the QLogic fibre 

channel HBAs, you must perform setup of the HBAs on the storage 

array. Follow the steps here exactly as they are presented. 

__ Step a.   The HBA must be logged into the storage subsystem; and, 

even though no LUN will be available yet, you can use the 

BIOS to discover the storage subsystem. 

__ Step b.   Once the storage subsystem has discovered the HBA 

WWPNs, you must configure them as the HBAs to the boot 

LUN, using the host mapping procedures. 

__ Step c.   Now, the BIOS can be used to discover the newly 

configured LUN.

__ Step 5.   Save and exit. 

__ Step 6.   Reboot the server.

Installation media 

The installation media, or source for installation, can be CD, NFS, HTTP, or FTP. 

For this procedure, an NFS exported set of CDs is used; however, any of the 

previously mentioned installation sources may be used. 

For SLES 9 and RHEL 4, the included device drivers will work correctly for the 

initial installation of the OS. If an older OS installation is required, additional device 

driver disks may be required to successfully discover and install to the SAN volume. 

If this is the case, please refer to the fibre channel HBA vendor Web site for the 

Device Driver Disk (DD Disk), and use the DD Disk driver, instead of the driver 

packaged with the distribution. 

SAN installation 

When you have successfully performed all the installation prerequisites, you are 

ready to begin the SAN installation procedure. 

Procedure 

__ Step 1.   Verify that the fibre channel HBA module is loaded and that the SAN 

devices to be used for installation have been detected. For 2GB QLogic 

adapters, the driver name should be qla2300; for 4GB adapters, the 

driver name should be qla2400; and, for 2GB or 4GB Emulex adapters 

the driver name should be lpfc.

Note:  Because of how Linux discovers SAN devices, and if SAN 

devices have already been configured for multiple path access, 

Linux will discover the same physical device multiple times, once 

for each logical path to the device. Only a single path is required 

to be available to the device before continuing. 

__ Step 2.   Select the desired options until arriving at the Installation Settings. 

Here, modification of the partitioning settings is required before 

continuing with the procedure. 

v   For SLES installations, it is recommended that partitioning be 

performed manually so that ext3 file systems can be selected. 
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v   For RHEL installations, automatic partitioning can be used. By 

default, automatic partitioning will set up both a boot partition and an 

LVM partition. In this instance, the LVM partition would contain the 

root and swap partitions. Manual partitioning can be performed, if 

automatic partitioning is not the desired configuration.

__ Step 3.   Continue with the installation. Allow the installation to complete and 

reboot the system. 

__ Step 4.   After the system has successfully rebooted, verify that the adapter 

BIOS discovered the SAN LUN used for booting. Usually, a message 

displaying the configured LUN is shown. If the expected LUN is not 

shown, use the BIOS configuration utility for the HBA to modify the 

BIOS so it will boot from the hard disk. The system should now boot to 

the new Linux OS installation.

Note:  The installed boot device can be designated as the default boot 

device for the system. This is not required, but it will enable 

unattended reboots after this procedure is completed. 

__ Step 5.   Boot the system in single path mode from the SAN. Using the df 

command, verify where the root is mounted by looking at the mounted 

devices. Using the swapon -s command, verify that the swap and other 

configured partitions are correctly mounted. The single path boot from 

SAN is now complete. To modify the boot/root, and other devices, to 

boot using the RDAC driver, proceed to the Multipath configuration 

section of the procedure.

Multipath configuration 

The following steps for multipath configuration use examples, and the values used 

may be different for your system. In some instances, there may not be a /boot 

mount; instead, the boot files will reside in the /boot directory on the root/ 

mounted file system. It is recommended, though not required, that sda be used as 

the RDAC boot device.

Notes:  

1.   Perform this procedure in a single path environment. Once completed, and 

when booting with RDAC configured, additional paths to the device may later be 

added. 

2.   All commands in this procedure begin with a # sign and may be followed by the 

command output. 

3.   Compilation tools and kernel source packages are required. Verify that tools and 

source packages have been installed before proceeding. 

4.   Check the SAN boot limitations section, which will contain any known issues, 

restrictions, or limitations to the current procedure.

Perform the following steps to complete the multipath configuration. 

__ Step 1.   If applicable, apply kernel updates to get the correct kernel version for 

the environment. If the kernel update is performed later, the RDAC 

driver will first have to be uninstalled. 

__ Step 2.   Verify the version of the installed fibre channel HBA device driver. It 

may be necessary to update the driver from the base installation, before 

proceeding. 

__ Step 3.   Download the RDAC driver source. Unpack the driver, and follow the 

installation procedure in the readme, which will contain the most current 

installation instructions. 
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__ Step 4.   Update the boot loader script to point at the newly created initrd 

image. For GRUB loaders, the file is located in /boot/grub/menu.lst. 

For LILO, the file is located in /etc/lilo.conf. For LILO, to complete 

the configuration update, the lilo command must be run after editing 

the configuration file.

Note:  It is recommended that you create a separate entry in the boot 

loader configuration files. This allows booting to a system without 

RDAC enabled; it also allows recovery after a failed edit of the 

configuration file. 

The boot configuration with the updated initrd image, which includes 

the RDAC driver, should be set as the default. 

__ Step 5.   The system can now be rebooted. 

__ Step 6.   Verify that the system boots successfully, that the RDAC driver is 

installed, and that all file systems are correctly mounted. The following 

commands can be used to verify this information: 

# df 

# swapon -s 

# ls /proc/mpp 

# ls /proc/mpp/* 

__ Step 7.   Additional paths between the storage array and server can now be 

added. If the server is going to be used to manage the storage array, 

Storage Manager can now be installed on the server. For Storage 

Manager installation instructions, see “Installing the Storage Manager 

10.10 software” on page 85. 

__ Step 8.   Verify that the persistent binding for /var/mpp/devicemapping is 

up-to-date. The /var/mpp/devicemapping file tells RDAC which storage 

array to configure first. If additional storage arrays will be added to the 

server, the storage array with the boot/root volume should always be 

first in the device mapping file. To update this file, run the following 

command: 

# mppUpdate 

After the # mppUpdate command is run, cat the /var/mpp/devicemapping 

file, using the following command: 

# cat /var/mpp/devicemapping 

0:<DS4x00 SAN Boot Device> 

The storage array for the boot/root volume should be at entry 0. If the 

boot/root volume is not at entry 0, edit the file to reorder the storage 

array entries so the array for the boot/root volume is at entry 0. Run the 

# mppUpdate command, again. 

__ Step 9.   The installation is now complete.

Removing RDAC from a SAN booted system 

Removing RDAC from a SAN booted system should only be done after removing all 

secondary paths to the storage array leaving only a single available path to the 

array. 

__ Step 1.   Reboot the system. 

__ Step 2.   On reboot, select the boot option that does not include the mpp driver. 

This is to prepare the system for removing the driver. 

__ Step 3.   Change to the directory used during the installation. 

__ Step 4.   Run the command make uninstall; this will remove the mpp initrd 

image and modules from the kernel and /boot directories. 
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__ Step 5.   Edit the /boot/grub/menu.lst, for GRUB, or /etc/lilo.conf, for LILO, to 

remove the RDAC/mpp entry for the boot menu. Also make sure that 

the default section is pointed to a valid boot label.
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Appendix  A.  Using  the  IBM  System  Storage  DS4000  Controller  

Firmware  Upgrade  Tool  

IBM System Storage DS4000 Controller Firmware Upgrade Tool  

overview 

 

Caution: 

Before using the IBM System Storage DS4000 Controller Firmware Upgrade 

Tool to migrate to version 07.10, it is extremely important that all data for 

DS4800, DS4700, and DS4200s be completely backed up and that existing 

system configurations be saved. Once the tool has completed an upgrade, 

controllers cannot be returned to previous firmware version levels. The 

Controller Firmware Upgrade Tool is to be used only when migrating DS4800, 

DS4700, and DS4200 controllers from version 06.xx to version 07.10. This tool 

is not intended to replace, nor should be used to perform, standard upgrades 

for controller, ESM, or drive firmware. (To perform a standard controller, ESM, 

or drive firmware upgrade, please see “Downloading NVSRAM, controller 

firmware, ESM firmware” on page 121.) 

 You must perform the upgrade offline. You should perform the overall installation of 

Storage Manager into an existing host environment online. For most failover drivers 

to take effect, you must reboot the host. 

You must make sure that all devices have an Optimal status before you download 

firmware. You must also check the current firmware level. 

Attention:  Potential loss of data access—Make sure the firmware you download 

is compatible with the Storage Manager software that is installed on 

your storage system. If non-compatible firmware is downloaded, you 

might lose access to the drives in the storage system, so upgrade 

Storage Manager first. 

Do not make changes to your configuration or remove drives or 

enclosures during the upgrade process. 

For information about the current firmware versions, see “Readme files 

and concepts” on page 1 to find out how to access the most recent 

Storage Manager readme files on the Web. 

Checking the device health conditions 

Perform the following steps to determine the health condition of your device. 

1.   From the Array Management Window in Storage Manager, right-click the 

storage system. The Storage Manager software establishes communication with 

each managed device and determines the current device status. 

There are six possible status conditions: 

v    Optimal—Every component in the managed device is in the desired working 

condition. 

v    Needs Attention—A problem exists with the managed device that requires 

intervention to correct it. 
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v    Fixing—A Needs Attention condition has been corrected, and the managed 

device is currently changing to an Optimal status. 

v    Unresponsive—The storage management station cannot communicate with 

the device, or one controller or both controllers in the storage system. 

v    Contacting Device—The management software is establishing contact with 

the device. 

v    Needs Upgrade—The storage system is running a level of firmware that is 

no longer supported by the storage management software.

2.   If the status is a Needs Attention status, write down the condition. Contact an 

IBM Technical Support representative for fault resolution.

Note:  The Recovery Guru in the Storage Manager software also provides a 

detailed explanation of, and recovery procedures for, the conditions.

Installing the upgrade tool 

To install the upgrade tool, complete the following steps. 

1.   Open the SMFWUpgInstaller-xxxx-10.10.A5.xx.bin installation file, according to 

your operating system procedures. The IBM System Storage DS4000 Controller 

Firmware Upgrade Tool installation window appears. 

2.   Click Next. 

3.   Accept the license agreement, and click Next. 

4.   Select the folder in which you want to install the tool, and click Next. 

5.   Click Install. 

6.   Click Done.

Adding a storage subsystem 

To add a storage subsystem using the upgrade tool, perform the following steps. 

1.   Click Add. The Select Addition Method window appears. 

2.   Select either Automatic or Manual.
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3.   Click OK to begin adding storage subsystems. 

4.   To see any issues with the storage system you added that might impede 

upgrading the firmware, click View Log.

Downloading the firmware 

To download the firmware, perform the following steps. 

1.   You need to first select the storage subsystem you want to activate to enable 

the download button, then Click Download Firmware. The Download Firmware 

window appears.
 

ds4k_swut_initial

  

Figure 29. Selection Addition Method window
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2.   Select the controller firmware file that you want to download. Click Browse to 

choose the file from a directory on your computer or on your network. 

3.   Select the NVSRAM file you want to download. Click Browse to choose the file 

from a directory on your computer or on your network. 

ds4k_swut_download

  

Figure 30. Download Firmware window
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4.   Click OK. The firmware starts to download. A status bar appears in the 

Controller Firmware Upgrade window.
 

The firmware begins the activation process, and the status bar in the IBM System 

Storage DS4000 Controller Firmware Upgrade Tool window appears.
 

ds4k_swut_progress

  

Figure 31. Download progress window
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Viewing  the IBM System Storage DS4000 Controller Firmware Upgrade 

Tool  log file 

If you encounter any problems updating your firmware, perform the following steps 

to view the log file. 

1.   Click View Log. The View Log window appears. This log documents any issues 

with the storage system that might prevent you from updating the firmware. 

2.   If any issues are documented in the log, correct those issues before you try to 

download the firmware.

ds4k_swut_activate

  

Figure 32. Firmware activating window
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Appendix  B.  Installing  previous  Storage  Manager  versions  in 

a NetWare  configuration  

This appendix describes how to install the Storage Manager versions 9.10 through 

9.15 in standard (noncluster) and cluster server configurations in the NetWare 6.0 

and 6.5 operating system environments.

Note:  Although DS4000 Storage Manager 10.10 is not currently supported on 

NetWare, controller firmware version 06.16.xx.xx and above does support 

DS4000 storage subsystem attachment to a NetWare host. 

If you have existing storage systems, read “Storage subsystem management 

methods” on page 11. 

To ensure proper installation, complete all preparation tasks described in “Planning 

and preparing for NetWare installation.” 

Important:  Always check the Storage Manager readme file for your operating 

system before installing the software. A readme file contains important 

information that was not available when this guide was prepared. 

See “Readme files and concepts” on page 1 to find out how to access 

the most recent Storage Manager readme files on the Web. 

Planning and preparing for NetWare installation 

Note:  There are no NetWare servers with AMD, AMD64 or Intel EM64T processor 

architecture running with NetWare operating systems written in AMD64 or 

EM64T native code. If the IA-32 version of the operating system is installed 

and is running in compatibility mode on the AMD64 or EM64T servers, then 

you can use the appropriate DS4000 Storage Manager IA-32 software 

package for NetWare. 

Table 20 on page 166 shows the installation sequence for Storage Manager 

software components and provides information to help you plan for the installation 

of the storage management software. 

Important: 

v   If you are upgrading from Storage Manager version 8.x, remove the current 

software before installing Storage Manager version 9.1x. 

v   No reboot is required during the client software installation process. The Event 

Monitor software is installed automatically during client software installation.

Installation overview 

You must install Storage Manager software components on both management 

stations and host computers. 

Table 20 on page 166 shows the installation sequence for Storage Manager 

software components. 
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Table 20. Software component installation sequence in a Novell NetWare 6.0 environment 

System type Software installation sequence 

Management station Storage Manager 10.10 Client (SMclient) 

Host computer and 

cluster node 

1.   Storage Manager 10.10 Client (SMclient) 

The Storage Manager 10.10 Client software package also includes 

the following host software components. 

a.   Storage Manager 10.10 Utility (SMutil) 

This required component contains the hot_add and SMdevices 

utilities. 

b.   Storage Manager 10.10 Agent (SMagent) 

This optional component is necessary if you intend to use the 

host-agent management method.

2.   Fibre channel host bus adapter device driver 

3.   LSIMPE.cdm driver and NetWare native failover device driver
  

Important: Be sure to complete the following activities before you install Storage 

Manager 10.10. 

1.   Uninstall Storage Manager 8.4x or 9.10. See “Uninstalling Storage Management 

8.4x software components” on page 167 or “Uninstalling Storage Management 

10.10 software components” on page 178. 

2.   Install the host bus adapter.

To install the storage management software in a NetWare 6.0 or 6.5 operating 

system environments, you must install the software on each host computer in the 

following order: 

1.   Fibre channel host bus adapter device driver 

2.   LSIMPE.cdm driver and NetWare native failover device driver 

3.   NetWare Agent component of QLogic SANsurfer

NetWare software requirements 

Table 21 lists the disk space that is required for installing the Storage Manager 

software in a NetWare environment. During the installation of each software 

package, you may need up to 130 MB of free disk space. 

 Table 21. Installation requirements for NetWare by software package 

Package Disk space requirement 

Storage Manager 9.1x Client (SMclient) 65 MB 

LSIMPE.CDM driver 2 MB 

QLogic SANsurfer (see the Notes at the end of 

the table) 

2 MB 

IBM HA device driver 2 MB 

Note: Another 160 MB on a separate Microsoft Windows computer is required to install the 

actual QLogic SANsurfer program. This program will work with the installed agent in the 

NetWare server to allow for the IBM DS4000 and FC2, FC2-133 Fibre Channel Host Bus 

Adapter maintenance and troubleshooting
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NetWare operating system requirements 

Each management station, host computer, or cluster node requires one of the 

following operating systems. 

Important:  Check the Storage Manager readme files for the latest supported 

operating system and host software versions. 

See “Readme files and concepts” on page 1 to find out how to access 

the most recent Storage Manager readme files on the Web. 

Management stations 

v   Windows 2000 Server with Service Pack 4 

v   Windows 2000 Professional with Service Pack 4 

v   Windows 2000 Advanced Server with Service Pack 4 

v   Windows XP 

v   Windows Server 2003

Host computers 

v   Novell NetWare 6.0 with Service Pack 4 

v   Novell NetWare 6.5 with Service Pack 2

Cluster nodes 

v   Novell NetWare 6.0 with Service Pack 4 and NCS 1.6 

v   Novell NetWare 6.5 with Service Pack 2 and NCS 1.7

IBM DS4000 Storage Manager Version 9.1x software for NetWare 

The Storage Manager Version 9.1x software package contains the following 

software components for NetWare: 

v   The following component is installed on both the host and management station. 

–   Storage Manager 9.1x Client (SMclient)

v    The following components are installed only on the host. 

–   LSIMPE.CDM 

Versions of this component appear on the latest IBM fibre channel HBA 

device driver for NetWare, on Novell NetWare Support Packs and on the 

Novell web site. Always select the latest version of this component for use. 

Download this software component from the following Web site: 

support.novell.com

Recommendation:  In a Novell NetWare environment, you should manage the 

DS4000 storage subsystem using the direct (out-of-band) 

method. 

Uninstalling Storage Management 8.4x software components 

If you are upgrading from any Storage Manager version 8.4x, it will be necessary 

for you to remove the current software before installing Storage Manager 9.1x. No 

reboot is required after removing a Storage Manager software package. Existing 

storage array mappings and storage partition configurations are retained during 

software removal and will be recognized by the new client software. 
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Use the following procedure to uninstall one or more of the components of Storage 

Manager 8.4x. If you are uninstalling components released with an earlier version of 

the storage management software, use the uninstall procedure that came with the 

version of the storage management software that you are currently running. 

1.   From the System x server Graphical Console, click Novell → Install. 

The Installed Products window opens. 

2.   In the list of currently installed products, select the component you want to 

remove from the list and click Delete. 

The name of the Storage Manager packages are: 

a.   Storage Manager Agent. IBM recommends direct (out-of-band) management 

in NetWare environment. 

b.   Storage Manager Utility 

c.   Storage Manager (this is the client)

3.   Click OK in the Confirm Product Deletion window to proceed with the 

uninstallation. Repeat step 2 to remove each Storage Manger component. 

4.   A Please Wait pop-up window displays while the package uninstalls. 

5.   The Installed Products window will display again when the uninstallation is 

complete.

Storage Manager 9.14 or 9.15 Client 

This section provides instructions for installing Storage Manager 9.1x Client on 

management stations and host computers. 

Before you install the software, make sure that: 

v   The management station or host computer has at least 140 MB of available disk 

space. 

v   All programs are closed. 

v   The HBA and the driver are installed.

Important: 

v   When you install Storage Manager 9.1x client software on a stand-alone host 

and manage storage subsystems through the fibre channel I/O path rather than 

through the network, you must install the TCP/IP software on the host and assign 

an IP address to the host. 

v   Modify these instructions as required for your particular installation.

Installing Storage Manager 9.1x Client (SMclient) 

Perform the following steps to install SMclient: 

 1.   Insert the IBM DS4000 Storage Manager installation CD into the CD-ROM 

drive. 

 2.   Based on your version of Novell NetWare, perform one of the following actions: 

v   Novell NetWare 6.0 with SP 4 or later, proceed with step 3. 

v   Novell NetWare 6.5 with SP 2 or later, proceed with step 4.

 3.   To mount the installation CD, if needed, type the following command from the 

System Console and press Enter. 

load CDROM 

 4.   To copy the zip file from the installation CD to the sys:\volume in the host 

NetWare system, type the following command from the System Console and 

press Enter. 
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copy cd<CDname>:\Netware\filename.zip  SYS:\ 

...where filename.zip is the name of the zip file containing the IBM DS4000 

Storage Manager host software for NetWare. 

In the NetWare Console window, unzip the filename.zip file using the 

following command: 

unzip -o SYS:\filename.ZIP 

The system extracts the install.ncf file and the instdata directory to the 

temporary location specified. 

...where SYS:\ is the zip file’s temporary location. 

 5.   From the System Console window, type the following command, and press 

Enter. 

sys:/install 

The Please Wait window displays while the software is loading. When the 

software is loaded, the Introduction window displays. 

 6.   Select Next. 

The License Agreement window displays. 

 7.   Read and select the option that accepts the terms of the License Agreement. 

 8.   Select Next. 

 9.   The Choose Install Folder window opens. Click the Choose button to select a 

folder different than the default folder listed. The default folder name is 

StorageManager. 

10.   Click Next to continue. 

11.   The 20-Second Delay dialog displays. 

12.   Select OK. 

13.   The Select Installation Type window displays. 

14.   Ensure that for the host, the Typical (Full) installation type is selected. 

v   The full installation type involves installation of the following components: 

–   SMclient 

–   SMagent 

–   SMutil

v   The custom installation type allows you to manually select the options for 

installation. 

v   The management station only installation type involves installation of only 

SMclient. 

The selected installation type is indicated in blue text. 

15.   Select Next. 

If the software already exists, the Overwrite Warning dialog displays. 

16.   Select OK. 

The Pre-Installation Summary window displays. 

17.   Select Install. 

The Installing window displays while the software is loading. When the 

software is loaded, the Install Complete window displays. 

18.   Select Done. 

The Restart The GUI dialog displays. 

19.   Read and select OK.
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Verifying the Storage Manager 9.1x Client installation 

Perform the following steps to restart the GUI and to verify that the packages were 

successfully installed: 

1.   From the Novell menu, select Close GUI.... 

The Close GUI dialog displays. 

2.   Select OK. 

3.   To restart the GUI, type the following command from the System Console, and 

press Enter. 

startx 

4.   Select Novell → Programs, and verify that the IBM DS4000 Client program 

name displays in the Programs list. 

5.   Open the file browser and select the install folder named: sys:\storagemanager. 

You will see Client, Agent, and Util folders if you selected the Typical (Full 

Installation) option during the installation procedure. 

6.   Verify that SMagent.ncf files reside in the SYS:\StorageManager\Agent directory. 

See “Stopping and starting the host-agent software” on page 177. 

7.   Verify that the hot_add.ncf and SMdevices.ncf files reside in the folder that you 

installed the NetWare host software. Its default location is SYS:\StorageManager\
util. 

8.   Depending on success or failure of the installation, do one of the following: 

If the IBM DS4000 Storage Manager 9 Client Enterprise Management window 

displays, the installation was successful. Perform activities detailed in 

“Removing the temporary files” and Chapter 8, “Completing storage 

management installation and configuration,” on page 113 

If the IBM DS4000 Storage Manager Client does not display, a failure has 

occurred and the installation was unsuccessful. Repeat the steps detailed in 

“Installing Storage Manager 9.1x Client (SMclient)” on page 168 and “Verifying 

the Storage Manager 9.1x Client installation.” If the failure persists, refer to 

Storage Manager 9.1x Release Notes or contact your IBM technical support 

representative.

Removing the temporary files 

Use the following procedure to remove the temporary installation files from the 

temporary directory. 

1.   Using the NetWare File Browser, select and delete the install.ncf file and the 

InstData directory in the SYS:\ volume

Note:  This file and directory are in the root of the SYS:\ volume unless the user 

placed them elsewhere. Delete them using the file browser delete 

function. 

2.   Choose one of the following actions: 

v   Storage management software is required on other systems — For each 

system that will be used as a storage management station or host, perform 

the software removal and installation procedures described in “Planning and 

preparing for NetWare installation” on page 165 and “Installing Storage 

Manager 9.1x Client (SMclient)” on page 168. 

v   Storage management software installation is complete is completed on 

all systems — See “Starting the host agent manually” on page 178.
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Installing the NetWare fibre channel HBA device driver 

An IBM fibre channel host bus adapter (HBA) provides the interface between a host 

server and a DS4000 storage subsystem. IBM DS4000 fibre channel HBAs are 

high-performance, direct memory access, bus-master, host adapters that are 

designed for high-end systems. These HBAs support all fibre channel peripheral 

devices that support private-loop direct-attach and fabric-loop attachment. The 

Novell NetWare native failover device driver enables your operating system to 

communicate with the fibre channel HBA. 

See the readme file included in the driver package for installation instructions 

associated with your operating system. For more information, see the Installation 

and User’s Guide for your particular fibre channel HBA model. Additional information 

can also be found in Appendix I, “Host bus adapter settings,” on page 215.

Note:  Depending on your controller’s firmware version, change the LUNs per target 

BIOS setting from the default value of 0 to 31 or 255 for IBM DS4000 fibre 

channel HBA. In addition, review the device driver readme for any other 

required modifications to the default HBA BIOS and host operating system 

registry settings to ensure optimal performance. If you make any changes to 

the HBA BIOS settings, the machine will reboot automatically. 

The current readme file and latest multipath I/O device driver are available at the 

following Web site: 

www.ibm.com/servers/storage/support/disk/ 

See “Readme files and concepts” on page 1 to find out how to access the most 

recent Storage Manager readme files on the Web. 

Continue with “Installing QLogic SANsurfer” on page 172. 

Installing the LSIMPE driver and NetWare native failover device driver 

The NetWare native failover device driver is available in NW5.1 SP7 or later, NW6.0 

SP3 or later, and in NW6.5 SP1a or later. 

Note:  Always use the Novell NetWare native failover device in the latest SP for a 

particular NetWare operating system version. In addition, use the later 

version of the LSIMPE.CDM file from either the latest Novell Support Pack or 

the version that is included with the IBM fibre channel HBA device driver for 

NetWare which is available at the IBM DS4000 support web site. 

The LSIMPE.CDM driver is used in a Novell NetWare environment to enable the 

Novell native multipath device driver to recognize the NetWare host-mapped logical 

drives that were created on DS4000 storage subsystems. The LSIMPE.CDM driver is 

a custom driver module that is packaged with the IBM DS4000 Host Adapter driver 

and the Novell operating system distribution CD. In case of a failure along the I/O 

path, the Novell native multipath device driver sends the I/O requests through the 

alternate path and Auto-Volume Transfer (AVT) moves the logical drive within the 

DS4000 storage subsystem. 

See the current IBM fibre channel HBA device driver readme file for the current 

LSIMPE.CDM driver, and the pointer to the Novell native multipath device driver 

installation instructions. 

www.ibm.com/servers/storage/support/disk/ 
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Continue with “Installing the NetWare fibre channel HBA device driver” on page 171. 

Installing QLogic SANsurfer 

After you install IBM DS4000 Storage Manager, consider installing the QLogic 

SANsurfer Storage Management Suite. You can use this diagnostic application to 

verify the status of the fibre channel connections before you use the storage 

subsystem. 

For information about installing and using this software, see the IBM System 

Storage DS4000 Problem Determination Guide or see the Storage Manager online 

help. 

Setting up a Novell NetWare DHCP server 

To directly manage storage subsystems through the Ethernet connection to each 

controller, you will need to set up a DHCP or BOOTP-compatible server and 

configure the following options: 

v   Router/Gateway 

v   DNS Server 

v   Hostname 

v   DNS

A Novell NetWare DHCP server automatically assigns IP addresses and other 

configuration information to clients upon request or when the clients are restarted. 

Perform the following steps to set up a Novell NetWare DHCP server: 

1.   Install DNS/DHCP Services, either during or after installing NetWare 6. 

2.   Install the DNS/DHCP Management Console. 

3.   Create the DHCP server object. 

4.   Create the DHCP subnet address. 

5.   Create the subnet address range. 

6.   Create the IP address object. 

7.   Start the DHCP server.

Each of these tasks is described in detail in the sections that follow. 

Adding Novell DNS/DHCP Services during the NetWare 6.0 installation 

Perform the following steps to add Novell DNS/DHCP Services during the NetWare 

installation: 

1.   From the Installation Options window, select Custom. 

2.   From the Components window, select the Novell DNS/DHCP Services check 

box. 

3.   Follow the on-screen instructions to complete the NetWare installation.

Adding Novell DNS/DHCP Services after the NetWare 6.0 installation 

Perform the following steps to add Novell DNS/DHCP Services after the NetWare 

installation: 

1.   Insert the NetWare 6.0 Installation CD into the CD-ROM drive. Then mount the 

CD as a volume. 

2.   Load NWCONFIG and select Product Options. 
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3.   Select Install a Product not Listed. 

4.   Press F3 and specify the volume name of the CD. The X Server-Graphical 

Console window opens. 

5.   In the Additional Products and Services dialog box, select the Novell 

DNS/DHCP Services check box. 

6.   Follow the on-screen instructions to complete installation.

Note:  Installing the DNS/DHCP Service will extend the Novell Directory Services 

(NDS) schema and create the following NDS objects: 

v   DNSDHCP-GROUP Group object 

v   DNS/DHCP Locator object 

v   RootServerInfo Zone object

Installing the DNS/DHCP Management Console 

Perform the following steps to install the DNS/DHCP Management Console and 

NetWare Administrator snap-in files on the client workstation you will use to 

administer DNS and DHCP: 

1.   If you have not done so, install the latest version of Novell Client 32 on your 

workstation. 

2.   From the workstation, run the SYS:PUBLIC\DNSDHCP\SETUP.EXE program. 

3.   Install the DNS/DHCP Management Console on the local hard-disk drive. 

4.   Install the NetWare Administrator snap-in files in the SYS:PUBLIC\WIN32 directory. 

5.   Restart the workstation. 

6.   To start the DNS/DHCP Management Console, double-click the shortcut icon on 

the desktop, type the NDS tree name, and click Launch.

Note:  You can install the DNS/DHCP Management Console on a workstation, or 

you can access it from the Tools menu of the NetWare Administrator utility. 

Creating the DHCP server object 

Use the DHCP Management Console to create a DHCP server object. You can 

create a DHCP server object under any of the following objects: 

v   Organization (O) 

v   Organization Unit (OU) 

v   Country (C) 

v   Locality (L)

Perform the following steps to create a DHCP server object: 

1.   From the DHCP Management Console, click the DHCP Service tab. 

2.   In the left pane, select Our Network. 

3.   Click Create. The Create New DHCP Object window opens. 

4.   Select DHCP Server. Click OK. The Create DHCP Server window opens. 

5.   Select a server. Click Create. This creates the DHCP server object, called 

DHCP_servername, in NDS. 

6.   In the DHCP Management Console, locate the icon for the DHCP server object 

at the bottom of the DHCP Service tab. The server object displays with a red 

line through it, indicating that the DHCP server has not been started. 

7.   Continue with “Creating the DHCP subnet object” on page 174.
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Creating the DHCP subnet object 

Perform the following steps to create a DHCP subnet object for each of the subnets 

for which you want to assign addresses: 

1.   In the DNS/DHCP Management Console, click the DHCP Service tab. 

2.   Select Our Network or the DHCP Server Object. 

3.   Click Create. The Create New DHCP Object window opens. 

4.   Select Subnet. Then click OK. The Create Subnet window opens. 

5.   For each subnet, type the following information: 

v   Subnet name 

v   NDS context 

v   Subnet address 

v   Subnet mask 

v   Default DHCP Server

6.   Click Create. The DHCP subnet object is created and displayed in the 

DNS/DHCP Management Console.

Creating the subnet address range 

Perform the following steps to create a subnet address range object: 

1.   From the DNS/DHCP Management Console, click the DHCP Service tab. 

2.   Select the subnet object under which you want to create the subnet address 

range object. Then click Create. The Create New DHCP Record window opens. 

3.   Select Subnet Address Range. Then click OK. The Create New Subnet 

Address Range window opens. 

4.   Type the following information for the subnet address range: 

v   Subnet address range name 

v   Starting address 

v   Ending address

5.   Click Create. 

6.   Select the Define Additional Properties check box. Then set the Range Type 

to Dynamic BOOTP and DHCP.

Creating the IP address object 

Use the DNS/DHCP Management Console to create IP address objects. You use IP 

address objects for the following purposes: 

v   To exclude an IP address from assignment 

v   To assign an IP address manually to a specific host 

v   To record dynamic IP address leases

Perform the following steps to create an IP address object: 

 1.   From the DNS/DHCP Management Console, click the DHCP Service tab. 

 2.   Select the subnet object of the target IP address. Then click Create. 

 3.   Select IP Address. Click OK. The Create IP Address window opens. 

 4.   In the IP Address field, type the IP address for the first controller. 

 5.   In the Assignment field, select Manual. 

 6.   In the Client Identifier field, specify the MAC address. 

 7.   In the MAC Address field, enter the hardware Ethernet MAC address for the 

controller. 
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8.   Select the Define Additional Properties check box. 

 9.   In the Hostname field, type the eight-character name for the controller. 

10.   In the Usage field, select Permanent. 

11.   Repeat steps 3 on page 174 through 10 for each controller.

Starting the DHCP server 

To start the DHCP server, at the DHCP server console, type: 

LOAD DHCPSRVR 

The DHCP server can now respond to client requests and assign IP addresses. 

Notes:  

1.   To load the DHCP server automatically each time the server starts, place the 

DHCPSRVR command in the SYS:\SYSTEM\AUTOEXEC.NCF directory. 

2.   For additional information about setting up, configuring, or using Novell 

DNS/DHCP Services, see either the Novell Documentation CD or to the 

following Web site: 

www.novell.com/documentation/

Verifying the TCP/IP protocol and setting up the host or DNS table 

The normal default installation process will install the TCP/IP software package. 

Perform the following steps to set up the host or DNS table. Make sure that the 

host names for the controller match the IP addresses for the controllers. 

Important:  To manage storage subsystems through a firewall, configure the firewall 

to open port 2463 to TCP data after you complete these steps. 

1.   Update either the host table or the DNS table to specify a host name to 

associate with an IP address. If you do not have a DNS table, edit the two host 

tables that are found in the sys:etc\hosts directories. (Your directory will be 

different if the operating system is not installed on the root.) 

To set up the host tables for the controllers, open the hosts file that is located in 

the \etc\ directory. Use a text editor to update the host file to create the 

following IP address and controller name entries. For example: 

Mappings of host names and host aliases to IP addresses 

127.0.0.1   loopback lb local host loopback address 

Examples from a fictitious network: 

 129.47.4.2 ta tahiti ta.some.com loghost 

129.47.6.40 osd-frog 

129.47.6.144 sj-in5 in5 

197.67.172.71 sj-in1 in1 

  

Configuring storage management 

After you install Storage Manager, complete the tasks that are described in 

Chapter 8, “Completing storage management installation and configuration,” on 

page 113. These tasks include the following: 

v   Performing an initial automatic discovery of storage subsystems 

v   Adding devices 

v   Naming storage subsystems 
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v   Creating arrays and logical drives 

v   Downloading controller firmware and NVSRAM 

v   Verifying and defining the default host type 

v   Setting up alert notifications

Using the storage management software for NetWare 

This section provides information on how to add or delete logical drives using the 

hot_add and SMdevices utilities, start and stop the host-agent software, and 

uninstall Storage Manager components in a NetWare operating system 

environment. 

Adding or deleting logical drives 

Use the following instructions to add or delete logical drives in a standard 

(noncluster) configuration. 

Creating logical drives 

When you create new logical drives with the storage management software, you 

must add the new logical drives to Novell NetWare. Refer to the Novell NetWare 

documentation for details about adding a drive. Novell NetWare recognizes each 

logical drive (not array) as a single drive. 

After creating logical drives, run the hot_add and SMdevices utilities that are 

provided with the storage management software. The Hot Add utility adds newly 

created logical drives to the operating system, and the SMdevices utility identifies 

logical drives by their associated operating system device names. For information 

about how to use these utilities, see “Using the hot_add utility” and “Using the 

SMdevices utility” on page 177. 

Deleting logical drives 

Important: If you have data or logical drives that you want to keep, do not click 

Configure → Reset Configure. This will reset the controller unit and delete all 

previously-configured logical drives. 

Before you delete logical drives with the storage management software or use 

Configure → Reset Configuration, stop all input and output activity to the affected 

storage subsystem. Then dismount any Novell NetWare volumes that are 

associated with the logical drives. 

Using the hot_add utility 

The hot_add utility enables you to add new logical drives without restarting the 

system. The utility registers the new logical drives with the operating system so that 

you can use nwconfig to create partitions, add device names, and so on. The 

hot_add utility is part of the Storage Manager 10.10 Utility package. 

When you finish creating logical drives on a particular storage subsystem, go to the 

host that is attached to that storage subsystem, and perform the following steps to 

use the hot_add utility: 

1.   From the Server Console, type: 

InstalationFolder(ie. SYS:\StorageManger)\Util\hot_add 

2.   Press Enter. 

The new logical drives are available through the NetWare Disk Manager.
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Using the SMdevices utility 

The Storage Manager 10.10 Utility software package includes a utility called 

SMdevices that you can use to view the storage subsystem logical drive that is 

associated with a particular operating-system device name. This utility is helpful 

when you want to create drives, volumes, or a combination of both for the logical 

drive using the nwconfig program. 

When you finish creating the logical drives on a particular storage subsystem, go to 

the host that is attached to that storage subsystem, and perform the following steps 

to use SMdevices: 

1.   From the Server Console type: 

InstalationFolder(ie. SYS:\StorageManger)\Util\SMdevices 

2.   Press Enter. 

The software displays device identification information. For example, you might 

see the following: 

Note:  Note: IN NW6.5, the following information is displayed in the Logger 

window instead of on the same NetWare Console window screen.

 V596-A3-D0:0[Storage Subsystem MARKETING, Logical Drive DEBIT, 

LUN 0, WWN <600a0b800007545c0000008d3a308b6e>]  

 V596-A3-D0:1 [Storage Subsystem MARKETING, Logical Drive DEBIT, LUN 1, 

WWN <600a0b80000756ec000000a93a307d2a>] 

 V596-A3-D0:1F [Storage Subsystem MARKETING, Logical Drive Access volume, 

LUN 31, WWN <600a0b800007545c0000009000000000>] 

 Where V596-A3-D0:0; 

  

The numbers at the beginning of each line constitute the device name. The 

device name identifies the adapter or device as follows: 

Vendor number [V596]. A unique number specific to the device vendor. 

Adapter number [A3]. The instance number of an adapter registered with 

NWPA. In the example, A3 identifies the first instance of an adapter installed in 

the server. 

Device number [D0]. The number of the disk or other device. 

Logical unit number [0,1,1F]. The LUN identifies individual devices when more 

than one device is attached to one bus. 

Storage Subsystem [x]. The storage subsystem name. 

Logical Drive [x]. The logical drive name. 

LUN [x]. The logical unit number associated with the logical drive. 

WWN  [x]. The worldwide name for the logical drive.

Stopping and starting the host-agent software 

Use the procedures in the following sections to stop and start the host-agent 

software installed on the host or cluster node. 

Notes:  

1.   The smagent.nlm module will remain loaded after the agent java service ends 

until you reboot the server. 
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2.   If an access logical drive is not detected after a restart, the host-agent software 

will automatically stop running. Restart the host or cluster node so that new 

host-agent-managed storage subsystems will be discovered. 

3.    SMagent requires that JAVA version 1.4.2 or later be installed. Unpredictable 

behavior may result if versions earlier than version 1.4.2 version are installed.

Stopping the host-agent software 

You must stop the host-agent software if you want to add storage subsystems. 

When you restart the service, the host-agent software discovers the new storage 

subsystems and adds them to the management domain. 

Perform the following steps to stop the host-agent software: 

1.   From the system console, press Ctrl+Esc, and then select System Console. 

2.   At the prompt, type: 

java -show 

Look for the following line: 

"devmgr.versioned.agent.AgentServer.............QQQ" 

where QQQ is the process ID. 

3.   At the prompt type the following: 

java -killQQQ 

where QQQ is the process ID from the java -show command. 

4.   Press Enter.

Starting the host agent manually 

To add storage subsystems, start the host-agent software manually either when you 

start the system or if it is already stopped. 

Perform the following steps to start the host agent manually: 

1.   From the system console, press Ctrl+Esc, and then select System Console. 

2.   At the prompt, type: 

smagent 

3.   Press Enter. 

The agent will start and display the following message when UTM LUNs are 

scanned: 

Activating 

4.   Return to ConsoleOne. Press Ctrl+Esc, and then click System x server → 

Graphical Console.

Uninstalling Storage Management 10.10 software components 

Use the following procedure to uninstall one or more of the components of Storage 

Manager 10.10. 

 1.   From the System x server Graphical Console, type the following command and 

press Enter. 

sys:\storage manager\suiteuninstall.ncf 

The Uninstall window opens. 

 2.   Select Next. 

The Uninstall Options window opens. 

 3.   Select the Complete Uninstall option. 

 4.   Select Next. 

 

178 DS4000 Installation and Host Support Guide for Windows 2000/Server 2003, NetWare, ESX Server, and Linux



When the software removal completes, the Uninstall Complete window opens. 

 5.   Select Done. 

The Restart the GUI dialog opens. 

 6.   Select OK. 

 7.   From the Novell Menu select Close GUI... 

The Close GUI dialog opens. 

 8.   Select Yes. 

 9.   To restart the GUI, from the System Console, type the following command, and 

press Enter. 

startx 

10.   Using the NetWare File Browser, select and delete the install.ncf file and 

InstData directory in the SYS:\ volume. This file and the directory are in the 

root of the SYS:\ volume, unless the user choose to place it elsewhere.

Note:  Do not perform this step if you already deleted the files required for 

installation when you installed the IBM DS4000 Storage Manager host 

software for NetWare. 

11.   Are you installing a new version of the software? 

Yes. See Appendix B, “Installing previous Storage Manager versions in a 

NetWare configuration,” on page 165. 

No. You have completed this procedure.

NetWare operating system limitations 

This appendix contains information about how to operate the storage management 

software in a NetWare environment. For the most up-to-date information, always 

check the most recent DS4000 Storage Manager readme file for NetWare. 

See “Readme files and concepts” on page 1 to find out how to access the most 

recent Storage Manager readme files on the Web. 

Note:  These limitations may only occur when you manage storage subsystem with 

older firmware versions. 

Table 22 on page 180 lists the limitations that apply when you use the IBM DS4000 

Storage Manager Version 9.1x with Novell NetWare. 
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Table 22. Novell NetWare limitations and workarounds 

Limitation Workaround 

If you are upgrading controller firmware in 

IBM FAStT500 storage controller (M/T 3552) 

with 512MB Cache, you will have to stop I/O 

and reboot both controllers before upgrading 

firmware followed by NVSRAM. You can 

reboot the controllers either by power cycling 

the storage subsystem or by pressing the 

Reset button on both controllers. The Reset 

button is located on the right of the indicator 

lights in the opening on the front of each 

controller unit. 

To determine Storage Controller cache level, 

perform the following: 

1.   On a storage management station start 

the client software and select a storage 

subsystem. 

2.   Select Tools → Manage Device to open 

the Subsystem Management Window. 

3.   Highlight the Storage Subsystem that you 

are upgrading and then select Storage 

Subsystem → Profile. It may take a little 

time for it to create the Storage 

Subsystem profile. 

4.   Under the Controllers heading is an entry 

that displays information similar to the 

following example: 

Cache/processor size (MB):  256/32

If this setting is listed as 512/32 you will need 

to arrange to perform this upgrade procedure 

at a time that you can stop I/O to the Storage 

Subsystem in order to ensure a successful 

firmware download and installation. 

None. 

The system might display the DS4000 

Storage Manager dialog windows as cropped 

without the vertical and horizontal scroll bars. 

Move the mouse pointer over the edge of the 

window until the mouse pointer changes to a 

window resize pointer. Left-click your mouse; 

hold to grip the window’s edge and resize the 

window. 
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Table 22. Novell NetWare limitations and workarounds (continued) 

Limitation Workaround 

Storage Manager prompts you for a password 

if all hard disk drives are removed from the 

storage subsystem. 

After removing all drives from a storage 

subsystem (or powering on the controller only 

without any drive expansion enclosures), the 

IBM DS4000 Storage Manager software will 

prompt you for a password when trying to 

start the software or trying to perform 

protected operations. Any password entered 

will fail. 

Password information is stored on a reserved 

area of each hard disk drive on the storage 

subsystem. Each drive stores a mirrored copy 

of the password data. When there are no 

drives in the storage subsystem, the storage 

management software does not find the 

password data when you attempt password 

protected operations. Add one drive to the 

storage subsystem and retry the operation. 

Since the RAID controller unit should not be 

powered on until the expansion units are 

attached and powered on, this should be 

done by powering off the RAID controller unit, 

properly attaching all expansion units (with 

drives installed), to the RAID controller unit 

and powering them on, and then powering 

the RAID controller unit back on. At this point 

the storage subsystems can be rediscovered 

and managed using the IBM DS4000 Storage 

Manager 10.10 software. 

It is possible to circumvent IBM DS4000 

storage subsystem hardware and software 

designs for redundant pathways from the host 

system. This is accomplished by connecting a 

single host adapter from the host system to 

one of the controller miniHUBs, and then 

connecting this miniHUB to the miniHUB of 

the other controller, creating a Fibre Channel 

Arbitrated Loop (FC-AL) between the host 

adapter and the two IBM DS4000 storage 

subsystem controllers. This configuration 

leaves no redundant path to the host system. 

When connecting two miniHUBs together, 

always connect the IN port of one miniHUB to 

the OUT port of the other miniHUB or 

visa-versa. Do not connect the IN port of one 

to the IN port of the other miniHUB or the 

OUT port of one miniHUB to the OUT port of 

the other miniHUB. 

This configuration is not supported by IBM. 

Dynamically changing the cache read ahead 

multiplier setting via the storage manager 

client may result in an error message 

indicating the operation has failed. Despite 

the error message, the request to change the 

cache read ahead multiplier will remain 

queued to the controllers and will eventually 

complete when I/O activity to the storage 

subsystem has subsided. 

In order to avoid the error message and any 

delays in the cache read ahead multiplier 

value changing, it is recommended to change 

the cache read ahead multiplier when the 

subsystem is in a quiesced state. 

If the SMagent is running on the NetWare 

server and a fiber-optic cable is pulled or a 

path failure occurs, the NetWare server might 

end. 

Stop the SMagent and manage the DS4000 

using the direct (out-of-band) method of 

management. See “Stopping the host-agent 

software” on page 178 and use the procedure 

for uninstalling the SMagent software. 

Clicking a vertical scroll arrow (either up or 

down) causes the scroll box to move all the 

way to the opposite end of the scroll bar. 

This is a known defect in the Java Runtime 

Environment. Click the scroll box and slide it 

until you reach the desired position in the 

Help window. 
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Table 22. Novell NetWare limitations and workarounds (continued) 

Limitation Workaround 

Logical drive migration (removing a set of 

drives that are configured with logical drives 

from one storage subsystem for insertion into 

another storage subsystem) is not supported 

because it could cause loss of configuration. 

Either use the migration instructions in the 

IBM System Storage DS4000 Hard Drive and 

Storage Expansion Enclosure Installation and 

Migration Guide or contact an IBM technical 

support representative for assistance in 

performing this procedure. 

When you manage storage subsystems 

through the host-agent software and use the 

storage management software to download 

controller firmware, the download process can 

take up to 10 minutes to complete. 

None. 

The controller firmware does not recognize or 

communicate with a single controller until slot 

A is populated. This limitation does not apply 

to storage subsystems that were originally 

configured with two controllers. 

When you configure a new storage 

subsystem with a single controller, you must 

place the controller in slot A. 

Public loop configurations (managed hubs 

that are attached to switches) are not 

supported. 

None. 

Multipath failover will work only if the storage 

controllers are in active/active mode. 

When you configure the storage subsystem, 

change both controllers to active status. 

When you remove a fan or power supply field 

replaceable unit (FRU) from a storage 

subsystem while the system is running, the 

storage management software does not 

report an error message, and the component 

is not reported as missing. 

Note: Fan and power supply FRU failures 

are reported. 

Replace the missing fan or power supply 

FRUs immediately to ensure redundancy. 

Make sure that the fan or power supply FRU 

is properly seated in the controller unit. 

Your windows and online Help displays a 

brownish hash pattern when you run in 

256-color mode. 

Run the Storage Manager 10.10 application 

in a higher display mode. 

When performing a redundancy check (parity 

scan) from the storage management 

application, machine type 3542 (FAStT200) 

can take several minutes longer than 

machine type 3526 (IBM Netfinity Fibre 

Channel RAID Controller Unit) and 3552 

(FAStT500) controller platforms. 

None. 

When attempting to manage a storage 

subsystem where the RAID controller unit 

does not have access to logical drives, 

Storage Manager prompts you for a 

password. This occurs even if no password 

has been set up. The automatic discovery 

locates and identifies each storage 

subsystem as two separate storage 

subsystems. 

Ensure that at least one IBM DS4000 

EXP700 Storage Expansion Unit with at least 

one logical drive is properly attached to the 

IBM DS4400 RAID controller unit in each 

storage subsystem being managed. The 

RAID controller unit should not be powered 

on until the expansion units are attached and 

powered on. Power off the RAID controller 

unit, properly attach all expansion units with 

the drives installed to the RAID controller unit, 

and power them on; then, power on the RAID 

controller unit. At this point, the storage 

subsystems can be rediscovered and 

managed by using the DS4000 Storage 

Manager software. 
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Table 22. Novell NetWare limitations and workarounds (continued) 

Limitation Workaround 

You might not see the maximum number of 

drives during Automatic Configuration if you 

are using drives of different capacities. 

Use Manual Configuration to select individual 

drives and select the maximum number of 

drives allowed. 

When you connect an IBM System Storage 

DS4000 EXP700 Storage Expansion Unit to a 

FAStT200, the drive speed must be set to 

1Gbps. 

None. 

When you issue a Subsystem Management 

command from the IBM DS4000 Storage 

Manager client, the command may be 

cached. If so, the system issues the error: 

Error 21 - The Operation cannot complete 

because a... is in progress. The IBM 

DS4000 Storage Manager client will run such 

cached commands as soon as the controller 

resources become available. 

Wait for at least ten minutes; then, check to 

see if the IBM DS4000 Storage Manager 

client has run the command. If it has not, 

reissue the command.
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Appendix  C.  Installing  Storage  Manager  9.2x  Client  

This section describes how to install different components of Storage Manager host 

software on management stations and host computers that run Windows operating 

systems. The installation is applicable for Storage Manager 9.2x host software only. 

Before you install the software, make sure that the management station or host 

computer has at least 300 MB (370 MB for Windows Server 2003 IA-64 [Itanium 2] 

environment) of available disk space for the installation software package, the 

temporary files during installation, and the final files after the installation. The final 

installation directory size will be 170 MB, if you install all software packages in 

Windows 2000 or Windows Server 2003 32-bit environment. In a Windows Server 

2003 IA-64 (Itanium 2) environment, the final installation directory size will be 200 

MB. 

Important:  When you install SMclient on a stand-alone host and manage storage 

subsystems through the fibre channel I/O path rather than through the 

network, you must install the TCP/IP software on the host and assign 

an IP address to the host. 

Starting with the DS4000 Storage Manager host software version 9.12, all four 

components—SMclient, multipath driver, SMagent and SMutil—of the host software 

are packaged in a single host software package installer. Depending on the user’s 

needs, up to four packages can be installed using this host software package 

installation program. 

Notes:  

1.   If the operating system of the computer that you want to install this software is 

of management support list only (like Windows XP and Windows 2000 

Professional), the only host software component that is available for installation 

is the SMclient program. 

2.   Windows 2000 Professional and Windows XP support the DS4000 Storage 

Manager Client package only. Do not install any other storage management 

software packages on Windows 2000 Professional or XP. The multipath driver is 

not supported on these Windows operating systems. 

Perform the following steps to install the DS4000 Storage Manager host software 

packages in either a server or management station. 

Important: These installation instructions are not for servers with SAN-boot or 

Remote-boot disk. 

 1.   Before installing this software, close all other programs. 

 2.   Insert the IBM DS4000 Storage Manager Version 9.2x support for Microsoft 

Windows operating system's CD into the CD-ROM drive.

Note:  If you downloaded the Storage Manager version 9.2x host software 

package for Windows from the DS4000 support Web site, you must 

unzip the downloaded .zip file to unpack the content of the Storage 

Manager host software Web package for Windows into your specified 

directory. Go to this directory and select the Windows directory to get 

access to the Windows host software package install program. Go to 

step 6 on page 61. 

 3.   From the Windows desktop, double-click the My Computer icon. The My 

Computer window is displayed. 
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4.   Double-click the CD-ROM drive that has your DS4000 Storage Manager 

Version 9.2x CD. The CD window is displayed. 

 5.   Select the appropriate directory in the CD for your operating system 

architecture (IA-32-bit or IA-64-bit). 

 Directory Operating System 

Win32 Windows 2000 Server, Advanced Server 

and DataCenter 

WS03_x86 Windows Server 2003 x86 32bit edition 

(IA32) Server, Enterprise Edition and 

DataCenter 

WS03_IA64 Windows Server 2003 IA-64 64-bit edition 

(Itanium Architecture 64 only) Server, 

Enterprise Edition and DataCenter 

WS03_x64 Windows Server 2003 X64 64bit edition 

(AMD64 and EM64T) Server, Enterprise 

Edition and DataCenter
  

 6.   To launch the host software package installer, double-click the .exe file, such 

as SMIA-WS....exe. 

 7.   For Storage Manager 09.19 and later only, the installer displays an IBM 

System Storage DS4000 Storage Manager splash screen with a drop-down 

menu. From this drop-down menu, you can select a language option. 

(Language selection is optional if you are performing an English language 

installation.) The language option you select will determine the language 

version of the License Agreement that is displayed. Once you have selected a 

language, click the OK button. 

 8.   The Introduction window is displayed. Click Next to continue. 

 9.   The License Agreement window will be displayed. Read the License 

Agreement and select either I accept the terms of the License Agreement or 

I do not accept the terms of the License Agreement radio button and click 

Next to continue with the installation. If you choose not to accept the terms of 

the License Agreement, the Installer wizard will terminate. (Otherwise, proceed 

to next step.) 

10.   The Copyright Statement window is displayed. Click Next. 

11.   The Choose Install Folder window is displayed, identifying the default install 

directory. The default directory is Windows_boot_drive_letter:\Program 

Files\IBM_DS4000. You could change this value to another directory; but it is 

recommended to keep the specified default installation directory. 

12.   Click Next. 

The Select Installation Type window is displayed. 

13.   Based on the type of installation you are performing, select one of the 

following actions. Note that the following steps are written for a typical (full 

installation). 

v   Typical (Full Installation)—This selection, which is the default, installs all of 

the packages on the system. This is a safe choice if you do not know which 

installation type to select. This option will install all four host software 

components - SMclient, mulitpath driver, SMagent and SMutil.

Notes:  

a.   You must select the Custom installation option if you do not use the 

DS4000 RDAC or a DS4000 MPIO/DSM driver as multipath/failover 

driver such as Symantec Dynamic Multipathing for Windows (DMP). 
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b.   For a Microsoft Windows XP operating system environment, the only 

package that will be installed in a typical installation is the client 

package.

v   Management Station—This selection installs the software needed to 

configure, manage, and monitor a storage array. This option is for your 

workstation or management PC. This option will install SMclient program 

only. 

v   Host—This selection installs the storage array server software. Use this 

type of installation for the host (server) connected to the storage array 

(Windows 2000 and Windows Server 2003 only). This option will install all 

host software components with the exception of SMclient program. 

v   Custom—This selection enables you to customize the features to be 

installed.

The selected installation type is highlighted in blue text. 

14.   Click Next. 

If there are previously installed Storage Manager software packages, the 

Overwrite Warning dialog is displayed. 

15.   If the Overwrite Warning dialog is displayed, click OK. 

The Automatically Start Monitor? window is displayed. This refers to the Event 

Monitor service, which monitors the specified DS4000 storage subsystems and 

forward any critical alerts from those subsystems when the SMclient program 

is not running. 

16.   In the Automatically Start Monitor? window, select the appropriate option for 

your system.

Notes:  

a.   To enable automatic ESM firmware synchronization, you must enable the 

Event Monitor. Select Automatically Start Monitor. (See “Automatic ESM 

firmware synchronization” on page 124 for more information.) 

b.   If you start the Event Monitor service on multiple machines, you might 

receive duplicate error messages from the same storage array. To avoid 

receiving duplicate error messages, start the monitor on only one machine. 

It is recommended that you run the monitor on one machine that will run 

continually.

17.   If an RDAC/failover driver package was selected to be installed, a Select 

Multipath drive window driver will be displayed. Select either RDAC or MPIO 

as the choice for the multipath driver that will be installed. Click Next to 

continue. 

Refer to “Redundant disk array controller” on page 9 for more info about 

RDAC and MPIO multipath driver and the requirements to support either type 

of multipath driver. 

18.   Click Next. 

The Pre-Installation Summary window is displayed. 

19.   Click Install. 

The Installing window is displayed while the software is loading. The 

Installation/Remove status window is also displayed throughout the installation 

process. 

The Security Alert dialog might be displayed multiple times. 

20.   Did the Security Alert dialog display? 

v   Yes—Click Yes. 
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v   No—Go to step 21 on page 64. When the software is loaded, the Install 

Complete window is displayed. 

Important: 

a.   If RDAC is not installed in the computer, the Install Complete window might 

display an error message stating that the installation is finished and that 

there are some warnings. The message suggests looking at the installation 

log for details. The installation log contains a warning that a Win32 

exception can be found. This is normal and expected behavior. The 

installation was successful 

b.   If you cancel an installation before the installation completes its run (while 

the progress bar is still visible), the installation might not clean up the 

aborted installation properly, and the host-software installation wizard 

creates an install log. In addition, the Add/Remove Program window might 

show that the program is already installed. However, when you try to 

uninstall it, you will get an uninstallation error and whether you want to 

remove the entry from the Add/Remove program list. Click Yes to remove 

the entry. Then, you must delete the .xml file in the 

Windows_boot_drive_letter:\Program Files\Zero G Registry directory. If 

you did not delete the .xml file, when you try to run the DS4000 Storage 

Manager Installation wizard again, it will state that an existing version of 

the program is already installed and whether you want to update it. 

However, when you click OK and proceed through the installation process, 

the files will be installed in the following directory: 

Documents and Settings\user_login_ID\LocalSettings\ 

Temp\UniqueDirectoryName\Windows\NULL 

This directory does not exist. In the above directory name, the 

user_login_ID and UniqueDirectoryName fields will be different for 

different installations. The Windows_boot_drive_letter:\Program 

Files\Zero G Registry directory might be hidden from the normal 

Windows Explorer view. If this is the case, change the settings of the 

Windows Explorer to Show hidden files and folders.

If you cancel the installation before the progress bar is visible, the installation 

wizard will clean up the abort process properly. You do not need to do anything 

before starting the wizard again. 

21.   Verify that the Yes, restart my system option is selected. 

22.   Click Done. 

Several files and program packages are installed to the directory that you 

specified in step 11 on page 62. The default directory is 

Windows_boot_drive_letter:\Program Files\IBM_DS4000. 

The installation is completed, and Windows is restarted. 

Important: If you repeatedly cancel an installation or uninstallation before the 

process completes its run and try to install again, the installation process might 

not work, and the software might not be installed after the installation process 

is completed. The installation complete panel tells you where the software is 

installed, but it is not there. If this problem occurs, delete the .xml file from the 

Windows_boot_drive_letter:\Program Files\Zero G directory. 

23.   To verify that the software packages were installed, go to Appendix D, 

“Verifying the installation,” on page 189.
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Appendix  D.  Verifying  the  installation  

Use this procedure to verify that the host software package installer ran 

successfully. 

1.   Select Start → Settings → Control Panel. 

The Control Panel window opens. Select Add/Remove programs. The 

Add/Remove Programs Properties window opens. 

2.   Look for the IBM DS4000 System Storage Storage Manager Host Software 

entry. 

3.   Was the installation successful (no failure reported)? 

v   Yes—Go to Chapter 8, “Completing storage management installation and 

configuration,” on page 113. 

v   No—Repeat the steps in Appendix C, “Installing Storage Manager 9.2x 

Client,” on page 185. If the failure persists, contact IBM Technical Support. 

If you installed other host software packages besides the SMclient software 

package, you may use this procedure to verify that the packages were installed 

successfully: 

WARNING: If you use Registry Editor incorrectly, you may cause serious problems 

that may require you to reinstall your operating system. IBM cannot guarantee that 

you can solve problems that result from using Registry Editor incorrectly. Use 

Registry Editor at your own risk. 

1.   During the host software package installation, an additional window will be 

displayed to select whether an RDAC or a MPIO/DSM driver is to be installed 

as a multipath driver. 

Note:  If a version of RDAC driver is already installed in the host server, it must 

be uninstalled and the server must be rebooted before the MPIO/DSM 

driver can be installed and vice versa. 

2.   Install the directory for RDAC and MPIO. 

v   For RDAC: C:\Program Files\IBM_DS4000\mpp 

v   For MPIO/DSM: C:\Program Files\DSMDrivers\ds4dsm

3.   To identify that RDAC is installed, there is a RDAC Multipath Pseudo-Bus entry 

under the SCSI and RAID Controllers folder of the Device Manager in the 

Microsoft Windows Computer Management window after the SMIA installation 

wizard completes and the server is rebooted. If there are logical drives from the 

DS4000 storage subsystems mapped to the server, they will be claimed by the 

RDAC driver and presented to the Windows operating system as RDAC Virtual 

Disks under the Disk Drives folder. 
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4.   To identify that MPIO is installed there is a Multipath Support entry under SCSI 

and RAID Controllers folder of the Device Manager in the Microsoft Windows 

Computer Management window after the SMIA installation wizard completes 

and the server is rebooted. If there are logical drives from the DS4000 storage 

subsystems mapped to the server, they will be claimed by the MPIO driver and 

presented to the Windows operating system as IBM xxx Multipath Disk Device 

under the Disk Drives folder where xxx is the product ID of the DS4000 storage 

subsystem as reported through the SCSI inquiry command. In the graphic, the 

product ID is 1814 FAStT as reported by a DS4700 storage subsystem. 

 

  

Figure 33. RDAC  devices
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In addition, under the System Devices folder, there are two entries for the 

Device Specific Modules: IBM DS3000/DS4000 Series Device Specific Modules 

for Multi-Path and IBM DS3000/DS4000 UTM Disk Manager. IBM 

DS3000/DS4000 UTM Disk Manager is for managing the IBM Universal Xport 

SCSI Disk Devices, which are the handles for the DS4000 Storage Manager 

client program to perform in-band management.
 

  

Figure 34. Multipath Support entry under SCSI and RAID Controllers folder of the Device 

Manager
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5.   To tell what the version and associated component files of the DSM are, 

right-click the DSM and choose Properties on the *.sys file to get the version. 

You can also get the properties information by selecting the DSM from the 

Device Manager. 

6.   The base registry path for all drivers is HKEY_LOCAL_MACHINE\System\
CurrentControlSet\Services. MPP has an rdacdisk and rdacbus key. The DSM 

has a key that is named based on the driver name. For IBM the name is 

ds4dsm for the DSM driver and ds4utm for the UTM driver. 

7.   Open the Command Prompt window and type in regedt32. 

8.   Go to the registry key \HKEY_LOCAL_MACHINE\SOFTWARE\Storage for Windows 

2000, Windows Server 2003/2008 x86 edition or Windows Server 2003 IA64 

edition. For Windows Server 2003/2008 x64 edition, go to the 

\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Storage key instead. 

9.   For each package that you installed, there would be a folder under the 

\HKEY_LOCAL_MACHINE\SOFTWARE\Storage or \HKEY_LOCAL_MACHINE\SOFTWARE\
WOW6432Node\Storage key. Click on that folder name and look for the Version 
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Figure 35. System Devices folder
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data field in the right window pane. The Version data field will have the correct 

version of the host software package that you installed. Record these versions 

for future reference. For example, shows that all four host-software packages 

were installed in this server and the version of the SMutil package is 

09.12.35.00.
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Figure 36. Registry Editor window
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Appendix  E.  Operating  system  limitations  

This appendix contains the following sections: 

v   “Windows operating system limitations” 

v   “Linux operating system limitations” on page 204 

v   “VMware ESX Server operating system limitations” on page 207

Windows operating system limitations 

This appendix contains information about how to operate the storage management 

software in a Windows 2000, or Windows Server 2003 environment. For the most 

up-to-date information, always check the most recent DS4000 Storage Manager 

readme file for Windows 2000 or Windows Server 2003. 

See “Readme files and concepts” on page 1 to find out how to access the most 

recent Storage Manager readme files on the Web. 

Limitations of Windows operating systems 

Table 23 on page 196 explains limitations that apply when you use the IBM DS4000 

Storage Manager Version 10.10 with Windows 2000 and Windows Server 2003. 

Note:  These limitations may only occur when you manage storage subsystems 

with older firmware versions.
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Table 23. Windows operating system limitations and workarounds 

Limitation Workaround 

If you are upgrading controller firmware in 

IBM FAStT500 storage controller (M/T 

3552) with 512MB Cache, you will have to 

stop I/O and reboot both controllers 

before upgrading firmware followed by 

NVSRAM. You can reboot the controllers 

either by power cycling the storage 

subsystem or by pressing the Reset 

button on both controllers. The Reset 

button is located on the right of the 

indicator lights in the opening on the front 

of each controller unit. 

To determine Storage Controller cache 

level, perform the following: 

1.   On a storage management station 

start the client software and select a 

storage subsystem. 

2.   Select Tools → Manage Device to 

open the Subsystem Management 

Window. 

3.   Highlight the Storage Subsystem that 

you are upgrading and then select 

Storage Subsystem → Profile. It may 

take a little time for it to create the 

Storage Subsystem profile. 

4.   Under the Controllers heading is an 

entry that displays information similar 

to the following example: 

Cache/processor size (MB):  256/32

If this setting is listed as 512/32 you will 

need to arrange to perform this upgrade 

procedure at a time that you can stop I/O 

to the Storage Subsystem in order to 

ensure a successful firmware download 

and installation. 

None. 
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Table 23. Windows operating system limitations and workarounds (continued) 

Limitation Workaround 

Storage Manager prompts you for a 

password if all hard disk drives are 

removed from the storage subsystem. 

After removing all drives from a storage 

subsystem (or not powering on drives and 

only the controller), the IBM DS4000 

Storage Manager software will prompt you 

for a password when trying to start the 

software or trying to perform protected 

operations. Any password entered will fail. 

Password information is stored on a 

reserved area of each hard disk drive on 

the storage subsystem. Each drive stores 

a mirrored copy of the password data. 

When there are no drives in the storage 

subsystem, the storage management 

software does not find the password data 

when you attempt password protected 

operations. Add one drive to the storage 

subsystem and retry the operation. 

Since the RAID controller unit should not be 

powered on until the expansion units are 

attached and powered on, this should be done by 

powering off the RAID controller unit, properly 

attaching all expansion units (with drives 

installed), to the RAID controller unit and 

powering them on, and then powering the RAID 

controller unit back on. At this point the storage 

subsystems can be rediscovered and managed 

using the IBM DS4000 Storage Manager 

software. 

If you get "Error 21 - The Operation 

cannot complete because a  ...  is in 

progress" error when you issue a 

Subsystem Management command from 

the IBM DS4000 Storage Manager Client, 

the command may be cached for 

execution when the storage subsystem 

was busy with other tasks even though 

the Storage Manager GUI returned a 

″command not be able to execute″ error. 

If the command is cached, the IBM 

DS4000 Storage Manager Client will run 

the command as soon as the controller 

resources are available. 

Wait for at least ten minutes after an issued 

command failed to execute and check to see 

whether the command has been run. If not, 

reattempt the command. 

When the server HBA ports are directly 

connected to the DS4000 storage 

subsystem controllers, do not download 

firmware and NVSRAM files to the 

controllers with IOs being generated to 

the LUNs in the DS4000 storage 

subsystem. There is no IOs restriction in 

SAN Fabric environment, for example, 

when the HBA port are connected to the 

DS4000 storage subsystem controller 

ports via fibre channel switches. 

None. 

When using the RDAC package from the 

Storage Manager 8.40 host-software 

package or earlier, rebooting a host 

server might cause its mapped LUNs 

move to a non-preferred path. 

Either use the DS4000 Storage Manager client 

program to redistribute the LUNs to their 

preferred path or upgrade the RDAC driver to the 

version that is packaged with Storage Manager 

host software version 9.1 or later. 
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Table 23. Windows operating system limitations and workarounds (continued) 

Limitation Workaround 

Dynamically changing the cache read 

ahead multiplier setting via the storage 

manager client may result in an error 

message indicating the operation has 

failed. Despite the error message, the 

request to change the cache read ahead 

multiplier will remain queued to the 

controllers and will eventually complete 

when I/O activity to the storage 

subsystem has subsided. 

In order to avoid the error message and any 

delays in the cache read ahead multiplier value 

changing, it is recommended to change the 

cache read ahead multiplier when the subsystem 

is in a quiesced state. 

In System x x330 server, when two of the 

Dynamic disks are mirrored together by 

the Windows OS and the LUN that these 

disks are defined on failovers/failbacks, 

the server might hang after failover. 

None. 

There are no host type for the Windows 

Server 2003 in the host-type pull-down 

menu in the Defined host port or 

Changing default Host Type window. 

Windows 2000 and Windows Server 2003 share 

the following host type options: 

v   Windows 2000/Server 2003 non-clustered 

v   Windows 2000/Server 2003 clustered

If the above entries are not displayed in the 

host-type pull down window, use these host type 

options for the default host type for Windows 

Server 2003 host port or for the host type of the 

defined port of an FC HBA that is installed in a 

Windows Server 2003 server instead. 

v   Windows 2000 non-clustered 

v   Windows 2000 clustered 

If you click a vertical scroll arrow either up 

or down, the scroll box will move all the 

way to the opposite end of the scroll bar. 

This is a known defect in the Java Runtime 

Environment. Click the scroll box and slide it until 

you reach the position that you want in the Help 

window. 

Data or configuration loss might occur 

during a logical drive migration. Logical 

drive migration consists of removing 

configured physical drives from one 

storage subsystem and inserting them 

into another storage subsystem. 

Either use the migration instructions in the IBM 

System Storage DS4000 Hard Drive and Storage 

Expansion Enclosure Installation and Migration 

Guide or contact an IBM technical support 

representative for assistance in performing this 

procedure. 

Array migration is not supported because 

it could cause loss of configuration and 

data. Array migration consists of removing 

a set of drives configured with arrays from 

one storage subsystem and inserting 

them into another storage subsystem. 

Either use the migration instructions in the IBM 

System Storage DS4000 Hard Drive and Storage 

Expansion Enclosure Installation and Migration 

Guide or contact an IBM technical support 

representative for assistance in performing this 

procedure. 

If you manage storage subsystems 

through the host-agent software and use 

the storage management software to 

download controller firmware, the 

download process can take up to 10 

minutes to complete. 

None. 
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Table 23. Windows operating system limitations and workarounds (continued) 

Limitation Workaround 

When you configure a new storage 

subsystem with a single controller, you 

must place the controller in slot A. The 

controller firmware cannot recognize or 

communicate with a single controller until 

slot A is populated. This restriction does 

not apply to storage subsystems that 

were originally configured with two 

controllers. 

None. 

The following loop configuration is not 

supported: IBM Fibre Channel Hub 

(machine type 3523) in conjunction with 

the IBM Fibre Channel Switch (machine 

types 2109 S16 and 2109 S08) or the 

IBM Fibre Channel Switch (machine types 

3534 F08 and 2109 F16). 

None. 

A controller failover occurs in an 

active/active controller pair, and 

ownership of arrays transfers from the 

failed preferred owner to the other 

controller of the repair. The failed 

controller is replaced and brought online. 

The array ownership is not automatically 

transferred back to the preferred controller 

owner. 

Immediately after you replace the controller, click 

Storage subsystem → Redistribute Arrays in 

the Subsystem Management window to 

redistribute arrays back to their preferred 

controller owners. For more information, refer to 

the Enterprise Management online help. 

After adding a host device to the 

management domain of more than five 

clients, the host-agent-managed storage 

subsystems attached to that host become 

unresponsive. 

Make sure that a single instance of the 

host-agent software communicates with no more 

than five clients. 

When you connect a DS4000 EXP700 

Storage Expansion Unit to a FAStT200, 

you must set the drive speed to 1Gbps. 

None. 
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Table 23. Windows operating system limitations and workarounds (continued) 

Limitation Workaround 

After you install the host-agent software, 

the host displays the error message 

Service Error 100. 

The cause includes: 

v   The host-agent software does not find any 

controllers with firmware version 05.3x.xx.xx or 

later. Upgrade the firmware to the latest 

firmware level from the IBM support Web site 

at: 

www.ibm.com/support/ 

For more information, see “Direct-management 

method workaround” on page 203. 

v   The access logical drive has been removed 

from NVSRAM or the storage partition defined 

for the host. Perform one of the following 

tasks: 

–   Manage the storage subsystem by using 

the direct-management method. See 

“Direct-management method workaround” 

on page 203. 

–   Define the access logical drive for the host 

and restart SMagent. See“SMagent 

workaround for defining additional access 

LUN mapping” on page 203.

v   The NVSRAM on the controllers in a storage 

subsystem that you want to manage contains 

an access logical drive LUN that is in use by 

another logical drive, or is not supported by 

the operating system or installed patches. For 

example, the access logical drive is configured 

at LUN 31, and the operating system and 

service packs support only eight LUNs. 

Perform one of the following tasks: 

–   Manage the storage subsystem by using 

the direct-management method. See 

“Direct-management method workaround” 

on page 203. 

–   Change the LUN mapping for the 

host-access logical drive to a LUN that is 

not in use and is supported by the 

operating system either from a different 

computer that has management access to 

the storage subsystem, or establish a direct 

management connection to the storage 

subsystem from the current host. For more 

information, see “SMagent workaround for 

changing existing access LUN mapping” on 

page 204. 

Auto LUN/Array Transfer is not enabled. If 

a controller fails over arrays to the 

alternate controller and the failed 

controller is replaced and brought back 

online, the arrays will not automatically 

transfer to the preferred controller. 

Manually select the Redistribute Logical Drives 

menu option in the IBM DS4000 Storage 

Manager client GUI. 

A brownish hash pattern displays in the 

dialog windows and in online help when 

operating in 256-color mode. 

Run the DS4000 Storage Manager application in 

a higher display mode. 
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Table 23. Windows operating system limitations and workarounds (continued) 

Limitation Workaround 

The system might display the DS4000 

Storage Manager dialog windows as 

cropped without the vertical and horizontal 

scroll bars. 

Move the mouse pointer over the edge of the 

window until the mouse pointer changes to a 

window resize pointer. Left-click your mouse; 

hold to grip the window’s edge and resize the 

window. 

The controller in the IBM DS4000 storage 

subsystem with firmware 05.3x.xx.xx is 

connected to a SAN with more than 64 

host connections per controller port that 

can log into the controllers, exceeding the 

maximum number of host connections 

that can be seen and log into the 

controller. 

Either use the switch zoning function or 

rearrange the SAN connections so that only the 

following maximum number of host connections 

can be seen and log into the controller as 

follows: 

v   The following DS4000 storage subsystems 

have two ports per controller – one per 

minihub slot. 

–   DS4500, Machine Type 1742 

–   DS4400, Machine Type 1742 

–   FAStT500, Machine Type 3552

v    The DS4300, machine type 1722 has two 

ports per controller. 

v   The FAStT200, machine type 3542 has only 

one port per controller. 

It is possible to circumvent IBM DS4000 

storage subsystem hardware and 

software designs for redundant pathways 

from the host system. This is 

accomplished by connecting a single host 

adapter from the host system to one of 

the controller minihubs, and then 

connecting this minihub to the minihub of 

the other controller, creating a Fibre 

Channel Arbitrated Loop (FC-AL) between 

the host adapter and the two IBM DS4000 

storage subsystem controllers. This 

configuration leaves no redundant path to 

the host system. 

When connecting two minihubs together, always 

connect the IN port of one minihub to the OUT 

port of the other minihub or vice versa. Do not 

connect the IN port of one to the IN port of the 

other minihub or the OUT port of one minihub to 

the OUT port of the other minihub. 

Nevertheless, this configuration is not supported 

by IBM. 

When you issue a Subsystem 

Management command from the IBM 

DS4000 Storage Manager client, the 

command may be cached. If so, the 

system will issue the error: Error 21 - 

The Operation cannot complete because 

a... is in progress. The IBM DS4000 

Storage Manager client will run such 

cached commands as soon as the 

controller resources become available. 

Wait for at least ten minutes; then, check to see 

if the IBM DS4000 Storage Manager client has 

run the command. If it has not, reissue the 

command. 

You must always uninstall IBM DS4000 

Storage Manager RDAC before you 

uninstall the host bus adapter driver. 

Failure to do so may result in a hung 

system or blue screen. 

None. 
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Table 23. Windows operating system limitations and workarounds (continued) 

Limitation Workaround 

When you upgrade the DS4000 Storage 

Subsystem controller firmware from any 

version 05.00.xx.xx (or earlier) to version 

05.2x.xx.xx (or later), the controller 

returns the first four bytes of the firmware 

revision to the Product Revision Field of 

the SCSI LUN inquiry data. Windows 

2000 uses this Product Revision data as 

part of its LUN identification method. In 

doing so, Windows 2000 incorrectly 

interprets your upgrade of the firmware 

revision level and subsequent Product 

Revision data change to mean that you 

have also removed LUNs with the original 

Product Revision data from the server. 

When the DS4000 Storage Manager 

hot_add utility later executes the scan for 

hardware changes task, or when you 

select the Scan For Hardware Changes 

menu option of the Devices folder in the 

Computer Management window, Windows 

2000 displays the Unsafe Removal of 

Devices dialogs for the original LUNs. The 

devices cited in these dialogs are RDAC 

Virtual Disks and xxxx SCSI devices, 

where xxxx represents either 1722 

(DS4300), 1742 (DS4400), 3552 

(FAStT500) or 3542 (FAStT200), 

depending on the machine type of the 

DS4000 storage subsystem from which 

Windows 2000 had mapped the original 

LUNs. Under these circumstances, the 

Windows 2000 server will lose 

connectivity to the LUNs in the DS4000 

Storage Subsystem whose controller 

firmware you updated. 

This problem will not occur when you 

upgrade the DS4000 Storage Subsystem 

controller firmware from version 

05.20.xx.xx to version 05.3x.xx.xx or later 

because the Product Revision data field 

was fixed at 0520. 

After you apply the new DS4000 Storage 

Subsystem controller firmware and NVSRAM, 

you must perform one of the following 

procedures reconnect DS4000 storage 

subsystems to their logical drives: 

v   rescan the server for hardware changes. 

v   Add the logical drives back to the server. 

v   Reboot all of the Windows 2000 servers that 

originally had LUNs mapped in the affected 

DS4000 Storage Subsystem. 
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Table 23. Windows operating system limitations and workarounds (continued) 

Limitation Workaround 

After using the Microsoft Cluster 

Administrator to configure a server cluster, 

the disk timeout value in the system 

registry is changed to an incorrect value. 

Complete the following procedure to change the 

disk timeout value to the correct value after the 

server cluster configuration is complete. 

1.   Select Start → Run. 

2.   Type the following command and press Enter: 

regedit 

The Registry Editor is displayed. 

3.   From the left pane of the Registry Editor, 

navigate to the directory: 

HKEY_LOCAL_MACHINE\System\ 

CurrentControlSet\Services\Disk 

4.   From the right pane of the Registry Editor, 

double-click TimeOutValue. 

The Edit DWORD Value dialog is displayed. 

5.   In the Value Data text area, type decimal 60 

(or the value to which your system was 

previously set), and press Enter. 

6.   Under Base, select Hexadecimal. 

7.   Select OK.
  

Direct-management method workaround 

Perform the following steps for the direct-management method workaround: 

1.   Connect the two controller Ethernet ports to the network. 

2.   Follow the direct-management setup instructions in Chapter 2, “Preparing for 

installation,” on page 37 to manage the subsystem directly. 

3.   Open the Storage Manager Enterprise Management window. Click Edit → Add 

device. 

4.   Type the IP address for the first controller and click Add. 

5.   Repeat to add the IP address of the additional controllers. 

6.   Click Close. 

7.   Right-click the newly added storage subsystem and select Manage Device. The 

Subsystem Management window for the storage subsystem opens. Proceed 

with the storage subsystem management tasks.

SMagent workaround for defining additional access LUN 

mapping 

Perform the following steps to define additional access LUN mapping for SMagent: 

1.   Go to a different computer that has management access to the storage 

subsystem, or establish a direct management connection to the storage 

subsystem from the current host. 

2.   Start the IBM DS4000 Storage Manager Client and open the Subsystem 

Management window for the storage subsystem. 

3.   Click the Mappings View tab. 

4.   Right-click the Default Group and select Define Additional mappings. 

5.   Select Access. 

6.   From the LUN drop-down menu, select Logical Unit Number (LUN) 31. 

7.   Click Add to define the access LUN. 
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8.   Click Close. In the Define Mapping pane, a LUN with the Access name 

displays. 

9.   Close the window and restart the host. When the host restarts, the SMagent 

service starts.

SMagent workaround for changing existing access LUN mapping 

Perform the following steps to change existing access LUN mapping: 

1.   Go to a different computer that has management access to the storage 

subsystem, or establish a direct management connection to the storage 

subsystem from the current host. 

2.   Start the IBM DS4000 Storage Manager Client and open the Subsystem 

Management window for the storage subsystem. 

3.   Click the Mappings View tab. 

4.   From the topology pane, select the Default Group or the corresponding host 

partition. 

5.   Right-click Access and select Change Mapping. A Change Mapping window 

opens. 

6.   From the LUN drop-down menu, select the LUN that your operating system 

supports. If it is not available, you must remove one of the existing storage 

partitioning mappings. 

7.   Click OK. 

8.   Close the window and restart the host. When the host restarts, the SMagent 

service starts.

Linux operating system limitations 

This appendix contains information that is specific to operating the storage 

management software in a Linux environment. For the most up-to-date information, 

always check the most recent DS4000 Storage Manager readme files for Linux. 

See “Readme files and concepts” on page 1 to find out how to access the most 

recent Storage Manager readme files on the Web. 

Note:  These limitations may only occur when you manage storage subsystem with 

older firmware versions. 

Table 24 on page 205 lists the limitations that apply when you use IBM DS4000 

Storage Manager version 9.1x or above with Linux. 
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Table 24. Linux limitations and workarounds 

Limitations Workaround 

If you are upgrading controller firmware in 

IBM FAStT500 storage controller (M/T 3552) 

with 512MB Cache, you will have to stop I/O 

and reboot both controllers before upgrading 

firmware followed by NVSRAM. You can 

reboot the controllers either by power cycling 

the storage subsystem or by pressing the 

Reset button on both controllers. The Reset 

button is located on the right of the indicator 

lights in the opening on the front of each 

controller unit. 

To determine Storage Controller cache level, 

perform the following: 

1.   On a storage management station start 

the client software and select a storage 

subsystem. 

2.   Select Tools → Manage Device to open 

the Subsystem Management Window. 

3.   Highlight the Storage Subsystem that you 

are upgrading and then select Storage 

Subsystem → Profile. It may take a little 

time for it to create the Storage 

Subsystem profile. 

4.   Under the Controllers heading is an entry 

that displays information similar to the 

following example: 

Cache/processor size (MB):  256/32

If this setting is listed as 512/32 you will need 

to arrange to perform this upgrade procedure 

at a time that you can stop I/O to the Storage 

Subsystem in order to ensure a successful 

firmware download and installation. 

None. 

Storage Manager prompts you for a password 

if all hard disk drives are removed from the 

storage subsystem. 

After removing all drives from a storage 

subsystem (or powering on the controller only 

without any drive expansion enclosures), the 

IBM DS4000 Storage Manager software will 

prompt you for a password when trying to 

start the software or trying to perform 

protected operations. Any password entered 

will fail. 

Password information is stored on a reserved 

area of each hard disk drive on the storage 

subsystem. Each drive stores a mirrored copy 

of the password data. When there are no 

drives in the storage subsystem, the storage 

management software does not find the 

password data when you attempt password 

protected operations. Add one drive to the 

storage subsystem and retry the operation. 

Since the RAID controller unit should not be 

powered on until the expansion units are 

attached and powered on, this should be 

done by powering off the RAID controller unit, 

properly attaching all expansion units (with 

drives installed), to the RAID controller unit 

and powering them on, and then powering 

the RAID controller unit back on. At this point 

the storage subsystems can be rediscovered 

and managed using the IBM DS4000 Storage 

Manager software. 
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Table 24. Linux limitations and workarounds (continued) 

Limitations Workaround 

The DS4000 Storage Management dialog 

windows may be displayed cropped without 

the vertical and horizontal scroll bars. 

Move the mouse pointer over the edge of the 

window until the mouse pointer changes to 

window resize pointer, left click and hold to 

grip the window edge to resize it. 

Dynamically changing the cache read ahead 

multiplier setting via the storage manager 

client may result in an error message 

indicating the operation has failed. Despite 

the error message, the request to change the 

cache read ahead multiplier will remain 

queued to the controllers and will eventually 

complete when I/O activity to the storage 

subsystem has subsided. 

In order to avoid the error message and any 

delays in the cache read ahead multiplier 

value changing, it is recommended to change 

the cache read ahead multiplier when the 

subsystem is in a quiesced state. 

It is possible to circumvent IBM DS4000 

storage subsystem hardware and software 

designs for redundant pathways from the host 

system. This is accomplished by connecting a 

single host adapter from the host system to 

one of the controller miniHUBs, and then 

connecting this miniHUB to the miniHUB of 

the other controller, creating a Fibre Channel 

Arbitrated Loop (FC-AL) between the host 

adapter and the two IBM DS4000 storage 

subsystem controllers. This configuration 

leaves no redundant path to the host system. 

When connecting two miniHUBs together, 

always connect the IN port of one miniHUB to 

the OUT port of the other miniHUB or visa 

versa. Do not connect the IN port of one to 

the IN port of the other miniHUB or the OUT 

port of one miniHUB to the OUT port of the 

other miniHUB. 

This configuration is not supported by IBM. 

Vixel Rapport 2000 fibre channel hubs using 

controllers with firmware version 04.01.02 

cause problems, including damage to data, 

system instability, and disrupted loop activity. 

Do not use Vixel Rapport 2000 fibre channel 

hubs when your system is operating in a 

controller or an I/O path fault-tolerant 

environment. 

The maximum number of physical drives 

allowed in a single RAID 5 logical drive is 29. 

The maximum number of physical drives 

allowed in a single RAID 1 logical drive is 28. 

None. 

After removing all drives from a storage 

subsystem, you are prompted for a password 

at software startup or when you perform 

protected operations, all passwords you enter 

fail. 

Add one of the drives to the storage 

subsystem and attempt the operation again. 

Removing a set of drives that are configured 

with logical drives from one storage 

subsystem for insertion into another storage 

subsystem is not supported because it might 

cause loss of configuration. 

Either use the migration instructions in the 

IBM System Storage DS4000 Hard Drive and 

Storage Expansion Enclosure Installation and 

Migration Guide or contact an IBM technical 

support representative for assistance in 

performing this procedure. 

A standard non-network configuration is not 

supported when the Linux host does not have 

the TCP/IP software installed. 

Install the TCP/IP software on the Linux host 

computer and assign the host a static IP 

address. 

Multipath failover will work only if the storage 

controllers are in active/active mode. 

When you configure the storage subsystem, 

change both controllers to active status. 
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Table 24. Linux limitations and workarounds (continued) 

Limitations Workaround 

The controller firmware does not recognize or 

communicate with a single controller until slot 

A is populated. This restriction does not apply 

to storage subsystems that were originally 

configured with two controllers. 

When you configure a new storage 

subsystem with a single controller, you must 

place the controller in slot A. 

Your windows and online help display a 

brownish hash pattern when you run in 

256-color mode. 

Run the Storage Manager application in a 

higher display mode. 

When you perform a redundancy check 

(parity scan) from the storage management 

application, machine type 3542 (FAStT200) 

can take several minutes longer than 

machine type 1742 (DS4400) and 3552 

(FAStT500) controller platforms. 

None. 

You might not see the maximum number of 

drives during Automatic Configuration if you 

are using drives of different capacities. 

Use Manual Configuration to select individual 

drives and select the maximum number of 

drives allowed. 

When you connect an IBM System Storage 

DS4000 EXP700 Storage Expansion Unit to a 

FAStT200, the drive speed must be set to 

1Gbps. 

None. 

When you issue a Subsystem Management 

command from the IBM DS4000 Storage 

Manager client, the command may be 

cached. If so, the system will issue the error: 

Error 21 - The Operation cannot complete 

because a... is in progress. The IBM 

DS4000 Storage Manager client will run such 

cached commands as soon as the controller 

resources become available. 

Wait for at least ten minutes; then, check to 

see if the IBM DS4000 Storage Manager 

client has run the command. If it has not, 

reissue the command.

  

VMware ESX Server operating system limitations 

This appendix contains information about how to operate the storage management 

software in a VMware ESX Server environment. For the most up-to-date 

information, see the most recent DS4000 Storage Manager readme file for VMware 

ESX Server. 

See “Readme files and concepts” on page 1 to find out how to access the most 

recent Storage Manager readme files on the Web. 

Table 25 lists the limitations that apply when you use IBM DS4000 Storage 

Manager Version 10.10 with VMware ESX Server. 

 Table 25. VMware ESX Server limitations and workarounds 

Limitations Workaround 

VMware ESX Server clustering function is not 

supported. Clustering between guest 

operating systems is not supported. 

None. 

For information about possible support in 

future releases, contact your IBM service 

representative or submit an RPQ. 
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Table 25. VMware ESX Server limitations and workarounds (continued) 

Limitations Workaround 

The maximum number of guest operating 

systems that are supported on each VMware 

ESX Server is 16. 

None. 

For information about possible support in 

future releases, contact your IBM service 

representative or submit an RPQ. 

New logical drives cannot be successfully 

created and assigned to a guest operating 

system. 

Although a guest operating system can scan 

for new logical drives dynamically, the guest 

operating system must be powered off before 

new logical drives can be created within 

VMware ESX Server and assigned to that 

guest. 

When you issue a Subsystem Management 

command from the IBM DS4000 Storage 

Manager client, the command may be 

cached. If so, the system will issue the error: 

Error 21 - The Operation cannot complete 

because a... is in progress. The IBM 

DS4000 Storage Manager client will run such 

cached commands as soon as the controller 

resources become available. 

Wait for at least ten minutes; then, check to 

see if the IBM DS4000 Storage Manager 

client has run the command. If it has not, 

reissue the command.
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Appendix  F.  SAN  boot  on  Windows  limitations  

This appendix contains information that is specific to operating SAN in a Windows 

environment. The following is the current list of known limitations and restrictions 

when a Windows system is booted from a SAN attached DS4000 storage array. 

Some of these issues may be fixed in later releases of software or firmware for the 

DS4000 storage array. Please consult the README file for the specific release of 

firmware and drivers which are being installed to verify if any of these restrictions or 

limitations have been resolved. 

Table 26 lists the limitations that apply when you use SAN on Windows. 

 Table 26. SAN on Windows limitations and workarounds 

Limitations Workaround 

Interaction between AVT and RDAC  

When using RDAC, AVT must be disabled to 

avoid a condition where a LUN may thrash 

between controllers due to receiving 

commands from RDAC while being managed 

by AVT. In this event, if a failover to a 

non-preferred path has occurred, an attempt 

to reboot the system may result in the system 

failing to reboot. 

Note: AVT-enabled is a part of the SAN 

instructions, only for BladeCenter® with 

DS4000. 

The following actions may need to be 

performed to recover the storage array. 

v   Use the Storage Manager from an 

independent system to verify that state of 

the Boot LUN. 

v   Verify that the Boot LUN is on the 

preferred controller; and if not, resolve any 

issues that caused the LUN to failover to 

the non-preferred controller. 

v   Verify that all paths to both controllers are 

available and active. 

v   Verify during power on of the server that 

the fibre channel HBA BIOS successfully 

configures the boot LUN. 

At this time more then one storage array 

cannot be supported when SAN Boot is 

configured on a DS4000. If additional storage 

arrays are attached, it is likely that the system 

will fail to boot. 
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Appendix  G.  SAN  boot  on  Linux  limitations  

This appendix contains information that is specific to operating SAN in a Linux 

environment. The following is the current list of known limitations and restrictions 

when a Linux system is booted from a SAN attached DS4000 storage array. Some 

of this issues may be fixed in later releases of software or firmware for the DS4x00 

storage array. Please consult the README file for the specific release of firmware 

and drivers which are being installed to verify if any of these restrictions or 

limitations have been resolved. 

Table 27 lists the limitations that apply when you use SAN on Linux. 

 Table 27. SAN on Linux limitations and workarounds 

Limitations Workaround 

Interaction between AVT and RDAC  

When using RDAC, AVT must be disabled to 

avoid a condition where a LUN may thrash 

between controllers due to receiving 

commands from RDAC while being managed 

by AVT. In this event, if a failover to a 

non-preferred path has occurred, an attempt 

to reboot the system may fail. 

Note: AVT-enabled is a part of the SAN 

instructions, only for BladeCenter with 

DS4000. 

The following actions may need to be 

performed to recover the storage array. 

v   Use the Storage Manager from an 

independent system to verify that state of 

the Boot LUN. 

v   Verify that the Boot LUN is on the 

preferred controller; and if not, resolve any 

issues that caused the LUN to failover to 

the non-preferred controller. 

v   Verify that all paths to both controllers are 

available and active. 

v   Verify during power on of the server that 

the fibre channel HBA BIOS successfully 

configures the boot LUN. 

With the 09.01.B5.35 RDAC driver, there is 

an installation issue where the make install 

will fail. 

Edit the Makefile in the install directory, and 

add the following line to the end of the 

copyfiles section:depmod -a 

More then one storage array cannot be 

supported when SAN Boot is configured 

using QLogic adapters. If additional storage 

arrays are attached, it is likely that the system 

will fail to boot. 

No workaround at this time.
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Appendix  H.  Storage  subsystem  and  controller  information  

record  

Table 28 provides a data sheet for recording storage subsystem names, 

management types, Ethernet hardware addresses, and IP addresses. Make a copy 

of this table and complete the information for your storage subsystems and 

controllers. Use the information to set up the BOOTP table for the network server 

and the host or Domain Name System (DNS) table. The information is also helpful 

if you add storage subsystems after initial installation. The column headings show a 

page reference for detailed instructions about how to obtain the information. For a 

sample information record, refer to Table 14 on page 42. 

 Table 28. Storage subsystem and controller information record 

Storage 

subsystem 

name (page 

42) 

Management 

method (page 

11) 

Controllers-Ethernet and IP 

addresses, and host name (pages 

42 and 47) 

Host-IP address 

and host name 

(page 47) 
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Appendix  I. Host  bus  adapter  settings  

This appendix covers the default settings for a variety of host bus adapters (HBAs) 

suitable for use with DS4000 storage subsystems. 

Please refer to the readme file that is included in the fibre channel host bus adapter 

BIOS or device driver package for any up-to-date changes to the settings. 

An HBA is used to connect servers to fibre channel topologies. Its function is similar 

to that provided by network adapters to access LAN resources. The device driver 

for an HBA is typically responsible for providing support for a fibre channel topology, 

whether point-to-point, loop, or fabric. 

The Fast!UTIL feature enables you to access and modify an adapter’s default 

settings to optimize its performance. 

See also:  For detailed HBA support information, see the following Web sites: 

v   www-03.ibm.com/servers/storage/support/config/hba/index.wss 

v   www-03.ibm.com/servers/storage/disk/ds4000/pdf/interop-matrix.pdf

www-03.ibm.com/servers/storage/support/config/hba/index.wss 

Setting host bus adapters 

It is often necessary to adjust the settings of your HBA to match the capabilities of 

your device. This section describes how to access those settings to make the 

necessary adjustments. 

Accessing HBA settings through Fast!UTIL 

The Fast!UTIL feature provides access to host bus adapter settings. To access this 

feature, simultaneously press and hold the ALT and Q keys or the Ctrl and Q keys 

during BIOS initialization. It may take a few seconds for the Fast!UTIL menu to 

appear. If more than one board is installed, Fast!UTIL prompts you to select a board 

to configure. After you change adapter settings, Fast!UTIL reboots your system to 

load the new parameters. Upon entering Fast!UTIL, the following selections are 

available on the Fast!UTIL Options menu: 

v   Configuration Settings 

v   Loopback Test 

v   Select Host Adapter

You will access the host bus adapter settings through the Configuration Settings 

menu in Fast!UTIL. See “Host adapter settings” on page 216 and “Advanced 

Adapter Settings” on page 216 for detailed information on the settings. 

Note:  Alternatively, you can also use the QLogic SANsurfer program to modify the 

"Host adapter settings” and “Advanced adapter settings” preferences from 

the Microsoft Windows operating system environment. However, you must 

reboot the servers for the changes to become effective.
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Host adapter settings 

Access the host bus adapter settings through the Configuration Settings menu in 

Fast!UTIL and select Adapter Settings. The default host bus adapter settings for 

the FC2-133 HBA are as follows: 

Host Adapter BIOS 

When this setting is Disabled, the ROM BIOS on the FC2-133 HBA is 

Disabled, freeing space in upper memory. This setting must be Enabled if 

you are booting from an fibre channel disk drive attached to the FC2-133 

board. The default is Disabled. 

Frame Size 

This setting specifies the maximum frame length supported by the FC2-133 

HBA. The default size is 2048, which provides maximum performance for 

F-Port (point-to-point) connections. 

Loop Reset Delay 

After resetting the loop, the firmware refrains from initiating any loop activity 

for the number of seconds specified in this setting. The default is 5 

seconds. 

Adapter Hard Loop ID 

This setting forces the adapter to attempt to use the ID specified in the 

Hard Loop ID setting. The default is Enabled. 

Hard Loop ID  

If the Adapter Hard Loop ID setting is Enabled, the adapter attempts to use 

the ID specified in this setting. The default ID is 125. It is recommended to 

set this ID to a unique value from 0-125 if there are more than one adapters 

connected to a FC-AL loop and the Adapter Hard Loop ID setting is 

Enabled. 

Spin Up Delay 

When this bit is set, the BIOS will wait up to five minutes to find the first 

drive. The default setting is Disabled. 

Connection Options  

This setting defines the type of connection (loop or point to point) or 

connection preference. The default is 2, which is loop preferred unless 

point-to-point. 

Fibre Channel Tape Support 

This setting enables FCP-2 recovery. The default is Enabled. It is 

recommended to change this setting to Disabled if the HBA is not 

connected to a tape device. 

Data Rate 

This setting determines the data rate. When this setting is 0, the FC2-133 

HBA runs at 1Gbps. When this setting is 1, the FC2-133 HBA runs at 

2Gbps. When this setting is 2, Fast!UTIL determines what rate your system 

can accommodate and sets the rate accordingly. The default is 2 

(auto-configure).

Advanced Adapter Settings 

Access the following advanced host bus adapter settings through the Configuration 

Settings menu in Fast!UTIL and select Advanced Adapter Settings. The default 

settings for the FC2-133 HBA are as follows: 

Execution Throttle 

This setting specifies the maximum number of commands executing on any 
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one port. When a port’s execution throttle is reached, no new commands 

are executed until the current command finishes executing. The valid 

options for this setting are 1-256. The default is 255. 

LUNs per Target 

This setting specifies the number of LUNs per target. Multiple LUN support 

is typically for redundant array of independent disks (RAID) boxes that use 

LUNs to map drives. The default is 0. For host operating systems other than 

Microsoft Windows, one may need to change this setting to a value other 0 

to allow the host seeing more than one logical drive from the DS4000 

storage subsystem. 

Enable LIP Reset 

This setting determines the type of loop initialization process (LIP) reset that 

is used when the operating system initiates a bus reset routine. When this 

setting is yes, the driver initiates a global LIP reset to clear the target device 

reservations. When this setting is no, the driver initiates a global LIP reset 

with full login. The default is No. 

Enable LIP Full Login 

This setting instructs the ISP chip to re-login to all ports after any LIP. The 

default is Yes. 

Enable Target Reset 

This setting enables the drivers to issue a Target Reset command to all 

devices on the loop when a SCSI Bus Reset command is issued. The 

default is Yes. 

Login Retry Count 

This setting specifies the number of times the software tries to log in to a 

device. The default is 30 retries. 

Port Down Retry Count 

This setting specifies the number of seconds the software retries a 

command to a port returning port down status. The default is 30 seconds. 

For the Microsoft Windows servers in MSCS configuration, the ″Port Down 

Retry Count″ BIOS parameter must be changed from the default of 30 to 

70. 

Link Down Timeout 

This setting specifies the number of seconds the software waits for a link 

down to come up. The default is 60 seconds. 

Extended Error Logging 

This setting provides additional error and debug information to the operating 

system. When enabled, events are logged into the Windows NT Event 

Viewer. The default is Disabled. 

RIO Operation Mode 

This setting specifies the reduced interrupt operation (RIO) modes, if 

supported by the software driver. RIO modes allow posting multiple 

command completions in a single interrupt. The default is 0. 

Interrupt Delay Timer 

This setting contains the value (in 100-microsecond increments) used by a 

timer to set the wait time between accessing (DMA) a set of handles and 

generating an interrupt. The default is 0.
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QLogic host bus adapter settings 

Note:  The BIOS settings under the Windows column are the default values that are 

set when the adapters are ordered from IBM as IBM FC-2 (QLA2310), 

FC2-133 (QLA2340) and System Storage DS4000 single-port and dual-port 

4Gbps (QLx2460 and QLx2462) FC host bus adapters. If the adapters are 

not from IBM, the default BIOS may not be the same as the ones defined in 

the Microsoft Windows column. There is one exception, the default setting 

for fibre channel tape support is enabled. 

Table 29 covers the default settings for IBM fibre channel FC-2 and FC2-133 

(QLogic adapter models QLA2310 and QLA2340) host bus adapter settings (for 

BIOS V1.35 and later) by operating system as well as the default registry settings 

for Microsoft Windows OS’s. DS4000 products require BIOS V1.43 or later for these 

adapters. In addition, these settings are also the default BIOS settings for the newer 

DS4000 4Gbps single and dual-port host bus adapters (QLogic adapter models 

QLx2460 and QLx2462). The 4Gbps host bus adapters adapter BIOS version is 

1.12 or later. See the appropriate readme file for the latest updates to these values.

 Table 29. QLogic model QLA2310, QLA2340, QL2342, QLx2460 and QLx2462 host bus adapter settings by operating 

system 

Item Windows Linux NetWare VMware ESX 

Server NT 2000 / Server 2003 

BIOS  settings 

Host Adapter settings 

Host Adapter BIOS  Disabled Disabled Disabled Disabled 

Frame Size 2048 2048 2048 2048 

Loop Reset Delay 5 5 8 5 

Adapter Hard Loop ID Enabled Enabled Enabled Enabled 

Hard Loop ID (should 

be unique for each HBA) 

1251 1251 1251 1251 

Spin Up Delay Disabled Disabled Disabled Disabled 

Connection Options 2 2 2 2 

Fibre Channel Tape 

Support 

Disabled3 Disabled3 Disabled3 Disabled3 

Data Rate 2 2 2 2 

Advanced adapter settings 

Execution Throttle 255 255 255 255 

LUNs  per Target 0 0 0 32 

Enable LIP Reset No No No No No 

Enable LIP Full Login Yes Yes Yes Yes Yes 

Enable Target Reset Yes Yes Yes Yes Yes 

Login Retry Count 30 30 30 30 

Port Down  Retry Count 30 30 12 302 

Link Down  Time Out  60 60 60 60 

Extended Error 

Logging 

Disabled Disabled Disabled Disabled 
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Table 29. QLogic model QLA2310, QLA2340, QL2342, QLx2460 and QLx2462 host bus adapter settings by operating 

system (continued) 

RIO  Operation Mode 0 0 0 0 

Interrupt Delay Timer 0 0 0 0 

Data Rate 2 2 2 2 

Registry settings5 (HKEY_LOCAL_MACHINE  → System → CurrentControlSet → Services → QL2300 → Parameters → 

Device) 

LargeLUNs N/A N/A N/A N/A 

MaximumSGList 0xff 0xff N/A N/A 

Registry settings5 (HKEY_LOCAL_MACHINE  → System → CurrentControlSet → Services → QL2300 → Parameters → 

Device) under the DriverParameter variable. 

BusChange N/A 0 N/A N/A 

Registry settings5 (HKEY_LOCAL_MACHINE  → System → CurrentControlSet → Services → Disk) 

TimeOutValue 0x3C (60 

secs)4 

0x3C (60 secs)4 N/A N/A 

Notes:  

1.   This setting must be changed to a unique AL-PA value if there is more than one FC device in the FC-AL loop. 

2.   For larger configurations with heavy I/O loads or in Microsoft cluster service (MSCS) environment, it is 

recommended to change this value to 70. 

3.   This setting should be changed to enable or supported when the HBA is connected to a Tape device only. It is 

recommended to set it to Disabled when connecting to a DS4000 storage subsystem. 

4.   In certain storage subsystem maximum configuration installations, it may be required to set the TimeOutValue to 

120 (decimal). Changing this value to a higher value might affect your application especially when it requires the 

disk I/O completion acknowledgement within a certain amount of time. 

5.   Registry settings can be accessed by clicking Start, select Run..., type regedit into the Open: field, and then click 

OK.

 Attention:  Exercise caution when changing the Windows registry. Changing the wrong registry entry or making 

an incorrect entry for a setting can introduce an error that prevents your server from booting up or operating 

correctly.
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Note:  The BIOS settings under the Windows column are the default values that are 

set when the adapters are ordered from IBM as IBM FAStT (QLA2200) FC 

host bus adapters. If the adapters are not from IBM, the default BIOS may 

not be the same as the ones defined in the Microsoft Windows column. 

There is one exception, the default setting for fibre channel tape support is 

enabled. 

Table 30 covers the default settings for various IBM DS4000 FC host bus adapters 

(QLogic adapter QL220x) models (for BIOS V1.81) by operating system. See the 

appropriate readme file for the latest updates to these values.

 Table 30. QLogic model QL220x (for BIOS V1.81) host bus adapter settings by operating system 

Item Windows Linux NetWare 

NT 2000 / Server 2003 

BIOS  settings 

Host Adapter settings 

Host Adapter BIOS  Disabled Disabled Disabled Disabled 

Frame Size 2048 2048 2048 2048 

Loop Reset Delay 5 5 8 5 

Adapter Hard Loop ID Enabled Enabled Enabled Enabled 

Hard Loop ID (should be 

unique for each HBA) 

1251 1251 1251 1251 

Spin Up Delay Disabled Disabled Disabled Disabled 

Advanced adapter settings 

Execution Throttle 256 256 256 256 

>4 Gbyte Addressing Disabled Disabled Disabled Disabled 

LUNs  per Target 0 0 0 32 

Enable LIP Reset No No No No 

Enable LIP Full Login Yes Yes Yes Yes 

Enable Target Reset Yes Yes Yes Yes 

Login Retry Count 30 30 30 30 

Port Down  Retry Count 30 30 12 302 

IOCB  Allocation 256 256 256 256 

Extended Error Logging Disabled Disabled Disabled Disabled 

Extended Firmware Settings 

Extended Control Block Enabled Enabled Enabled Enabled 

RIO  Operation Mode 0 0 0 0 

Connection Options 3 3 3 3 

Class 2 Service Disabled Disabled Disabled Disabled 

ACK0  Disabled Disabled Disabled Disabled 

Fibre Channel Tape Support Supported3 Supported3 Supported3 Supported3 

Fibre Channel Confirm Disabled Disabled Disabled Disabled 

Command Reference 

Number 

Disabled Disabled Disabled Disabled 

Read Transfer Ready Disabled Disabled Disabled Disabled 
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Table 30. QLogic model QL220x (for BIOS V1.81) host bus adapter settings by operating system (continued) 

Response Timer 0 0 0 0 

Interrupt Delay Time 0 0 0 0 

Registry settings4 (HKEY_LOCAL_MACHINE  → System → CurrentControlSet → Services → QL2200 → Parameters → 

Device) 

LargeLuns 1 

MaximumSGList 0x21 0x21 

Registry settings4 (HKEY_LOCAL_MACHINE  → System → CurrentControlSet → Services → Disk) 

TimeOutValue 0x3C 0x3C 

Registry settings4 (HKEY_LOCAL_MACHINE  → System → CurrentControlSet → Services → QL2200 → Parameters → 

Device) under the DriverParameter variable 

BusChange 0 

Notes:  

1.   This setting must be changed to a unique AL-PA value if there is more than one FC device in the FC-AL loop. 

2.   For larger configurations with heavy I/O loads, it is recommended to change this value to 70. 

3.   This setting should be changed to enable or supported when the HBA is connected to a Tape device only. It is 

recommended to set it to Disabled when connecting to DS4000 storage subsystem. 

4.   Registry settings can be accessed by clicking Start, select Run..., type regedit into the Open: field, and then click 

OK.

 Attention:  Exercise caution when changing the Windows registry. Changing the wrong registry entry or making 

an incorrect entry for a setting can introduce an error that prevents your server from booting up or operating 

correctly.
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Appendix  J.  DS4000  Diagnostic  Data  Capture  (DDC)  

DDC information 

Under rare circumstances an internal controller error can force a routine to perform 

a function referred to as a DDC or Diagnostic Data Capture. When this has 

occurred, if you open the Enterprise Management window you will notice a red stop 

sign next to the name of the storage that has the error (is in a non-optimal state). 

Click on that storage to bring up the Subsystem Management window. You can then 

click on the Recovery Guru which will show what the issue is, or you can check in 

the MEL (DS4000 Storage Manager Major Events Log), where a critical event will 

be posted. See “DDC MEL events” on page 225. 

DDC function implementation 

In order to assist IBM support in collecting data for troubleshooting certain unusual 

events in controller firmware, the Diagnostic Data Capture (DDC) function was 

implemented in the latest controller firmware version of the following DS4000 

storage subsystem controller firmware versions: 

v   07.10.xx.xx 

v   06.23.xx.xx or greater 

v   06.19.xx.xx 

v   06.16.xx.xx 

v   06.15.24.xx or higher 

v   06.12.27.xx or higher

Note:  This function is not implemented with controller firmware code versions that 

are less then 06.12.27.xx level. 

How Diagnostic Data Capture works 

When the DDC function is implemented, the DS4000 storage subsystem status will 

change from Optimal to Needs Attention due to DDC. This will occur whenever the 

controllers in the DS4000 subsystem detect unusual events like Master abort (due 

to a bad address accessed by the fibre channel chip resulting in a PCI bus error), 

when the controller is not able to process host I/O requests for an extended period 

of time (several minutes), when there is destination device number registry 

corruption, an EDC error is returned by the disk drives, a Quiescence failure for the 

Logical Drive owned by the alternate controller. or corruption in records related to 

Storage Partition Management. Once the Needs Attention due to DDC flag is set, it 

will be persistent across the power-cycle and controller reboot, provided the 

controller cache batteries are sufficiently charged. In addition, data reflecting the 

state of the subsystem controllers at the moment in time that the unusual event 

occurred will be collected and saved until it is retrieved by the user. To clear the 

Needs Attention due to DDC flag and to retrieve the saved diagnostic data, see 

“Recovery steps” on page 224. 

Because the current DDC function implementation will hold the DDC data for only 

one unusual event at a time until the DDC data is saved, the SMcli commands must 

be performed as soon as possible whenever the Needs Attention due to DDC error 

occurs. This is so the controllers can be ready for capturing data for any other 

unusual events. Until the diagnostic data is saved and the Needs Attention due to 

DDC flag is cleared, any occurrences of other unusual events will not trigger the 

controller to capture diagnostic data for those events. An unusual event is 

considered a candidate for a DDC trigger if a previous DDC trigger is at least 48 
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hours old or the user has successfully retrieved the previous DDC information. In 

addition, DDC information is only available in the case of a controller that is online. 

A controller that is in service or lock down mode will not trigger a DDC event. After 

collecting the DDC data, contact IBM support to report the problem and to enlist 

assistance in troubleshooting the condition that triggered the event. 

Recovery steps 

Follow steps 1–6 to complete the DDC recovery process. 

1.   Open either the Script Editor from the Enterprise Management Window (EMW), 

or the Command Line Interface (CLI).

Note:  Refer to the EMW online help for more information on the syntax of 

these commands. 

2.    

 Table 31. Recovery Step 2 

If... Then... 

You want to save the diagnostic data Go to Step 3. 

You do NOT want to save the diagnostic 

data 

Go to Step 5.

  

3.   Execute the following SMcli command: 

save storageSubsystem diagnosticData file="filename "; 

Where filename is the location and name of the file that will be saved. The file 

will be formatted as a .zip file.

Note:  Currently, the esm parameter of the command syntax is not supported. 

4.    

 Table 32. Recovery Step 4 

If... Then... 

No error was returned Go to Step 6. 

An error was returned If... Then... 

The error message indicates 

that there was a problem 

saving the data 

Wait 2 minutes and then 

restart Step 3. 

The error message indicates 

that there was a problem 

resetting the data 

Wait 2 minutes and then go 

to Step 5.

  

5.   Execute the following SMcli command: 

reset storageSubsystem diagnosticData; 

 Table 33. Recovery Step 5 

If... Then... 

No error was returned Go to step 6. 

An error was returned Wait 2 minutes and then execute the 

command again. The controllers may need 

additional time to update status. Note that 

you may also get an error if the diagnostic 

data status has already been reset. 

Go to step 6.
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6.   Select Recheck to rerun the Recovery Guru. The failure should no longer 

appear in the Summary area.

After this process has been successfully completed, the DDC message will 

automatically be removed, and a recheck of the Recovery Guru will show no entries 

for DDC capture. If for some reason the data has not been removed, the Recovery 

Guru gives an example of how to clear the DDC information without saving the 

data. Follow the above procedure using the following command in the script editor: 

reset storageSubsystem diagnosticData; 

DDC MEL events 

When the Diagnostic Data Capture action is triggered by an unusual event, one or 

more of the following events will be posted in the storage subsystems event logs, 

depending on the user actions. 

1.   Event number: 0x6900. 

Description: Diagnostic Data is available. 

Priority: Critical. 

This is logged when an unusual controller event triggers the DDC function to 

store Diagnostic Data. 

2.   Event number: 0x6901. 

Description: Diagnostic Data retrieval operation started. 

Priority: Informational. 

This is logged when the user runs the SMcli command to retrieve and save the 

Diagnostic Data, as described in step 3 of the “Recovery steps” on page 224. 

3.   Event number: 0x6902. 

Description: Diagnostic Data retrieval operation completed. 

Priority: Informational. 

This is logged when the Diagnostic Data retrieval and save completes. 

4.   Event number: 0x6903. 

Description: Diagnostic Data Needs Attention status/flag cleared. 

Priority: Informational. 

This is logged when the user resets the Needs Attention flag due to DDC, using 

the SMcli command or Diagnostic Data retrieval and save completes 

successfully when initiated by the user executing the save storageSubsystem 

diagnosticData SMcli command.
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Appendix  K.  Additional  DS4000  documentation  

The following tables present an overview of the IBM System Storage DS4000 

Storage Manager, Storage Subsystem, and Storage Expansion Enclosure product 

libraries, as well as other related documents. Each table lists documents that are 

included in the libraries and what common tasks they address. 

You can access the documents listed in these tables at both of the following Web 

sites: 

www.ibm.com/servers/storage/support/disk/ 

www.ibm.com/shop/publications/order/ 

DS4000 Storage Manager Version 10 library 

Table 34 associates each document in the DS4000 Version 10 Storage Manager 

library with its related common user tasks.

 Table 34. DS4000 Storage Manager Version 10 titles by user tasks 

Title User tasks 

Planning Hardware 

installation 

Software 

installation 

Configuration Operation and 

administration 

Diagnosis and 

maintenance 

IBM System 

Storage DS4000 

Storage Manager 

Installation and Host 

Support Guide for 

Windows 

2000/Server 

2003/2008, 

NetWare, VMWare 

ESX Server, and 

Linux 

U U U 

IBM System 

Storage DS4000 

Storage Manager 

Installation and Host 

Support Guide for 

AIX, UNIX, Solaris, 

and Linux on 

POWER  

U U U 

IBM System 

Storage DS4000 

Storage Manager 

Copy Services 

User’s Guide 

U U U U 

IBM System 

Storage DS4000 

Storage Manager 

Concepts Guide 

U U U U U U 
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Table 34. DS4000 Storage Manager Version 10 titles by user tasks (continued) 

Title User tasks 

Planning Hardware 

installation 

Software 

installation 

Configuration Operation and 

administration 

Diagnosis and 

maintenance 

IBM  System 

Storage DS4000 

Fibre Channel and 

Serial ATA Intermix 

Premium Feature 

Installation 

Overview 

U U U U 

  

DS4800 Storage Subsystem library 

Table 35 associates each document in the DS4800 Storage Subsystem library with 

its related common user tasks.

 Table 35. DS4800 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4800 Storage 

Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

Quick start guide, 

Quick reference for 

the DS4800 

U U U 

IBM TotalStorage® 

DS4800 Controller 

Cache Upgrade Kit 

Instructions 

U U U  
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DS4700 Storage Subsystem library 

Table 36 associates each document in the DS4700 Storage Subsystem library with 

its related common user tasks.

 Table 36. DS4700 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4700 Storage 

Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

Quick start guide, 

Quick reference for 

the DS4700 and 

DS4200, Sections 2, 

3, and 4 also for 

installing the 

EXP810 and 

EXP420 

U U U  
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DS4500 Storage Subsystem library 

Table 37 associates each document in the DS4500 (previously FAStT900) Storage 

Subsystem library with its related common user tasks.

 Table 37. DS4500 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4500 Storage 

Subsystem 

Installation, User's, 

and Maintenance 

Guide 

U U U U U 

IBM TotalStorage 

DS4500 Storage 

Subsystem Cabling 

Instructions 

U U 

IBM TotalStorage 

DS4500 Rack 

Mounting 

Instructions 

U U  
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DS4400 Storage Subsystem library 

Table 38 associates each document in the DS4400 (previously FAStT700) Storage 

Subsystem library with its related common user tasks. 

 Table 38. DS4400 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Server User’s Guide 

U U U U U 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Server Installation 

and Support Guide 

U U U U 

IBM TotalStorage 

DS4400 Fibre 

Channel Cabling 

Instructions 

U U  
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DS4300 Storage Subsystem library 

Table 39 associates each document in the DS4300 (previously FAStT600) Storage 

Subsystem library with its related common user tasks.

 Table 39. DS4300 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4300 Storage 

Subsystem 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM TotalStorage 

DS4300 Rack 

Mounting 

Instructions 

U U 

IBM TotalStorage 

DS4300 Storage 

Subsystem Cabling 

Instructions 

U U 

IBM TotalStorage 

DS4300 SCU  Base 

Upgrade Kit 

U U 

IBM TotalStorage 

DS4300 SCU  Turbo 

Upgrade Kit 

U U 

IBM TotalStorage 

DS4300 Turbo 

Models 6LU/6LX 

Upgrade Kit 

U U  
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DS4200 Express Storage Subsystem library 

Table 40 associates each document in the DS4200 Express Storage Subsystem 

library with its related common user tasks.

 Table 40. DS4200 Express Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4200 Express 

Storage Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

Quick start guide, 

Quick reference for 

the DS4700 and 

DS4200, Sections 2, 

3, and 4 also for 

installing the 

EXP810 and 

EXP420 

U U U  
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DS4100 Storage Subsystem library 

Table 41 associates each document in the DS4100 (previously FAStT100) Storage 

Subsystem library with its related common user tasks.

 Table 41. DS4100 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4100 Storage 

Server Installation, 

User’s and 

Maintenance Guide 

U U U U U 

IBM TotalStorage 

DS4100 Storage 

Server Cabling 

Guide 

U  
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DS4000 Storage Expansion Enclosure documents 

Table 42 associates each of the following documents with its related common user 

tasks. 

 Table 42. DS4000 Storage Expansion Enclosure document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4000 EXP810 

Storage Expansion 

Enclosure 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

Quick start guide, 

Quick reference for 

the DS4700 and 

DS4200, Sections 2, 

3, and 4 also for 

installing the 

EXP810 and 

EXP420 

U U U 

IBM TotalStorage 

DS4000 EXP700 

and EXP710 

Storage Expansion 

Enclosures 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM DS4000 

EXP500 Installation 

and User’s Guide 

U U U U U 

IBM System Storage 

DS4000 EXP420 

Storage Expansion 

Enclosure 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

DS4000 Hard Drive 

and Storage 

Expansion 

Enclosures 

Installation and 

Migration Guide 

U U  
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Other DS4000 and DS4000-related documents 

Table 43 associates each of the following documents with its related common user 

tasks. 

 Table 43. DS4000 and DS4000–related document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM Safety 

Information 

U 

IBM TotalStorage 

DS4000 Hardware 

Maintenance Manual 

¹ 

U 

IBM System Storage 

DS4000 Problem 

Determination Guide 

U 

IBM Fibre Channel 

Planning and 

Integration: User’s 

Guide and Service 

Information 

U U U U 

IBM TotalStorage 

DS4000 FC2-133 

Host Bus Adapter 

Installation and 

User’s Guide 

U U 

IBM TotalStorage 

DS4000 FC2-133 

Dual Port Host Bus 

Adapter Installation 

and User’s Guide 

U U 

IBM Netfinity Fibre 

Channel Cabling 

Instructions 

U 

IBM Fibre Channel 

SAN  Configuration 

Setup Guide 

U U U U 

Notes:  

1.   The IBM TotalStorage DS4000 Hardware Maintenance Manual does not contain maintenance information for the 

IBM System Storage DS4100, DS4200, DS4300, DS4500, DS4700, or DS4800 storage subsystems. You can find 

maintenance information for these products in the IBM System Storage DSx000 Storage Subsystem Installation, 

User's, and Maintenance Guide for the particular subsystem.
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Appendix  L. Accessibility  

This section provides information about alternate keyboard navigation, which is a 

DS4000 Storage Manager accessibility feature. Accessibility features help a user 

who has a physical disability, such as restricted mobility or limited vision, to use 

software products successfully. 

By using the alternate keyboard operations that are described in this section, you 

can use keys or key combinations to perform Storage Manager tasks and initiate 

many menu actions that can also be done with a mouse. 

Note: In addition to the keyboard operations that are described in this section, the 

DS4000 Storage Manager version 9.14 - 10.10 (and later) software installation 

packages for Windows include a screen reader software interface. 

To enable the screen reader, select Custom Installation when using the installation 

wizard to install Storage Manager 9.14 - 10.10 (or later) on a Windows 

host/management station. Then, in the Select Product Features window, select Java 

Access Bridge in addition to the other required host software components. 

Table 44 defines the keyboard operations that enable you to navigate, select, or 

activate user interface components. The following terms are used in the table: 

v   Navigate means to move the input focus from one user interface component to 

another. 

v   Select means to choose one or more components, typically for a subsequent 

action. 

v   Activate means to carry out the action of a particular component.

Note:  In general, navigation between components requires the following keys: 

v   Tab - Moves keyboard focus to the next component or to the first member 

of the next group of components 

v   Shift-Tab - Moves keyboard focus to the previous component or to the 

first component in the previous group of components 

v   Arrow keys - Move keyboard focus within the individual components of a 

group of components

 Table 44. DS4000 Storage Manager alternate keyboard operations 

Short cut Action 

F1 Open the Help. 

F10 Move keyboard focus to main menu bar and post first 

menu; use the arrow keys to navigate through the 

available options. 

Alt+F4 Close the management window. 

Alt+F6 Move keyboard focus between dialogs (non-modal) and 

between management windows. 
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Table 44. DS4000 Storage Manager alternate keyboard operations (continued) 

Short cut Action 

Alt+ underlined letter Access menu items, buttons, and other interface 

components by using the keys associated with the 

underlined letters. 

For the menu options, select the Alt + underlined letter 

combination to access a main menu, and then select the 

underlined letter to access the individual menu item. 

For other interface components, use the Alt + underlined 

letter combination. 

Ctrl+F1 Display or conceal a tool tip when keyboard focus is on 

the toolbar. 

Spacebar Select an item or activate a hyperlink. 

Ctrl+Spacebar 

(Contiguous/Non-contiguous) 

AMW Logical/Physical View 

Select multiple drives in the Physical View. 

To select multiple drives, select one drive by pressing 

Spacebar, and then press Tab to switch focus to the next 

drive you want to select; press Ctrl+Spacebar to select 

the drive. 

If you press Spacebar alone when multiple drives are 

selected then all selections are removed. 

Use the Ctrl+Spacebar combination to deselect a drive 

when multiple drives are selected. 

This behavior is the same for contiguous and 

non-contiguous selection of drives. 

End, Page Down Move keyboard focus to the last item in the list. 

Esc Close the current dialog (does not require keyboard 

focus). 

Home, Page Up Move keyboard focus to the first item in the list. 

Shift+Tab Move keyboard focus through components in the reverse 

direction. 

Ctrl+Tab Move keyboard focus from a table to the next user 

interface component. 

Tab Navigate keyboard focus between components or select 

a hyperlink. 

Down arrow Move keyboard focus down one item in the list. 

Left arrow Move keyboard focus to the left. 

Right arrow Move keyboard focus to the right. 

Up arrow Move keyboard focus up one item in the list.
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Notices  

This publication was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 

other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM 

product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may be 

used instead. However, it is the user’s responsibility to evaluate and verify the 

operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 

described in this document. The furnishing of this document does not give you any 

license to these patents. You can send license inquiries, in writing, to: 

   IBM Director of Licensing 

   IBM Corporation 

   North Castle Drive 

   Armonk, NY 10504-1785 

   U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS 

OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or 

implied warranties in certain transactions, therefore, this statement may not apply to 

you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. IBM may make improvements and/or 

changes in the product(s) and/or the program(s) described in this publication at any 

time without notice. 

Any references in this publication to non-IBM Web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those 

Web sites. The materials at those Web sites are not part of the materials for this 

IBM product, and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 

appropriate without incurring any obligation to you. 

Trademarks  

The following are trademarks of International Business Machines Corporation in the 

United States, other countries, or both: 

 e-business logo InstallAnywhere 

AIX Netfinity 

the eServer™ logo (Eserver) ServerProven 

FlashCopy System Storage 

IBM Tivoli 
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IntelliStation® TotalStorage 

IBMLink™ System x
  

Intel and Pentium are trademarks of Intel Corporation in the United States, other 

countries, or both. 

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in 

the United States, other countries, or both. 

Java and all Java-based trademarks and logos are trademarks or registered 

trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. 

Linux is a registered trademark of Linus Torvalds in the United States, other 

countries, or both. 

UNIX is a registered trademark of The Open Group in the United States and other 

countries. 

QLogic and SANsurfer are registered trademarks of QLogic Corporation in the 

United States, other countries, or both. 

Other company, product, or service names may be the trademarks or service marks 

of others. 

Important notes 

Processor speeds indicate the internal clock speed of the microprocessor; other 

factors also affect application performance. 

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often 

less than the maximum possible. 

When referring to processor storage, real and virtual storage, or channel volume, 

KB stands for approximately 1000 bytes, MB stands for approximately 1 000 000 

bytes, and GB stands for approximately 1 000 000 000 bytes. 

When referring to hard disk drive capacity or communications volume, MB stands 

for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible 

capacity may vary depending on operating environments. 

Maximum internal hard disk drive capacities assume the replacement of any 

standard hard disk drives and population of all hard disk drive bays with the largest 

currently supported drives available from IBM. 

Maximum memory may require replacement of the standard memory with an 

optional memory module. 

IBM makes no representation or warranties regarding non-IBM products and 

services that are ServerProven, including but not limited to the implied warranties of 

merchantability and fitness for a particular purpose. These products are offered and 

warranted solely by third parties. 

IBM makes no representations or warranties with respect to non-IBM products. 

Support (if any) for the non-IBM products is provided by the third party, not IBM. 
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Some software may differ from its retail version (if available), and may not include 

user manuals or all program functionality. 
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Glossary  

This glossary provides definitions for the 

terminology and abbreviations used in IBM 

System Storage DS4000 publications. 

If you do not find the term you are looking for, see 

the IBM Glossary of Computing Terms located at 

the following Web site: 

www.ibm.com/ibm/terminology 

This glossary also includes terms and definitions 

from: 

v   Information Technology Vocabulary by 

Subcommittee 1, Joint Technical Committee 1, 

of the International Organization for 

Standardization and the International 

Electrotechnical Commission (ISO/IEC 

JTC1/SC1). Definitions are identified by the 

symbol (I) after the definition; definitions taken 

from draft international standards, committee 

drafts, and working papers by ISO/IEC 

JTC1/SC1 are identified by the symbol (T) after 

the definition, indicating that final agreement 

has not yet been reached among the 

participating National Bodies of SC1. 

v   IBM Glossary of Computing Terms. New York: 

McGraw-Hill, 1994.

The following cross-reference conventions are 

used in this glossary: 

See Refers you to (a) a term that is the 

expanded form of an abbreviation or 

acronym, or (b) a synonym or more 

preferred term. 

See also 

Refers you to a related term.

Abstract Windowing Toolkit (AWT).  A Java graphical 

user interface (GUI). 

accelerated graphics port (AGP).  A bus specification 

that gives low-cost 3D graphics cards faster access to 

main memory on personal computers than the usual 

peripheral component interconnect (PCI) bus. AGP 

reduces the overall cost of creating high-end graphics 

subsystems by using existing system memory. 

access volume.  A special logical drive that allows the 

host-agent to communicate with the controllers in the 

storage subsystem. 

adapter.  A printed circuit assembly that transmits user 

data input/output (I/O) between the internal bus of the 

host system and the external fibre-channel (FC) link and 

vice versa. Also called an I/O adapter, host adapter, or 

FC adapter. 

advanced technology (AT®) bus architecture.  A bus 

standard for IBM compatibles. It extends the XT™ bus 

architecture to 16 bits and also allows for bus 

mastering, although only the first 16 MB of main 

memory are available for direct access. 

agent.  A server program that receives virtual 

connections from the network manager (the client 

program) in a Simple Network Management 

Protocol-Transmission Control Protocol/Internet Protocol 

(SNMP-TCP/IP) network-managing environment. 

AGP.   See accelerated graphics port. 

AL_PA.   See arbitrated loop physical address. 

arbitrated loop.  One of three existing fibre-channel 

topologies, in which 2 - 126 ports are interconnected 

serially in a single loop circuit. Access to the Fibre 

Channel Arbitrated Loop (FC-AL) is controlled by an 

arbitration scheme. The FC-AL topology supports all 

classes of service and guarantees in-order delivery of 

FC frames when the originator and responder are on 

the same FC-AL. The default topology for the disk array 

is arbitrated loop. An arbitrated loop is sometimes 

referred to as a Stealth Mode. 

arbitrated loop physical address (AL_PA).  An 8-bit 

value that is used to uniquely identify an individual port 

within a loop. A loop can have one or more AL_PAs. 

array.  A collection of fibre-channel or SATA hard drives 

that are logically grouped together. All the drives in the 

array are assigned the same RAID level. An array is 

sometimes referred to as a ″RAID set.″ See also 

redundant array of independent disks (RAID), RAID 

level. 

asynchronous write mode.  In remote mirroring, an 

option that allows the primary controller to return a write 

I/O request completion to the host server before data 

has been successfully written by the secondary 

controller. See also synchronous write mode, remote 

mirroring, Global Copy,Global Mirroring. 

AT.  See advanced technology (AT) bus architecture. 

ATA.  See AT-attached. 

AT-attached.  Peripheral devices that are compatible 

with the original IBM AT computer standard in which 

signals on a 40-pin AT-attached (ATA) ribbon cable 

followed the timings and constraints of the Industry 

Standard Architecture (ISA) system bus on the IBM PC 

AT computer. Equivalent to integrated drive electronics 

(IDE). 
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auto-volume transfer/auto-disk transfer (AVT/ADT).  

A function that provides automatic failover in case of 

controller failure on a storage subsystem. 

AVT/ADT.   See auto-volume transfer/auto-disk transfer. 

AWT.  See Abstract Windowing Toolkit. 

basic input/output system (BIOS).  The personal 

computer code that controls basic hardware operations, 

such as interactions with diskette drives, hard disk 

drives, and the keyboard. 

BIOS.   See basic input/output system. 

BOOTP.   See bootstrap protocol. 

bootstrap protocol (BOOTP).  In Transmission Control 

Protocol/Internet Protocol (TCP/IP) networking, an 

alternative protocol by which a diskless machine can 

obtain its Internet Protocol (IP) address and such 

configuration information as IP addresses of various 

servers from a BOOTP server. 

bridge.  A storage area network (SAN) device that 

provides physical and transport conversion, such as 

fibre channel to small computer system interface (SCSI) 

bridge. 

bridge group.  A bridge and the collection of devices 

connected to it. 

broadcast.  The simultaneous transmission of data to 

more than one destination. 

cathode ray tube (CRT).  A display device in which 

controlled electron beams are used to display 

alphanumeric or graphical data on an 

electroluminescent screen. 

client.  A computer system or process that requests a 

service of another computer system or process that is 

typically referred to as a server. Multiple clients can 

share access to a common server. 

command.  A statement used to initiate an action or 

start a service. A command consists of the command 

name abbreviation, and its parameters and flags if 

applicable. A command can be issued by typing it on a 

command line or selecting it from a menu. 

community string.  The name of a community 

contained in each Simple Network Management 

Protocol (SNMP) message. 

concurrent download.  A method of downloading and 

installing firmware that does not require the user to stop 

I/O to the controllers during the process. 

CRC.   See cyclic redundancy check. 

CRT.  See cathode ray tube. 

CRU.   See customer replaceable unit. 

customer replaceable unit (CRU).  An assembly or 

part that a customer can replace in its entirety when any 

of its components fail. Contrast with field replaceable 

unit (FRU). 

cyclic redundancy check (CRC).   (1) A redundancy 

check in which the check key is generated by a cyclic 

algorithm. (2) An error detection technique performed at 

both the sending and receiving stations. 

dac.  See disk array controller. 

dar.  See disk array router. 

DASD.   See direct access storage device. 

data striping.  See striping. 

default host group.  A logical collection of discovered 

host ports, defined host computers, and defined host 

groups in the storage-partition topology that fulfill the 

following requirements: 

v   Are not involved in specific logical drive-to-LUN 

mappings 

v   Share access to logical drives with default logical 

drive-to-LUN mappings

device type.  Identifier used to place devices in the 

physical map, such as the switch, hub, or storage. 

DHCP.   See Dynamic Host Configuration Protocol. 

direct access storage device (DASD).   A device in 

which access time is effectively independent of the 

location of the data. Information is entered and retrieved 

without reference to previously accessed data. (For 

example, a disk drive is a DASD, in contrast with a tape 

drive, which stores data as a linear sequence.) DASDs 

include both fixed and removable storage devices. 

direct memory access (DMA).   The transfer of data 

between memory and an input/output (I/O) device 

without processor intervention. 

disk array controller (dac).  A disk array controller 

device that represents the two controllers of an array. 

See also disk array router. 

disk array router (dar).  A disk array router that 

represents an entire array, including current and 

deferred paths to all logical unit numbers (LUNs) (hdisks 

on AIX). See also disk array controller. 

DMA.   See direct memory access. 

domain.  The most significant byte in the node port 

(N_port) identifier for the fibre-channel (FC) device. It is 

not used in the fibre channel-small computer system 

interface (FC-SCSI) hardware path ID. It is required to 

be the same for all SCSI targets logically connected to 

an FC adapter. 
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drive channels.  The DS4200, DS4700, and DS4800 

subsystems use dual-port drive channels that, from the 

physical point of view, are connected in the same way 

as two drive loops. However, from the point of view of 

the number of drives and enclosures, they are treated 

as a single drive loop instead of two different drive 

loops. A group of storage expansion enclosures are 

connected to the DS4000 storage subsystems using a 

drive channel from each controller. This pair of drive 

channels is referred to as a redundant drive channel 

pair. 

drive loops.  A drive loop consists of one channel from 

each controller combined to form one pair of redundant 

drive channels or a redundant drive loop. Each drive 

loop is associated with two ports. (There are two drive 

channels and four associated ports per controller.) For 

the DS4800, drive loops are more commonly referred to 

as drive channels. See drive channels. 

DRAM.   See dynamic random access memory. 

Dynamic Host Configuration Protocol (DHCP).  A 

protocol defined by the Internet Engineering Task Force 

that is used for dynamically assigning Internet Protocol 

(IP) addresses to computers in a network. 

dynamic random access memory (DRAM).   A 

storage in which the cells require repetitive application 

of control signals to retain stored data. 

ECC.   See error correction coding. 

EEPROM.   See electrically erasable programmable 

read-only memory. 

EISA.  See Extended Industry Standard Architecture. 

electrically erasable programmable read-only 

memory (EEPROM).  A type of memory chip which can 

retain its contents without consistent electrical power. 

Unlike the PROM which can be programmed only once, 

the EEPROM can be erased electrically. Because it can 

only be reprogrammed a limited number of times before 

it wears out, it is appropriate for storing small amounts 

of data that are changed infrequently. 

electrostatic discharge (ESD).  The flow of current 

that results when objects that have a static charge 

come into close enough proximity to discharge. 

environmental service module (ESM) canister.  A 

component in a storage expansion enclosure that 

monitors the environmental condition of the components 

in that enclosure. Not all storage subsystems have ESM 

canisters. 

E_port.  See expansion port. 

error correction coding (ECC).  A method for 

encoding data so that transmission errors can be 

detected and corrected by examining the data on the 

receiving end. Most ECCs are characterized by the 

maximum number of errors they can detect and correct. 

ESD.  See electrostatic discharge. 

ESM canister.  See environmental service module 

canister. 

automatic ESM firmware synchronization.  When 

you install a new ESM into an existing storage 

expansion enclosure in a DS4000 storage subsystem 

that supports automatic ESM firmware synchronization, 

the firmware in the new ESM is automatically 

synchronized with the firmware in the existing ESM. 

EXP.  See storage expansion enclosure. 

expansion port (E_port).  A port that connects the 

switches for two fabrics. 

Extended Industry Standard Architecture (EISA).  A 

bus standard for IBM compatibles that extends the 

Industry Standard Architecture (ISA) bus architecture to 

32 bits and allows more than one central processing 

unit (CPU) to share the bus. See also Industry Standard 

Architecture. 

fabric.  A fibre channel entity which interconnects and 

facilitates logins of N_ports attached to it. The fabric is 

responsible for routing frames between source and 

destination N_ports using address information in the 

frame header. A fabric can be as simple as a 

point-to-point channel between two N-ports, or as 

complex as a frame-routing switch that provides multiple 

and redundant internal pathways within the fabric 

between F_ports. 

fabric port (F_port).  In a fabric, an access point for 

connecting a user’s N_port. An F_port facilitates N_port 

logins to the fabric from nodes connected to the fabric. 

An F_port is addressable by the N_port connected to it. 

See also fabric. 

FC.  See Fibre Channel. 

FC-AL.  See arbitrated loop. 

feature enable identifier.  A unique identifier for the 

storage subsystem, which is used in the process of 

generating a premium feature key. See also premium 

feature key. 

Fibre Channel (FC).  A set of standards for a serial 

input/output (I/O) bus capable of transferring data 

between two ports at up to 100 Mbps, with standards 

proposals to go to higher speeds. FC supports 

point-to-point, arbitrated loop, and switched topologies. 

Fibre Channel Arbitrated Loop (FC-AL).  See 

arbitrated loop. 

Fibre Channel Protocol (FCP) for small computer 

system interface (SCSI).  A high-level fibre-channel 

mapping layer (FC-4) that uses lower-level fibre-channel 
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(FC-PH) services to transmit SCSI commands, data, 

and status information between a SCSI initiator and a 

SCSI target across the FC link by using FC frame and 

sequence formats. 

field replaceable unit (FRU).  An assembly that is 

replaced in its entirety when any one of its components 

fails. In some cases, a field replaceable unit might 

contain other field replaceable units. Contrast with 

customer replaceable unit (CRU). 

FlashCopy.  A premium feature for DS4000 that can 

make an instantaneous copy of the data in a volume. 

F_port.  See fabric port. 

FRU.   See field replaceable unit. 

GBIC.   See gigabit interface converter 

gigabit interface converter (GBIC).   A transceiver that 

performs serial, optical-to-electrical, and 

electrical-to-optical signal conversions for high-speed 

networking. A GBIC can be hot swapped. See also 

small form-factor pluggable. 

Global Copy.  Refers to a remote logical drive mirror 

pair that is set up using asynchronous write mode 

without the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring without 

Consistency Group.″ Global Copy does not ensure that 

write requests to multiple primary logical drives are 

carried out in the same order on the secondary logical 

drives as they are on the primary logical drives. If it is 

critical that writes to the primary logical drives are 

carried out in the same order in the appropriate 

secondary logical drives, Global Mirroring should be 

used instead of Global Copy. See also asynchronous 

write mode, Global Mirroring, remote mirroring, Metro 

Mirroring. 

Global Mirroring.  Refers to a remote logical drive 

mirror pair that is set up using asynchronous write mode 

with the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring with Consistency 

Group.″ Global Mirroring ensures that write requests to 

multiple primary logical drives are carried out in the 

same order on the secondary logical drives as they are 

on the primary logical drives, preventing data on the 

secondary logical drives from becoming inconsistent 

with the data on the primary logical drives. See also 

asynchronous write mode, Global Copy, remote 

mirroring, Metro Mirroring. 

graphical user interface (GUI).  A type of computer 

interface that presents a visual metaphor of a real-world 

scene, often of a desktop, by combining high-resolution 

graphics, pointing devices, menu bars and other menus, 

overlapping windows, icons, and the object-action 

relationship. 

GUI.   See graphical user interface. 

HBA.   See host bus adapter. 

hdisk.  An AIX term representing a logical unit number 

(LUN) on an array. 

heterogeneous host environment.  A host system in 

which multiple host servers, which use different 

operating systems with their own unique disk storage 

subsystem settings, connect to the same DS4000 

storage subsystem at the same time. See also host. 

host.  A system that is directly attached to the storage 

subsystem through a fibre-channel input/output (I/O) 

path. This system is used to serve data (typically in the 

form of files) from the storage subsystem. A system can 

be both a storage management station and a host 

simultaneously. 

host bus adapter (HBA).   An interface between the 

fibre-channel network and a workstation or server. 

host computer.  See host. 

host group.  An entity in the storage partition topology 

that defines a logical collection of host computers that 

require shared access to one or more logical drives. 

host port.  Ports that physically reside on the host 

adapters and are automatically discovered by the 

DS4000 Storage Manager software. To give a host 

computer access to a partition, its associated host ports 

must be defined. 

hot swap.  To replace a hardware component without 

turning off the system. 

hub.  In a network, a point at which circuits are either 

connected or switched. For example, in a star network, 

the hub is the central node; in a star/ring network, it is 

the location of wiring concentrators. 

IBMSAN  driver.  The device driver that is used in a 

Novell NetWare environment to provide multipath 

input/output (I/O) support to the storage controller. 

IC.   See integrated circuit. 

IDE.  See integrated drive electronics. 

in-band.  Transmission of management protocol over 

the fibre-channel transport. 

Industry Standard Architecture (ISA).  Unofficial 

name for the bus architecture of the IBM PC/XT™ 

personal computer. This bus design included expansion 

slots for plugging in various adapter boards. Early 

versions had an 8-bit data path, later expanded to 16 

bits. The ″Extended Industry Standard Architecture″ 

(EISA) further expanded the data path to 32 bits. See 

also Extended Industry Standard Architecture. 
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initial program load (IPL).  The initialization procedure 

that causes an operating system to commence 

operation. Also referred to as a system restart, system 

startup, and boot. 

integrated circuit (IC).  A microelectronic 

semiconductor device that consists of many 

interconnected transistors and other components. ICs 

are constructed on a small rectangle cut from a silicon 

crystal or other semiconductor material. The small size 

of these circuits allows high speed, low power 

dissipation, and reduced manufacturing cost compared 

with board-level integration. Also known as a chip. 

integrated drive electronics (IDE).  A disk drive 

interface based on the 16-bit IBM personal computer 

Industry Standard Architecture (ISA) in which the 

controller electronics reside on the drive itself, 

eliminating the need for a separate adapter card. Also 

known as an Advanced Technology Attachment 

Interface (ATA). 

Internet Protocol (IP).  A protocol that routes data 

through a network or interconnected networks. IP acts 

as an intermediary between the higher protocol layers 

and the physical network. 

Internet Protocol (IP) address.  The unique 32-bit 

address that specifies the location of each device or 

workstation on the Internet. For example, 9.67.97.103 is 

an IP address. 

interrupt request (IRQ).  A type of input found on 

many processors that causes the processor to suspend 

normal processing temporarily and start running an 

interrupt handler routine. Some processors have several 

interrupt request inputs that allow different priority 

interrupts. 

IP.  See Internet Protocol. 

IPL.  See initial program load. 

IRQ.   See interrupt request. 

ISA.  See Industry Standard Architecture. 

Java Runtime Environment (JRE).  A subset of the 

Java Development Kit (JDK) for end users and 

developers who want to redistribute the Java Runtime 

Environment (JRE). The JRE consists of the Java virtual 

machine, the Java Core Classes, and supporting files. 

JRE.  See Java Runtime Environment. 

label.  A discovered or user entered property value that 

is displayed underneath each device in the Physical and 

Data Path maps. 

LAN.   See local area network. 

LBA.   See logical block address. 

local area network (LAN).  A computer network 

located on a user’s premises within a limited geographic 

area. 

logical block address (LBA).  The address of a logical 

block. Logical block addresses are typically used in 

hosts’ I/O commands. The SCSI disk command 

protocol, for example, uses logical block addresses. 

logical partition (LPAR).  (1) A subset of a single 

system that contains resources (processors, memory, 

and input/output devices). A logical partition operates as 

an independent system. If hardware requirements are 

met, multiple logical partitions can exist within a system. 

(2) A fixed-size portion of a logical volume. A logical 

partition is the same size as the physical partitions in its 

volume group. Unless the logical volume of which it is a 

part is mirrored, each logical partition corresponds to, 

and its contents are stored on, a single physical 

partition. (3) One to three physical partitions (copies). 

The number of logical partitions within a logical volume 

is variable. 

logical unit number (LUN).  An identifier used on a 

small computer system interface (SCSI) bus to 

distinguish among up to eight devices (logical units) with 

the same SCSI ID. 

loop address.  The unique ID of a node in 

fibre-channel loop topology sometimes referred to as a 

loop ID. 

loop group.  A collection of storage area network 

(SAN) devices that are interconnected serially in a 

single loop circuit. 

loop port.  A node port (N_port) or fabric port (F_port) 

that supports arbitrated loop functions associated with 

an arbitrated loop topology. 

LPAR.  See logical partition. 

LUN.  See logical unit number. 

MAC.   See medium access control. 

management information base (MIB).  The 

information that is on an agent. It is an abstraction of 

configuration and status information. 

man  pages.  In UNIX-based operating systems, online 

documentation for operating system commands, 

subroutines, system calls, file formats, special files, 

stand-alone utilities, and miscellaneous facilities. 

Invoked by the man  command. 

MCA.   See micro channel architecture. 

media scan.  A media scan is a background process 

that runs on all logical drives in the storage subsystem 

for which it has been enabled, providing error detection 

on the drive media. The media scan process scans all 
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logical drive data to verify that it can be accessed, and 

optionally scans the logical drive redundancy 

information. 

medium access control (MAC).   In local area 

networks (LANs), the sublayer of the data link control 

layer that supports medium-dependent functions and 

uses the services of the physical layer to provide 

services to the logical link control sublayer. The MAC 

sublayer includes the method of determining when a 

device has access to the transmission medium. 

Metro Mirroring.  This term is used to refer to a 

remote logical drive mirror pair which is set up with 

synchronous write mode. See also remote mirroring, 

Global Mirroring. 

MIB.   See management information base. 

micro channel architecture (MCA).   Hardware that is 

used for PS/2 Model 50 computers and above to 

provide better growth potential and performance 

characteristics when compared with the original 

personal computer design. 

Microsoft Cluster Server (MSCS).  MSCS, a feature 

of Windows NT Server (Enterprise Edition), supports the 

connection of two servers into a cluster for higher 

availability and easier manageability. MSCS can 

automatically detect and recover from server or 

application failures. It can also be used to balance 

server workload and provide for planned maintenance. 

mini hub.  An interface card or port device that 

receives shortwave fiber channel GBICs or SFPs. 

These devices enable redundant fibre channel 

connections from the host computers, either directly or 

through a fibre channel switch or managed hub, over 

optical fiber cables to the DS4000 Storage Server 

controllers. Each DS4000 controller is responsible for 

two mini hubs. Each mini hub has two ports. Four host 

ports (two on each controller) provide a cluster solution 

without use of a switch. Two host-side mini hubs are 

shipped as standard. See also host port, gigabit 

interface converter (GBIC), small form-factor pluggable 

(SFP). 

mirroring.  A fault-tolerance technique in which 

information on a hard disk is duplicated on additional 

hard disks. See also remote mirroring. 

model.  The model identification that is assigned to a 

device by its manufacturer. 

MSCS.   See Microsoft Cluster Server. 

network management station (NMS).  In the Simple 

Network Management Protocol (SNMP), a station that 

runs management application programs that monitor 

and control network elements. 

NMI.   See non-maskable interrupt. 

NMS.  See network management station. 

non-maskable interrupt (NMI).  A hardware interrupt 

that another service request cannot overrule (mask). An 

NMI bypasses and takes priority over interrupt requests 

generated by software, the keyboard, and other such 

devices and is issued to the microprocessor only in 

disastrous circumstances, such as severe memory 

errors or impending power failures. 

node.  A physical device that allows for the 

transmission of data within a network. 

node port (N_port).  A fibre-channel defined hardware 

entity that performs data communications over the 

fibre-channel link. It is identifiable by a unique worldwide 

name. It can act as an originator or a responder. 

nonvolatile storage (NVS).  A storage device whose 

contents are not lost when power is cut off. 

N_port.  See node port. 

NVS.  See nonvolatile storage. 

NVSRAM.   Nonvolatile storage random access 

memory. See nonvolatile storage. 

Object Data Manager (ODM).   An AIX proprietary 

storage mechanism for ASCII stanza files that are 

edited as part of configuring a drive into the kernel. 

ODM.   See Object Data Manager. 

out-of-band.  Transmission of management protocols 

outside of the fibre-channel network, typically over 

Ethernet. 

partitioning.  See storage partition. 

parity check.  (1) A test to determine whether the 

number of ones (or zeros) in an array of binary digits is 

odd or even. (2) A mathematical operation on the 

numerical representation of the information 

communicated between two pieces. For example, if 

parity is odd, any character represented by an even 

number has a bit added to it, making it odd, and an 

information receiver checks that each unit of information 

has an odd value. 

PCI local bus.  See peripheral component interconnect 

local bus. 

PDF.  See portable document format. 

performance events.  Events related to thresholds set 

on storage area network (SAN) performance. 

peripheral component interconnect local bus (PCI  

local bus).  A local bus for PCs, from Intel, that 

provides a high-speed data path between the CPU and 

up to 10 peripherals (video, disk, network, and so on). 

The PCI bus coexists in the PC with the Industry 

Standard Architecture (ISA) or Extended Industry 
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Standard Architecture (EISA) bus. ISA and EISA boards 

plug into an IA or EISA slot, while high-speed PCI 

controllers plug into a PCI slot. See also Industry 

Standard Architecture, Extended Industry Standard 

Architecture. 

polling delay.  The time in seconds between 

successive discovery processes during which discovery 

is inactive. 

port.  A part of the system unit or remote controller to 

which cables for external devices (such as display 

stations, terminals, printers, switches, or external 

storage units) are attached. The port is an access point 

for data entry or exit. A device can contain one or more 

ports. 

portable document format (PDF).  A standard 

specified by Adobe® Systems, Incorporated, for the 

electronic distribution of documents. PDF files are 

compact; can be distributed globally by e-mail, the Web, 

intranets, or CD-ROM; and can be viewed with the 

Acrobat Reader, which is software from Adobe Systems 

that can be downloaded at no cost from the Adobe 

Systems home page. 

premium feature key.  A file that the storage 

subsystem controller uses to enable an authorized 

premium feature. The file contains the feature enable 

identifier of the storage subsystem for which the 

premium feature is authorized, and data about the 

premium feature. See also feature enable identifier. 

private loop.  A freestanding arbitrated loop with no 

fabric attachment. See also arbitrated loop. 

program temporary fix (PTF).  A temporary solution or 

bypass of a problem diagnosed by IBM in a current 

unaltered release of the program. 

PTF.  See program temporary fix. 

RAID.   See redundant array of independent disks 

(RAID). 

RAID  level.  An array’s RAID level is a number that 

refers to the method used to achieve redundancy and 

fault tolerance in the array. See also array, redundant 

array of independent disks (RAID). 

RAID  set.  See array. 

RAM.   See random-access memory. 

random-access memory (RAM).   A temporary storage 

location in which the central processing unit (CPU) 

stores and executes its processes. Contrast with DASD. 

RDAC.   See redundant disk array controller. 

read-only memory (ROM).   Memory in which stored 

data cannot be changed by the user except under 

special conditions. 

recoverable virtual shared disk (RVSD).  A virtual 

shared disk on a server node configured to provide 

continuous access to data and file systems in a cluster. 

redundant array of independent disks (RAID).  A 

collection of disk drives (array) that appears as a single 

volume to the server, which is fault tolerant through an 

assigned method of data striping, mirroring, or parity 

checking. Each array is assigned a RAID level, which is 

a specific number that refers to the method used to 

achieve redundancy and fault tolerance. See also array, 

parity check, mirroring, RAID level, striping. 

redundant disk array controller (RDAC).   (1) In 

hardware, a redundant set of controllers (either 

active/passive or active/active). (2) In software, a layer 

that manages the input/output (I/O) through the active 

controller during normal operation and transparently 

reroutes I/Os to the other controller in the redundant set 

if a controller or I/O path fails. 

remote mirroring.  Online, real-time replication of data 

between storage subsystems that are maintained on 

separate media. The Enhanced Remote Mirror Option is 

a DS4000 premium feature that provides support for 

remote mirroring. See also Global Mirroring, Metro 

Mirroring. 

ROM.   See read-only memory. 

router.  A computer that determines the path of 

network traffic flow. The path selection is made from 

several paths based on information obtained from 

specific protocols, algorithms that attempt to identify the 

shortest or best path, and other criteria such as metrics 

or protocol-specific destination addresses. 

RVSD.  See recoverable virtual shared disk. 

SAI.  See Storage Array Identifier. 

SA Identifier.  See Storage Array Identifier. 

SAN.   See storage area network. 

SATA.  See serial ATA. 

scope.  Defines a group of controllers by their Internet 

Protocol (IP) addresses. A scope must be created and 

defined so that dynamic IP addresses can be assigned 

to controllers on the network. 

SCSI.  See small computer system interface. 

segmented loop port (SL_port).  A port that allows 

division of a fibre-channel private loop into multiple 

segments. Each segment can pass frames around as 

an independent loop and can connect through the fabric 

to other segments of the same loop. 

sense data.  (1) Data sent with a negative response, 

indicating the reason for the response. (2) Data 

describing an I/O error. Sense data is presented to a 

host system in response to a sense request command. 
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serial ATA.  The standard for a high-speed alternative 

to small computer system interface (SCSI) hard drives. 

The SATA-1 standard is equivalent in performance to a 

10 000 RPM SCSI drive. 

serial storage architecture (SSA).  An interface 

specification from IBM in which devices are arranged in 

a ring topology. SSA, which is compatible with small 

computer system interface (SCSI) devices, allows 

full-duplex packet multiplexed serial data transfers at 

rates of 20 Mbps in each direction. 

server.  A functional hardware and software unit that 

delivers shared resources to workstation client units on 

a computer network. 

server/device events.  Events that occur on the server 

or a designated device that meet criteria that the user 

sets. 

SFP.  See small form-factor pluggable. 

Simple Network Management Protocol (SNMP).  In 

the Internet suite of protocols, a network management 

protocol that is used to monitor routers and attached 

networks. SNMP is an application layer protocol. 

Information on devices managed is defined and stored 

in the application’s Management Information Base 

(MIB). 

SL_port.  See segmented loop port. 

SMagent.  The DS4000 Storage Manager optional 

Java-based host-agent software, which can be used on 

Microsoft Windows, Novell NetWare, AIX, HP-UX, 

Solaris, and Linux on POWER host systems to manage 

storage subsystems through the host fibre-channel 

connection. 

SMclient.  The DS4000 Storage Manager client 

software, which is a Java-based graphical user interface 

(GUI) that is used to configure, manage, and 

troubleshoot storage servers and storage expansion 

enclosures in a DS4000 storage subsystem. SMclient 

can be used on a host system or on a storage 

management station. 

SMruntime.  A Java compiler for the SMclient. 

SMutil.  The DS4000 Storage Manager utility software 

that is used on Microsoft Windows, AIX, HP-UX, Solaris, 

and Linux on POWER host systems to register and map 

new logical drives to the operating system. In Microsoft 

Windows, it also contains a utility to flush the cached 

data of the operating system for a particular drive before 

creating a FlashCopy. 

small computer system interface (SCSI).  A standard 

hardware interface that enables a variety of peripheral 

devices to communicate with one another. 

small form-factor pluggable (SFP).  An optical 

transceiver that is used to convert signals between 

optical fiber cables and switches. An SFP is smaller 

than a gigabit interface converter (GBIC). See also 

gigabit interface converter. 

SNMP.  See Simple Network Management Protocol and 

SNMPv1. 

SNMP trap event.  (1) (2) An event notification sent by 

the SNMP agent that identifies conditions, such as 

thresholds, that exceed a predetermined value. See 

also Simple Network Management Protocol. 

SNMPv1.  The original standard for SNMP is now 

referred to as SNMPv1, as opposed to SNMPv2, a 

revision of SNMP. See also Simple Network 

Management Protocol. 

SRAM.   See static random access memory. 

SSA.  See serial storage architecture. 

static random access memory (SRAM).   Random 

access memory based on the logic circuit know as 

flip-flop. It is called static because it retains a value as 

long as power is supplied, unlike dynamic random 

access memory (DRAM), which must be regularly 

refreshed. It is however, still volatile, meaning that it can 

lose its contents when the power is turned off. 

storage area network (SAN).  A dedicated storage 

network tailored to a specific environment, combining 

servers, storage products, networking products, 

software, and services. See also fabric. 

Storage Array Identifier (SAI or SA Identifier).  The 

Storage Array Identifier is the identification value used 

by the DS4000 Storage Manager host software 

(SMClient) to uniquely identify each managed storage 

server. The DS4000 Storage Manager SMClient 

program maintains Storage Array Identifier records of 

previously-discovered storage servers in the host 

resident file, which allows it to retain discovery 

information in a persistent fashion. 

storage expansion enclosure (EXP).  A feature that 

can be connected to a system unit to provide additional 

storage and processing capacity. 

storage management station.  A system that is used 

to manage the storage subsystem. A storage 

management station does not need to be attached to 

the storage subsystem through the fibre-channel 

input/output (I/O) path. 

storage partition.  Storage subsystem logical drives 

that are visible to a host computer or are shared among 

host computers that are part of a host group. 

storage partition topology.  In the DS4000 Storage 

Manager client, the Topology view of the Mappings 

window displays the default host group, the defined host 

group, the host computer, and host-port nodes. The 

host port, host computer, and host group topological 
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elements must be defined to grant access to host 

computers and host groups using logical drive-to-LUN 

mappings. 

striping.  Splitting data to be written into equal blocks 

and writing blocks simultaneously to separate disk 

drives. Striping maximizes performance to the disks. 

Reading the data back is also scheduled in parallel, with 

a block being read concurrently from each disk then 

reassembled at the host. 

subnet.  An interconnected but independent segment 

of a network that is identified by its Internet Protocol (IP) 

address. 

sweep method.  A method of sending Simple Network 

Management Protocol (SNMP) requests for information 

to all the devices on a subnet by sending the request to 

every device in the network. 

switch.  A fibre-channel device that provides full 

bandwidth per port and high-speed routing of data by 

using link-level addressing. 

switch group.  A switch and the collection of devices 

connected to it that are not in other groups. 

switch zoning.  See zoning. 

synchronous write mode.  In remote mirroring, an 

option that requires the primary controller to wait for the 

acknowledgment of a write operation from the 

secondary controller before returning a write I/O request 

completion to the host. See also asynchronous write 

mode, remote mirroring, Metro Mirroring. 

system name.  Device name assigned by the vendor’s 

third-party software. 

TCP.   See Transmission Control Protocol. 

TCP/IP.  See Transmission Control Protocol/Internet 

Protocol. 

terminate and stay resident program (TSR 

program).  A program that installs part of itself as an 

extension of DOS when it is executed. 

topology.  The physical or logical arrangement of 

devices on a network. The three fibre-channel 

topologies are fabric, arbitrated loop, and point-to-point. 

The default topology for the disk array is arbitrated loop. 

TL_port.  See translated loop port. 

transceiver.  A device that is used to transmit and 

receive data. Transceiver is an abbreviation of 

transmitter-receiver. 

translated loop port (TL_port).  A port that connects 

to a private loop and allows connectivity between the 

private loop devices and off loop devices (devices not 

connected to that particular TL_port). 

Transmission Control Protocol (TCP).  A 

communication protocol used in the Internet and in any 

network that follows the Internet Engineering Task Force 

(IETF) standards for internetwork protocol. TCP 

provides a reliable host-to-host protocol between hosts 

in packed-switched communication networks and in 

interconnected systems of such networks. It uses the 

Internet Protocol (IP) as the underlying protocol. 

Transmission Control Protocol/Internet Protocol 

(TCP/IP).  A set of communication protocols that 

provide peer-to-peer connectivity functions for both local 

and wide-area networks. 

trap.  In the Simple Network Management Protocol 

(SNMP), a message sent by a managed node (agent 

function) to a management station to report an 

exception condition. 

trap recipient.  Receiver of a forwarded Simple 

Network Management Protocol (SNMP) trap. 

Specifically, a trap receiver is defined by an Internet 

Protocol (IP) address and port to which traps are sent. 

Presumably, the actual recipient is a software 

application running at the IP address and listening to 

the port. 

TSR program.  See terminate and stay resident 

program. 

uninterruptible power supply.  A source of power 

from a battery that is installed between a computer 

system and its power source. The uninterruptible power 

supply keeps the system running if a commercial power 

failure occurs, until an orderly shutdown of the system 

can be performed. 

user action events.  Actions that the user takes, such 

as changes in the storage area network (SAN), changed 

settings, and so on. 

worldwide port name (WWPN).   A unique identifier for 

a switch on local and global networks. 

worldwide name (WWN).  A globally unique 64-bit 

identifier assigned to each fibre channel port. 

WORM.   See write-once read-many. 

write-once read many (WORM).   Any type of storage 

medium to which data can be written only a single time, 

but can be read from any number of times. After the 

data is recorded, it cannot be altered. 

WWN.   See worldwide name. 

zoning.  (1) In fibre channel environments, the 

grouping of multiple ports to form a virtual, private, 

storage network. Ports that are members of a zone can 

communicate with each other, but are isolated from 

ports in other zones. (2) A function that allows 

segmentation of nodes by address, name, or physical 

port and is provided by fabric switches or hubs.
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